This list contains all the error numbers and error descriptions for Microsoft
Access 2007, 2003, 2002, and 2000.
We hope you find this list useful for reviewing errors that may appear in
your application.
To minimize the space, duplicate descriptions are eliminated, so if all four
Access versions have the same error description for an error ID, only the
2007 version is shown. Similarly, if the Access 2003 version is the same as
2007, it's not shown, but if the 2002 version differs, it is shown.
To reduce space, undefined error descriptions which provide no meaning
("Application-defined or object-defined error") are excluded from this list.
Supporting the Microsoft Access community since 1992.
FMS, Inc.
http://www.fmsinc.com/MicrosoftAccess
Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

5

2007

Error Description
Invalid procedure call or argument

6

2007

Overflow

7

2007

Out of memory

9

2007

Subscript out of range

10

2007

This array is fixed or temporarily locked

11

2007

Division by zero

13

2007

Type mismatch

14

2007

Out of string space

16

2007

Expression too complex

17

2007

Can't perform requested operation

18

2007

User interrupt occurred

28

2007

Out of stack space

47

2007

Too many DLL application clients

48

2007

Error in loading DLL

49

2007

Bad DLL calling convention

51

2007

Internal error

52

2007

Bad file name or number

53

2007

File not found

54

2007

Bad file mode

55

2007

File already open

57

2007

Device I/O error

58

2007

File already exists

59

2007

Bad record length

61

2007

Disk full

62

2007

Input past end of file
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Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

Error Description

63

2007

Bad record number

67

2007

Too many files

68

2007

Device unavailable

70

2007

Permission denied

71

2007

Disk not ready

74

2007

Can't rename with different drive

75

2007

Path/File access error

76

2007

Path not found

93

2007

Invalid pattern string

96

2007

Unable to sink events of object because the object is already firing events to the
maximum number of event receivers that it supports

97

2007

Can not call friend function on object which is not an instance of defining class

98

2007

A property or method call cannot include a reference to a private object, either as
an argument or as a return value

321

2007

Invalid file format

322

2007

Can't create necessary temporary file

325

2007

Invalid format in resource file

380

2007

Invalid property value

381

2007

Invalid property array index

382

2007

Set not supported at runtime

383

2007

Set not supported (read-only property)

385

2007

Need property array index

387

2007

Set not permitted

393

2007

Get not supported at runtime

394

2007

Get not supported (write-only property)

422

2007

Property not found

423

2007

Property or method not found

424

2007

Object required

429

2007

ActiveX component can't create object

430

2007

Class does not support Automation or does not support expected interface

432

2007

File name or class name not found during Automation operation

438

2007

Object doesn't support this property or method

440

2007

Automation error

442

2007

Connection to type library or object library for remote process has been lost. Press
OK for dialog to remove reference.

443

2007

Automation object does not have a default value

445

2007

Object doesn't support this action

446

2007

Object doesn't support named arguments

447

2007

Object doesn't support current locale setting

448

2007

Named argument not found

449

2007

Argument not optional

450

2007

Wrong number of arguments or invalid property assignment
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Numbe

Access

451

2007

Property let procedure not defined and property get procedure did not return an
object

452

2007

Invalid ordinal

453

2007

Specified DLL function not found

454

2007

Code resource not found

455

2007

Code resource lock error

457

2007

This key is already associated with an element of this collection

458

2007

Variable uses an Automation type not supported in Visual Basic

459

2007

Object or class does not support the set of events

460

2007

Invalid clipboard format

461

2007

Method or data member not found

462

2007

The remote server machine does not exist or is unavailable

463

2007

Class not registered on local machine

481

2007

Invalid picture

482

2007

Printer error

735

2007

Can't save file to TEMP

744

2007

Search text not found

746

2007

Replacements too long

2001

2007
2003

You canceled the previous operation.@@@1@2@5738@1
You canceled the previous operation.@@@1@5738@1

2002

2007

You tried to perform an operation involving a function or feature that was not
installed in this version of Microsoft Office Access.@@@1@@@1
You tried to perform an operation involving a function or feature that was not
installed in this version of Microsoft Office Access.@@@1@@1
You tried to perform an operation involving a function or feature that was not
installed in this version of Microsoft Access.@@@1@@1

2003
2002

Error Description

2004

2007

There isn't enough memory to perform this operation. Close unneeded programs
and try the operation again.

2005

2007

There isn't enough free memory to start Microsoft Office Access.@Close unneeded
programs and try again.For information on freeing memory, search the Microsoft
Windows Help index for 'memory, troubleshooting'.@@1@@@3
There isn't enough free memory to start Microsoft Office Access.@Close unneeded
programs and try again.For information on freeing memory, search the Microsoft
Windows Help index for 'memory, troubleshooting'.@@1@@3
There isn't enough free memory to start Microsoft Access.@Close unneeded
programs and try again.For information on freeing memory, search the Microsoft
Windows Help index for 'memory, troubleshooting'.@@1@@3

2003

2002

2006

2007

2003

2002

The object name '|' you entered doesn't follow Microsoft Office Access objectnaming rules.@For more information about naming objects, click
Help.@@2@1@553714184@1
The object name '|' you entered doesn't follow Microsoft Office Access objectnaming rules.@For more information about naming objects, click
Help.@@2@553714184@1
The object name '|' you entered doesn't follow Microsoft Access object-naming
rules.@For more information about naming objects, click Help.@@2@611734@1
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Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

2007

2007

2003

2008

2007
2003

2009

2007

2003
2010

2007
2003

Error Description
You already have an open database object named '|.'@Use a different name for
each database object of the same type.If you want this object to replace the
original object, close the original object, and then save this object using the same
name.For more information on renaming a database object, click
Help.@@2@1@9043@1
You already have an open database object named '|.'@Use a different name for
each database object of the same type.If you want this object to replace the
original object, close the original object, and then save this object using the same
name.For more information on renaming a database object, click
Help.@@2@209043@1
You
and
You
and

can't delete the database object '|' while it's open.@Close the database object,
then delete it.@@1@@@1
can't delete the database object '|' while it's open.@Close the database object,
then delete it.@@1@@1

You can't rename the database object '|' while it's open.@Close the database
object, and then rename it.@@1@@@1
You can't rename the database object '|' while it's open.@Close the database
object, and then rename it.@@1@@1

You
and
You
and

can't delete the database object '|' while it's open.@Close the database object,
then delete it.@@1@@@1
can't delete the database object '|' while it's open.@Close the database object,
then delete it.@@1@@1

2011

2007

The password you entered is incorrect.

2014

2007

You have given this |1 the same name as an existing |2 in your database.@You
can't give a table and a query the same name.@Give this object a name that isn't
already used by another table or query.@1@@@1
You have given this |1 the same name as an existing |2 in your database.@You
can't give a table and a query the same name.@Give this object a name that isn't
already used by another table or query.@1@@1

2003

2015

2007

2003

2002

There are no registered wizards of this type.@Rerun Microsoft Office Access or
Microsoft Office Setup to reinstall the wizards. If you want to preserve your security
or custom settings, back up the Microsoft Office Access workgroup information
file.For more information on backing up files, search the Microsoft Windows Help
index for 'backing up files'.@@1@@@1
There are no registered wizards of this type.@Rerun Microsoft Office Access or
Microsoft Office Setup to reinstall the wizards. If you want to preserve your security
or custom settings, back up the Microsoft Office Access workgroup information
file.For more information on backing up files, search the Microsoft Windows Help
index for 'backing up files'.@@1@@1
There are no registered wizards of this type.@Rerun Microsoft Access or Microsoft
Office Setup to reinstall the wizards. If you want to preserve your security or
custom settings, back up the Microsoft Access workgroup information file.For
more information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@@1@@1

2016

2007

You can't modify the attributes of System Tables.

2017

2007

Microsoft helps protect this Visual Basic for Applications Project with a password.
You must supply the password in the Visual Basic Editor before you can perform this
operation.@@@1@@@1
Microsoft helps protect this Visual Basic for Applications Project with a password.
You must supply the password in the Visual Basic Editor before you can perform this
operation.@@@1@@1
This Visual Basic for Applications Project has been protected with a password. You
must supply the password in the Visual Basic Editor before you can perform this
operation.@@@1@@1

2003

2000
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Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

2018

2007
2003

2019

2007

2003

2000

2020

2021

2007
2003
2007
2003

2022

2007
2003

2023
2024

2007
2003
2007

2003

2025

2007
2003
2002
2000

2026

2027

2007
2003

2007

The data access page name '|' you entered is misspelled or refers to a data access
page that isn't open or doesn't exist.@@@1@@@1
The data access page name '|' you entered is misspelled or refers to a data access
page that isn't open or doesn't exist.@@@1@@1
The number you used to refer to the data access page is invalid.@Use the Count
property to count the open data access pages and make sure that the page number
is not greater than the number of open data access pages minus
one.@@1@4@2019460@1
The number you used to refer to the data access page is invalid.@Use the Count
property to count the open data access pages and make sure that the page number
is not greater than the number of open data access pages minus
one.@@1@2019460@1
The number you used to refer to the data access page is invalid.@Use the Count
property to count the open data access pPage and make sure that the page number
is not greater than the number of open data access pages minus
one.@@1@2019460@1

The data access page theme name '|' you entered is misspelled or refers to a theme
name that doesn't exist.@@@1@@1
One or more operators in the filter expression is invalid.@For a valid list of
operators refer to the help file@@1@@@1
One or more operators in the filter expression is invalid.@For a valid list of
operators refer to the help file@@1@@1
You entered an expression that requires a data access page to be the active
window.@@@1@2@5601@1
You entered an expression that requires a data access page to be the active
window.@@@1@5601@1
The file name you specified for the data access page already exists.@@@1@5601@1

The report snapshot was not created because you don't have enough free disk
space for temporary work files.@To fix this, free up disk space (for example, empty
the Recycle Bin or delete unnecessary files).@@1@@@1
The report snapshot was not created because you don't have enough free disk
space for temporary work files.@To fix this, free up disk space (for example, empty
the Recycle Bin or delete unnecessary files).@@1@@1
The file is not in the correct format for a Microsoft Office Access
project.@@@1@@@1
The file is not in the correct format for a Microsoft Office Access project.@@@1@@1
The file is not in the correct format for a Microsoft Access project.@@@1@@1
The ADP file is not in the correct format for a Microsoft Access project.@@@1@@1
Your computer is missing at least one of the Microsoft Access 97 object libraries.
Your converted database will not work until you open this database using Access 97
and then fix any missing references. @Press OK to continue saving this database in
the Access 97 format with missing references, or press Cancel if you no longer wish
to save this database.@@4@@2

2002

This operation is not supported for Microsoft Office Access 1.X
databases.@@@1@@@1
This operation is not supported for Microsoft Office Access 1.X
databases.@@@1@@1
This operation is not supported for Microsoft Access 1.X databases.@@@1@@1

2007
2002

Microsoft Office Access was unable to close the database object.
Microsoft Access was unable to close the database object.

2003

2028

Error Description
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Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

2029

2007

Microsoft Office applications cannot suspend while you have documents open from a
network location. Exit the applications or close the open documents and try again.

2030

2007

The Microsoft Office Access project '|' will be opened read-only because one of the
following occurred:@Either the file is locked for editing by another user, the file (or
the folder in which it is located) is marked as read-only, or you specified that you
wanted to open the file read-only.@@3@@@1
The Microsoft Office Access project '|' will be opened read-only because one of the
following occurred:@The file is locked for editing by another user, or the file (or the
folder in which it is located,) is marked as read-only, or you specified that you
wanted to open this file read-only.@@1@@1
The Microsoft Access project '|' will be opened read-only because one of the
following occurred:@The file is locked for editing by another user, or the file (or the
folder in which it is located,) is marked as read-only, or you specified that you
wanted to open this file read-only.@@1@@1
The database '|' will be opened read-only because one of the following
occurred:@the file is locked for editing by another user, or the file (or the folder in
which it is located,) is marked as read-only, or you specified that you wanted to
open this file read-only@@1@@1

2003

2002

2000

2031

2007
2003

2032

2007
2003
2000

Error Description

You can't convert or enable an MDE file.@@@1@@@1
You can't convert or enable an MDE file.@@@1@@1
Some errors happened during the conversion. No converted database was
generated.@@@1@@1
Some errors happened during the conversion. No converted database is
generated.@@@1@@1

2033

2007
2003

Name conflicts with existing module, project, or object library.@@@1@@@1
Name conflicts with existing module, project, or object library.@@@1@@1

2034

2007
2003

Cannot Compile Project.@@@1@@@1
Cannot Compile Project.@@@1@@1

2035

2007
2003

Cannot Load Project of wrong version.@@@1@@@1
Cannot Load Project of wrong version.@@@1@@1

2036

2007
2003

2002
2037

2007

2003

2002

2038

2007
2000

2039

2007
2003

2040

2007
2003

Microsoft Office Access does not support using ADP Projects when running in
Runtime Mode.@@@1@@1
Microsoft Access does not support using ADP Projects when running in Runtime
Mode.@@@1@@1
Microsoft Office Access could not perform name AutoCorrect during this operation.
The 'Log name AutoCorrect' option is set, but the Data and Misc. Objects is not
checked out.@@@1@@@3
Microsoft Office Access could not perform name AutoCorrect during this operation.
The 'Log name AutoCorrect' option is set, but the Data and Misc. Objects is not
checked out.@@@1@@3
Microsoft Access could not perform name AutoCorrect during this operation. The
'Log name AutoCorrect' option is set, but the Data and Misc. Objects is not checked
out.@@@1@@3
The file '|' cannot be opened because it has been locked by another user.
The file '|' cannot be opened because it has been locked by another user
You cannot convert a workgroup file from Microsoft Access2000 to Access 97. You
must create new security settings in Access 97.

Microsoft Office Access can't run.@@@1@@@3
Microsoft Office Access can't run.@@@1@@3
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Numbe

Access

2040

2002

Microsoft Access can't run.@@@1@@3

2041

2007
2002

Microsoft Office Access couldn't find file '|'. This file is required for startup.
Microsoft Access couldn't find file '|'. This file is required for startup.

2042

2007

A system error occurred, or there isn't enough free memory to start Microsoft Office
Access. Close unneeded programs and try again.
A system error occurred, or there isn't enough free memory to start Microsoft
Access. Close unneeded programs and try again.

2002
2043

2007
2003
2002

2044

2007
2003
2002

2045

2007

2003

2002

2000

2046

2007

2003

2002

2047
2048

2007
2000
2007

2003

Error Description

Microsoft Office Access can't find the database file '|.'@Make sure you entered the
correct path and file name.@@1@@@1
Microsoft Office Access can't find the database file '|.'@Make sure you entered the
correct path and file name.@@1@@1
Microsoft Access can't find the database file '|.'@Make sure you entered the correct
path and file name.@@1@@1

You can't exit Microsoft Office Access now.@If you're running a Visual Basic module
that is using OLE or DDE, you may need to interrupt the module.@@1@@@1
You can't exit Microsoft Office Access now.@If you're running a Visual Basic module
that is using OLE or DDE, you may need to interrupt the module.@@1@@1
You can't exit Microsoft Access now.@If you're running a Visual Basic module that is
using OLE or DDE, you may need to interrupt the module.@@1@@1
The command line you used to start Microsoft Office Access contains an option that
Microsoft Office Access doesn't recognize.@Exit and restart Microsoft Office Access
using valid command-line options.@@1@@@1
The command line you used to start Microsoft Office Access contains an option that
Microsoft Office Access doesn't recognize.@Exit and restart Microsoft Office Access
using valid command-line options.@@1@@1
The command line you used to start Microsoft Access contains an option that
Microsoft Access doesn't recognize.@Exit and restart Microsoft Access using valid
command-line options.@@1@@1
The command line you used to start Microsoft Access contains an option that
Microsoft Access doesn't recognize.@Exit and restart Microsoft Access using valid
command-line options.@@2@510252@1
The command or action '|' isn't available now.@* You may be in a read-only
database or an unconverted database from an earlier version of Microsoft Office
Access.* The type of object the action applies to isn't currently selected or isn't in
the active view.@Use only those commands and macro actions that are currently
available for this database.@1@@@1
The command or action '|' isn't available now.@* You may be in a read-only
database or an unconverted database from an earlier version of Microsoft Office
Access.* The type of object the action applies to isn't currently selected or isn't in
the active view.@Use only those commands and macro actions that are currently
available for this database.@1@@1
The command or action '|' isn't available now.@* You may be in a read-only
database or an unconverted database from an earlier version of Microsoft
Access.* The type of object the action applies to isn't currently selected or isn't in
the active view.@Use only those commands and macro actions that are currently
available for this database.@1@@1
Microsoft Access can't run.@@@1@@3

There isn't enough free memory to open the file '|.'@Close unneeded programs and
try again.For more information on freeing memory, search the Microsoft Windows
Help index for 'memory, troubleshooting'.@@1@@@1
There isn't enough free memory to open the file '|.'@Close unneeded programs and
try again.For more information on freeing memory, search the Microsoft Windows
Help index for 'memory, troubleshooting'.@@1@@1
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Numbe

Access

2049

2007
2003

Error Description
The Tahoma font is not present. To restore it, please run Detect and Repair from
the Help menu.

2050

2007
2003

Enter an OLE/DDE Timeout setting from 0 through 300 seconds.@@@1@@@1
Enter an OLE/DDE Timeout setting from 0 through 300 seconds.@@@1@@1

2051

2007

The object name '|1' can't be longer than |2 characters according to Microsoft Office
Access object-naming rules.@@@1@@@1
The object name '|1' can't be longer than |2 characters according to Microsoft Office
Access object-naming rules.@@@1@@1
The object name '|1' can't be longer than |2 characters according to Microsoft
Access object-naming rules.@@@1@@1
The object name '|' can't be longer than 64 characters according to Microsoft Access
object-naming rules.@@@1@@1

2003
2002
2000
2052

2007

There isn't enough free memory to update the display. Close unneeded programs
and try again.

2053

2007
2003

The command name can't be blank.@Please choose a name.@@1@@@1
The command name can't be blank.@Please choose a name.@@1@@1

2054

2007

Microsoft Office Access is unable to load the Visual Basic for Applications dynamiclink library (DLL) Vbe6.@Rerun the Microsoft Office Access Setup
program.@@1@@@3
Microsoft Office Access is unable to load the Visual Basic for Applications dynamiclink library (DLL) Vbe6.@Rerun the Microsoft Office Access Setup
program.@@1@@3
Microsoft Access is unable to load the Visual Basic for Applications dynamic-link
library (DLL) Vbe6.@Rerun the Microsoft Access Setup program.@@1@@3

2003

2002
2055

2007
2003

The expression '|' you entered is invalid.@@@1@1@11732@1
The expression '|' you entered is invalid.@@@1@311732@1

2056

2007
2003
2002

Microsoft Office Access can't supply context-sensitive Help.@@@1@@@1
Microsoft Office Access can't supply context-sensitive Help.@@@1@@1
Microsoft Access can't supply context-sensitive Help.@@@1@@1

2057

2007

There isn't enough stack memory left to perform the operation.@The operation is
too complicated. Try simplifying the operation.@@1@@@3
There isn't enough stack memory left to perform the operation.@The operation is
too complicated. Try simplifying the operation.@@1@@3

2003
2058

2007

2003

2002

2059

2007
2003

The file '|' is incompatible. Microsoft Office Access needs to be reinstalled.@Run
Setup to reinstall Microsoft Office Access. If you want to preserve your security or
custom settings, back up the Microsoft Office Access workgroup information
file.For more information on backing up files, search the Microsoft Windows Help
index for 'backing up files'.@@1@@185309@3
The file '|' is incompatible. Microsoft Office Access needs to be reinstalled.@Run
Setup to reinstall Microsoft Office Access. If you want to preserve your security or
custom settings, back up the Microsoft Office Access workgroup information
file.For more information on backing up files, search the Microsoft Windows Help
index for 'backing up files'.@@1@@3
The file '|' is incompatible. Microsoft Access needs to be reinstalled.@Run Setup to
reinstall Microsoft Access. If you want to preserve your security or custom settings,
back up the Microsoft Access workgroup information file.For more information on
backing up files, search the Microsoft Windows Help index for 'backing up
files'.@@1@@3

Microsoft Office Access
that you spell its name
Microsoft Office Access
that you spell its name
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Numbe

Access

2059

2002

Microsoft Access cannot find the object '|'.@Make sure the object exists and that
you spell its name correctly.@@1@@1

2060

2007

You can't create a field list based on the action query '|.'@Action queries don't have
fields. A form or report must be based on a table, or on a select or crosstab
query.@Change the RecordSource property for the form or report, or open the
action query and change it to a select query.@1@1@9232@1
You can't create a field list based on the action query '|.'@Action queries don't have
fields. A form or report must be based on a table, or on a select or crosstab
query.@Change the RecordSource property for the form or report, or open the
action query and change it to a select query.@1@209232@1

2003

Error Description

2061

2007
2003

Enter a zero or greater-than-zero number for this option.@@@1@@@1
Enter a zero or greater-than-zero number for this option.@@@1@@1

2062

2007

The command name must be shorter than 255 Characters.@Please choose a
name.@@1@@@1
The command name must be shorter than 255 Characters.@Please choose a
name.@@1@@1

2003
2063

2007

2003

2002

2064

2007

2003

2065

2007

2003

2066

2007
2003
2002

Microsoft Office Access can't create, open, or write to the index file '|'; the
information (.inf) file it uses to keep track of dBASE indexes.@The index file may be
damaged, or you may not have read/write permission for the network drive you're
trying to link to.@You can link to the dBASE file without specifying any dBASE
indexes, but the existing indexes will not be used with the linked table.@1@@@1
Microsoft Office Access can't create, open, or write to the index file '|'; the
information (.inf) file it uses to keep track of dBASE indexes.@The index file may be
damaged, or you may not have read/write permission for the network drive you're
trying to link to.@You can link to the dBASE file without specifying any dBASE
indexes, but the existing indexes will not be used with the linked table.@1@@1
Microsoft Access can't create, open, or write to the index file '|'; the information
(.inf) file it uses to keep track of dBASE indexes.@The index file may be damaged,
or you may not have read/write permission for the network drive you're trying to
link to.@You can link to the dBASE file without specifying any dBASE indexes, but
the existing indexes will not be used with the linked table.@1@@1
The menu bar value '|' is invalid.@You supplied an argument to the DoMenuItem
method that refers to a menu bar that is invalid.@Use an intrinsic constant or
numeric value that refers to a valid menu bar value, such as
acFormbar.@1@1@11895@1
The menu bar value '|' is invalid.@You supplied an argument to the DoMenuItem
method that refers to a menu bar that is invalid.@Use an intrinsic constant or
numeric value that refers to a valid menu bar value, such as
acFormbar.@1@611895@1
The name for the menu, command, or subcommand you entered is invalid.@You
supplied an argument to the DoMenuItem method that refers to a menu name,
command, or subcommand that is invalid.@Use an intrinsic constant or numeric
value that refers to a valid menu, command, or subcommand value, such as
acRecordsMenu.@1@1@11895@1
The name for the menu, command, or subcommand you entered is invalid.@You
supplied an argument to the DoMenuItem method that refers to a menu name,
command, or subcommand that is invalid.@Use an intrinsic constant or numeric
value that refers to a valid menu, command, or subcommand value, such as
acRecordsMenu.@1@611895@1
A video adapter resolution of at least 640 x 480 pixels is required to run Microsoft
Office Access.
A video adapter resolution of at least 640 x 480 pixels is required to run Microsoft
Access.
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Numbe

Access

2067

2007

2003

2002

2068

2007

2003

2069

2007

2003

2070

2007
2003

2071

2007

2003

Error Description
A menu bar macro can only be run if the menu bar macro name is the setting used
by particular properties or options.@You tried to run a menu bar macro containing
the AddMenu action.Set one of the following properties or options to the name of
the menu bar macro:* The MenuBar property of a form or report.* The
ShortcutMenuBar property of a form, report, or control.* The Menu Bar or
Shortcut Menu Bar option in the Startup dialog box.This error also occurs if
Microsoft Office Access attempts to run a menu bar macro containing an AddMenu
action that follows an action that makes some other object the active object. For
example, the OpenForm action.@@2@1@3704@1
A menu bar macro can only be run if the menu bar macro name is the setting used
by particular properties or options.@You tried to run a menu bar macro containing
the AddMenu action.Set one of the following properties or options to the name of
the menu bar macro:* The MenuBar property of a form or report.* The
ShortcutMenuBar property of a form, report, or control.* The Menu Bar or
Shortcut Menu Bar option in the Startup dialog box.This error also occurs if
Microsoft Office Access attempts to run a menu bar macro containing an AddMenu
action that follows an action that makes some other object the active object. For
example, the OpenForm action.@@2@603704@1
A menu bar macro can only be run if the menu bar macro name is the setting used
by particular properties or options.@You tried to run a menu bar macro containing
the AddMenu action.Set one of the following properties or options to the name of
the menu bar macro:* The MenuBar property of a form or report.* The
ShortcutMenuBar property of a form, report, or control.* The Menu Bar or
Shortcut Menu Bar option in the Startup dialog box.This error also occurs if
Microsoft Access attempts to run a menu bar macro containing an AddMenu action
that follows an action that makes some other object the active object. For example,
the OpenForm action.@@2@603704@1

The selected item is customized and
information on creating custom Help
Help.@@2@1@10930@1
The selected item is customized and
information on creating custom Help
Help.@@2@110930@1

doesn't have context-sensitive Help.@For more
for a form, report, or control, click
doesn't have context-sensitive Help.@For more
for a form, report, or control, click

The key or key combination |1 in |2 has invalid syntax or is not allowed.@Use the
SendKeys syntax to specify the key or key combinations.For the allowed key or
key combinations, click Help.@@2@1@10144@1
The key or key combination |1 in |2 has invalid syntax or is not allowed.@Use the
SendKeys syntax to specify the key or key combinations.For the allowed key or
key combinations, click Help.@@2@610144@1
You already assigned the key or key combination |1 in |2 to another macro.@Only
the first key or key combination will be used.@@2@1@10144@1
You already assigned the key or key combination |1 in |2 to another macro.@Only
the first key or key combination will be used.@@2@610144@1
The Docking property can't be set to '|1' at this time.@If you want to set the
Docking property to '|2', move the toolbar from its current position and try
again.@@1@@@1
The Docking property can't be set to '|1' at this time.@If you want to set the
Docking property to '|2', move the toolbar from its current position and try
again.@@1@@1

2072

2007
2003

All objects were imported successfully.
Successfully imported '|'.

2073

2007

Successfully exported '|'.

2074

2007
2003

This operation is not supported within transactions.@@@1@@@1
This operation is not supported within transactions.@@@1@@1

2075

2007

This operation requires an open database.@@@1@@@1
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Access

2075

2003

This operation requires an open database.@@@1@@1

2076

2007

Successfully linked '|'.

2077

2007

This Recordset is not updatable

2078

2007

Help isn't available due to lack of memory or improper installation of Microsoft
Windows or Microsoft Office Access.@For more information on troubleshooting a low
memory problem, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@If you need to reinstall Microsoft Office Access, you may want to
preserve your security or custom settings. To do so, back up the Microsoft Office
Access workgroup information file.For more information on backing up files,
search the Microsoft Windows Help index for 'backing up files'.@1@@@3
Help isn't available due to lack of memory or improper installation of Microsoft
Windows or Microsoft Office Access.@For more information on troubleshooting a low
memory problem, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@If you need to reinstall Microsoft Office Access, you may want to
preserve your security or custom settings. To do so, back up the Microsoft Office
Access workgroup information file.For more information on backing up files,
search the Microsoft Windows Help index for 'backing up files'.@1@@3
Help isn't available due to lack of memory or improper installation of Microsoft
Windows or Microsoft Access.@For more information on troubleshooting a low
memory problem, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@If you need to reinstall Microsoft Access, you may want to
preserve your security or custom settings. To do so, back up the Microsoft Access
workgroup information file.For more information on backing up files, search the
Microsoft Windows Help index for 'backing up files'.@1@@3

2003

2002

Error Description

2079

2007
2000

Form is read-only, because the Unique Table property is not set.
Form is read-only because the Unique Table property is not set.

2080

2007

The toolbar or menu | already exists.@Do you want to replace the existing toolbar
or menu?@@19@@@2
The toolbar or menu | already exists.@Do you want to replace the existing toolbar
or menu?@@19@@2

2003
2081

2007
2003

2082

2083

2007
2003

2007
2003

The Create From Macro command only works when a macro is selected in the
Navigation Pane.@@@1@@@1
The Create From Macro command only works when a macro is selected in the
Database window.@@@1@@1

Only fields from the Unique Table can be edited.
The database '|' is read-only.@You can't save changes made to data or object
definitions in this database.@@1@@@1
The database '|' is read-only.@You can't save changes made to data or object
definitions in this database.@@1@@1

2084

2007

Field '|' is based on an expression and can't be edited

2085

2007

The ODBC Refresh Interval setting must be from 1 through 32,766
seconds.@@@1@@@1
The ODBC Refresh Interval setting must be from 1 through 32,766
seconds.@@@1@@1

2003
2086

2007

Recordset requires a form to be updatable.

2087

2007

Microsoft Office Access can't display the Add-ins submenu.@The Add-ins submenu
expression '|' you entered exceeds the 256-character limit.@Shorten the
macroname or functionname expression in the Menu Add-ins key of the Windows
Registry setting, and then restart Microsoft Office Access.For more information on
customizing Microsoft Office Access settings in the Windows Registry, click
Help.@2@1@9015@3
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Numbe

Access

2087

2003

2002

2088

2007

2003

2002

2089

2007
2003
2002

2090

2007

2003

2002

2091

2007
2003

Error Description
Microsoft Office Access can't display the Add-ins submenu.@The Add-ins submenu
expression '|' you entered exceeds the 256-character limit.@Shorten the
macroname or functionname expression in the Menu Add-ins key of the Windows
Registry setting, and then restart Microsoft Office Access.For more information on
customizing Microsoft Office Access settings in the Windows Registry, click
Help.@2@109015@3
Microsoft Access can't display the Add-ins submenu.@The Add-ins submenu
expression '|' you entered exceeds the 256-character limit.@Shorten the
macroname or functionname expression in the Menu Add-ins key of the Windows
Registry setting, and then restart Microsoft Access.For more information on
customizing Microsoft Access settings in the Windows Registry, click
Help.@2@109015@3
Microsoft Office Access can't display the Add-ins submenu | because a setting you
entered in the Windows Registry is missing a macro name or function name
expression.@@Supply the missing expression in the Menu Add-ins key of the
Windows Registry, and then restart Microsoft Office Access.For more information
on customizing Microsoft Office Access settings in the Windows Registry, click
Help.@2@1@9015@3
Microsoft Office Access can't display the Add-ins submenu | because a setting you
entered in the Windows Registry is missing a macro name or function name
expression.@@Supply the missing expression in the Menu Add-ins key of the
Windows Registry, and then restart Microsoft Office Access.For more information
on customizing Microsoft Office Access settings in the Windows Registry, click
Help.@2@109015@3
Microsoft Access can't display the Add-ins submenu | because a setting you entered
in the Windows Registry is missing a macro name or function name
expression.@@Supply the missing expression in the Menu Add-ins key of the
Windows Registry, and then restart Microsoft Access.For more information on
customizing Microsoft Access settings in the Windows Registry, click
Help.@2@109015@3
Microsoft Office Access can't display the same menu more than once in a menu
bar.@@@1@1@3704@1
Microsoft Office Access can't display the same menu more than once in a menu
bar.@@@1@603704@1
Microsoft Access can't display the same menu more than once in a menu
bar.@@@1@603704@1

An action within the current global menu's macro group can't change the global
menu bar.@Microsoft Office Access can't display the global menu bar because the
macro called when you first set the global menu includes another action that tries to
reset the global menu.@Check your menu bar macros, and make sure that you set
the global menu bar only once.@1@@@1
An action within the current global menu's macro group can't change the global
menu bar.@Microsoft Office Access can't display the global menu bar because the
macro called when you first set the global menu includes another action that tries to
reset the global menu.@Check your menu bar macros, and make sure that you set
the global menu bar only once.@1@@1
An action within the current global menu's macro group can't change the global
menu bar.@Microsoft Access can't display the global menu bar because the macro
called when you first set the global menu includes another action that tries to reset
the global menu.@Check your menu bar macros, and make sure that you set the
global menu bar only once.@1@@1
'|' is an invalid name.@@@1@@@1
'|' is an invalid name.@@@1@@1
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Numbe

Access

2092

2007

2003

2002

2093

2007

2003

2094

2007

2003

2002

2095

2007
2003

2002
2096

Error Description
The value you specified for the Setting argument in the SetOption method is not the
correct type of Variant for this option.@You specified a string when Microsoft Office
Access expected a number.@See the Access Options dialog box (click the Microsoft
Office Button, and then click Access Options) to see what type of data is required to
set this particular option. For example, the setting for the Default Database Folder
option must be a string. To see what type of Variant you passed to the SetOption
method, use the VarType function.For more information, search the Help index for
'Variant data type' and 'VarType function'.@1@@@1
The value you specified for the setting argument in the SetOption method isn't the
correct type of Variant for this option.@You specified a string when Microsoft Office
Access expected a number.@Check the Options dialog box (Tools menu) to see
what type of data is required to set this particular option. For example, the setting
for the Default Database Folder option must be a string. To see what type of Variant
you passed to the SetOption method, use the VarType function.For more
information, search the Help index for 'Variant data type' and 'VarType
function'.@1@@1
The value you specified for the setting argument in the SetOption method isn't the
correct type of Variant for this option.@You specified a string when Microsoft Access
expected a number.@Check the Options dialog box (Tools menu) to see what type
of data is required to set this particular option. For example, the setting for the
Default Database Folder option must be a string. To see what type of Variant you
passed to the SetOption method, use the VarType function.For more information,
search the Help index for 'Variant data type' and 'VarType function'.@1@@1

The numeric value for the Setting argument in the SetOption method does not
correspond to any list box or option group settings in the Access Options dialog
box.@Valid settings are 0 (the first item in the list) through | (the last item in the
list).@@1@1@6210@1optimize.ids
The numeric value for the setting argument in the SetOption method doesn't
correspond to any list box or option group settings in the Options dialog box.@Valid
settings are 0 (the first item in the list) through | (the last item in the
list).@@1@606210@1
Microsoft Office Access cannot find the toolbar '|.'@You tried to run a macro that
includes a ShowToolbar action or a Visual Basic for Applications procedure that
includes a ShowToolbar method.* The toolbar name might be misspelled or might
refer to a legacy toolbar that is no longer available.* This action might refer to a
custom toolbar that was deleted from or renamed in the current database.* This
action might refer to a custom toolbar that exists in a different
database.@@1@1@6458@1
Microsoft Office Access can't find the toolbar '|.'@You tried to run a macro that
includes a ShowToolbar action or a Visual Basic procedure that includes a
ShowToolbar method.* The toolbar name may be misspelled.* This action may
refer to a custom toolbar that was deleted from or renamed in the current
database.* This action may refer to a custom toolbar that exists in a different
database.@@1@606458@1
Microsoft Access can't find the toolbar '|.'@You tried to run a macro that includes a
ShowToolbar action or a Visual Basic procedure that includes a ShowToolbar
method.* The toolbar name may be misspelled.* This action may refer to a
custom toolbar that was deleted from or renamed in the current database.* This
action may refer to a custom toolbar that exists in a different
database.@@1@606458@1
Microsoft Office Access can't switch to |.@The Microsoft application you tried to
open can't be found or hasn't been installed on your computer.@@1@@3
Microsoft Access can't switch to |.@The Microsoft application you tried to open can't
be found or hasn't been installed on your computer.@@1@@3

2007
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Numbe

Access

2096

2003

2002

2097

2007

2003

2002

2098

2007
2003

2100

2007

2003

2101

2007
2003

2102

2007

2003

2103

2007

Error Description
Microsoft Office Access can't open the Microsoft Office application because it can't
find the dynamic-link library Mstool32.@Run Setup to reinstall Microsoft Office
Access. If you want to preserve your security or custom settings, back up the
Microsoft Office Access workgroup information file.For more information on
backing up files, search the Microsoft Windows Help index for 'backing up
files'.@@1@@3
Microsoft Access can't open the Microsoft Office application because it can't find the
dynamic-link library Mstool32.@Run Setup to reinstall Microsoft Access. If you want
to preserve your security or custom settings, back up the Microsoft Access
workgroup information file.For more information on backing up files, search the
Microsoft Windows Help index for 'backing up files'.@@1@@3

The table for which you tried to create an import/export specification was created in
an earlier version of Microsoft Office Access.@To convert this database to the
current version of Microsoft Office Access, click the Microsoft Office Button, and then
click 'Convert'.@@1@@@1
The table you tried to create an import/export specification for was created in an
earlier version of Microsoft Office Access.@Convert this database to the current
version of Microsoft Office Access by using the Convert Database command (Tools
menu, Database Utilities submenu).@@1@@1
The table you tried to create an import/export specification for was created in an
earlier version of Microsoft Access.@Convert this database to the current version of
Microsoft Access by using the Convert Database command (Tools menu, Database
Utilities submenu).@@1@@1
The operation could not be completed because the Smart Tag '|' is not recognized
by your system.@@@1@@@1
The operation could not be completed because the Smart Tag '|' is not recognized
by your system
The control or subform control is too large for this location.@The number you
entered for the Left, Top, Height, or Width property is too large or is a negative
number.@Reduce the size of the control or subform control, or enter a positive
number.@1@@@1
The control or subform control is too large for this location.@The number you
entered for the Left, Top, Height, or Width property is too large or is a negative
number.@Reduce the size of the control or subform control, or enter a positive
number.@1@@1
The
this
The
this

setting you entered isn't valid for this property.@To
property, search the Help index for the name of the
setting you entered isn't valid for this property.@To
property, search the Help index for the name of the

see the valid settings for
property.@@1@@@1
see the valid settings for
property.@@1@@1

The form name '|' is misspelled or refers to a form that doesn't exist.@If the invalid
form name is in a macro, an Action Failed dialog box will display the macro name
and the macro's arguments after you click OK. Open the Macro window, and enter
the correct form name.@@1@@@1
The form name '|' is misspelled or refers to a form that doesn't exist.@If the invalid
form name is in a macro, an Action Failed dialog box will display the macro name
and the macro's arguments after you click OK. Open the Macro window, and enter
the correct form name.@@1@@1

The report name '|' you entered in either the property sheet or macro is misspelled
or refers to a report that doesn't exist.@If the invalid report name is in a macro, an
Action Failed dialog box will display the macro name and the macro's arguments
after you click OK. Open the Macro window, and enter the correct report
name.@@1@@@1
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Numbe

Access

2103

2003

The report name '|' you entered in either the property sheet or macro is misspelled
or refers to a report that doesn't exist.@If the invalid report name is in a macro, an
Action Failed dialog box will display the macro name and the macro's arguments
after you click OK. Open the Macro window, and enter the correct report
name.@@1@@1

2104

2007

You entered the control name '|,' which is already in use.@You already have a
control on the form with this name, or an existing control has its name mapped to
this name for Visual Basic.Visual Basic maps spaces in control names to
underscores. For example, My Control and My_Control are treated as duplicate
names.@@1@1@11734@1
You entered the control name '|,' which is already in use.@You already have a
control on the form with this name, or an existing control has its name mapped to
this name for Visual Basic.Visual Basic maps spaces in control names to
underscores. For example, My Control and My_Control are treated as duplicate
names.@@1@611734@1

2003

2105

2007
2003

2106

2007

2003

2002

2107

2007

2003

2108

2007

2003

Error Description

You can't go to the specified record.@You may be at the end of a
recordset.@@1@@@1
You can't go to the specified record.@You may be at the end of a
recordset.@@1@@1
| errors occurred when you loaded the form or report.@You loaded a form or report
that has controls or properties that Microsoft Office Access doesn't recognize and
will ignore.@@1@@@1
| errors occurred when you loaded the form or report.@You loaded a form or report
that has controls or properties that Microsoft Office Access doesn't recognize and
will ignore.@@1@@1
| errors occurred when you loaded the form or report.@You loaded a form or report
that has controls or properties that Microsoft Access doesn't recognize and will
ignore.@@1@@1

The value you entered does not meet the validation rule defined for the field or
control.@To see the validation rule, switch to Design view, click the appropriate
field, and then, if the property sheet is not open, press F4. Then, click the Data tab
in the property sheet.@Enter a value that meets the validation rule, or press ESC to
undo your changes.@1@1@11730@1
The value you entered doesn't meet the validation rule defined for the field or
control.@To see the validation rule, click Design view, click the appropriate field,
and then, if the property sheet isn't open, click the Properties button on the toolbar.
Then click the Data tab.@To solve this problem, enter a value that meets the
validation rule, or press ESC to undo your changes.@1@211730@1
You must save the field before you execute the GoToControl action, the GoToControl
method, or the SetFocus method.@You tried to move the focus to another control
using the SetFocus method, GoToControl action, or the GoToControl method.@Set
the macro or method to the AfterUpdate property instead of the BeforeUpdate
property so it saves the field before changing the focus.@1@1@6314@1
You must save the field before you execute the GoToControl action, the GoToControl
method, or the SetFocus method.@You tried to move the focus to another control
using the SetFocus method, GoToControl action, or the GoToControl method.@Set
the macro or method to the AfterUpdate property instead of the BeforeUpdate
property so it saves the field before changing the focus.@1@606314@1

2109

2007
2003

There is no field named '|' in the current record.@@@1@@@1
There is no field named '|' in the current record.@@@1@@1

2110

2007

Microsoft Office Access can't move the focus to the control |.@* The control may be
a type that can't receive the focus, such as a label.* The control's Visible property
may be set to No.* The control's Enabled property may be set to
No.@@1@1@3016@1
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Access

2110

2003

2002

2111

2007

2003

Error Description
Microsoft Office Access can't move the focus to the control |.@* The control may be
a type that can't receive the focus, such as a label.* The control's Visible property
may be set to No.* The control's Enabled property may be set to
No.@@1@603016@1
Microsoft Access can't move the focus to the control |.@* The control may be a type
that can't receive the focus, such as a label.* The control's Visible property may
be set to No.* The control's Enabled property may be set to No.@@1@603016@1

The changes you made can't be saved.@The save operation may have failed due to
the temporary locking of the records by another user.* Click OK to try again. You
may need to click OK several times (or wait until the other user closes the
table).* Click Cancel if repeated attempts to save your changes fail.@@3@@@1
The changes you made can't be saved.@The save operation may have failed due to
the temporary locking of the records by another user.* Click OK to try again. You
may need to click OK several times (or wait until the other user closes the
table).* Click Cancel if repeated attempts to save your changes fail.@@3@@1

2112

2007
2003

The item on the Clipboard can't be pasted into this control.@@@1@@@1
The item on the Clipboard can't be pasted into this control.@@@1@@1

2113

2007

The value you entered isn't valid for this field.@For example, you may have entered
text in a numeric field or a number that is larger than the FieldSize setting
permits.@@1@@@1
The value you entered isn't valid for this field.@For example, you may have entered
text in a numeric field or a number that is larger than the FieldSize setting
permits.@@1@@1

2003

2114

2007
2003
2002

2000
2115

2007

2003

2002

2116

2007

Microsoft Office Access doesn't support the format of the file '|,' or file is too large.
Try converting the file to BMP format.@@@1@@@1
Microsoft Office Access doesn't support the format of the file '|,' or file is too large.
Try converting the file to BMP or GIF format.@@@1@@1
Microsoft Access doesn't support the format of the file '|,' or file is too large. Try
converting the file to BMP or GIF format.@@@1@@1
Microsoft Access doesn't support the format of the file '|,' so it can't load the
picture.@@@1@@1

The macro or function set to the BeforeUpdate or ValidationRule property for this
field is preventing Microsoft Office Access from saving the data in the field.@* If this
is a macro, open the macro in the Macro window and remove the action that forces
a save (for example, GoToControl).* If the macro includes a SetValue action, set
the macro to the AfterUpdate property of the control instead.* If this is a function,
redefine the function in the Module window.@@1@@@1
The macro or function set to the BeforeUpdate or ValidationRule property for this
field is preventing Microsoft Office Access from saving the data in the field.@* If this
is a macro, open the macro in the Macro window and remove the action that forces
a save (for example, GoToControl).* If the macro includes a SetValue action, set
the macro to the AfterUpdate property of the control instead.* If this is a function,
redefine the function in the Module window.@@1@@1
The macro or function set to the BeforeUpdate or ValidationRule property for this
field is preventing Microsoft Access from saving the data in the field.@* If this is a
macro, open the macro in the Macro window and remove the action that forces a
save (for example, GoToControl).* If the macro includes a SetValue action, set
the macro to the AfterUpdate property of the control instead.* If this is a function,
redefine the function in the Module window.@@1@@1
The value violates the validation rule for the field or record.@For example, you
might have changed a validation rule without verifying whether the existing data
matches the new validation rule.@Click Undo to restore the previous value, or enter
a new value that meets the validation rule for the field or record.@2@1@9121@1
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Access

2116

2003

The value in the field or record violates the validation rule for the record or
field.@For example, you may have changed a validation rule without verifying
whether the existing data matches the new validation rule.@Click Undo on the Edit
menu to restore the previous value, or enter a new value that meets the validation
rule for the field.@2@209121@1

2117

2007

Microsoft Office Access has canceled the Paste operation.@The text on the
Clipboard is too long to paste into the form. For example, you may have pasted too
much text into a label or entered too much text in the ColumnWidths
property.@Paste smaller sections. For labels, you must paste fewer than 2,048
characters.@1@@@1
Microsoft Office Access has canceled the Paste operation.@The text on the
Clipboard is too long to paste into the form. For example, you may have pasted too
much text into a label or entered too much text in the ColumnWidths
property.@Paste smaller sections. For labels, you must paste fewer than 2,048
characters.@1@@1
Microsoft Access has canceled the Paste operation.@The text on the Clipboard is too
long to paste into the form. For example, you may have pasted too much text into a
label or entered too much text in the ColumnWidths property.@Paste smaller
sections. For labels, you must paste fewer than 2,048 characters.@1@@1

2003

2002

2118

2007

2003

2119

2007

2003

2120

2007

2003

2000

2121

2007

2003

2002

2122

2007

Error Description

You must save the current field before you run the Requery action.@* If you are
running a macro from the Navigation Pane, save the field first, and then run the
macro.* If the macro name is the setting of the BeforeUpdate property in a Visual
Basic function, set the AfterUpdate property to the name of the macro
instead.@@1@1@3033@1
You must save the current field before you run the Requery action.@* If you are
running a macro from the Database window, save the field first, and then run the
macro.* If the macro name is the setting of the BeforeUpdate property in a Visual
Basic function, set the AfterUpdate property to the name of the macro
instead.@@1@603033@1
The Requery action can't be used on the control '|.'@Certain controls, such as labels
and rectangles, can't receive the focus; therefore, you can't apply a Requery action
to them.@@1@1@3033@1
The Requery action can't be used on the control '|.'@Certain controls, such as labels
and rectangles, can't receive the focus; therefore, you can't apply a Requery action
to them.@@1@603033@1
To create a form, report or data access page using this wizard, you must first select
the table or query on which the form, report or data access page will be
based.@@@1@@@1
To create a form, report or data access page using this wizard, you must first select
the table or query on which the form, report or data access page will be
based.@@@1@@1
To create a form, report or data access page using this wizard, you must first select
the table or | on which the form, report or data access page will be
based.@@@1@@1

Microsoft Office Access can't open the form '|.'@It contains data that Microsoft
Office Access doesn't recognize.Re-create the form or, if you maintain backup
copies of your database, retrieve a copy of the form.@@1@@@1
Microsoft Office Access can't open the form '|.'@It contains data that Microsoft
Office Access doesn't recognize.Re-create the form or, if you maintain backup
copies of your database, retrieve a copy of the form.@@1@@1
Microsoft Access can't open the form '|.'@It contains data that Microsoft Access
doesn't recognize.Re-create the form or, if you maintain backup copies of your
database, retrieve a copy of the form.@@1@@1
You can't view a form as a continuous form if it contains a subform, an ActiveX
control, or a bound chart.@Set the DefaultView property of the form to Single Form,
Datasheet, PivotTable, or PivotChart.@@1@@@1
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Numbe

Access

2122

2003

2000

2123

2007
2003
2002

2124

2007
2003
2002

2125

2007
2003

2126

2007
2003

2127

2007
2003

2128

2007

2003
2002
2129

2007

2003

2130

2007
2003

Error Description
You can't view a form as a continuous form if it contains a subform, an ActiveX
control, or a bound chart.@Set the DefaultView property of the form to Single Form,
Datasheet, PivotTable, or PivotChart.@@1@@1
You can't view a form as a continuous form if it contains a subform, an ActiveX
control, or a bound chart.@Set the DefaultView property of the form to Single Form
or Datasheet.@@1@@1
The control name you entered doesn't follow Microsoft Office Access object-naming
rules.@@@2@1@11734@1
The control name you entered doesn't follow Microsoft Office Access object-naming
rules.@@@2@611734@1
The control name you entered doesn't follow Microsoft Access object-naming
rules.@@@2@611734@1

The form name you entered doesn't follow Microsoft Office Access object-naming
rules.@@@2@1@11734@1
The form name you entered doesn't follow Microsoft Office Access object-naming
rules.@@@2@611734@1
The form name you entered doesn't follow Microsoft Access object-naming
rules.@@@2@611734@1
The setting for the FontSize property must be from 1 through
127.@@@1@1@12551@1
The setting for the FontSize property must be from 1 through
127.@@@1@612551@1
The setting for the ColumnCount property must be from 1 through
255.@@@1@1@936@1
The setting for the ColumnCount property must be from 1 through
255.@@@1@600936@1
The setting for the BoundColumn property can't be greater than the setting for the
ColumnCount property.@@@1@1@839@1
The setting for the BoundColumn property can't be greater than the setting for the
ColumnCount property.@@@1@600839@1
Microsoft Office Access encountered errors while importing |1.@For more detailed
error information, see the file '|2'.@@1@@@1
Microsoft Office Access encountered errors while importing |1.@For more detailed
error information, see the file '|2'.@@1@@1
Microsoft Access encountered errors while importing |1.@For more detailed error
information, see the file '|2'.@@1@@1

The setting for the DefaultEditing property must be Allow Edits, Read Only, Data
Entry, or Can't Add Records.@Enter 1, 2, 3, or 4 for the DefaultEditing
property.@@1@@@1
The setting for the DefaultEditing property must be Allow Edits, Read Only, Data
Entry, or Can't Add Records.@Enter 1, 2, 3, or 4 for the DefaultEditing
property.@@1@@1
The settings for the GridX and GridY properties must be from 1 through
64.@@@1@@@1
The settings for the GridX and GridY properties must be from 1 through
64.@@@1@@1

2131

2007
2003

An expression can't be longer than 2,048 characters.@@@1@@@1
An expression can't be longer than 2,048 characters.@@@1@@1

2132

2007

The setting for the DecimalPlaces property must be from 0 through 15, or 255 for
Auto (default).@@@1@@@1
The setting for the DecimalPlaces property must be from 0 through 15, or 255 for
Auto (default).@@@1@@1

2003
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Numbe

Access

2133

2007
2003

2134

2007
2003

Error Description
You can't place a form (or report) within itself.@Select or enter a different form or
report to serve as the subform or subreport.@@1@@@1
You can't place a form (or report) within itself.@Select or enter a different form or
report to serve as the subform or subreport.@@1@@1
The setting for the Width property must be from 0 through 22 inches (55.87
cm).@@@1@@@1
The setting for the Width property must be from 0 through 22 inches (55.87
cm).@@@1@@1

2135

2007
2003

This property is read-only and can't be set.@@@1@@@1
This property is read-only and can't be set.@@@1@@1

2136

2007

To
on
To
on

2003
2137

2007

2003

2138

2007
2003

2139

2007
2003

2140

2007

2003

2002

2141

2007
2003
2002

2142

2007

2003

set this property, open the form or report in Design view.@For more information
this property, search the Help index for the name of the property.@@1@@@1
set this property, open the form or report in Design view.@For more information
this property, search the Help index for the name of the property.@@1@@1

You can't use Find or Replace now.@The fields are not searchable due to one of the
following:* The fields are controls (such as buttons or OLE objects).* The fields
have no data.* There are no fields to search.@@1@@@1
You can't use Find or Replace now.@The fields are not searchable due to one of the
following:* The fields are controls (such as buttons or OLE objects).* The fields
have no data.* There are no fields to search.@@1@@1
You can't search the field for the specified value.@Resolve the error given in the
previous error message before you attempt to search again.@@1@@@1
You can't search the field for the specified value.@Resolve the error given in the
previous error message before you attempt to search again.@@1@@1
You
any
You
any

can't replace the current value of the field with the replacement text.@Resolve
errors before making further replacements.@@1@@@1
can't replace the current value of the field with the replacement text.@Resolve
errors before making further replacements.@@1@@1

Microsoft Office Access cannot save the change you made to the record in the
Replace operation for the reason shown in the previous message.@Click Undo or
enter a new value in the field.@@1@@@1
Microsoft Office Access can't save the change you made to the record in the Replace
operation for the reason given in the previous error message.@Click Undo Current
Record on the Edit menu, or enter a new value in the field.@@1@@1
Microsoft Access can't save the change you made to the record in the Replace
operation for the reason given in the previous error message.@Click Undo Current
Record on the Edit menu, or enter a new value in the field.@@1@@1
Microsoft Office Access can't find the text you specified in the Find What
box.@@@1@@@1
Microsoft Office Access can't find the text you specified in the Find What
box.@@@1@@1
Microsoft Access can't find the text you specified in the Find What box.@@@1@@1
The FindRecord action requires a Find What argument.@You tried to run a macro
set to one of the current field's properties, but you left the Find What argument
blank.@When you click OK, an Action Failed dialog box will display the macro name
and the macro's arguments. In the Macro window, enter text or an expression for
the Find What argument, and try the Search operation again.@1@1@3015@1
The FindRecord action requires a Find What argument.@You tried to run a macro
set to one of the current field's properties, but you left the Find What argument
blank.@When you click OK, an Action Failed dialog box will display the macro name
and the macro's arguments. In the Macro window, enter text or an expression for
the Find What argument, and try the Search operation again.@1@603015@1
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Numbe

Access

2143

2007
2003

2144

2007
2003

2145

2007

2003

2146

2007
2003

2002

Error Description
You didn't specify search criteria with a FindRecord action.@In the Macro window,
insert a FindRecord action before the FindNext action.@@1@1@3015@1
You didn't specify search criteria with a FindRecord action.@In the Macro window,
insert a FindRecord action before the FindNext action.@@1@603015@1
The setting for the ListRows property must be from 1 through
255.@@@1@1@4055@1
The setting for the ListRows property must be from 1 through
255.@@@1@604055@1

The ColumnWidths property setting must be a value from 0 through 22 inches
(55.87 cm) for each column in a list box or a combo box.@If there is more than one
column, separate the numbers with either a semicolon or the list separator
character. List separator characters are defined in the Regional Settings section of
Windows Control Panel.@@1@1@847@1
The ColumnWidths property setting must be a value from 0 through 22 inches
(55.87 cm) for each column in a list box or a combo box.@If there is more than one
column, separate the numbers with either a semicolon or the list separator
character. List separator characters are defined in the Regional Settings section of
Windows Control Panel.@@1@600847@1
Microsoft Office Access can't save the last change for the reason given in the
previous error message.@For example, you may have entered a duplicate value in a
field with an index that prohibits duplicate values.@Click Undo on the Edit menu, or
enter a new value in the field.@1@@1
Microsoft Access can't save the last change for the reason given in the previous
error message.@For example, you may have entered a duplicate value in a field
with an index that prohibits duplicate values.@Click Undo on the Edit menu, or
enter a new value in the field.@1@@1

2147

2007
2003

You must be in Design view to create or delete controls.@@@1@2@5054@1
You must be in Design view to create or delete controls.@@@1@5054@1

2148

2007

The number you used to refer to the form or report section is invalid.@Make sure
that the number is less than the number of sections in the form or
report.@@1@@@1
The number you used to refer to the form or report section is invalid.@Make sure
that the number is less than the number of sections in the form or report.@@1@@1

2003
2149

2007
2003

The
you
The
you

constant you entered for the control type is invalid.@For a list of valid constants
can use to create a control, click Help.@@2@1@10905@1
constant you entered for the control type is invalid.@For a list of valid constants
can use to create a control, click Help.@@2@610905@1

2150

2007
2003

This type of control can't contain other controls.@@@1@@@1
This type of control can't contain other controls.@@@1@@1

2151

2007

The parent control can't contain
used the CreateControl function
box.@@1@@@1
The parent control can't contain
used the CreateControl function
box.@@1@@1

2003

the type of control you selected.@For example, you
to designate an option group as the parent of a text
the type of control you selected.@For example, you
to designate an option group as the parent of a text

2152

2007
2003

You can set group levels for reports only, not for forms.@@@1@@@1
You can set group levels for reports only, not for forms.@@@1@@1

2153

2007
2003

You can't specify more than 10 group levels.@@@1@@@1
You can't specify more than 10 group levels.@@@1@@1

2154

2007

You can't call this function when the Group, Sort, and Total Pane is
open.@@@1@@@1
You can't call this function when the Sorting and Grouping box is open.@@@1@@1

2003
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Numbe

Access

2155

2007
2003

2002

2156

2007
2003
2002

2157

2007

2003

2158

2007

2003

2159

2007

2003

2160

2007

2003

2002

2161

2007

2003

Error Description
Microsoft Office Access has encountered an error in compiling the Visual Basic
code.@You don't have permission to edit code; inform someone who does have
permission about this error.@@1@@1
Microsoft Access has encountered an error in compiling the Visual Basic code.@You
don't have permission to edit code; inform someone who does have permission
about this error.@@1@@1
Microsoft Office Access has encountered an error in compiling the Visual Basic
code.@Do you want to view the error in its context?@@19@@2
Microsoft Access has encountered an error in compiling the Visual Basic code.@Do
you want to view the error in its context?@@19@@2
The sum of the top margin, the bottom
the height of the page footer is greater
on.@@@1@@@1
The sum of the top margin, the bottom
the height of the page footer is greater
on.@@@1@@1

margin, the height of the page header, and
than the length of the page you are printing
margin, the height of the page header, and
than the length of the page you are printing

You can use the Print method and the report graphics methods (Circle, Line, PSet,
and Scale) only in an event procedure or a macro set to the OnPrint, the OnFormat,
or the OnPage event property.@@@1@1@10129@1
You can use the Print method and the report graphics methods (Circle, Line, PSet,
and Scale) only in an event procedure or a macro set to the OnPrint, the OnFormat,
or the OnPage event property.@@@1@210129@1
There isn't enough memory to initialize the Print method or one of the report
graphics methods (Circle, Line, PSet, Scale).@Close unneeded programs and try
again to print or preview the report.For more information on freeing memory,
search the Microsoft Windows Help index for 'memory, troubleshooting'.@@1@@@1
There isn't enough memory to initialize the Print method or one of the report
graphics methods (Circle, Line, PSet, Scale).@Close unneeded programs and try
again to print or preview the report.For more information on freeing memory,
search the Microsoft Windows Help index for 'memory, troubleshooting'.@@1@@1
Microsoft Office Access couldn't create the graphic or text.@An error occurred while
initializing the Print method or one of the report graphics methods (Circle, Line,
PSet, Scale).@Close unneeded programs and try again to print or preview the
report.For information on freeing memory, search the Microsoft Windows Help
index for 'memory, troubleshooting'.@1@@@1
Microsoft Office Access couldn't create the graphic or text.@An error occurred while
initializing the Print method or one of the report graphics methods (Circle, Line,
PSet, Scale).@Close unneeded programs and try again to print or preview the
report.For information on freeing memory, search the Microsoft Windows Help
index for 'memory, troubleshooting'.@1@@1
Microsoft Access couldn't create the graphic or text.@An error occurred while
initializing the Print method or one of the report graphics methods (Circle, Line,
PSet, Scale).@Close unneeded programs and try again to print or preview the
report.For information on freeing memory, search the Microsoft Windows Help
index for 'memory, troubleshooting'.@1@@1

The text or expression you entered doesn't match the type of data you are
searching for.@Redefine the text or expression, or search in a different
field.@@1@@@1
The text or expression you entered doesn't match the type of data you are
searching for.@Redefine the text or expression, or search in a different
field.@@1@@1
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Numbe

Access

2162

2007

2003

2163

2007
2003

Error Description
A macro set to one of the current field's properties failed because of an error in a
FindRecord action argument.@In the Macro window, change the Search As
Formatted argument to Yes. If you want the argument setting to remain No, do all
of the following:* Select No for the Match Case argument.* Select Yes for the
Only Current Field argument.* Make sure you are searching in a bound
control.@@2@1@3015@1
A macro set to one of the current field's properties failed because of an error in a
FindRecord action argument.@In the Macro window, change the Search As
Formatted argument to Yes. If you want the argument setting to remain No, do all
of the following:* Select No for the Match Case argument.* Select Yes for the
Only Current Field argument.* Make sure you are searching in a bound
control.@@2@603015@1
The page number you used as an argument for the GoToPage action or method
doesn't exist in this form.@@@1@1@3017@1
The page number you used as an argument for the GoToPage action or method
doesn't exist in this form.@@@1@603017@1

2164

2007
2003

You can't disable a control while it has the focus.@@@1@2@5250@1
You can't disable a control while it has the focus.@@@1@5250@1

2165

2007
2003

You can't hide a control that has the focus.@@@1@@@1
You can't hide a control that has the focus.@@@1@@1

2166

2007
2003

You can't lock a control while it has unsaved changes.@@@1@@@1
You can't lock a control while it has unsaved changes.@@@1@@1

2167

2007
2003

This property is read-only and can't be modified.@@@1@@@1
This property is read-only and can't be modified.@@@1@@1

2169

2007

You can't save this record at this time.@Microsoft Office Access may have
encountered an error while trying to save a record.If you close this object now,
the data changes you made will be lost.Do you want to close the database object
anyway?@@20@@@2
You can't save this record at this time.@Microsoft Office Access may have
encountered an error while trying to save a record.If you close this object now,
the data changes you made will be lost.Do you want to close the database object
anyway?@@20@@2
You can't save this record at this time.@Microsoft Access may have encountered an
error while trying to save a record.If you close this object now, the data changes
you made will be lost.Do you want to close the database object
anyway?@@20@@2
You can't save this record at this time.@Microsoft Access may have encountered an
error while trying to save a record.If you close this object now, the data changes
you made will be lost.Do you want to close the database object
anyway?@@19@@2

2003

2002

2000

2170

2007

2003

2171

2007
2003

There isn't enough memory to retrieve data for the list box.@Close unneeded
programs. Then close and reopen the active form, and click the list box again.For
more information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@@1
There isn't enough memory to retrieve data for the list box.@Close unneeded
programs. Then close and reopen the active form, and click the list box again.For
more information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@1
You can't have more than seven nested subforms in a main form.@Remove the
eigth nested subform.@@1@@@1
You can't have more than seven nested subforms in a main form.@Remove the
eigth nested subform.@@1@@1
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Numbe

Access

2172

2007

2003

2173

2007

2003

2174

2007

2003

2175

2007

2003

2176

2007
2003

2177

2007
2003

2178

2007

2003

2181

2007

2003

2182

2007
2003

Error Description
You can't use a pass-through query or a non-fixed-column crosstab query as a
record source for a subform or subreport.@Before you bind the subform or
subreport to a crosstab query, set the query's ColumnHeadings
property.@@2@1@9979@1
You can't use a pass-through query or a non-fixed-column crosstab query as a
record source for a subform or subreport.@Before you bind the subform or
subreport to a crosstab query, set the query's ColumnHeadings
property.@@2@209979@1
The control '|' the macro is attempting to search can't be searched.@Try one of the
following:* Add a GoToControl action before the FindRecord action.* For the
FindRecord action, change the Only Current Field action argument from Yes to
No.* Change the focus to a searchable control.@@2@1@3015@1
The control '|' the macro is attempting to search can't be searched.@Try one of the
following:* Add a GoToControl action before the FindRecord action.* For the
FindRecord action, change the Only Current Field action argument from Yes to
No.* Change the focus to a searchable control.@@2@603015@1
You can't switch to a different view at this time.@Code was executing when you
tried to switch views.@If you are debugging code, you must end the debugging
operation before switching views.@1@@@1
You can't switch to a different view at this time.@Code was executing when you
tried to switch views.@If you are debugging code, you must end the debugging
operation before switching views.@1@@1

There isn't enough free memory to continue the Search operation.@Close unneeded
programs. Then try the Search operation again.For more information on freeing
memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@@3
There isn't enough free memory to continue the Search operation.@Close unneeded
programs. Then try the Search operation again.For more information on freeing
memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@3
The setting for this property
characters for this property,
The setting for this property
characters for this property,

is too long.@You can enter up to either 255 or 2,048
depending on the data type.@@1@@@1
is too long.@You can enter up to either 255 or 2,048
depending on the data type.@@1@@1

You can't insert a report into a form.@A report can be inserted only into a
report.@@1@@@1
You can't insert a report into a form.@A report can be inserted only into a
report.@@1@@1
You can't add another section now.@The maximum total height for all sections in a
report, including the section headers, is 200 inches (508 cm).@Remove or reduce
the height of at least one section, and then add the new section.@1@@@1
You can't add another section now.@The maximum total height for all sections in a
report, including the section headers, is 200 inches (508 cm).@Remove or reduce
the height of at least one section, and then add the new section.@1@@1
You can't sort on a calculated field in a form.@You can sort on a calculated field only
in a query.@Create a calculated field in a query, sort the field, and then base the
form on the query.Because the query must execute before the form opens, the
form will open more slowly.@1@@@1
You can't sort on a calculated field in a form.@You can sort on a calculated field only
in a query.@Create a calculated field in a query, sort the field, and then base the
form on the query.Because the query must execute before the form opens, the
form will open more slowly.@1@@1

You can't sort on this field.@@@1@@@1
You can't sort on this field.@@@1@@1
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Numbe

Access

2183

2007

2003

2002

2184

2007
2003

2185

2007

2003

2186

2007
2003

Error Description
Microsoft Office Access can't create an object of the type requested.@You are trying
either to create a form from a report that has been saved as text, or to create a
report from a saved form.@@1@@@1
Microsoft Office Access can't create an object of the type requested.@You are trying
either to create a form from a report that has been saved as text, or to create a
report from a saved form.@@1@@1
Microsoft Access can't create an object of the type requested.@You are trying either
to create a form from a report that has been saved as text, or to create a report
from a saved form.@@1@@1

The value you used for the TabIndex property isn't valid. The correct values are
from 0 through |.@@@2@1@6348@1
The value you used for the TabIndex property isn't valid. The correct values are
from 0 through |.@@@2@606348@1
You can't reference a property or method for a control unless the control has the
focus.@Try one of the following:* Move the focus to the control before you
reference the property. In Visual Basic code, use the SetFocus method. In a macro,
use the GoToControl action.* Reference or set the property from a macro or event
procedure that runs when the GotFocus event for the control
occurs.@@2@1@6215@1
You can't reference a property or method for a control unless the control has the
focus.@Try one of the following:* Move the focus to the control before you
reference the property. In Visual Basic code, use the SetFocus method. In a macro,
use the GoToControl action.* Reference or set the property from a macro or event
procedure that runs when the GotFocus event for the control
occurs.@@2@606215@1
This property isn't available in Design view.@Switch to Form view to access this
property, or remove the reference to the property.@@1@@@1
This property isn't available in Design view.@Switch to Form view to access this
property, or remove the reference to the property.@@1@@1

2187

2007
2003

This property is available only in Design view.@@@1@@@1
This property is available only in Design view.@@@1@@1

2188

2007

The object you attempted to load from text has an invalid value for the property '|1'
on a |2.@@@1@@@1
The object you attempted to load from text has an invalid value for the property '|1'
on a |2.@@@1@@1

2003
2189

2007

2003

The code contains a syntax error, or a Microsoft Office Access function you need is
not available.@If the syntax is correct, check the Control Wizards subkey or the
Libraries key in the Microsoft Office Access section of the Windows Registry to verify
that the entries you need are listed and available.@If the entries are correct, either
you must correct the Microsoft Office Access Utility Add-in, or the file acWzlib or this
wizard has been disabled. To reenable this wizard, run Microsoft Office Access or
Microsoft Office Setup again to reinstall Microsoft Office Access. Before you reinstall
Microsoft Office Access, delete the Windows Registry keys for the Microsoft Office
Access Utility Add-in and acWzlib.@1@@@1
Your code contains a syntax error, or a Microsoft Office Access function you need
isn't available.@If the syntax is correct, check the Control Wizards subkey or the
Libraries key in the Microsoft Office Access section of the Windows Registry to verify
that the entries you need are listed and available.@If the entries are correct, you
need to correct the Microsoft Office Access Utility Add-in or the file acWzlib or this
wizard has been disabled. To reenable this wizard, click About Microsoft Office
Access on the Help menu, and then click the Disabled Items button to view a list of
addins which you can enable. Rerun Microsoft Office Access or Microsoft Office
Setup to reinstall Microsoft Office Access. Before you reinstall, delete the Windows
Registry keys for the Microsoft Office Access Utility Add-in and acWzlib.@1@@1
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Numbe

Access

2189

2002

2000

2190

2007
2003

2191

2007
2003
2000

2192

2007

2003

2193

2007
2003

2194

2007
2003

2195

2007
2003
2002

2196

2007

Error Description
Your code contains a syntax error, or a Microsoft Access function you need isn't
available.@If the syntax is correct, check the Control Wizards subkey or the
Libraries key in the Microsoft Access section of the Windows Registry to verify that
the entries you need are listed and available.@If the entries are correct, you need
to correct the Microsoft Access Utility Add-in or the file acWzlib or this wizard has
been disabled. To reenable this wizard, click About Microsoft Access on the Help
menu, and then click the Disabled Items button to view a list of addins which you
can enable. Rerun Microsoft Access or Microsoft Office Setup to reinstall Microsoft
Access. Before you reinstall, delete the Windows Registry keys for the Microsoft
Access Utility Add-in and acWzlib.@1@@1
Your code contains a syntax error, or a Microsoft Access function you need isn't
available.@If the syntax is correct, check the Control Wizards subkey or the
Libraries key in the Microsoft Access section of the Windows Registry to verify that
the entries you need are listed and available.@If the entries are correct, you need
to correct the Microsoft Access Utility Add-in or the file acWzlib. To do so, run
Microsoft Access or Microsoft Office Setup to reinstall Microsoft Access. Before you
reinstall, delete the Windows Registry keys for the Microsoft Access Utility Add-in
and acWzlib.@1@@1
This property has been replaced by a new property; use the new property
instead.@@@1@@@1
This property has been replaced by a new property; use the new property
instead.@@@1@@1
You can't set the | property in print preview or after printing has started.@Try
setting this property in the OnOpen event.@@1@@@1
You can't set the | property in print preview or after printing has started.@Try
setting this property in the OnOpen event.@@1@@1
You can't set the | property after printing has started.@Try setting this property in
the OnOpen event.@@1@@1

The bitmap you specified is not in a device-independent bitmap (.dib) format.@You
tried to set the PictureData property of a form, report, button, or image
control.@@1@@@1
The bitmap you specified is not in a device-independent bitmap (.dib) format.@You
tried to set the PictureData property of a form, report, button, or image
control.@@1@@1
The left margin, right margin, or both margins are wider than the paper size
specified in the Print Setup dialog box.@@@1@@@1
The left margin, right margin, or both margins are wider than the paper size
specified in the Print Setup dialog box.@@@1@@1
You can't set the PictureData property in Datasheet view.@To see the valid settings
for this property, search the Help index for 'PictureData property'.@@1@@@1
You can't set the PictureData property in Datasheet view.@To see the valid settings
for this property, search the Help index for 'PictureData property'.@@1@@1
The section name you entered doesn't follow Microsoft Office Access object-naming
rules.@@@2@1@11734@1
The section name you entered doesn't follow Microsoft Office Access object-naming
rules.@@@2@611734@1
The section name you entered doesn't follow Microsoft Access object-naming
rules.@@@2@611734@1
Microsoft Office Access can't retrieve the value of this property.@The property isn't
available from the view in which you're running the macro or Visual Basic code, or
Microsoft Office Access encountered an error while retrieving the value of the
property.To see the valid settings for this property, search the Help index for the
name of the property.@@1@@@1

Copyright (c) 2008 FMS, Inc.

fmsinc.com

Page 25 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

2196

2003

2002

2197

2007

2003

Error Description
Microsoft Office Access can't retrieve the value of this property.@The property isn't
available from the view in which you're running the macro or Visual Basic code, or
Microsoft Office Access encountered an error while retrieving the value of the
property.To see the valid settings for this property, search the Help index for the
name of the property.@@1@@1
Microsoft Access can't retrieve the value of this property.@The property isn't
available from the view in which you're running the macro or Visual Basic code, or
Microsoft Access encountered an error while retrieving the value of the
property.To see the valid settings for this property, search the Help index for the
name of the property.@@1@@1
You can't set a subform control's SourceObject property to a zero-length string if
you're displaying the main form in Form view.@You can set this property to a zerolength string from Design view, Datasheet view, or Print Preview.@@1@@@1
You can't set a subform control's SourceObject property to a zero-length string if
you're displaying the main form in Form view.@You can set this property to a zerolength string from Design view, Datasheet view, or Print Preview.@@1@@1

2200

2007
2003

The number you entered is invalid.@@@1@@@1
The number you entered is invalid.@@@1@@1

2201

2007

There was a problem retrieving printer information for the |1 on |2. The object may
have been sent to a printer that is unavailable.@@@@@@
There was a problem retrieving printer information for the |1 on |2. The object may
have been sent to a printer that is unavailable.@@@@@

2003
2202

2007

2003

2000

2203

2007

2003

2204

2007

2003

2205

2007

2003

2206

2007

There are currently no printers installed on your computer. To use this feature, you
must first install a printer in Windows.@For more information about how to install a
printer, search for "install printer" in Windows Help.@@1@@@1
You must install a printer before you print.@To install a printer, point to Settings on
the Windows Start menu, click Printers, and then double-click Add Printer. Follow
the instructions in the wizard.@@1@@1
You must install a printer before you design, print, or preview.@To install a printer,
point to Settings on the Windows Start menu, click Printers, and then double-click
Add Printer. Follow the instructions in the wizard.@@1@@1
The dynamic-link library Commdlg failed: error code '0x|'.@The printer driver for
the selected printer may be incorrectly installed.For information on selecting
another printer or reinstalling this printer from Microsoft Windows, search the
Windows Help index for 'printer setup'.@@1@@@1
The dynamic-link library Commdlg failed: error code '0x|'.@The printer driver for
the selected printer may be incorrectly installed.For information on selecting
another printer or reinstalling this printer from Microsoft Windows, search the
Windows Help index for 'printer setup'.@@1@@1
The default printer driver isn't set up correctly.@For information on setting a default
printer, search the Microsoft Windows Help index for 'default printer,
setting'.@@1@@@1
The default printer driver isn't set up correctly.@For information on setting a default
printer, search the Microsoft Windows Help index for 'default printer,
setting'.@@1@@1
The default printer driver isn't set up correctly.@For information on setting a default
printer, search the Microsoft Windows Help index for 'default printer,
setting'.@@1@@@1
The default printer driver isn't set up correctly.@For information on setting a default
printer, search the Microsoft Windows Help index for 'default printer,
setting'.@@1@@1
The page number you entered is invalid.@For example, it may be a negative
number or an invalid range, such as 6 to 3.@@1@@@1
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Access

2206

2003

The page number you entered is invalid.@For example, it may be a negative
number or an invalid range, such as 6 to 3.@@1@@1

2207

2007

Microsoft Office Access can't print macros.@You tried to use the PrintOut action or
method, but the active object is a macro.@If you want to print an object other than
a macro, use the SelectObject action or method to select the desired object before
you run the PrintOut action.@1@1@3041@1
Microsoft Office Access can't print macros.@You tried to use the PrintOut action or
method, but the active object is a macro.@If you want to print an object other than
a macro, use the SelectObject action or method to select the desired object before
you run the PrintOut action.@1@603041@1
Microsoft Access can't print macros.@You tried to use the PrintOut action or
method, but the active object is a macro.@If you want to print an object other than
a macro, use the SelectObject action or method to select the desired object before
you run the PrintOut action.@1@603041@1

2003

2002

2210

2007

2003
2002

Error Description

Microsoft Office Access can't print or preview the page because the page size you
selected is larger than 22.75 inches.@@@1@@@1
Microsoft Office Access can't print or preview the page because the page size you
selected is larger than 22.75 inches.@@@1@@1
Microsoft Access can't print or preview the page because the page size you selected
is larger than 22.75 inches.@@@1@@1

2211

2007
2003
2002

Microsoft Office Access can't print or preview the Debug window.@@@1@@@1
Microsoft Office Access can't print or preview the Debug window.@@@1@@1
Microsoft Access can't print or preview the Debug window.@@@1@@1

2212

2007

Microsoft Office Access couldn't print your object.@Make sure that the specified
printer is available.For information on setting a default printer, search the
Windows Help index for 'default printer, setting'.@@1@@@1
Microsoft Office Access couldn't print your object.@Make sure that the specified
printer is available.For information on setting a default printer, search the
Windows Help index for 'default printer, setting'.@@1@@1
Microsoft Access couldn't print your object.@Make sure that the specified printer is
available.For information on setting a default printer, search the Windows Help
index for 'default printer, setting'.@@1@@1

2003

2002

2213

2007
2003

2214

2007
2003

2215

2007

2003

2002

There was a problem retrieving printer information for this object. The object may
have been sent to a printer that is unavailable.@@@1@@@1
There was a problem retrieving printer information for this object. The object may
have been sent to a printer that is unavailable.@@@1@@1
There was a problem retrieving information from the printer. New printer has not
been set.@@@1@@@1
There was a problem retrieving information from the printer. New printer has not
been set.@@@1@@1

Microsoft Office Access cannot print this PivotTable because its |1 exceed(s) 22.75
inches.@Reduce the |1 by making changes to the formatting or included data of the
PivotTable view, and then try to print again.@@1@@@1
Microsoft Office Access cannot print this PivotTable because its |1 exceed(s) 22.75
inches.@Reduce the |1 by making changes to the formatting or included data of the
PivotTable view, and then try to print again.@@1@@1
Microsoft Access cannot print this PivotTable because its |1 exceed(s) 22.75
inches.@Reduce the |1 by making changes to the formatting or included data of the
PivotTable view, and then try to print again.@@1@@1

2220

2007
2003
2002

Microsoft Office Access can't open the file '|'.@@@1@@@1
Microsoft Office Access can't open the file '|'.@@@1@@1
Microsoft Access can't open the file '|'.@@@1@@1

2221

2007

The text is too long to be edited.@@@1@@@1
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Access

2221

2003

The text is too long to be edited.@@@1@@1

2222

2007
2003

This control is read-only and can't be modified.@@@1@@@1
This control is read-only and can't be modified.@@@1@@1

2223

2007

The file name '|' is too long.@Enter a file name that's 256 characters or
less.@@1@@@1
The file name '|' is too long.@Enter a file name that's 256 characters or
less.@@1@@1

2003
2225

2007

2003

2002

2226

2007

2003

2002

2227

2007

2003

2002

2229

2007

2003

2002

Error Description

Microsoft Office Access couldn't open the Clipboard.@The Clipboard isn't
responding, probably because another application is using it. Close all other
applications and try the operation again.@@1@@@1
Microsoft Office Access couldn't open the Clipboard.@The Clipboard isn't
responding, probably because another application is using it. Close all other
applications and try the operation again.@@1@@1
Microsoft Access couldn't open the Clipboard.@The Clipboard isn't responding,
probably because another application is using it. Close all other applications and try
the operation again.@@1@@1

The Clipboard isn't responding, so Microsoft Office Access can't paste the
Clipboard's contents.@* Another application may be using the Clipboard.* There
may not be enough free memory for the paste operation.Close all other
applications, and then copy and paste again.@@1@@@1
The Clipboard isn't responding, so Microsoft Office Access can't paste the
Clipboard's contents.@* Another application may be using the Clipboard.* There
may not be enough free memory for the paste operation.Close all other
applications, and then copy and paste again.@@1@@1
The Clipboard isn't responding, so Microsoft Access can't paste the Clipboard's
contents.@* Another application may be using the Clipboard.* There may not be
enough free memory for the paste operation.Close all other applications, and then
copy and paste again.@@1@@1
The data on the Clipboard is damaged, so Microsoft Office Access can't paste
it.@There may be an error in the Clipboard, or there may not be enough free
memory. Try the operation again.@@1@@@1
The data on the Clipboard is damaged, so Microsoft Office Access can't paste
it.@There may be an error in the Clipboard, or there may not be enough free
memory. Try the operation again.@@1@@1
The data on the Clipboard is damaged, so Microsoft Access can't paste it.@There
may be an error in the Clipboard, or there may not be enough free memory. Try the
operation again.@@1@@1

Microsoft Office Access can't start the OLE server.@You tried to use a form, report,
or datasheet that contains an OLE object, but the OLE server (the application used
to create the object) may not be registered properly. Reinstall the OLE server to
register it correctly.@@1@@@1
Microsoft Office Access can't start the OLE server.@You tried to use a form, report,
or datasheet that contains an OLE object, but the OLE server (the application used
to create the object) may not be registered properly. Reinstall the OLE server to
register it correctly.@@1@@1
Microsoft Access can't start the OLE server.@You tried to use a form, report, or
datasheet that contains an OLE object, but the OLE server (the application used to
create the object) may not be registered properly. Reinstall the OLE server to
register it correctly.@@1@@1

2234

2007
2003
2002

Microsoft Office Access can't paste the OLE object.@@@1@@@1
Microsoft Office Access can't paste the OLE object.@@@1@@1
Microsoft Access can't paste the OLE object.@@@1@@1

2237

2007

The text you entered isn't an item in the list.@Select an item from the list, or enter
text that matches one of the listed items.@@1@@@1
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Access

2237

2003

The text you entered isn't an item in the list.@Select an item from the list, or enter
text that matches one of the listed items.@@1@@1

2239

2007

Microsoft Office Access has detected that this database is in an inconsistent state,
and cannot attempt to recover the database because the file is read-only. To allow
Access to recover the database, close the database and set the file to read/write,
and then open the database.@@@1@@@1
The database '|' needs to be repaired or isn't a Microsoft Office Access database
file.@You may have quit Microsoft Office Access unexpectedly with the database
open.@To repair the database, click the Repair Database command on the Tools
menu (Database Utilities submenu).If the database can't be repaired, the .mdb
file is unusable. Restore the database from a backup copy or create a new
database.@1@@1
The database '|' needs to be repaired or isn't a Microsoft Access database file.@You
may have quit Microsoft Access unexpectedly with the database open.@To repair
the database, click the Repair Database command on the Tools menu (Database
Utilities submenu).If the database can't be repaired, the .mdb file is unusable.
Restore the database from a backup copy or create a new database.@1@@1

2003

2002

2243

2007
2003
2002

2244

2007

2003

2245

2007
2003

2246

2007
2003

2002

2260

2007

Error Description

The data in the Clipboard isn't recognizable; Microsoft Office Access can't paste the
OLE object.@@@1@@@1
The data in the Clipboard isn't recognizable; Microsoft Office Access can't paste the
OLE object.@@@1@@1
The data in the Clipboard isn't recognizable; Microsoft Access can't paste the OLE
object.@@@1@@1
The file name you specified in the Picture property for a command button or toggle
button can't be read.@* The file you specified may be corrupted. Restore the file
from a backup copy or re-create the file.* The disk where the file is located may
be unreadable.@@1@@@1
The file name you specified in the Picture property for a command button or toggle
button can't be read.@* The file you specified may be corrupted. Restore the file
from a backup copy or re-create the file.* The disk where the file is located may
be unreadable.@@1@@1
The file you specified doesn't contain valid icon data.@Specify a valid icon
file.@@1@1@829@1
The file you specified doesn't contain valid icon data.@Specify a valid icon
file.@@1@600829@1

Microsoft Office Access can't run the query; the parameter values are too
large.@The total length of all the values entered for the parameters cannot exceed
1,024 characters.@@1@@1
Microsoft Access can't run the query; the parameter values are too large.@The total
length of all the values entered for the parameters cannot exceed 1,024
characters.@@1@@1
An error occurred while sending data to the OLE server (the application used to
create the object).@* You may have tried to send too much data. If you're creating
a chart and the chart is based on a query, modify the query so that it selects less
data. If the chart is based on a table, consider basing it on a query instead so that
you can limit the data.* You may be using an OLE server that doesn't accept the
Clipboard format.* You may not be able to start the OLE server because it's not
properly registered. Reinstall it to register it.* Your computer may be low on
memory. Close other application windows to free up memory.@@1@1@8951@1
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Access

2260

2003

Error Description

2000

An error occurred while sending data to the OLE server (the application used to
create the object).@* You may have tried to send too much data. If you're creating
a chart and the chart is based on a query, modify the query so that it selects less
data. If the chart is based on a table, consider basing it on a query instead so that
you can limit the data.* You may be using an OLE server that doesn't accept the
Clipboard format.* You may not be able to start the OLE server because it's not
properly registered. Reinstall it to register it.* Your computer may be low on
memory. Close other application windows to free up memory.@@1@208951@1
An error occurred while sending data to the OLE server (the application used to
create the object).@* You may have tried to send too much data. If you're creating
a chart and the chart is based on a query, modify the query so that it selects less
data. If the chart is based on a table, consider basing it on a query instead so that
you can limit the data.* You may be using an OLE server that doesn't accept the
Clipboard format.* You may not be able to start the OLE server because it's not
properly registered. Reinstall it to register it.* Your computer may be low on
memory. Close windows to free up memory, or restart Microsoft
Windows.@@1@208951@1

2262

2007
2003

This value must be a number.@@@1@@@1
This value must be a number.@@@1@@1

2263

2007
2003

The number is too large.@@@1@@@1
The number is too large.@@@1@@1

2264

2007

Microsoft Office Access didn't recognize the unit of measurement.@Type a valid
unit, such as inches (in) or centimeters (cm).@@1@@@1
Microsoft Office Access didn't recognize the unit of measurement.@Type a valid
unit, such as inches (in) or centimeters (cm).@@1@@1
Microsoft Access didn't recognize the unit of measurement.@Type a valid unit, such
as inches (in) or centimeters (cm).@@1@@1

2003
2002
2265

2007
2003

2266

2007

2003

2267

2007
2003

2269

2007

2003

2272

2007
2003

2273

2007
2003

You must specify a unit of measurement, such as inches (in) or centimeters
(cm).@@@1@@@1
You must specify a unit of measurement, such as inches (in) or centimeters
(cm).@@@1@@1

'|' may not be a valid setting for the RowSourceType property, or there was a
compile error in the function.@For information on valid settings for the
RowSourceType property, click Help.@@2@1@3853@1
'|' may not be a valid setting for the RowSourceType property, or there was a
compile error in the function.@For information on valid settings for the
RowSourceType property, click Help.@@2@603853@1
There is not enough disk space to create a temporary buffer file for printing.@Free
up some disk space to make room for the temporary buffer file.@@1@@@1
There is not enough disk space to create a temporary buffer file for printing.@Free
up some disk space to make room for the temporary buffer file.@@1@@1
Some library databases couldn't be loaded because too many were specified.@To
change library database references, click References on the Tools
menu.@@1@1@9017@1
Some library databases couldn't be loaded because too many were specified.@To
change library database references, click References on the Tools
menu.@@1@209017@1
The setting for the Update Retry Interval must be from 0 through 1,000
milliseconds.@@@1@@@1
The setting for the Update Retry Interval must be from 0 through 1,000
milliseconds.@@@1@@1
The setting for Update Retries must be from 0 through 10.@@@1@@@1
The setting for Update Retries must be from 0 through 10.@@@1@@1
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Access

2274

2007
2003

The database '|' is already open as a library database.@@@1@@@1
The database '|' is already open as a library database.@@@1@@1

2275

2007

The string returned by the builder was too long.@The result will be
truncated.@@1@@@1
The string returned by the builder was too long.@The result will be
truncated.@@1@@1

2003

2276

2007

2003

Error Description

The custom builder you're using caused an error by changing the focus to a
different window while you were using it.@Enter a value without using the custom
builder.@@1@@@1
The custom builder you're using caused an error by changing the focus to a
different window while you were using it.@Enter a value without using the custom
builder.@@1@@1

2277

2007
2003

There was a font initialization error.@@@1@@@1
There was a font initialization error.@@@1@@1

2278

2007

Microsoft Office Access can't save your changes to this bound OLE object.@Either
you don't have permission to write to the record in which the object is stored, or the
record is locked by another user.Copy the object to the Clipboard (select the
object and click Copy on the Edit menu), and click Undo Current Record on the Edit
menu. Then open the application you used to create the object, paste the object
from the Clipboard, and save it.@@1@1@10222@1
Microsoft Office Access can't save your changes to this bound OLE object.@Either
you don't have permission to write to the record in which the object is stored, or the
record is locked by another user.Copy the object to the Clipboard (select the
object and click Copy on the Edit menu), and click Undo Current Record on the Edit
menu. Then open the application you used to create the object, paste the object
from the Clipboard, and save it.@@1@410222@1
Microsoft Access can't save your changes to this bound OLE object.@Either you
don't have permission to write to the record in which the object is stored, or the
record is locked by another user.Copy the object to the Clipboard (select the
object and click Copy on the Edit menu), and click Undo Current Record on the Edit
menu. Then open the application you used to create the object, paste the object
from the Clipboard, and save it.@@1@410222@1

2003

2002

2279

2007
2003

2280

2007

2003

2002

2281

2007

2003

The value you entered isn't appropriate for the input mask '|' specified for this
field.@@@2@1@9118@1
The value you entered isn't appropriate for the input mask '|' specified for this
field.@@@2@509118@1
You have added more output formats to the Windows Registry than Microsoft Office
Access can initialize.@Some output formats will not be available. Remove those
formats that you never or least often use.@@1@@@1
You have added more output formats to the Windows Registry than Microsoft Office
Access can initialize.@Some output formats will not be available. Remove those
formats that you never or least often use.@@1@@1
You have added more output formats to the Windows Registry than Microsoft
Access can initialize.@Some output formats will not be available. Remove those
formats that you never or least often use.@@1@@1

Output format information is missing. There appears to be a problem with your
Microsoft Office Access installation. Please reinstall Microsoft Office Access or
contact your system administrator or help desk representative.@@@2@1@9015@1
The formats that enable you to output data as a Microsoft Excel, rich-text format,
MS-DOS text, or HTML file are missing or incorrectly registered in the Windows
Registry.@Run Setup to reinstall Microsoft Office Access or, if you're familiar with
the settings in the Registry, try to correct them yourself. For more information
about the Registry, click Help.@@2@109015@1
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Access

2281

2002

The formats that enable you to output data as a Microsoft Excel, rich-text format,
MS-DOS text, or HTML file are missing or incorrectly registered in the Windows
Registry.@Run Setup to reinstall Microsoft Access or, if you're familiar with the
settings in the Registry, try to correct them yourself. For more information about
the Registry, click Help.@@2@109015@1

2282

2007

The format in which you are attempting to output the current object is not
available.@Either you are attempting to output the current object to a format that is
not valid for its object type, or the formats that enable you to output data as a
Microsoft Excel, rich-text format, MS-DOS text, or HTML file are missing from the
Windows Registry. Run Setup to reinstall Microsoft Office Access or, if you're familiar
with the settings in the Registry, try to correct them yourself. For more information
on the Registry, click Help.@@2@1@9015@1
The format in which you are attempting to output the current object is not
available.@Either you are attempting to output the current object to a format that is
not valid for its object type, or the formats that enable you to output data as a
Microsoft Excel, rich-text format, MS-DOS text, or HTML file are missing from the
Windows Registry. Run Setup to reinstall Microsoft Office Access or, if you're familiar
with the settings in the Registry, try to correct them yourself. For more information
on the Registry, click Help.@@2@109015@1
The format in which you are attempting to output the current object is not
available.@Either you are attempting to output the current object to a format that is
not valid for its object type, or the formats that enable you to output data as a
Microsoft Excel, rich-text format, MS-DOS text, or HTML file are missing from the
Windows Registry. Run Setup to reinstall Microsoft Access or, if you're familiar with
the settings in the Registry, try to correct them yourself. For more information on
the Registry, click Help.@@2@109015@1
The formats that enable you to output data as a Microsoft Excel, rich-text format,
MS-DOS text, or HTML file are missing from the Windows Registry.@Run Setup to
reinstall Microsoft Access or, if you're familiar with the settings in the Registry, try
to correct them yourself. For more information on the Registry, click
Help.@@2@109015@1

2003

2002

2000

2283

2007

2003

2002

2284

2007

2003

Error Description

The format specification for '|' is invalid.@You can't save output data to a file in this
format until you correct the setting for the format in the Windows Registry. Run
Setup to reinstall Microsoft Office Access or, if you're familiar with the settings in the
Registry, try to correct them yourself. For more information on the Registry, click
Help.@@2@1@9015@1
The format specification for '|' is invalid.@You can't save output data to a file in this
format until you correct the setting for the format in the Windows Registry. Run
Setup to reinstall Microsoft Office Access or, if you're familiar with the settings in the
Registry, try to correct them yourself. For more information on the Registry, click
Help.@@2@109015@1
The format specification for '|' is invalid.@You can't save output data to a file in this
format until you correct the setting for the format in the Windows Registry. Run
Setup to reinstall Microsoft Access or, if you're familiar with the settings in the
Registry, try to correct them yourself. For more information on the Registry, click
Help.@@2@109015@1
Microsoft Office Access can't write to the file.@* The network may not be working.
Wait until the network is working, and then try again.* You may be out of
memory. Close one or more Microsoft Office Access windows, close other
applications, and then try again.@@1@@@1
Microsoft Office Access can't write to the file.@* The network may not be working.
Wait until the network is working, and then try again.* You may be out of
memory. Close one or more Microsoft Office Access windows, close other
applications, and then try again.@@1@@1
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Access

2284

2002

2000

2285

2007

2003

2002

2000

2286

2007

2003

2002

2000

2287

2007
2003
2002

2288

2007

Error Description
Microsoft Access can't write to the file.@* The network may not be working. Wait
until the network is working, and then try again.* You may be out of memory.
Close one or more Microsoft Access windows, close other applications, and then try
again.@@1@@1
Microsoft Access can't write to the file.@* The network may not be working. Wait
until the network is working, and then try again.* You may be out of memory.
Close one or more Microsoft Access windows, close other applications, or restart
Microsoft Windows, and then try again.@@1@@1
Microsoft Office Access can't create the output file.@* You may be out of disk space
on the destination drive.* The network may not be working. Wait until the
network is working, and then try again.* You may be out of memory. Close one or
more Microsoft Office Access windows, close other applications, and then try
again.@@1@@@1
Microsoft Office Access can't create the output file.@* You may be out of disk space
on the destination drive.* The network may not be working. Wait until the
network is working, and then try again.* You may be out of memory. Close one or
more Microsoft Office Access windows, close other applications, and then try
again.@@1@@1
Microsoft Access can't create the output file.@* You may be out of disk space on the
destination drive.* The network may not be working. Wait until the network is
working, and then try again.* You may be out of memory. Close one or more
Microsoft Access windows, close other applications, and then try again.@@1@@1
Microsoft Access can't create the output file.@* You may be out of disk space on the
destination drive.* The network may not be working. Wait until the network is
working, and then try again.* You may be out of memory. Close one or more
Microsoft Access windows, close other applications, or restart Microsoft Windows,
and then try again.@@1@@1

Microsoft Office Access can't close the file.@* The network may not be working.
Wait until the network is working, and then try again.* You may be out of
memory. Close one or more Microsoft Office Access windows, close other
applications, and then try again.@@1@@@1
Microsoft Office Access can't close the file.@* The network may not be working.
Wait until the network is working, and then try again.* You may be out of
memory. Close one or more Microsoft Office Access windows, close other
applications, and then try again.@@1@@1
Microsoft Access can't close the file.@* The network may not be working. Wait until
the network is working, and then try again.* You may be out of memory. Close
one or more Microsoft Access windows, close other applications, and then try
again.@@1@@1
Microsoft Access can't close the file.@* The network may not be working. Wait until
the network is working, and then try again.* You may be out of memory. Close
one or more Microsoft Access windows, close other applications, or restart Microsoft
Windows, and then try again.@@1@@1
Microsoft Office Access can't open the mail session.@Check your mail application to
make sure that it's working properly.@@1@@@1
Microsoft Office Access can't open the mail session.@Check your mail application to
make sure that it's working properly.@@1@@1
Microsoft Access can't open the mail session.@Check your mail application to make
sure that it's working properly.@@1@@1
Microsoft Office Access can't load the '|' format.@The setting for this format in the
Windows Registry is incorrect. You can't save the output data to a file in this format
until you correct the setting in the Registry.@Run Setup to reinstall Microsoft Office
Access or, if you're familiar with the settings in the Registry, try to correct them
yourself. For more information on the Registry, click Help.@2@1@9015@1

Copyright (c) 2008 FMS, Inc.

fmsinc.com

Page 33 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

2288

2003

2002

2289

2007

Error Description
Microsoft Office Access can't load the '|' format.@The setting for this format in the
Windows Registry is incorrect. You can't save the output data to a file in this format
until you correct the setting in the Registry.@Run Setup to reinstall Microsoft Office
Access or, if you're familiar with the settings in the Registry, try to correct them
yourself. For more information on the Registry, click Help.@2@109015@1
Microsoft Access can't load the '|' format.@The setting for this format in the
Windows Registry is incorrect. You can't save the output data to a file in this format
until you correct the setting in the Registry.@Run Setup to reinstall Microsoft Access
or, if you're familiar with the settings in the Registry, try to correct them yourself.
For more information on the Registry, click Help.@2@109015@1

2003
2002

Microsoft Office Access can't output the module in the requested
format.@@@1@@@1
Microsoft Office Access can't output the module in the requested format.@@@1@@1
Microsoft Access can't output the module in the requested format.@@@1@@1

2290

2007
2003

There were too many message recipients; the message was not sent.@@@1@@@1
There were too many message recipients; the message was not sent.@@@1@@1

2291

2007
2003

There are too many message attachments; the message was not
sent.@@@1@@@1
There are too many message attachments; the message was not sent.@@@1@@1

2292

2007
2003

The message text is too long, so it was not sent.@@@1@@@1
The message text is too long, so it was not sent.@@@1@@1

2293

2007

Microsoft Office Access can't send this e-mail message.@Before attempting to send
an e-mail message from Microsoft Office Access, resolve the problem identified in
the previous message, or configure your computer to send and receive e-mail
messages.@@1@@@1
Microsoft Office Access can't send this e-mail message.@Before attempting to send
an e-mail message from Microsoft Office Access, resolve the problem identified in
the previous message, or configure your computer to send and receive e-mail
messages.@@1@@1
Microsoft Access can't send this e-mail message.@Before attempting to send an email message from Microsoft Access, resolve the problem identified in the previous
message, or configure your computer to send and receive e-mail
messages.@@1@@1
Microsoft Access can't send a message for the reason stated in the preceding
alert.@Resolve that problem, and then send the message again.@@1@@1

2003

2002

2000
2294

2007

2003

2002

2000

Microsoft Office Access can't attach the object; the message was not sent.@* The
network may not be working. Wait until the network is working, and then try
again.* You may be out of memory. Close one or more Microsoft Office Access
windows, close other applications, and then try again.@@1@@@1
Microsoft Office Access can't attach the object; the message was not sent.@* The
network may not be working. Wait until the network is working, and then try
again.* You may be out of memory. Close one or more Microsoft Office Access
windows, close other applications, and then try again.@@1@@1
Microsoft Access can't attach the object; the message was not sent.@* The network
may not be working. Wait until the network is working, and then try again.* You
may be out of memory. Close one or more Microsoft Access windows, close other
applications, and then try again.@@1@@1
Microsoft Access can't attach the object; the message was not sent.@* The network
may not be working. Wait until the network is working, and then try again.* You
may be out of memory. Close one or more Microsoft Access windows, close other
applications, or restart Microsoft Windows, and then try again.@@1@@1

2295

2007
2003

Unknown message recipient(s); the message was not sent.@@@1@@@1
Unknown message recipient(s); the message was not sent.@@@1@@1

2296

2007

The password is invalid; the message wasn't sent.@@@1@@@1
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Numbe

Access

2296

2003

The password is invalid; the message wasn't sent.@@@1@@1

2297

2007

Microsoft Office Access can't open the mail session.@You may be out of memory.
Close one or more Microsoft Office Access windows, close other applications, and
then try again. You may also want to check your mail application to ensure that it's
working properly.@@1@@@1
Microsoft Office Access can't open the mail session.@You may be out of memory.
Close one or more Microsoft Office Access windows, close other applications, and
then try again. You may also want to check your mail application to ensure that it's
working properly.@@1@@1
Microsoft Access can't open the mail session.@You may be out of memory. Close
one or more Microsoft Access windows, close other applications, and then try again.
You may also want to check your mail application to ensure that it's working
properly.@@1@@1
Microsoft Access can't open the mail session.@You may be out of memory. Close
one or more Microsoft Access windows, close other applications, or restart Microsoft
Windows, and then try again. You may also want to check your mail application to
ensure that it's working properly.@@1@@1

2003

2002

2000

2298

2007

2003

2002

2299

2007

2003

2002

2300

2007

2003

Error Description

Microsoft Office Access can't start the wizard, builder, or add-in.@* The library
database containing the wizard, builder, or add-in may not be installed. Point to
Add-ins on the Tools menu, and then click Add-in Manager to see if the library
database is installed.* The wizard, builder, or add-in code may not be compiled
and Microsoft Office Access can't compile it. There may be a syntax error in the
code.* The key for the add-in in the Windows Registry file may be
incorrect.@@2@1@9015@1
Microsoft Office Access can't start the wizard, builder, or add-in.@* The library
database containing the wizard, builder, or add-in may not be installed. Point to
Add-ins on the Tools menu, and then click Add-in Manager to see if the library
database is installed.* The wizard, builder, or add-in code may not be compiled
and Microsoft Office Access can't compile it. There may be a syntax error in the
code.* The key for the add-in in the Windows Registry file may be
incorrect.@@2@109015@1
Microsoft Access can't start the wizard, builder, or add-in.@* The library database
containing the wizard, builder, or add-in may not be installed. Point to Add-ins on
the Tools menu, and then click Add-in Manager to see if the library database is
installed.* The wizard, builder, or add-in code may not be compiled and Microsoft
Access can't compile it. There may be a syntax error in the code.* The key for the
add-in in the Windows Registry file may be incorrect.@@2@109015@1
Microsoft Office Access can't open the Zoom box.@The Microsoft Office Access
Utility add-in is missing or was modified. Rerun Microsoft Office Access or Microsoft
Office Setup to reinstall Microsoft Office Access and the Microsoft Office Access
Utility add-in.@@1@1@12620@1
Microsoft Office Access can't open the Zoom box.@The Microsoft Office Access
Utility add-in is missing or was modified. Rerun Microsoft Office Access or Microsoft
Office Setup to reinstall Microsoft Office Access and the Microsoft Office Access
Utility add-in.@@1@212620@1
Microsoft Access can't open the Zoom box.@The Microsoft Access Utility add-in is
missing or was modified. Rerun Microsoft Access or Microsoft Office Setup to
reinstall Microsoft Access and the Microsoft Access Utility add-in.@@1@212620@1
Microsoft Office Access can't output because there are too many controls
that have different styles, such as color and font.@Select fewer controls,
try again.@@1@@@1
Microsoft Office Access can't output because there are too many controls
that have different styles, such as color and font.@Select fewer controls,
try again.@@1@@1
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Numbe

Access

2300

2002

2000

2301

2007

2003

2002

2000

2302

2007

2003

2002

2000

2303

2007

2003

2002

2304

2007
2003
2002

2305

2007

Error Description
Microsoft Access can't output because there are too many controls selected that
have different styles, such as color and font.@Select fewer controls, and then try
again.@@1@@1
Microsoft Access can't output because you have selected too many controls with
differing styles, such as color and font.@Reduce the number of controls selected,
and then try again.@@1@@1
There are not enough system resources to output the data.@Close one or more
Microsoft Office Access windows and close other applications. Then try to output the
data again.@@1@@@1
There are not enough system resources to output the data.@Close one or more
Microsoft Office Access windows and close other applications. Then try to output the
data again.@@1@@1
There are not enough system resources to output the data.@Close one or more
Microsoft Access windows and close other applications. Then try to output the data
again.@@1@@1
There are not enough system resources to output the data.@Close one or more
Microsoft Access windows, close other applications, or restart Microsoft Windows.
Then try to output the data again.@@1@@1

Microsoft Office Access can't save the output data to the file you've selected.@* The
file may be open. If so, close it, and then save the output data to the file again.*
If you are using a template, check to make sure the template exists.* If the file
isn't open, check to make sure that you have enough free disk space.* Make sure
that the file exists on the path specified.* Check to make sure you have
permission to write to the specified folder.@@1@@@1
Microsoft Office Access can't save the output data to the file you've selected.@* The
file may be open. If so, close it, and then save the output data to the file again.*
If you are using a template, check to make sure the template exists.* If the file
isn't open, check to make sure that you have enough free disk space.* Make sure
that the file exists on the path specified.* Check to make sure you have
permission to write to the specified folder.@@1@@1
Microsoft Access can't save the output data to the file you've selected.@* The file
may be open. If so, close it, and then save the output data to the file again.* If
you are using a template, check to make sure the template exists.* If the file isn't
open, check to make sure that you have enough free disk space.* Make sure that
the file exists on the path specified.@@1@@1
Microsoft Access can't save the output data to the file you've selected.@* The file
may be open. If so, close it, and then save the output data to the file again.* If
you are using a template, check to make sure the template exists.* If the file isn't
open, check to make sure that you have enough free disk space.@@1@@1
Microsoft Office Access can't output data now.@* The network may not be working.
Wait until the network is working, and then try again.* You may be out of disk
space. Free up disk space and try again.@@1@@@1
Microsoft Office Access can't output data now.@* The network may not be working.
Wait until the network is working, and then try again.* You may be out of disk
space. Free up disk space and try again.@@1@@1
Microsoft Access can't output data now.@* The network may not be working. Wait
until the network is working, and then try again.* You may be out of disk space.
Free up disk space and try again.@@1@@1

Microsoft Office Access can't save output data to the specified file.@Make sure that
you have enough free disk space on your destination drive.@@1@@@1
Microsoft Office Access can't save output data to the specified file.@Make sure that
you have enough free disk space on your destination drive.@@1@@1
Microsoft Access can't save output data to the specified file.@Make sure that you
have enough free disk space on your destination drive.@@1@@1
There are too many columns to output, based on the limitation specified in the
output format or by Microsoft Office Access.@@@1@@@1
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Numbe

Access

Error Description

2305

2003

There are too many
output format or by
There are too many
output format or by

2002
2306

2007
2003
2002

2307

columns to output, based on the limitation specified in the
Microsoft Office Access.@@@1@@1
columns to output, based on the limitation specified in the
Microsoft Access.@@@1@@1

There are too many rows to output, based on the limitation specified by the output
format or by Microsoft Office Access.@@@1@@@1
There are too many rows to output, based on the limitation specified by the output
format or by Microsoft Office Access.@@@1@@1
There are too many rows to output, based on the limitation specified by the output
format or by Microsoft Access.@@@1@@1

2007
2003

You haven't selected any data, or the object you've selected is blank.@@@1@@1

2308

2007
2003

The file '|' already exists.@Do you want to replace the existing file?@@20@@@2
The file '|' already exists.@Do you want to replace the existing file?@@20@@2

2309

2007

There is an invalid add-in entry for '|.'@There is an error in the Windows Registry
for this add-in. Correct the setting and restart Microsoft Office Access. For
information on the Registry, click Help.@@2@1@9015@1
There is an invalid add-in entry for '|.'@There is an error in the Windows Registry
for this add-in. Correct the setting and restart Microsoft Office Access. For
information on the Registry, click Help.@@2@109015@1
There is an invalid add-in entry for '|.'@There is an error in the Windows Registry
for this add-in. Correct the setting and restart Microsoft Access. For information on
the Registry, click Help.@@2@109015@1

2003

2002

2311

2007
2003

There isn't enough memory to run the NotInList event procedure.@@@1@@@1
There isn't enough memory to run the NotInList event procedure.@@@1@@1

2312

2007

The shortcut '|' must be re-created.@The file may be missing, damaged, or in an
older format that can't be read.@@1@@@1
The shortcut '|' must be re-created.@The file may be missing, damaged, or in an
older format that can't be read.@@1@@1

2003
2313

2007
2003
2002

2314

2007
2003
2002

Microsoft Office Access can't find the shortcut databases '|1' or '|2.'@Re-create the
shortcut with the correct locations of the databases.@@2@1@9032@1
Microsoft Office Access can't find the shortcut databases '|1' or '|2.'@Re-create the
shortcut with the correct locations of the databases.@@2@209032@1
Microsoft Access can't find the shortcut databases '|1' or '|2.'@Re-create the
shortcut with the correct locations of the databases.@@2@209032@1

Microsoft Office Access can't find the shortcut database '|.'@Re-create the shortcut
with the correct location of the database.@@2@1@9032@1
Microsoft Office Access can't find the shortcut database '|.'@Re-create the shortcut
with the correct location of the database.@@2@209032@1
Microsoft Access can't find the shortcut database '|.'@Re-create the shortcut with
the correct location of the database.@@2@209032@1

2315

2007
2003

The input string is too long.@@@1@@@1
The input string is too long.@@@1@@1

2316

2007

This table or query can't be opened because it has no visible fields.@This can result
if the table or query has only system fields, and the Show System Objects option is
off.@To turn on the Show System Objects option, click Options on the Tools menu,
click the View tab, and select the System Objects check box.@1@@@1
This table or query can't be opened because it has no visible fields.@This can result
if the table or query has only system fields, and the Show System Objects option is
off.@To turn on the Show System Objects option, click Options on the Tools menu,
click the View tab, and select the System Objects check box.@1@@1

2003
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Numbe

Access

2317

2007
2003
2002

2319

2320

2007
2003
2002
2007

2003

2002

2321

2007

2003

2322

2007

2003

2323

2007

2003

2324

2007

Error Description
The database '|' can't be repaired or isn't a Microsoft Office Access database
file.@@@1@@@1
The database '|' can't be repaired or isn't a Microsoft Office Access database
file.@@@1@@1
The database '|' can't be repaired or isn't a Microsoft Access database
file.@@@1@@1

Microsoft Office Access can't import the object '|' while it is open.@@@1@@3
Microsoft Access can't import the object '|' while it is open.@@@1@@3
Microsoft Office Access can't display the field for which you entered Where in the
Total row.@Clear the Show check box for that field. If you want this field to appear
in the query's results, add it to the design grid twice. For the field that will appear
in the query's results, don't specify Where in the Total row, and make sure the
Show check box is checked.@@1@@@1
Microsoft Office Access can't display the field for which you entered Where in the
Total row.@Clear the Show check box for that field. If you want this field to appear
in the query's results, add it to the design grid twice. For the field that will appear
in the query's results, don't specify Where in the Total row, and make sure the
Show check box is checked.@@1@@1
Microsoft Access can't display the field for which you entered Where in the Total
row.@Clear the Show check box for that field. If you want this field to appear in the
query's results, add it to the design grid twice. For the field that will appear in the
query's results, don't specify Where in the Total row, and make sure the Show
check box is checked.@@1@@1

You can't set criteria before you add a field or expression to the Field row.@Either
add a field from the field list to the column and enter an expression, or delete the
criteria.@@1@@@1
You can't set criteria before you add a field or expression to the Field row.@Either
add a field from the field list to the column and enter an expression, or delete the
criteria.@@1@@1
You can't sort on the asterisk (*).@Because the asterisk represents all fields in the
underlying table or query, you can't sort on it.@Add the asterisk to the query design
grid, along with the specific fields you want to sort on. Clear the Show check box for
the sorting fields, and then specify a sort order.@1@@@1
You can't sort on the asterisk (*).@Because the asterisk represents all fields in the
underlying table or query, you can't sort on it.@Add the asterisk to the query design
grid, along with the specific fields you want to sort on. Clear the Show check box for
the sorting fields, and then specify a sort order.@1@@1
You can't specify criteria for the asterisk (*).@Because the asterisk represents all
the fields in the underlying table or query, you can't specify criteria for it.@Add the
asterisk to the query design grid, along with the field(s) you want to set criteria for,
and then enter criteria for the specific fields. In the query design grid, clear the
Show check box for the criteria field(s), before you run the query.@1@@@1
You can't specify criteria for the asterisk (*).@Because the asterisk represents all
the fields in the underlying table or query, you can't specify criteria for it.@Add the
asterisk to the query design grid, along with the field(s) you want to set criteria for,
and then enter criteria for the specific fields. In the query design grid, clear the
Show check box for the criteria field(s), before you run the query.@1@@1
You can't calculate totals on the asterisk (*).@Because the asterisk represents all
the fields in the table, you can't calculate totals on it.@Remove the asterisk from
the query design grid. Add the fields you want to use to the design grid, and then
select the total you want to calculate for specific fields.@1@2@11202@1
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Numbe

Access

2324

2003

You can't calculate totals on the asterisk (*).@Because the asterisk represents all
the fields in the table, you can't calculate totals on it.@Remove the asterisk from
the query design grid. Add the fields you want to use to the design grid, and then
select the total you want to calculate for specific fields.@1@11202@1

2325

2007

The field name you entered exceeds the 64-character limit of the LinkMasterFields
property.@When you use the Relationships command (on the Database Tools tab,
click Relationships) to define a relationship between the tables underlying a form
and subform, Microsoft Office Access links the form and subform automatically and
sets the LinkChildFields and LinkMasterFields properties.@@1@1@3990@1
The field name you entered exceeds the LinkMasterFields property's 64-character
limit.@When you use the Relationships command (Tools menu) to define a
relationship between the tables underlying a form and subform, Microsoft Office
Access links the form and subform automatically and sets the LinkChildFields and
LinkMasterFields properties.@@1@603990@1
The field name you entered exceeds the LinkMasterFields property's 64-character
limit.@When you use the Relationships command (Tools menu) to define a
relationship between the tables underlying a form and subform, Microsoft Access
links the form and subform automatically and sets the LinkChildFields and
LinkMasterFields properties.@@1@603990@1

2003

2002

2326

2007

2003

2327

2007

2003

2328

2007

2003

2329

2007
2003

2330

2007

2003

Error Description

You can't specify Group By, Expression, or Where in the Total row for this
column.@Specify an aggregate function, such as Sum or Count, for the field or
expression you designate as the Value in the crosstab query.For more information
on aggregate functions, click Help.@@2@1@9980@1
You can't specify Group By, Expression, or Where in the Total row for this
column.@Specify an aggregate function, such as Sum or Count, for the field or
expression you designate as the Value in the crosstab query.For more information
on aggregate functions, click Help.@@2@209980@1
You must enter Group By in the Total row for a field that has Column Heading in the
Crosstab row.@The values derived from the field or expression that you designate
as the Column Heading are used to group data in the crosstab
query.@@1@1@9980@1
You must enter Group By in the Total row for a field that has Column Heading in the
Crosstab row.@The values derived from the field or expression that you designate
as the Column Heading are used to group data in the crosstab
query.@@1@209980@1
You can't run an update query on the asterisk (*).@Because the asterisk represents
all the fields in the table, you can't update it.@Remove the asterisk from the query
design grid. Add the fields you want to update to the design grid.@1@1@10001@1
You can't run an update query on the asterisk (*).@Because the asterisk represents
all the fields in the table, you can't update it.@Remove the asterisk from the query
design grid. Add the fields you want to update to the design grid.@1@210001@1
To create a crosstab query, you must specify one or more Row Heading(s) options,
one Column Heading option, and one Value option.@@@1@1@9980@1
To create a crosstab query, you must specify one or more Row Heading(s) options,
one Column Heading option, and one Value option.@@@1@209980@1

Microsoft Office Access can't represent the join expression | in Design view.@* One
or more fields may have been deleted or renamed.* The name of one or more
fields or tables specified in the join expression may be misspelled.* The join may
use an operator that isn't supported in Design view, such as > or <.@@1@@@1
Microsoft Office Access can't represent the join expression | in Design view.@* One
or more fields may have been deleted or renamed.* The name of one or more
fields or tables specified in the join expression may be misspelled.* The join may
use an operator that isn't supported in Design view, such as > or <.@@1@@1
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Numbe

Access

2330

2002

Microsoft Access can't represent the join expression | in Design view.@* One or
more fields may have been deleted or renamed.* The name of one or more fields
or tables specified in the join expression may be misspelled.* The join may use an
operator that isn't supported in Design view, such as > or <.@@1@@1

2331

2007

You must enter Group By in the Total row for at least one of the Row Heading
options you enter in the Crosstab row.@@@1@1@9980@1
You must enter Group By in the Total row for at least one of the Row Heading
options you enter in the Crosstab row.@@@1@209980@1

2003
2332

2007

2003

2002

2333

2007

2003

2334

2007

2003

2002

2335

2007

Error Description

Microsoft Office Access can't match the fields you added using the asterisk (*) in
the append query.@Because the asterisk represents all the fields in the underlying
table or query, you can't append an asterisk to one field or expression, and you
can't append a single field or expression to an asterisk.@Append an asterisk to an
asterisk (for example, a table to a table), or append specific fields.@1@1@9999@1
Microsoft Office Access can't match the fields you added using the asterisk (*) in
the append query.@Because the asterisk represents all the fields in the underlying
table or query, you can't append an asterisk to one field or expression, and you
can't append a single field or expression to an asterisk.@Append an asterisk to an
asterisk (for example, a table to a table), or append specific fields.@1@209999@1
Microsoft Access can't match the fields you added using the asterisk (*) in the
append query.@Because the asterisk represents all the fields in the underlying table
or query, you can't append an asterisk to one field or expression, and you can't
append a single field or expression to an asterisk.@Append an asterisk to an
asterisk (for example, a table to a table), or append specific fields.@1@209999@1
You must enter the name of the table you are creating or appending records
to.@You tried to define a make-table or append query without specifying a
destination table.@@1@@@1
You must enter the name of the table you are creating or appending records
to.@You tried to define a make-table or append query without specifying a
destination table.@@1@@1
Microsoft Office Access can't print '|' because it is an action query.@Because action
queries don't produce a recordset, you can't print a Datasheet view of them.Note
that an exclamation point (!) joined to a query icon in the Navigation Pane marks an
action query.@To print a Datasheet view of the records that will be selected by the
query, display the query in Design view, click the Datasheet button, and then click
the Print button.@1@@@1
Microsoft Office Access can't print '|' because it is an action query.@Because action
queries don't produce a recordset, you can't print a Datasheet view of them.Note
that an exclamation point (!) joined to a query icon in the Database window marks
an action query.@To print a Datasheet view of the records that will be selected by
the query, display the query in Design view, click the Datasheet button, and then
click the Print button.@1@@1
Microsoft Access can't print '|' because it is an action query.@Because action
queries don't produce a recordset, you can't print a Datasheet view of them.Note
that an exclamation point (!) joined to a query icon in the Database window marks
an action query.@To print a Datasheet view of the records that will be selected by
the query, display the query in Design view, click the Datasheet button, and then
click the Print button.@1@@1
You must specify the same number of fields when you set the LinkChildFields and
LinkMasterFields properties.@You entered a different number of fields for one
property than you did for the other.If you use the Relationships command (on the
Database Tools tab, click Relationships) to define a relationship between the tables
underlying the form and subform, Microsoft Office Access will link the form and
subform automatically and then set the LinkChildFields and LinkMasterFields
properties.@@1@1@9086@1
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Numbe

Access

2335

2003

2002

2337

2007

2003

2338

2007
2003
2002

2339

2007

2003

2002

2340

2007
2003

2342

2007

2003

2343

2007
2003

2344

2007

Error Description
You must use the same number of fields when you set the LinkChildFields and
LinkMasterFields properties.@You entered a different number of fields for one
property than you did for the other.If you use the Relationships command (Tools
menu) to define a relationship between the tables underlying the form and subform,
Microsoft Office Access will link the form and subform automatically and then set the
LinkChildFields and LinkMasterFields properties.@@1@209086@1
You must use the same number of fields when you set the LinkChildFields and
LinkMasterFields properties.@You entered a different number of fields for one
property than you did for the other.If you use the Relationships command (Tools
menu) to define a relationship between the tables underlying the form and subform,
Microsoft Access will link the form and subform automatically and then set the
LinkChildFields and LinkMasterFields properties.@@1@209086@1
You can't specify criteria on the same field for which you entered Value in the
Crosstab row.@You tried to display a crosstab query after entering Value in the
Crosstab row and criteria in the Criteria row.@If you want this field to supply the
cross-tabulated values in the crosstab query, delete the entry in the Criteria row. If
you want this to be a criteria field, leave the Crosstab row blank.@1@1@9980@1
You can't specify criteria on the same field for which you entered Value in the
Crosstab row.@You tried to display a crosstab query after entering Value in the
Crosstab row and criteria in the Criteria row.@If you want this field to supply the
cross-tabulated values in the crosstab query, delete the entry in the Criteria row. If
you want this to be a criteria field, leave the Crosstab row blank.@1@209980@1
Microsoft Office Access truncated the expression you entered.@The expression '|'
exceeds the 1,024-character limit for the query design grid.@@1@@@1
Microsoft Office Access truncated the expression you entered.@The expression '|'
exceeds the 1,024-character limit for the query design grid.@@1@@1
Microsoft Access truncated the expression you entered.@The expression '|' exceeds
the 1,024-character limit for the query design grid.@@1@@1

Microsoft Office Access can't create a temporary link.@You reached the limit for the
number of links in your database. Microsoft Office Access needs to create a
temporary link in order to import your ODBC table.@Remove all unneeded links or
tables.@1@@@1
Microsoft Office Access can't create a temporary link.@You reached the limit for the
number of links in your database. Microsoft Office Access needs to create a
temporary link in order to import your ODBC table.@Remove all unneeded links or
tables.@1@@1
Microsoft Access can't create a temporary link.@You reached the limit for the
number of links in your database. Microsoft Access needs to create a temporary link
in order to import your ODBC table.@Remove all unneeded links or tables.@1@@1
The expression you entered exceeds the 1,024-character limit for the query design
grid.@@@1@@@1
The expression you entered exceeds the 1,024-character limit for the query design
grid.@@@1@@1
A RunSQL action requires an argument consisting of an SQL statement.@For
example, an action query that appends records starts with INSERT INTO. A datadefinition query that creates a table starts with CREATE TABLE.@@1@1@3698@1
A RunSQL action requires an argument consisting of an SQL statement.@For
example, an action query that appends records starts with INSERT INTO. A datadefinition query that creates a table starts with CREATE TABLE.@@1@603698@1

The value you entered exceeds the Alias property's 64-character
limit.@@@1@1@6146@1
The value you entered exceeds the Alias property's 64-character
limit.@@@1@606146@1
For the TopValues property in the query property sheet, you must enter an integer
greater than zero.@@@1@@@1
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Access

2344

2003

For the TopValues property in the query property sheet, you must enter an integer
greater than zero.@@@1@@1

2345

2007

For the TopValues property in the query property sheet, you must enter a
percentage from 1 through 100.@@@1@@@1
For the TopValues property in the query property sheet, you must enter a
percentage from 1 through 100.@@@1@@1

2003

2346

2007
2003

2347

2007

2003

2002

Error Description

For the TopValues property in the query property sheet, you must enter a number
greater than zero.@@@1@@@1
For the TopValues property in the query property sheet, you must enter a number
greater than zero.@@@1@@1
Microsoft Office Access can't find the file name you entered for the DestinationDB
property in an action query's property sheet.@You may have misspelled the
database file name, or the file may have been deleted or
renamed.@@1@1@6183@1
Microsoft Office Access can't find the file name you entered for the DestinationDB
property in an action query's property sheet.@You may have misspelled the
database file name, or the file may have been deleted or renamed.@@1@606183@1
Microsoft Access can't find the file name you entered for the DestinationDB property
in an action query's property sheet.@You may have misspelled the database file
name, or the file may have been deleted or renamed.@@1@606183@1

2348

2007
2003

You can't leave the Alias property blank.@@@1@1@6146@1
You can't leave the Alias property blank.@@@1@606146@1

2349

2007

For the TopValues property in the query property sheet, you must enter a number
smaller than 2,147,483,647.@@@1@@@1
For the TopValues property in the query property sheet, you must enter a number
smaller than 2,147,483,647.@@@1@@1

2003
2350

2007

2003

2002

2351

2007
2003
2002

2352

2007
2003

2353

2007
2003

Microsoft Office Access can't save the query.@* The query is a pass-through query
and can't be represented as a simple SQL string. Save the query as a named query
from the Query Builder. When you close the Query Builder, Microsoft Office Access
will fill the RecordSource or RowSource property with the saved query name.*
Make sure the query doesn't have an SQL syntax error.@@1@1@4309@1
Microsoft Office Access can't save the query.@* The query is a pass-through query
and can't be represented as a simple SQL string. Save the query as a named query
from the Query Builder. When you close the Query Builder, Microsoft Office Access
will fill the RecordSource or RowSource property with the saved query name.*
Make sure the query doesn't have an SQL syntax error.@@1@604309@1
Microsoft Access can't save the query.@* The query is a pass-through query and
can't be represented as a simple SQL string. Save the query as a named query from
the Query Builder. When you close the Query Builder, Microsoft Access will fill the
RecordSource or RowSource property with the saved query name.* Make sure the
query doesn't have an SQL syntax error.@@1@604309@1

Microsoft Office Access can't represent an implicit VALUES clause in the query
design grid.@Edit this in SQL view.@@1@@@1
Microsoft Office Access can't represent an implicit VALUES clause in the query
design grid.@Edit this in SQL view.@@1@@1
Microsoft Access can't represent an implicit VALUES clause in the query design
grid.@Edit this in SQL view.@@1@@1
You can't modify this query because it has been deleted or renamed by another
user.@@@1@@@1
You can't modify this query because it has been deleted or renamed by another
user.@@@1@@1
Bad query parameter '|'.@@@1@@@1
Bad query parameter '|'.@@@1@@1
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Access

2354

2007

This query or table has an expression that is failing to evaluate.

2355

2007

You can select up to | values in a column filter for a multi-valued field. Remove
some values, and then try again.

2356

2007

You cannot assign a multivalued or Attachment field to the Link Master Fields or
Link Child Fields properties.@@@1@@@1

2360

2007

A field name is missing.@You have defined
without specifying the field name.@Enter a
row.@1@@@1
A field name is missing.@You have defined
without specifying the field name.@Enter a
row.@1@@1

2003

2361

2007

2003

2002

Error Description

a data type or a description for a field
name for the field, or delete the

a data type or a description for a field
name for the field, or delete the

Microsoft Office Access can't save this table.@There are no fields in this
table.@Define at least one field by entering a field name and selecting a data
type.@1@@@1
Microsoft Office Access can't save this table.@There are no fields in this
table.@Define at least one field by entering a field name and selecting a data
type.@1@@1
Microsoft Access can't save this table.@There are no fields in this table.@Define at
least one field by entering a field name and selecting a data type.@1@@1

2362

2007
2003

You already have a field named '|.'@@@1@@@1
You already have a field named '|.'@@@1@@1

2363

2007

Microsoft Office Access allows only one AutoNumber field per table.@Use the
Number data type for similar fields.@@1@@@1
Microsoft Office Access allows only one AutoNumber field per table.@Use the
Number data type for similar fields.@@1@@1
Microsoft Access allows only one AutoNumber field per table.@Use the Number data
type for similar fields.@@1@@1

2003
2002
2364

2007
2003
2002

Microsoft Office Access can't open the table in Datasheet view.@@@1@@@1
Microsoft Office Access can't open the table in Datasheet view.@@@1@@1
Microsoft Access can't open the table in Datasheet view.@@@1@@1

2366

2007

Microsoft Office Access was unable to save the field ordering. All other changes
were saved successfully.@Click the Microsoft Office Button, point to Manage, and
then click Compact and Repair Database.@@1@@@1
Microsoft Office Access was unable to save the field ordering. All other changes
were saved successfully.@Close this database and choose the Repair Database
command on the Tools menu (Database Utilities submenu).@@1@@1
Microsoft Access was unable to save the field ordering. All other changes were
saved successfully.@Close this database and choose the Repair Database command
on the Tools menu (Database Utilities submenu).@@1@@1

2003

2002

2370

2007

2003

2371

2007
2003
2002

Removing or changing the index for this field would require removal of the primary
key.@If you want to delete the primary key, select that field and click the Primary
Key button.@@1@@@1
Removing or changing the index for this field would require removal of the primary
key.@If you want to delete the primary key, select that field and click the Primary
Key button.@@1@@1
Microsoft Office Access can't create a primary key. Your changes weren't
saved.@@@1@@@1
Microsoft Office Access can't create a primary key. Your changes weren't
saved.@@@1@@1
Microsoft Access can't create a primary key. Your changes weren't
saved.@@@1@@1

Copyright (c) 2008 FMS, Inc.

fmsinc.com

Page 43 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

2372

2007

Error Description

2000

The field name is not valid.@Make sure that the name doesn't contain a period (.),
exclamation point (!), bracket ([]), leading space, or non-printable character such
as a carriage return. If you have pasted the name from another application, try
pressing ESC and typing the name again.@@2@1@13793@1
The field name is not valid.@Make sure that the name doesn't contain a period (.),
exclamation point (!), bracket ([]), leading space, or non-printable character such
as a carriage return. If you have pasted the name from another application, try
pressing ESC and typing the name again.@@2@613793@1
The field name is invalid.@@@1@@1

2373

2007
2003

The setting for the FieldSize property must be from 0 through 255.@@@1@@@1
The setting for the FieldSize property must be from 0 through 255.@@@1@@1

2374

2007
2003

You can't create an index or primary key on more than 10 fields.@@@1@@@1
You can't create an index or primary key on more than 10 fields.@@@1@@1

2375

2007

You can't paste beyond the end of a table.@You have attempted to paste fields
beyond the 255th row in a table in Design view.@@1@@@1
You can't paste beyond the end of a table.@You have attempted to paste fields
beyond the 255th row in a table in Design view.@@1@@1

2003

2003

2376

2007
2003
2002

2377

2007

2003

2002

2378

2007
2003

2379

2007

2003
2380

2007

2003

Microsoft Office Access can't create a primary key.@You have selected too many
fields for a multiple-field primary key.@@1@@@1
Microsoft Office Access can't create a primary key.@You have selected too many
fields for a multiple-field primary key.@@1@@1
Microsoft Access can't create a primary key.@You have selected too many fields for
a multiple-field primary key.@@1@@1
Once you enter data in a table, you can't change the data type of any field to
AutoNumber, even if you haven't yet added data to that field.@Add a new field to
the table, and define its data type as AutoNumber. Microsoft Office Access then
enters data in the AutoNumber field automatically, numbering the records
consecutively starting with 1.@@1@@@1
Once you enter data in a table, you can't change the data type of any field to
AutoNumber, even if you haven't yet added data to that field.@Add a new field to
the table, and define its data type as AutoNumber. Microsoft Office Access then
enters data in the AutoNumber field automatically, numbering the records
consecutively starting with 1.@@1@@1
Once you enter data in a table, you can't change the data type of any field to
AutoNumber, even if you haven't yet added data to that field.@Add a new field to
the table, and define its data type as AutoNumber. Microsoft Access then enters
data in the AutoNumber field automatically, numbering the records consecutively
starting with 1.@@1@@1
This table is read-only.@Use a different name in the Save As dialog box to save
your changes.@@1@@@1
This table is read-only.@Use a different name in the Save As dialog box to save
your changes.@@1@@1

You can't create a primary key on a field of this data type.@You can't define a
primary key on fields with an OLE Object, Memo, Attachment, or Multi-valued
lookup field.@@1@@@1
You can't create a primary key on a field of this data type.@You can't define a
primary key on fields with an OLE Object data type.@@1@@1
Microsoft Office Access can't create a primary key because no fields have been
selected.@You have selected a row with no fields defined.@Place the insertion point
somewhere in the row of the field you want to define as the primary key.@1@@@1
Microsoft Office Access can't create a primary key because no fields have been
selected.@You have selected a row with no fields defined.@Place the insertion point
somewhere in the row of the field you want to define as the primary key.@1@@1
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Access

2380

2002

Microsoft Access can't create a primary key because no fields have been
selected.@You have selected a row with no fields defined.@Place the insertion point
somewhere in the row of the field you want to define as the primary key.@1@@1

2381

2007

Microsoft Office Access can't create a primary key because the field doesn't have a
name.@Name the field, and then define it as a primary key field.@@1@@@1
Microsoft Office Access can't create a primary key because the field doesn't have a
name.@Name the field, and then define it as a primary key field.@@1@@1
Microsoft Access can't create a primary key because the field doesn't have a
name.@Name the field, and then define it as a primary key field.@@1@@1

2003
2002
2382

2007

2003

2000

2383

2007
2003
2002

2384

2007

2003

Error Description

You can't switch to Datasheet view and you can't return to Design view.@Another
user has opened this table or a query, form, or report that is bound to this
table.@@1@@@1
You can't switch to Datasheet view and you can't return to Design view.@Another
user has opened this table or a query, form, or report that is bound to this
table.@@1@@1
You can't switch to Datasheet view and you can't return to Design view.@Another
user has opened this table, or a query, form, or report that is bound to this
table.@@1@@1
Microsoft Office Access can't change the data type.@There isn't enough disk space
or memory.@@1@@@1
Microsoft Office Access can't change the data type.@There isn't enough disk space
or memory.@@1@@1
Microsoft Access can't change the data type.@There isn't enough disk space or
memory.@@1@@1
You cannot change one field from an AutoNumber data type and add another
AutoNumber field at the same time.@Do the following:1. Delete the AutoNumber
field you just added, click the Microsoft Office Button, and then click Save.2. Add
the new AutoNumber field, and then save the table again.@@1@@@1
You can't change one field from an AutoNumber data type and add another
AutoNumber field at the same time.@Do the following:1. Delete the AutoNumber
field you added, and click Save on the File menu.2. Add the new AutoNumber
field, and save the table again.@@1@@1

2385

2007
2003

Errors were encountered during the save operation. |@@@1@@@1
Errors were encountered during the save operation. |@@@1@@1

2386

2007
2003
2002

Microsoft Office Access was unable to create the table.@@@1@@@1
Microsoft Office Access was unable to create the table.@@@1@@1
Microsoft Access was unable to create the table.@@@1@@1

2387

2007

You can't delete the table '|'; it is participating in one or more relationships.@If you
want to delete this table, first delete its relationships in the Relationships
window.@@1@@@1
You can't delete the table '|'; it is participating in one or more relationships.@If you
want to delete this table, first delete its relationships in the Relationships
window.@@1@@1

2003

2388

2007

2003

2389

2007
2003

You can't change the primary key.@This table is the
relationships.@If you want to change or remove the
relationship in the Relationships window.@1@@@1
You can't change the primary key.@This table is the
relationships.@If you want to change or remove the
relationship in the Relationships window.@1@@1

You can't delete
delete this field,
You can't delete
delete this field,
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Access

2390

2007

2003

2391

2007

2003

2002

2392

2007

2003

2393

2007

2003

2394

2007
2003

Error Description
You can't change the data type or field size of this field; it is part of one or more
relationships.@If you want to change the data type of this field, first delete its
relationships in the Relationships window.@@1@@@1
You can't change the data type or field size of this field; it is part of one or more
relationships.@If you want to change the data type of this field, first delete its
relationships in the Relationships window.@@1@@1
Field '|1' doesn't exist in destination table '|2.'@Microsoft Office Access was unable
to complete the append operation. The destination table must contain the same
fields as the table you are pasting from.@@1@@@1
Field '|1' doesn't exist in destination table '|2.'@Microsoft Office Access was unable
to complete the append operation. The destination table must contain the same
fields as the table you are pasting from.@@1@@1
Field '|1' doesn't exist in destination table '|2.'@Microsoft Access was unable to
complete the append operation. The destination table must contain the same fields
as the table you are pasting from.@@1@@1

You can't set the Unique property of a primary key to No.@A primary key, by
definition, contains only unique values.@If you want to allow nonunique values in
this field, remove the primary key definition by setting the Primary property to
No.@1@@@1
You can't set the Unique property of a primary key to No.@A primary key, by
definition, contains only unique values.@If you want to allow nonunique values in
this field, remove the primary key definition by setting the Primary property to
No.@1@@1
You can't set the IgnoreNulls property of a primary key to Yes.@A primary key, by
definition, can't allow null values.@If you want null values in this field, remove the
primary key definition by setting the Primary property to No.@1@@@1
You can't set the IgnoreNulls property of a primary key to Yes.@A primary key, by
definition, can't allow null values.@If you want null values in this field, remove the
primary key definition by setting the Primary property to No.@1@@1
The index name is invalid.@The index name may be too long (over 64 characters)
or contain invalid characters.@@1@@@1
The index name is invalid.@The index name may be too long (over 64 characters)
or contain invalid characters.@@1@@1

2395

2007
2003

Indexes must have names.@@@1@@@1
Indexes must have names.@@@1@@1

2396

2007

Microsoft Office Access can't create an index or primary key.@One or more field
names are missing.@Enter or select at least one field in the Field Name column for
each index you name.@1@@@1
Microsoft Office Access can't create an index or primary key.@One or more field
names are missing.@Enter or select at least one field in the Field Name column for
each index you name.@1@@1
Microsoft Access can't create an index or primary key.@One or more field names
are missing.@Enter or select at least one field in the Field Name column for each
index you name.@1@@1

2003

2002

2397

2007
2003

You already have an index named '|.'@@@1@@@1
You already have an index named '|.'@@@1@@1

2398

2007

The primary key has been changed.@This
relationships. Changes to the primary key
The primary key has been changed.@This
relationships. Changes to the primary key

2003
2399

2007
2003

table is the primary table in one or more
won't be saved.@@1@@@1
table is the primary table in one or more
won't be saved.@@1@@1

The setting for the FieldSize property must be from 1 through 8000.@@@1@@@1
The setting for the FieldSize property must be from 1 through 8000.@@@1@@1
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Access

2400

2007
2003

Error Description
The row you inserted in the grid exceeds the limit of 255 rows (fields) for a table or
1,000 rows (actions) for a macro.@@@1@@@1
The row you inserted in the grid exceeds the limit of 255 rows (fields) for a table or
1,000 rows (actions) for a macro.@@@1@@1

2401

2007

You can't delete the '|1' column at this time. @The '|1' column is part of the primary
key for the '|2' table. It is used to identify and store the rows in your table in the
database.@You cannot delete a primary key while using Datasheet view. To delete
the primary key, open the table in Design view and remove the primary key
field.@1@@@1

2420

2007
2003

The expression you entered has an invalid number.@@@2@1@11732@1
The expression you entered has an invalid number.@@@2@611732@1

2421

2007
2003

The expression you entered has an invalid date value.@@@2@1@11729@1
The expression you entered has an invalid date value.@@@2@611729@1

2422

2007

The expression you entered has an invalid string.@A string can be up to 2048
characters long, including opening and closing quotation marks.@@1@@@1
The expression you entered has an invalid string.@A string can be up to 2048
characters long, including opening and closing quotation marks.@@1@@1
The expression you entered has an invalid string.@A string can be up to 255
characters long, including opening and closing quotation marks.@@1@@1

2003
2000
2423

2007

2003

2424

2007
2003
2002

2425

2007
2003
2002

2426

2007

2003

2000

2427

2007
2003

The expression you entered has an invalid . (dot) or ! operator or invalid
parentheses.@You may have entered an invalid identifier or typed parentheses
following the Null constant.@@2@1@11736@1
The expression you entered has an invalid . (dot) or ! operator or invalid
parentheses.@You may have entered an invalid identifier or typed parentheses
following the Null constant.@@2@611736@1
The expression you entered has a field, control, or property name that Microsoft
Office Access can't find.@@@1@@@1
The expression you entered has a field, control, or property name that Microsoft
Office Access can't find.@@@1@@1
The expression you entered has a field, control, or property name that Microsoft
Access can't find.@@@1@@1
The expression you entered has a function name that Microsoft Office Access can't
find.@@@1@@@1
The expression you entered has a function name that Microsoft Office Access can't
find.@@@1@@1
The expression you entered has a function name that Microsoft Access can't
find.@@@1@@1
The function you entered can't be used in this expression.@* You may have used a
DoEvents, LBound, UBound, Spc, or Tab function in an expression.* You may
have used an aggregate function, such as Count, in a design grid or in a calculated
control or field.@@1@@@1
The function you entered can't be used in this expression.@* You may have used a
DoEvents, LBound, UBound, Spc, or Tab function in an expression.* You may
have used an aggregate function, such as Count, in a design grid or in a calculated
control or field.@@1@@1
The function you entered can't be used in this expression.@* You may have used a
DoEvents, LBound, UBound, Spc, or Tab function in an expression.* You may
have used an SQL aggregate function, such as Count, in a design grid or in a
calculated control or field.@@1@@1

You entered an expression that has no value.@The expression may refer to an
object that has no value, such as a form, a report, or a label control.@@1@@@1
You entered an expression that has no value.@The expression may refer to an
object that has no value, such as a form, a report, or a label control.@@1@@1
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Access

2428

2007

2003

Error Description
You entered an invalid argument in a domain aggregate function.@* A field in the
string expression may not be in the domain.* A field specified in the criteria
expression may not be in the domain.@@2@1@10931@1
You entered an invalid argument in a domain aggregate function.@* A field in the
string expression may not be in the domain.* A field specified in the criteria
expression may not be in the domain.@@2@610931@1

2429

2007
2003

The In operator you entered requires parentheses.@@@1@@@1
The In operator you entered requires parentheses.@@@1@@1

2430

2007

You did not enter the keyword And in the Between...And operator.@The correct
syntax is as follows:expression [Not] Between value1 And value2@@1@@@1
You did not enter the keyword And in the Between...And operator.@The correct
syntax is as follows:expression [Not] Between value1 And value2@@1@@1

2003
2431

2007
2003

2432

2007

2003

2433

2007

2003

2434

2007
2003

The expression you entered
comma without a preceding
The expression you entered
comma without a preceding

contains invalid syntax.@You may have entered a
value or identifier.@@1@@@1
contains invalid syntax.@You may have entered a
value or identifier.@@1@@1

The expression you entered contains invalid syntax, or you need to enclose your
text data in quotes.@You may have entered an invalid comma or omitted quotation
marks.For example, if the Default Value property of a text field is ''Huey, Louie,
and Dewey,'' it must be enclosed in quotes if you mean it as a literal text string.
This avoids the confusion with the expression ''Huey Louie'' And
''Dewey''.@@1@@@1
The expression you entered contains invalid syntax, or you need to enclose your
text data in quotes.@You may have entered an invalid comma or omitted quotation
marks.For example, if the Default Value property of a text field is ''Huey, Louie,
and Dewey,'' it must be enclosed in quotes if you mean it as a literal text string.
This avoids the confusion with the expression ''Huey Louie'' And ''Dewey''.@@1@@1
The expression you entered contains invalid syntax.@You may have entered an
operator, such as the + operator, in an expression without a corresponding
operand.@@1@@@1
The expression you entered contains invalid syntax.@You may have entered an
operator, such as the + operator, in an expression without a corresponding
operand.@@1@@1
The expression you
operand without an
The expression you
operand without an

entered contains invalid syntax.@You may have entered an
operator.@@1@@@1
entered contains invalid syntax.@You may have entered an
operator.@@1@@1

2435

2007
2003

The expression you entered has too many closing parentheses.@@@1@@@1
The expression you entered has too many closing parentheses.@@@1@@1

2436

2007

The expression you entered is missing a closing parenthesis, bracket (]), or vertical
bar (|).@@@1@@@1
The expression you entered is missing a closing parenthesis, bracket (]), or vertical
bar (|).@@@1@@1

2003
2437

2007
2003

The expression you entered has invalid vertical bars (|).@@@1@@@1
The expression you entered has invalid vertical bars (|).@@@1@@1

2438

2007

The expression you entered contains invalid syntax.@You omitted an operand or
operator, you entered an invalid character or comma, or you entered text without
surrounding it in quotation marks.@@2@1@11732@1
The expression you entered contains invalid syntax.@You omitted an operand or
operator, you entered an invalid character or comma, or you entered text without
surrounding it in quotation marks.@@2@611732@1

2003

2439

2007

The expression you entered has a function containing the wrong number of
arguments.@@@1@@@1

Copyright (c) 2008 FMS, Inc.

fmsinc.com

Page 48 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

2439

2003

The expression you entered has a function containing the wrong number of
arguments.@@@1@@1

2440

2007
2003

You must enclose IIf function arguments in parentheses.@@@1@3@1012957@1
You must enclose IIf function arguments in parentheses.@@@1@1012957@1

2442

2007

The expression you entered has invalid parentheses.@You may have used the
parenthesis syntax for an identifier in a query. Use the standard identifier
syntax:Forms![Form]![Control].@@1@1@11729@1
The expression you entered has invalid parentheses.@You may have used the
parenthesis syntax for an identifier in a query. Use the standard identifier
syntax:Forms![Form]![Control].@@1@411729@1

2003

2443

2007
2003

Error Description

You can use the Is operator only in an expression with Null or Not
Null.@@@1@3@1008950@1
You can use the Is operator only in an expression with Null or Not
Null.@@@1@1008950@1

2445

2007
2003

The expression you entered is too complex.@@@2@1@11732@1
The expression you entered is too complex.@@@2@611732@1

2446

2007

There isn't enough memory available to perform this calculation.@Close unneeded
programs, and try again.For more information on freeing memory, search the
Microsoft Windows Help index for 'memory, troubleshooting'.@@1@@@1
There isn't enough memory available to perform this calculation.@Close unneeded
programs, and try again.For more information on freeing memory, search the
Microsoft Windows Help index for 'memory, troubleshooting'.@@1@@1

2003

2447

2007

2003

2448

2007

2003

2449

2007

2003
2450

2007

2003

2002

2451

2007

There is an invalid use of the . (dot) or ! operator or invalid parentheses.@You may
have entered an invalid identifier or typed parentheses following the Null
constant.@@2@1@11736@1
There is an invalid use of the . (dot) or ! operator or invalid parentheses.@You may
have entered an invalid identifier or typed parentheses following the Null
constant.@@2@611736@1

You can't assign a value to this object.@* The object may be a control
only form.* The object may be on a form that is open in Design view.*
value may be too large for this field.@@1@1@9424@1
You can't assign a value to this object.@* The object may be a control
only form.* The object may be on a form that is open in Design view.*
value may be too large for this field.@@1@209424@1

on a readThe
on a readThe

There is an invalid method in an expression.@For example, you may have tried to
use the Print method with an object other than Report or
Debug.@@2@4@2015551@1
There is an invalid method in an expression.@For example, you may have tried to
use the Print method with an object other than Report or Debug.@@2@2015551@1
Microsoft Office Access can't find the form '|' referred to in a macro expression or
Visual Basic code.@* The form you referenced may be closed or may not exist in
this database.* Microsoft Office Access may have encountered a compile error in
a Visual Basic module for the form.@@1@1@11735@1
Microsoft Office Access can't find the form '|' referred to in a macro expression or
Visual Basic code.@* The form you referenced may be closed or may not exist in
this database.* Microsoft Office Access may have encountered a compile error in
a Visual Basic module for the form.@@1@211735@1
Microsoft Access can't find the form '|' referred to in a macro expression or Visual
Basic code.@* The form you referenced may be closed or may not exist in this
database.* Microsoft Access may have encountered a compile error in a Visual
Basic module for the form.@@1@211735@1

The report name '|' you entered is misspelled or refers to a report that isn't open or
doesn't exist.@@@1@@@1

Copyright (c) 2008 FMS, Inc.

fmsinc.com

Page 49 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

2451

2003

The report name '|' you entered is misspelled or refers to a report that isn't open or
doesn't exist.@@@1@@1

2452

2007

The expression you entered has an invalid reference to the Parent property.@For
example, you may be using the Parent property with a control on a main form or
report rather than with a control on a subform or subreport.@@2@1@4852@1
The expression you entered has an invalid reference to the Parent property.@For
example, you may be using the Parent property with a control on a main form or
report rather than with a control on a subform or subreport.@@2@604852@1

2003

2453

2007

2003
2454

2007

2003

2455

2007

2003

2456

2007

2003

2457

2007

2003

2458

2007

2003

2459

2007
2003

2460

2007
2003

2461

2007
2003

Error Description

The control name '|' you entered in your expression is misspelled or refers to a
control on a form or report that isn't open or doesn't exist.@@@1@1@11730@1
The control name '|' you entered in your expression is misspelled or refers to a
control on a form or report that isn't open or doesn't exist.@@@1@411730@1

The object name '|' you entered following the ! operator in the expression is
invalid.@For example, you may have tried to enter an identifier with two control
names separated by the ! operator.@@2@1@11736@1
The object name '|' you entered following the ! operator in the expression is
invalid.@For example, you may have tried to enter an identifier with two control
names separated by the ! operator.@@2@611736@1
You entered an expression that has an invalid reference to the property |.@The
property may not exist or may not apply to the object you
specified.@@2@4@2015567@1
You entered an expression that has an invalid reference to the property |.@The
property may not exist or may not apply to the object you
specified.@@2@2015567@1
The number you used to refer to the form is invalid.@Use the Count property to
count the open forms and make sure that the form number is not greater than the
number of open forms minus one.@@1@4@2019460@1
The number you used to refer to the form is invalid.@Use the Count property to
count the open forms and make sure that the form number is not greater than the
number of open forms minus one.@@1@2019460@1
The number you used to refer to the report is invalid.@Use the Count property to
count the open reports and make sure that the report number is not greater than
the number of open reports.@@1@4@2019460@1
The number you used to refer to the report is invalid.@Use the Count property to
count the open reports and make sure that the report number is not greater than
the number of open reports.@@1@2019460@1
The control number you specified is greater than the number of controls.@Use the
Count property to count the controls on the form or report and then check that the
control number you cite is within the range of existing
controls.@@1@4@2019460@1
The control number you specified is greater than the number of controls.@Use the
Count property to count the controls on the form or report and then check that the
control number you cite is within the range of existing controls.@@1@2019460@1
You can't refer to the Parent property of a form or report when either is open in
Design view.@@@1@@@1
You can't refer to the Parent property of a form or report when either is open in
Design view.@@@1@@1
You can't refer to the RecordsetClone property of a form open in Design
view.@@@1@1@7393@1
You can't refer to the RecordsetClone property of a form open in Design
view.@@@1@607393@1

Use a section number, not a string, to refer to a form or report
section.@@@1@@@1
Use a section number, not a string, to refer to a form or report section.@@@1@@1
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Access

2462

2007
2003

The section number you entered is invalid.@@@1@@@1
The section number you entered is invalid.@@@1@@1

2463

2007
2003

Use a number, not a string, to refer to a group level.@@@2@1@6361@1
Use a number, not a string, to refer to a group level.@@@2@606361@1

2464

2007

There is no sorting or grouping field or expression defined for the group level
number you used.@A valid group level number can be from 0 (for the first field or
expression you sort or group on) through 9 (for the tenth). Count the group levels
in the report starting with zero.@@1@@@1
There is no sorting or grouping field or expression defined for the group level
number you used.@A valid group level number can be from 0 (for the first field or
expression you sort or group on) through 9 (for the tenth). Count the group levels
in the report starting with zero.@@1@@1

2003

2465

2007

2003

2002

2466

2007

2003

2467

2007

2003

2468

2007

2003

2469

2007

Error Description

Microsoft Office Access can't find the field '|' referred to in your expression.@You
may have misspelled the field name, or the field may have been renamed or
deleted.@@1@1@11730@1
Microsoft Office Access can't find the field '|' referred to in your expression.@You
may have misspelled the field name, or the field may have been renamed or
deleted.@@1@411730@1
Microsoft Access can't find the field '|' referred to in your expression.@You may
have misspelled the field name, or the field may have been renamed or
deleted.@@1@411730@1
The expression you entered has an invalid
example, you may have used the Dynaset
table or query.@@1@@@1
The expression you entered has an invalid
example, you may have used the Dynaset
table or query.@@1@@1

reference to the Dynaset property.@For
property with a form that isn't based on a
reference to the Dynaset property.@For
property with a form that isn't based on a

The expression you entered refers to an object that is closed or doesn't exist.@For
example, you may have assigned a form to a Form object variable, closed the form,
and then referred to the object variable.@@1@@@1
The expression you entered refers to an object that is closed or doesn't exist.@For
example, you may have assigned a form to a Form object variable, closed the form,
and then referred to the object variable.@@1@@1
The value you entered for the interval, number, or date argument in the function is
invalid.@Check the argument to make sure that you entered it correctly.For more
information on valid argument values, search the Help index for 'DatePart function,'
'DateAdd function,' or 'DateDiff function'.@@1@@@1
The value you entered for the interval, number, or date argument in the function is
invalid.@Check the argument to make sure that you entered it correctly.For more
information on valid argument values, search the Help index for 'DatePart function,'
'DateAdd function,' or 'DateDiff function'.@@1@@1
The expression |2 you entered in the form control's ValidationRule property contains
the error |1.@Microsoft Office Access can't parse the ValidationRule expression you
entered. For example, if you enter the expression =MyFunction() in the
ValidationRule property, and the function MyFunction doesn't exist, Microsoft Office
Access displays the following message:Unknown function name in validation rule:
'MyFunction'.@To help you create expressions as arguments in Visual Basic, use the
Expression Builder. For more information, search the Help index for 'Expression
Builder'.@1@1@11805@1
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Access

2469

2003

2002

2470

2007

2003

2471

2007
2003

2472

2007
2003

2473

2007

2003

2474

2007

2003

2475

2007
2003

2476

2007
2003

Error Description
The expression |2 you entered in the form control's ValidationRule property contains
the error |1.@Microsoft Office Access can't parse the ValidationRule expression you
entered. For example, if you enter the expression =MyFunction() in the
ValidationRule property, and the function MyFunction doesn't exist, Microsoft Office
Access displays the following message:Unknown function name in validation rule:
'MyFunction'.@To help you create expressions as arguments in Visual Basic, use the
Expression Builder. For more information, search the Help index for 'Expression
Builder'.@1@111805@1
The expression |2 you entered in the form control's ValidationRule property contains
the error |1.@Microsoft Access can't parse the ValidationRule expression you
entered. For example, if you enter the expression =MyFunction() in the
ValidationRule property, and the function MyFunction doesn't exist, Microsoft Access
displays the following message:Unknown function name in validation rule:
'MyFunction'.@To help you create expressions as arguments in Visual Basic, use the
Expression Builder. For more information, search the Help index for 'Expression
Builder'.@1@111805@1
There is a(n) '|' in the form control's ValidationRule property.@To help you create
expressions as arguments in Visual Basic, use the Expression Builder. For more
information, search the Help index for 'Expression Builder'.@@1@1@11805@1
There is a(n) '|' in the form control's ValidationRule property.@To help you create
expressions as arguments in Visual Basic, use the Expression Builder. For more
information, search the Help index for 'Expression Builder'.@@1@111805@1
The expression you entered as a query parameter produced this error:
'|'@@@2@1@11805@1
The expression you entered as a query parameter produced this error:
'|'@@@2@611805@1

The LinkMasterFields property setting has produced this error:
'|'@@@2@1@3990@1
The LinkMasterFields property setting has produced this error: '|'@@@2@603990@1
The expression |2 you entered as the event property setting produced the following
error: |1.@* The expression may not result in the name of a macro, the name of a
user-defined function, or [Event Procedure].* There may have been an error
evaluating the function, event, or macro.@@1@@@1
The expression |2 you entered as the event property setting produced the following
error: |1.@* The expression may not result in the name of a macro, the name of a
user-defined function, or [Event Procedure].* There may have been an error
evaluating the function, event, or macro.@@1@@1
The expression you entered requires the control to be in the active window.@Try
one of the following:* Open or select a form or report containing the control.*
Create a new control in the active window, and try the operation again.@@1@@@1
The expression you entered requires the control to be in the active window.@Try
one of the following:* Open or select a form or report containing the control.*
Create a new control in the active window, and try the operation again.@@1@@1

You entered an expression that requires a form to be the active
window.@@@1@2@5601@1
You entered an expression that requires a form to be the active
window.@@@1@5601@1
You entered an expression that requires a report to be the active
window.@@@1@2@5603@1
You entered an expression that requires a report to be the active
window.@@@1@5603@1
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Access

2477

2007

2003

2478

2007

2003

2002

2479

2007

2003

2480

2007

2003

Error Description
You entered an invalid objecttype value '|' in an If TypeOf object Is objecttype
condition of an If...Then...Else statement.@The objecttype can be any one of the
following: BoundObjectFrame, CheckBox, ComboBox, CommandButton, Label, Line,
ListBox, UnboundObjectFrame, OptionButton, OptionGroup, PageBreak, Rectangle,
Subform, Subreport, TextBox, ToggleButton, ImageControl, or
OLEControl.@@1@@@1
You entered an invalid objecttype value '|' in an If TypeOf object Is objecttype
condition of an If...Then...Else statement.@The objecttype can be any one of the
following: BoundObjectFrame, CheckBox, ComboBox, CommandButton, Label, Line,
ListBox, UnboundObjectFrame, OptionButton, OptionGroup, PageBreak, Rectangle,
Subform, Subreport, TextBox, ToggleButton, ImageControl, or
OLEControl.@@1@@1
Microsoft Office Access doesn't allow you to use this method in the current
view.@Most methods, including the SetFocus and Requery methods, can't be used
in form or report Design view.@@2@4@2015551@1
Microsoft Office Access doesn't allow you to use this method in the current
view.@Most methods, including the SetFocus and Requery methods, can't be used
in form or report Design view.@@2@2015551@1
Microsoft Access doesn't allow you to use this method in the current view.@Most
methods, including the SetFocus and Requery methods, can't be used in form or
report Design view.@@2@2015551@1

The event procedure '|' can't be a Function procedure; it must be a Sub
procedure.@If you want to run a Function procedure when an event occurs, try one
of the following:* Set the event property to the name of a macro containing a
RunCode action that runs the Function procedure.* Set the event property to
=FunctionName().@@1@@@1
The event procedure '|' can't be a Function procedure; it must be a Sub
procedure.@If you want to run a Function procedure when an event occurs, try one
of the following:* Set the event property to the name of a macro containing a
RunCode action that runs the Function procedure.* Set the event property to
=FunctionName().@@1@@1
You referred to a property by a numeric argument that isn't one of the property
numbers in the collection.@Check the property numbers in the
collection.@@1@@@1
You referred to a property by a numeric argument that isn't one of the property
numbers in the collection.@Check the property numbers in the collection.@@1@@1

2481

2007
2003

You can't set a value while a document is in Print Preview.@@@1@@@1
You can't set a value while a document is in Print Preview.@@@1@@1

2482

2007

Microsoft Office Access can't find the name '|' you entered in the expression.@You
may have specified a control that wasn't on the current object without specifying
the correct form or report context.@To refer to a control on another form or report,
precede the control name with the name of a collection, usually either Forms or
Reports, and the name of the form or report to which the control belongs.For
example, Forms![Products]![Units In Stock].@1@@@1
Microsoft Office Access can't find the name '|' you entered in the expression.@You
may have specified a control that wasn't on the current object without specifying
the correct form or report context.@To refer to a control on another form or report,
precede the control name with the name of a collection, usually either Forms or
Reports, and the name of the form or report to which the control belongs.For
example, Forms![Products]![Units In Stock].@1@@1
Microsoft Access can't find the name '|' you entered in the expression.@You may
have specified a control that wasn't on the current object without specifying the
correct form or report context.@To refer to a control on another form or report,
precede the control name with the name of a collection, usually either Forms or
Reports, and the name of the form or report to which the control belongs.For
example, Forms![Products]![Units In Stock].@1@@1

2003

2002
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Access

2483

2007

2003

Error Description
You can't move to a previous control when only one control has
the PreviousControl property only after you've moved the focus
control.@@1@1@7144@1
You can't move to a previous control when only one control has
the PreviousControl property only after you've moved the focus
control.@@1@607144@1

had the focus.@Use
to a second

had the focus.@Use
to a second

2484

2007
2003

There is no active datasheet.@@@1@@@1
There is no active datasheet.@@@1@@1

2485

2007

Microsoft Office Access can't find the object '|.'@If '|' is a new macro or macro
group, make sure you have saved it and that you have typed its name
correctly.@@1@1@10183@1
Microsoft Office Access can't find the macro '|.'@The macro (or its macro group)
doesn't exist, or the macro is new but hasn't been saved.Note that when you
enter the macrogroupname.macroname syntax in an argument, you must specify
the name the macro's macro group was last saved under.@@1@210183@1
Microsoft Access can't find the macro '|.'@The macro (or its macro group) doesn't
exist, or the macro is new but hasn't been saved.Note that when you enter the
macrogroupname.macroname syntax in an argument, you must specify the name
the macro's macro group was last saved under.@@1@210183@1

2003

2002

2486

2007

2003

2002

2487

2007

You can't carry out this action at the present time.@You tried to run a macro or
used the DoCmd object in Visual Basic to carry out an action. However, Microsoft
Office Access is performing another activity that prevents this action from being
carried out now.For example, no actions on a form can be carried out while
Microsoft Office Access is repainting a control or calculating an expression.@Carry
out the action later.@1@@@1
You can't carry out this action at the present time.@You tried to run a macro or
used the DoCmd object in Visual Basic to carry out an action. However, Microsoft
Office Access is performing another activity that prevents this action from being
carried out now.For example, no actions on a form can be carried out while
Microsoft Office Access is repainting a control or calculating an expression.@Carry
out the action later.@1@@1
You can't carry out this action at the present time.@You tried to run a macro or
used the DoCmd object in Visual Basic to carry out an action. However, Microsoft
Access is performing another activity that prevents this action from being carried
out now.For example, no actions on a form can be carried out while Microsoft
Access is repainting a control or calculating an expression.@Carry out the action
later.@1@@1
The Object Type argument for the action or method is blank or invalid.@* For a
Close, GoToRecord, SearchForRecord or RepaintObject action, enter values for both
arguments, or leave both blank to perform the action on the active object.* For a
DeleteObject, Rename, or CopyObject action, enter values for both arguments, or
leave both blank to perform the action on the object currently selected in the
Navigation Pane.* For a SendObject or OutputTo action, enter values for both
arguments, or leave the Object Name argument blank if you want the action
performed on the active object of the specified object type.* If you're using a
method with the DoCmd object, use an intrinsic constant that equates to a valid
object type or the corresponding numeric value for the argument
name.@@1@1@12276@1
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Access

2487

2003

The Object Type argument for the action or method is blank or invalid.@* For a
Close, GoToRecord, or RepaintObject action, enter values for both arguments, or
leave both blank to perform the action on the active object.* For a DeleteObject,
Rename, or CopyObject action, enter values for both arguments, or leave both
blank to perform the action on the object currently selected in the Database
window.* For a SendObject or OutputTo action, enter values for both arguments,
or leave the Object Name argument blank if you want the action performed on the
active object of the specified object type.* If you're using a method with the
DoCmd object, use an intrinsic constant that equates to a valid object type or the
corresponding numeric value for the argument name.@@1@612276@1

2488

2007

You can't use the ApplyFilter action on this window.@* You tried to use the
ApplyFilter action or method, but you didn't apply the filter to a table, query, form,
or report.* You may have applied the filter to a form, but the form wasn't open in
Form or Datasheet view.* You may have applied the filter to a report but didn't
use the ApplyFilter action in a macro specified by the OnOpen property
setting.@Use the SelectObject action or method to select the table, query, form, or
report before applying the filter.@1@1@3041@1
You can't use the ApplyFilter action on this window.@* You tried to use the
ApplyFilter action or method, but you didn't apply the filter to a table, query, form,
or report.* You may have applied the filter to a form, but the form wasn't open in
Form or Datasheet view.* You may have applied the filter to a report but didn't
use the ApplyFilter action in a macro specified by the OnOpen property
setting.@Use the SelectObject action or method to select the table, query, form, or
report before applying the filter.@1@603041@1

2003

2489

2007

2003

2491

2007

2003

Error Description

The object '|' isn't open.@* The macro you are running (directly or indirectly)
contains a GoToRecord, RepaintObject, or SelectObject action, but the Object Name
argument names an object that is closed.* The objectname argument for the
GoToRecord, RepaintObject, or SelectObject method names an object that is
closed.@Use one of the Open actions or methods to open the object so that you can
carry out the desired action.@1@@@1
The object '|' isn't open.@* The macro you are running (directly or indirectly)
contains a GoToRecord, RepaintObject, or SelectObject action, but the Object Name
argument names an object that is closed.* The objectname argument for the
GoToRecord, RepaintObject, or SelectObject method names an object that is
closed.@Use one of the Open actions or methods to open the object so that you can
carry out the desired action.@1@@1
The action or method is invalid because the form or report isn't bound to a table or
query.@You tried to use the ApplyFilter or SearchForRecord action or method.
However, the form or report you applied the filter to is not based on a table or
query, so the form or report doesn't have any records to apply a filter to.@Use the
SelectObject action or method to select the desired form or report before you run
the ApplyFilter action.To base a form or report on a table or query, open the form
or report in Design view, and enter the table or query name in the RecordSource
property.@1@1@3041@1
The action or method is invalid because the form or report isn't bound to a table or
query.@You tried to use the ApplyFilter action or method. However, the form or
report you applied the filter to is not based on a table or query, so the form or
report doesn't have any records to apply a filter to.@Use the SelectObject action or
method to select the desired form or report before you run the ApplyFilter
action.To base a form or report on a table or query, open the form or report in
Design view, and enter the table or query name in the RecordSource
property.@1@603041@1
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Access

2492

2007

2003

2002

Error Description
Microsoft Office Access can't find the macro '|2' in the macro group '|1.'@You used
the macrogroupname.macroname syntax to specify a macro. You then tried to run
the macro (directly or indirectly), or you used the RunMacro method to run the
macro. However, the macro you specified isn't in this macro group.@Create the
macro in the macro group, specify the correct macro group, or specify the correct
macro name.@1@1@11313@1
Microsoft Office Access can't find the macro '|2' in the macro group '|1.'@You used
the macrogroupname.macroname syntax to specify a macro. You then tried to run
the macro (directly or indirectly), or you used the RunMacro method to run the
macro. However, the macro you specified isn't in this macro group.@Create the
macro in the macro group, specify the correct macro group, or specify the correct
macro name.@1@611313@1
Microsoft Access can't find the macro '|2' in the macro group '|1.'@You used the
macrogroupname.macroname syntax to specify a macro. You then tried to run the
macro (directly or indirectly), or you used the RunMacro method to run the macro.
However, the macro you specified isn't in this macro group.@Create the macro in
the macro group, specify the correct macro group, or specify the correct macro
name.@1@611313@1

2493

2007
2003

This action requires an Object Name argument.@@@1@@@1
This action requires an Object Name argument.@@@1@@1

2494

2007

The action or method requires a Form Name argument.@You tried to use the
OpenForm action or method, but you left the Form Name argument blank.@In the
Form Name argument, enter the name of a form in the current
database.@1@1@11313@1
The action or method requires a Form Name argument.@You tried to use the
OpenForm action or method, but you left the Form Name argument blank.@In the
Form Name argument, enter the name of a form in the current
database.@1@611313@1

2003

2495

2007

2003

2496

2007

2003

2497

2007

2003

2498

2007

The action or method requires a Table Name argument.@You tried to use the
OpenTable, TransferSpreadsheet, or TransferText action or method, but you left the
Table Name argument blank.@In the Table Name argument, enter the name of a
table that is in the current database.@1@@@1
The action or method requires a Table Name argument.@You tried to use the
OpenTable, TransferSpreadsheet, or TransferText action or method, but you left the
Table Name argument blank.@In the Table Name argument, enter the name of a
table that is in the current database.@1@@1
The action or method requires a Query Name argument.@You tried to use the
OpenQuery action or method, but you left the Query Name argument blank.@In the
Query Name argument, enter a query name.@1@@@1
The action or method requires a Query Name argument.@You tried to use the
OpenQuery action or method, but you left the Query Name argument blank.@In the
Query Name argument, enter a query name.@1@@1
The action or method requires a Report Name argument.@You tried to
OpenReport action or method, but you left the Report Name argument
the Report Name argument, enter the name of a report.@1@@@1
The action or method requires a Report Name argument.@You tried to
OpenReport action or method, but you left the Report Name argument
the Report Name argument, enter the name of a report.@1@@1

use the
blank.@In
use the
blank.@In

An expression you entered is the wrong data type for one of the arguments.@You
tried to run a macro or use a method to carry out an action, but an expression
evaluated to the wrong data type.For example, for the Close method you specified
a string for the Object Type argument, but this argument can be set only to certain
intrinsic constants or their numeric equivalents.@@1@@@1
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Access

2498

2003

An expression you entered is the wrong data type for one of the arguments.@You
tried to run a macro or use a method to carry out an action, but an expression
evaluated to the wrong data type.For example, for the Close method you specified
a string for the Object Type argument, but this argument can be set only to certain
intrinsic constants or their numeric equivalents.@@1@@1

2499

2007

You can't use the GoToRecord or SearchForRecord action or method on an object in
Design view.@Try one of the following:* Switch to Form or Datasheet view for a
form.* Switch to Datasheet view for a query or table.* If you are running a
macro or Visual Basic procedure containing an action that opens the object, set the
View argument to the correct view before you carry out the GoToRecord
action.@@2@1@3018@1
You can't use the GoToRecord action or method on an object in Design view.@Try
one of the following:* Switch to Form or Datasheet view for a form.* Switch to
Datasheet view for a query or table.* If you are running a macro or Visual Basic
procedure containing an action that opens the object, set the View argument to the
correct view before you carry out the GoToRecord action.@@2@603018@1

2003

2500

2007

2003

2501

2007

2003

2502

2007

2003

2002

2503

2007

Error Description

You must enter a number greater than zero for a Repeat Count argument.@You
tried to use the RunMacro action or method, but you entered a value less than zero
(or an expression that evaluates to less than zero) in the Repeat Count
argument.@To run the macro once, leave this argument blank.@1@@@1
You must enter a number greater than zero for a Repeat Count argument.@You
tried to use the RunMacro action or method, but you entered a value less than zero
(or an expression that evaluates to less than zero) in the Repeat Count
argument.@To run the macro once, leave this argument blank.@1@@1

The | action was canceled.@You used a method of the DoCmd object to carry out
an action in Visual Basic, but then clicked Cancel in a dialog box.For example, you
used the Close method to close a changed form, then clicked Cancel in the dialog
box that asks if you want to save the changes you made to the form.@@1@@@1
The | action was canceled.@You used a method of the DoCmd object to carry out
an action in Visual Basic, but then clicked Cancel in a dialog box.For example, you
used the Close method to close a changed form, then clicked Cancel in the dialog
box that asks if you want to save the changes you made to the form.@@1@@1
The action or method requires a Macro Name argument.@* You tried to use the
RunMacro action or method, but you left the Macro Name argument blank.*
Microsoft Office Access tried to create a custom menu bar for a form or report, but
the Menu Macro Name argument of the AddMenu action is blank.@In the Menu
Macro Name argument, enter the name of a macro or macro group that is in the
current database.@1@@@1
The action or method requires a Macro Name argument.@* You tried to use the
RunMacro action or method, but you left the Macro Name argument blank.*
Microsoft Office Access tried to create a custom menu bar for a form or report, but
the Menu Macro Name argument of the AddMenu action is blank.@In the Menu
Macro Name argument, enter the name of a macro or macro group that is in the
current database.@1@@1
The action or method requires a Macro Name argument.@* You tried to use the
RunMacro action or method, but you left the Macro Name argument blank.*
Microsoft Access tried to create a custom menu bar for a form or report, but the
Menu Macro Name argument of the AddMenu action is blank.@In the Menu Macro
Name argument, enter the name of a macro or macro group that is in the current
database.@1@@1
You can't use this action with the DoCmd object.@For a list of the actions that the
DoCmd object doesn't support and some alternatives to using these actions, click
Help.Any actions that aren't in this list can be used with the DoCmd
object.@@2@1@11313@1
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Access

2503

2003

You can't use this action with the DoCmd object.@For a list of the actions that the
DoCmd object doesn't support and some alternatives to using these actions, click
Help.Any actions that aren't in this list can be used with the DoCmd
object.@@2@611313@1

2504

2007

The action or method requires at least | argument(s).@You tried to run a macro
containing an action or used a method or action with the DoCmd object, but you
didn't set the required number of arguments.For example, if you use the
MoveSize action, you must set at least one of the four
arguments.@@1@1@11313@1
The action or method requires at least | argument(s).@You tried to run a macro
containing an action or used a method or action with the DoCmd object, but you
didn't set the required number of arguments.For example, if you use the
MoveSize action, you must set at least one of the four arguments.@@1@611313@1

2003

2505

2007

2003

2506

2007

2003

2507

2007

2003

2508

2007

2003

Error Description

An expression in argument | has an invalid value.@You tried to run a macro or used
the DoCmd object in Visual Basic. The argument number above is the position of
the argument as it appears in the Macro window, the Action Failed dialog box, or
the Object Browser (if you're using the DoCmd object).@Try one of the
following:* Select a setting from the drop-down list box in each argument.* Use
an intrinsic constant equating to a valid object type.* Substitute the correct
corresponding expression.@1@1@11895@1
An expression in argument | has an invalid value.@You tried to run a macro or used
the DoCmd object in Visual Basic. The argument number above is the position of
the argument as it appears in the Macro window, the Action Failed dialog box, or
the Object Browser (if you're using the DoCmd object).@Try one of the
following:* Select a setting from the drop-down list box in each argument.* Use
an intrinsic constant equating to a valid object type.* Substitute the correct
corresponding expression.@1@611895@1
A value you entered for the Transfer Type argument is invalid.@An expression in
the Transfer Type argument doesn't evaluate to a valid numeric value.@Valid values
for the Transfer Type argument are as follows:* 0, 1, and 2 for the
TransferDatabase action.* 0, 1, and 2 for the TransferSpreadsheet action.* 0
through 6 for the TransferText action.@1@1@11313@1
A value you entered for the Transfer Type argument is invalid.@An expression in
the Transfer Type argument doesn't evaluate to a valid numeric value.@Valid values
for the Transfer Type argument are as follows:* 0, 1, and 2 for the
TransferDatabase action.* 0, 1, and 2 for the TransferSpreadsheet action.* 0
through 6 for the TransferText action.@1@611313@1
The | type isn't an installed database type or doesn't support the operation you
chose.@You used the TransferDatabase method, but an expression in the
databasetype argument doesn't evaluate to a valid database type for importing,
exporting, or linking.For information on valid database types, click
Help.@@2@1@4780@1
The | type isn't an installed database type or doesn't support the operation you
chose.@You used the TransferDatabase method, but an expression in the
databasetype argument doesn't evaluate to a valid database type for importing,
exporting, or linking.For information on valid database types, click
Help.@@2@604780@1
A value you entered for the spreadsheettype argument is invalid.@You used the
TransferSpreadsheet method, and an expression in the spreadsheettype argument
doesn't evaluate to a valid numeric value.@Valid values are 0, 2, 3, 4, 5, 6, 7, and
8. Note that 1 is an invalid value; you can't import or export to a Lotus .wks format
file.@1@1@4781@1
A value you entered for the spreadsheettype argument is invalid.@You used the
TransferSpreadsheet method, and an expression in the spreadsheettype argument
doesn't evaluate to a valid numeric value.@Valid values are 0, 2, 3, 4, 5, 6, 7, and
8. Note that 1 is an invalid value; you can't import or export to a Lotus .wks format
file.@1@604781@1
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Access

2509

2007
2003

2510

2007

2003

2002

2511

2007

2003

2512

2007

2003

2002

2513

2007

2003
2002
2514

2007

2003

2515

2007

2003

Error Description
The setting for the Range argument can't be longer than 255
characters.@@@1@1@4781@1
The setting for the Range argument can't be longer than 255
characters.@@@1@604781@1
The expression you entered in the Specification Name argument exceeds the 64character limit.@Select one of the existing specification names from the argument
list box when you use the TransferText action in a macro, or enter a name in Visual
Basic that follows Microsoft Office Access object-naming rules.@@2@1@11734@1
The expression you entered in the Specification Name argument exceeds the 64character limit.@Select one of the existing specification names from the argument
list box when you use the TransferText action in a macro, or enter a name in Visual
Basic that follows Microsoft Office Access object-naming rules.@@2@611734@1
The expression you entered in the Specification Name argument exceeds the 64character limit.@Select one of the existing specification names from the argument
list box when you use the TransferText action in a macro, or enter a name in Visual
Basic that follows Microsoft Access object-naming rules.@@2@611734@1

The action or method requires a Specification Name argument.@You tried to use
the TransferText action or method and you specified a Transfer Type argument but
left the Specification Name argument blank.@In the Specification Name argument,
enter an existing specification name from the argument list box.@1@1@11313@1
The action or method requires a Specification Name argument.@You tried to use
the TransferText action or method and you specified a Transfer Type argument but
left the Specification Name argument blank.@In the Specification Name argument,
enter an existing specification name from the argument list box.@1@611313@1
Microsoft Office Access can't parse the expression: '|'.@Click OK to return to the
action argument or conditional expression where this expression appears, and then
correct the syntax.@@1@@@1
Microsoft Office Access can't parse the expression: '|'.@Click OK to return to the
action argument or conditional expression where this expression appears, and then
correct the syntax.@@1@@1
Microsoft Access can't parse the expression: '|'.@Click OK to return to the action
argument or conditional expression where this expression appears, and then correct
the syntax.@@1@@1
The Macro Name argument can't be longer than 64 characters according to
Microsoft Office Access object-naming rules.@@@1@1@11734@1
The Macro Name argument can't be longer than 64 characters according to
Microsoft Office Access object-naming rules.@@@1@411734@1
The Macro Name argument can't be longer than 64 characters according to
Microsoft Access object-naming rules.@@@1@411734@1

The action or method requires a Control Name argument.@You tried to use
GoToControl action or method, but you left the control name blank.@In the
Name argument, enter a control or field name from the active form or
datasheet.@1@1@11313@1
The action or method requires a Control Name argument.@You tried to use
GoToControl action or method, but you left the control name blank.@In the
Name argument, enter a control or field name from the active form or
datasheet.@1@611313@1

the
Control

the
Control

Microsoft Office Access can't open the macro '|' because it was saved using a
different version of Microsoft Office Access.@Re-create the macro in the current
version of Microsoft Office Access.@@1@@@1
Microsoft Office Access can't open the macro '|' because it was saved using a
different version of Microsoft Office Access.@Re-create the macro in the current
version of Microsoft Office Access.@@1@@1
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Access

2515

2002

Microsoft Access can't open the macro '|' because it was saved using a different
version of Microsoft Access.@Re-create the macro in the current version of Microsoft
Access.@@1@@1

2516

2007

Microsoft Office Access can't find the module '|.'@You tried to use the OpenModule
action or method, but Microsoft Office Access can't find the module you specified in
the Module Name argument.@Enter a valid module name from the current
database.@1@@@1
Microsoft Office Access can't find the module '|.'@You tried to use the OpenModule
action or method, but Microsoft Office Access can't find the module you specified in
the Module Name argument.@Enter a valid module name from the current
database.@1@@1
Microsoft Access can't find the module '|.'@You tried to use the OpenModule action
or method, but Microsoft Access can't find the module you specified in the Module
Name argument.@Enter a valid module name from the current database.@1@@1

2003

2002

2517

2007

2003

2002

2519

2520

2007
2003

2007

2003

2521

2007

2003

2522

2007

2003

2523

2007

Error Description

Microsoft Office Access can't find the procedure '|.'@* You may have used the Run
method in Visual Basic but entered an invalid procedure name, or you used the Run
method without first opening a database.* You tried to use the OpenModule
action or method, but you used an invalid procedure name.@@1@@@1
Microsoft Office Access can't find the procedure '|.'@* You may have used the Run
method in Visual Basic but entered an invalid procedure name, or you used the Run
method without first opening a database.* You tried to use the OpenModule
action or method, but you used an invalid procedure name.@@1@@1
Microsoft Access can't find the procedure '|.'@* You may have used the Run method
in Visual Basic but entered an invalid procedure name, or you used the Run method
without first opening a database.* You tried to use the OpenModule action or
method, but you used an invalid procedure name.@@1@@1
The database must be open for the SelectObject method to run.@You tried to run a
function in a library database, and the function contains the SelectObject
method.@@1@@1

The action or method requires a Module or Procedure Name argument.@You tried to
use the OpenModule action or method, but you didn't enter a name in either the
Module Name or the Procedure Name argument in the Macro window.@Enter a valid
name in one of these arguments.@1@@@1
The action or method requires a Module or Procedure Name argument.@You tried to
use the OpenModule action or method, but you didn't enter a name in either the
Module Name or the Procedure Name argument in the Macro window.@Enter a valid
name in one of these arguments.@1@@1
You have specified a Transfer Type that doesn't support the HTML Table Name
argument.@Leave the HTML Table Name argument blank unless you are using the
Import HTML or Link HTML Transfer Types.@@1@@@1
You have specified a Transfer Type that doesn't support the HTML Table Name
argument.@Leave the HTML Table Name argument blank unless you are using the
Import HTML or Link HTML Transfer Types.@@1@@1
The action or method requires a File Name argument.@You
TransferSpreadsheet or TransferText action or method.@In
argument, enter a file name.@1@1@11313@1
The action or method requires a File Name argument.@You
TransferSpreadsheet or TransferText action or method.@In
argument, enter a file name.@1@611313@1

tried to use the
the File Name

tried to use the
the File Name

The value you entered for the show argument is invalid.@You used the ShowToolbar
method.@Valid values for this argument are acToolbarYes, acToolbarWhereApprop,
and acToolbarNo, or the corresponding numeric values 0, 1, and 2.@1@1@12446@1
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Access

2523

2003

The value you entered for the show argument is invalid.@You used the ShowToolbar
method.@Valid values for this argument are acToolbarYes, acToolbarWhereApprop,
and acToolbarNo, or the corresponding numeric values 0, 1, and 2.@1@612446@1

2524

2007

Microsoft Office Access can't invoke the application using the RunApp action.@The
path to the application is invalid, or a component of the application is
missing.@Check the path in Windows Explorer or File Manager.@1@@@1
Microsoft Office Access can't invoke the application using the RunApp action.@The
path to the application is invalid, or a component of the application is
missing.@Check the path in Windows Explorer or File Manager.@1@@1
Microsoft Access can't invoke the application using the RunApp action.@The path to
the application is invalid, or a component of the application is missing.@Check the
path in Windows Explorer or File Manager.@1@@1

2003

2002

2525

2007

2003

2526

2007

2003

2002

2527

2007
2003
2002

2528

2007
2003

Error Description

A macro can call itself a maximum of 20 times.@Your macro contains a RunMacro
action that calls the same macro more than 20 times.@Use a condition to stop the
macro after it has been run 20 times, or call another macro with the RunMacro
action.@1@@@1
A macro can call itself a maximum of 20 times.@Your macro contains a RunMacro
action that calls the same macro more than 20 times.@Use a condition to stop the
macro after it has been run 20 times, or call another macro with the RunMacro
action.@1@@1
The SendKeys action requires the Microsoft Office Access Utility Add-in to be
loaded.@Rerun Microsoft Office Access or Microsoft Office Setup to reinstall
Microsoft Office Access and the Microsoft Office Access Utility Addin.@@1@@185309@1
The SendKeys action requires the Microsoft Office Access Utility Add-in to be
loaded.@Rerun Microsoft Office Access or Microsoft Office Setup to reinstall
Microsoft Office Access and the Microsoft Office Access Utility Add-in.@@1@@1
The SendKeys action requires the Microsoft Access Utility Add-in to be
loaded.@Rerun Microsoft Access or Microsoft Office Setup to reinstall Microsoft
Access and the Microsoft Access Utility Add-in.@@1@@1
Lotus .wks file formats aren't supported in the current version
Access.@Convert your .wks file to a more recent format, such
Lotus .wks file formats aren't supported in the current version
Access.@Convert your .wks file to a more recent format, such
Lotus .wks file formats aren't supported in the current version
Access.@Convert your .wks file to a more recent format, such

of Microsoft Office
as .wk1.@@1@@@1
of Microsoft Office
as .wk1.@@1@@1
of Microsoft
as .wk1.@@1@@1

The RunCommand macro action argument is missing, or you entered an invalid
command ID for the RunCommand method.@@@1@@@1
The RunCommand macro action argument is missing, or you entered an invalid
command ID for the RunCommand method.@@@1@@1

2529

2007
2003

The Toolbar argument can't be longer than 64 characters.@@@1@@@1
The Toolbar argument can't be longer than 64 characters.@@@1@@1

2530

2007

The SelectObject method can't be used on a report that is currently
printing.@@@1@@@1
The SelectObject method can't be used on a report that is currently
printing.@@@1@@1

2003
2531

2007
2003
2002

Your HTML file does not contain any tabular data that Microsoft Office Access can
import.@.@@1@@@1
Your HTML file does not contain any tabular data that Microsoft Office Access can
import.@.@@1@@1
Your HTML file does not contain any tabular data that Microsoft Access can
import.@.@@1@@1
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Access

2532

2007

2003

2002

2533

2007

2003

2534

2007

2003

2535

2007

2003

2536

2007
2003

Error Description
Microsoft Office Access can't find the macro or sub procedure '|.'@The specified
macro, macro group, or sub procedure doesn't exist.@Note that when you enter
the macrogroupname.macroname syntax in an argument, you must specify the
name the macro's macro group was last saved under. Also, ensure that the
referenced macro has been saved, or that the referenced sub procedure expects 0
arguments.@1@@@1
Microsoft Office Access can't find the macro or sub procedure '|.'@The specified
macro, macro group, or sub procedure doesn't exist.@Note that when you enter
the macrogroupname.macroname syntax in an argument, you must specify the
name the macro's macro group was last saved under. Also, ensure that the
referenced macro has been saved, or that the referenced sub procedure expects 0
arguments.@1@@1
Microsoft Access can't find the macro or sub procedure '|.'@The specified macro,
macro group, or sub procedure doesn't exist.@Note that when you enter the
macrogroupname.macroname syntax in an argument, you must specify the name
the macro's macro group was last saved under. Also, ensure that the referenced
macro has been saved, or that the referenced sub procedure expects 0
arguments.@1@@1
The ApplyFilter action requires that either the Filter Name or Where Condition
argument is set.@You tried to run a macro containing an ApplyFilter action, but you
didn't set the required arguments.@@1@1@11313@1
The ApplyFilter action requires that either the Filter Name or Where Condition
argument is set.@You tried to run a macro containing an ApplyFilter action, but you
didn't set the required arguments.@@1@611313@1
The action or method requires a data access page Name argument.@You tried to
use the OpenDataAccessPage action or method, but you left the data access page
Name argument blank.@In the data access page Name argument, enter the name
of a data access page in the current database.@1@1@11313@1
The action or method requires a data access page Name argument.@You tried to
use the OpenDataAccessPage action or method, but you left the data access page
Name argument blank.@In the data access page Name argument, enter the name
of a data access page in the current database.@1@611313@1

The ApplyFilter action contains a Filter Name that cannot be applied.@The filter
name is not a valid argument in the ApplyFilter action in Client
Server.@@1@1@11313@1
The ApplyFilter action contains a Filter Name that cannot be applied.@The filter
name is not a valid argument in the ApplyFilter action in Client
Server.@@1@611313@1
Macros are disabled in this database.@@@1@@1

2537

2007

The feature '|' is not available while the database is opened in disabled
mode.@@@1@@@1

2538

2007

The '|' macro action cannot be run in disabled mode.@@@1@@@1

2540

2007

The file '|' you tried to replace is a Microsoft Office Access system file that is in use
and can't be replaced or deleted.@@@1@@@1
The file '|' you tried to replace is a Microsoft Office Access system file that is in use
and can't be replaced or deleted.@@@1@@1
The file '|' you tried to replace is a Microsoft Access system file that is in use and
can't be replaced or deleted.@@@1@@1

2003
2002
2541

2007

The contents of the Clipboard have been deleted and can't be pasted.@Some
applications do not put large objects on the Clipboard. Instead, they put a pointer
to the object on the Clipboard. The pointer may vanish before the paste
happens.@@1@@@1
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Access

2541

2003

The contents of the Clipboard have been deleted and can't be pasted.@Some
applications do not put large objects on the Clipboard. Instead, they put a pointer
to the object on the Clipboard. The pointer may vanish before the paste
happens.@@1@@1

2542

2007

Specify the database name in the command line so that Microsoft Office Access can
find the macro.@@@1@@@1
Specify the database name in the command line so that Microsoft Office Access can
find the macro.@@@1@@1
Specify the database name in the command line so that Microsoft Access can find
the macro.@@@1@@1

2003
2002

2543

2007
2003

2544

2007
2003

2002

2545

2007

2003

2546

2007
2003

2547

2007
2003

2548

2007

2003

2002

Error Description

You can't paste a database object onto itself.@@@1@@@1
You can't paste a database object onto itself.@@@1@@1
Microsoft Office Access can't find the | you referenced in the Object Name
argument.@The macro you tried to run includes a SelectObject action with an
invalid name for the Object Name argument.@In the Database window, verify the
name of the object you want the macro to select. Then open the macro in the Macro
window and enter the correct name for the Object Name argument.@2@603041@1
Microsoft Access can't find the | you referenced in the Object Name argument.@The
macro you tried to run includes a SelectObject action with an invalid name for the
Object Name argument.@In the Database window, verify the name of the object
you want the macro to select. Then open the macro in the Macro window and enter
the correct name for the Object Name argument.@2@603041@1
The CopyObject action requires you to specify a different destination database or a
new name to copy from the current database.@The macro you are running includes
a CopyObject action.@Open the macro in the Macro window, and select the
CopyObject action. Enter a destination database or a new name in the appropriate
argument box.@1@1@3009@1
The CopyObject action requires you to specify a different destination database or a
new name to copy from the current database.@The macro you are running includes
a CopyObject action.@Open the macro in the Macro window, and select the
CopyObject action. Enter a destination database or a new name in the appropriate
argument box.@1@603009@1

Select a database object in the Navigation Pane before you run the macro
containing the | action.@@@2@1@3009@1
Select a database object in the Database window before you run the macro
containing the | action.@@@2@603009@1
The database '|' you tried to delete and replace is read-only and can't be deleted or
replaced.@Enter a different name for the new database.@@1@@@1
The database '|' you tried to delete and replace is read-only and can't be deleted or
replaced.@Enter a different name for the new database.@@1@@1
Microsoft Office Access can't run the Security Wizard because this database is open
in exclusive mode.@Do you want Microsoft Office Access to open the database in
shared mode and run the Security Wizard?@@19@@@2
Microsoft Office Access can't run the Security Wizard because this database is open
in exclusive mode.@Do you want Microsoft Office Access to open the database in
shared mode and run the Security Wizard?@@19@@2
Microsoft Access can't run the Security Wizard because this database is open in
exclusive mode.@Do you want Microsoft Access to open the database in shared
mode and run the Security Wizard?@@19@@2
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Access

2549

2007

2003

2002

2550

2007

2003

2002

2551

2007

2003

Error Description
Microsoft Office Access can't delete |1 after compacting it. The compacted database
has been named |2.@If you compact a database using the same name, Microsoft
Office Access creates a new compacted database and then deletes the original
database.In this case, however, the original database wasn't deleted because it is
read-only.@If you can, remove the read-only status, delete the original database,
and then rename the new database using the original name.If you can't remove
the read-only status, inform your workgroup administrator.@1@1@10299@1
Microsoft Office Access can't delete |1 after compacting it. The compacted database
has been named |2.@If you compact a database using the same name, Microsoft
Office Access creates a new compacted database and then deletes the original
database.In this case, however, the original database wasn't deleted because it is
read-only.@If you can, remove the read-only status, delete the original database,
and then rename the new database using the original name.If you can't remove
the read-only status, inform your workgroup administrator.@1@310299@1
Microsoft Access can't delete |1 after compacting it. The compacted database has
been named |2.@If you compact a database using the same name, Microsoft
Access creates a new compacted database and then deletes the original
database.In this case, however, the original database wasn't deleted because it is
read-only.@If you can, remove the read-only status, delete the original database,
and then rename the new database using the original name.If you can't remove
the read-only status, inform your workgroup administrator.@1@310299@1

Microsoft Office Access can't delete |1 after encoding it. The encoded database has
been named |2.@If you encode a database using the same name, Microsoft Office
Access creates a new encoded database, and then deletes the original
database.In this case, however, the original database can't be deleted because it
is read-only.@If you can, remove the read-only status, delete the original database,
and then rename the new database using the original name.If you can't remove
the read-only status, inform your workgroup administrator.@1@1@10299@1
Microsoft Office Access can't delete |1 after encoding it. The encoded database has
been named |2.@If you encode a database using the same name, Microsoft Office
Access creates a new encoded database, and then deletes the original
database.In this case, however, the original database can't be deleted because it
is read-only.@If you can, remove the read-only status, delete the original database,
and then rename the new database using the original name.If you can't remove
the read-only status, inform your workgroup administrator.@1@310299@1
Microsoft Access can't delete |1 after encrypting it. The encrypted database has
been named |2.@If you encrypt a database using the same name, Microsoft Access
creates a new encrypted database, and then deletes the original database.In this
case, however, the original database can't be deleted because it is read-only.@If
you can, remove the read-only status, delete the original database, and then
rename the new database using the original name.If you can't remove the readonly status, inform your workgroup administrator.@1@310299@1
Microsoft Office Access can't delete |1 after decoding it. The decoded database has
been named |2.@If you decode a database using the same name, Microsoft Office
Access creates a new decoded database, and then deletes the original
database.In this case, however, the original database can't be deleted because it
is read-only.@If you can, remove the read-only status, delete the original database,
and then rename the new database using the original name.If you can't remove
the read-only status, inform your workgroup administrator.@1@1@10299@1
Microsoft Office Access can't delete |1 after decoding it. The decoded database has
been named |2.@If you decode a database using the same name, Microsoft Office
Access creates a new decoded database, and then deletes the original
database.In this case, however, the original database can't be deleted because it
is read-only.@If you can, remove the read-only status, delete the original database,
and then rename the new database using the original name.If you can't remove
the read-only status, inform your workgroup administrator.@1@310299@1

Copyright (c) 2008 FMS, Inc.

fmsinc.com

Page 64 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

2551

2002

Microsoft Access can't delete |1 after decrypting it. The decrypted database has
been named |2.@If you decrypt a database using the same name, Microsoft Access
creates a new decrypted database, and then deletes the original database.In this
case, however, the original database can't be deleted because it is read-only.@If
you can, remove the read-only status, delete the original database, and then
rename the new database using the original name.If you can't remove the readonly status, inform your workgroup administrator.@1@310299@1

2552

2007

You can't encode a database that you didn't create or don't own.@See the owner of
the database or your workgroup administrator.@@1@@@1
You can't encode a database that you didn't create or don't own.@See the owner of
the database or your workgroup administrator.@@1@@1
You can't encrypt a database that you didn't create or don't own.@See the owner of
the database or your workgroup administrator.@@1@@1

2003
2002
2553

2007
2003
2002

2554

2007

2003

2556

2007

2003

2002

2557

2007
2003
2002
2000

2558

2559

2007
2000

2007

2003

2002

Error Description

You can't decode a database that you didn't create or don't own.@See the owner of
the database or your workgroup administrator.@@1@@@1
You can't decode a database that you didn't create or don't own.@See the owner of
the database or your workgroup administrator.@@1@@1
You can't decrypt a database that you didn't create or don't own.@See the owner of
the database or your workgroup administrator.@@1@@1
Can't find the database you specified, or you didn't specify a database at
all.@Specify a valid database name in the command line, and include a path if
necessary.@@1@1@10283@1
Can't find the database you specified, or you didn't specify a database at
all.@Specify a valid database name in the command line, and include a path if
necessary.@@1@110283@1
Microsoft Office Access can't run the Security Wizard because the database uses a
password.@Remove the database password by clicking Unset Database Password in
the Database Tools group on the Database Tools tab.@@1@@@1
Microsoft Office Access can't run the Security Wizard because the database has had
a password set on it.@You will have to unset the database password by choosing
Tools|Security|Unset Database Password.@@1@@1
Microsoft Access can't run the Security Wizard because the database has had a
password set on it.@You will have to unset the database password by choosing
Tools|Security|Unset Database Password.@@1@@1
The database you tried to convert was either created in or was already
the requested version of Microsoft Office Access.@@@1@@@1
The database you tried to convert was either created in or was already
the requested version of Microsoft Office Access.@@@1@@1
The database you tried to convert was either created in or was already
the requested version of Microsoft Access.@@@1@@1
The database you tried to convert was either created in or was already
the current version of Microsoft Access.@@@1@@1

converted to
converted to
converted to
converted to

@@@1@209029@3
Microsoft Office Access was unable to refresh the linked table '|1' in database '|2'
during conversion. Try to refresh the links manually by using the Linked Table
Manager command in the Database Tools group on the Database Tools tab.
Microsoft Office Access was unable to refresh the linked table '|1' in database '|2'
during conversion. Try and refresh the links manually by using the Linked Table
Manager (Tools menu, Database Utilities submenu)..
Microsoft Access was unable to refresh the linked table '|1' in database '|2' during
conversion. Try and refresh the links manually by using the Linked Table Manager
(Tools menu, Database Utilities submenu)..
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Access

2559

2000

Microsoft Access was unable to refresh the linked tables '|' during the
conversion.@Refresh the links manually by using the Linked Table Manager (Tools
menu, Add-ins submenu).@@2@209191@1

2560

2007
2003
2002

Microsoft Office Access is unable to load the Database Properties.@@@1@@@3
Microsoft Office Access is unable to load the Database Properties.@@@1@@3
Microsoft Access is unable to load the Database Properties.@@@1@@3

2561

2007
2003
2002

Microsoft Office Access can't display the Database Properties dialog
box.@@@1@@@1
Microsoft Office Access can't display the Database Properties dialog box.@@@1@@1
Microsoft Access can't display the Database Properties dialog box.@@@1@@1

2562

2007
2003
2002

Microsoft Office Access is unable to save the Database Properties.@@@1@@@1
Microsoft Office Access is unable to save the Database Properties.@@@1@@1
Microsoft Access is unable to save the Database Properties.@@@1@@1

2563

2007
2003

2002

2564

2007
2003

2565

2007
2003

2566

2007

2003

2002

2567

2007

2003

2002

Error Description

Microsoft Office Access can't load a dynamic-link library.@Run Setup to reinstall
Microsoft Office Access. If you want to preserve your security or custom settings,
back up the Microsoft Office Access workgroup information file. For information on
backing up files, search the Microsoft Windows Help index for 'backing up
files'.@@1@@3
Microsoft Access can't load a dynamic-link library.@Run Setup to reinstall Microsoft
Access. If you want to preserve your security or custom settings, back up the
Microsoft Access workgroup information file. For information on backing up files,
search the Microsoft Windows Help index for 'backing up files'.@@1@@3

You
and
You
and

can't hide the document '|' while it is open.@Close the database object first,
then hide it.@@1@@@1
can't hide the document '|' while it is open.@Close the database object first,
then hide it.@@1@@1

You can't unhide the database object '|' while it is open.@Close the database object
first, and then unhide it.@@1@@@1
You can't unhide the database object '|' while it is open.@Close the database object
first, and then unhide it.@@1@@1
Microsoft Office Access is unable to set the application's icon to the file '|'.@Make
sure the file is a valid icon (.ico) file. If you're using Microsoft Windows, you can also
use .bmp files.@@1@@@1
Microsoft Office Access is unable to set the application's icon to the file '|'.@Make
sure the file is a valid icon (.ico) file. If you're using Microsoft Windows, you can also
use .bmp files.@@1@@1
Microsoft Access is unable to set the application's icon to the file '|'.@Make sure the
file is a valid icon (.ico) file. If you're using Microsoft Windows, you can also use
.bmp files.@@1@@1

Microsoft Office Access can't open or convert this previous version database.@The
database was created in an earlier version of Microsoft Office Access. You don't
have appropriate security permissions to open or convert databases created in
earlier versions.@@1@@@1
Microsoft Office Access can't open or convert this previous version database.@The
database was created in an earlier version of Microsoft Office Access. You don't
have appropriate security permissions to open or convert databases created in
earlier versions.@@1@@1
Microsoft Access can't open or convert this previous version database.@The
database was created in an earlier version of Microsoft Access. You don't have
appropriate security permissions to open or convert databases created in earlier
versions.@@1@@1
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Access

2568

2007

2003

2002

2000
2569

2007
2003

2002

2570

2571

2007
2000

2007

2003

2002

2572

2007

Error Description
Microsoft Office Access can't undo this operation.@An object with the same name
already exists. Another user might have created an object named '|' after you had
performed this operation on an object with the same name.@@1@@@1
Microsoft Office Access can't undo this operation.@An object with the same name
already exists. Another user might have created an object named '|' after you had
performed this operation on an object with the same name.@@1@@1
Microsoft Access can't undo this operation.@An object with the same name already
exists. Another user might have created an object named '|' after you had
performed this operation on an object with the same name.@@1@@1
You can't undo this operation.@Another user has created an object with the name
'|'.@@1@@1
Microsoft Office Access can't delete |1 after enabling it. The enabled database has
been named |2.@If you enable a database using the same name, Microsoft Office
Access creates a new enabled database and then deletes the original database.In
this case, however, the original database wasn't deleted because it is read-only.@If
you can, remove the read-only status, delete the original database, and then
rename the new database using the original name.If you can't remove the readonly status, inform your workgroup administrator.@1@@1
Microsoft Access can't delete |1 after enabling it. The enabled database has been
named |2.@If you enable a database using the same name, Microsoft Access
creates a new enabled database and then deletes the original database.In this
case, however, the original database wasn't deleted because it is read-only.@If you
can, remove the read-only status, delete the original database, and then rename
the new database using the original name.If you can't remove the read-only
status, inform your workgroup administrator.@1@@1

@@@1@@3
You cannot modify objects created in an earlier version of Microsoft Office
Access.@To convert this database to the current version of Microsoft Office Access,
close the database, click the Microsoft Office Button, and then click
Convert.@@1@@@1
You can't modify objects created using an earlier version of Microsoft Office
Access.@To convert this database to the current version of Microsoft Office Access,
close the database, point to Database Utilities on the Tools menu, and then click
Convert Database.@@1@@1
You can't modify objects created using an earlier version of Microsoft Access.@To
convert this database to the current version of Microsoft Access, close the database,
point to Database Utilities on the Tools menu, and then click Convert
Database.@@1@@1
This database is in an unexpected state and Microsoft Office Access cannot open
it.@This database has been converted from a prior version of Microsoft Office
Access by using the DAO CompactDatabase method instead of the Convert
Database command (click the Microsoft Office Button and then click Convert).
Converting by using the DAO CompactDatabase method has left the database in a
partially converted state.@If you have a copy of the database in its original format,
click the Microsoft Office Button and then click Convert to convert it. If the original
database is no longer available, create a new database and import your tables and
queries to preserve your data and try again. Your other database objects cannot be
recovered.@1@@@1
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Access

2572

2003

2002

2573

2007

2003

2000

2574

2007

2003

2002

2575

2007
2003
2002

2576

2007

2003

Error Description
This database is in an unexpected state; Microsoft Office Access can't open it.@This
database has been converted from a prior version of Microsoft Office Access by
using the DAO CompactDatabase method instead of the Convert Database
command on the Tools menu (Database Utilities submenu). This has left the
database in a partially converted state.@If you have a copy of the database in its
original format, use the Convert Database command on the Tools menu (Database
Utilities submenu) to convert it. If the original database is no longer available,
create a new database and import your tables and queries to preserve your data.
Your other database objects can't be recovered.@1@@1
This database is in an unexpected state; Microsoft Access can't open it.@This
database has been converted from a prior version of Microsoft Access by using the
DAO CompactDatabase method instead of the Convert Database command on the
Tools menu (Database Utilities submenu). This has left the database in a partially
converted state.@If you have a copy of the database in its original format, use the
Convert Database command on the Tools menu (Database Utilities submenu) to
convert it. If the original database is no longer available, create a new database and
import your tables and queries to preserve your data. Your other database objects
can't be recovered.@1@@1
This database is a replica created in a different version of Access. @You can only
convert this replica by synchronizing with its Design Master. @Convert the Design
Master of this replica set then synchronize the replica with the Design
Master.@1@@@1
This database is a replica created in a different version of Access. @You can only
convert this replica by synchronizing with its Design Master. @Convert the Design
Master of this replica set then synchronize the replica with the Design
Master.@1@@1
This database is a replica from an earlier version of Microsoft Access. Microsoft
Access can't open it.@Replicas can't be converted except by their Design
Masters.@Convert the Design Master for this replica set to the current version of
Microsoft Access, and then synchronize the replica.@1@@1
You can't create another Microsoft Office Access database with the same name and
location as an existing database.@You carried out the Make MDE File command, but
tried to give the new database the same extension as the old one.@Accept the
default .mde extension for your new MDE database.@1@@@1
You can't create another Microsoft Office Access database with the same name and
location as an existing database.@You carried out the Make MDE File command, but
tried to give the new database the same extension as the old one.@Accept the
default .mde extension for your new MDE database.@1@@1
You can't create another Microsoft Access database with the same name and
location as an existing database.@You carried out the Make MDE File command, but
tried to give the new database the same extension as the old one.@Accept the
default .mde extension for your new MDE database.@1@@1
You can't create a Microsoft Office Access MDE database from a database
replica.@@@1@@@1
You can't create a Microsoft Office Access MDE database from a database
replica.@@@1@@1
You can't create a Microsoft Access MDE database from a database
replica.@@@1@@1

This database is a Microsoft Office Access 7.0/8.0/9.0 Design Master/Replica.@If
you click OK, the database you selected will be renamed to |1 and then converted
to |2. Everyone using a replica of this database will have to upgrade to Microsoft
Access 2000 after the next synchronization.@@4@@@2
This database is a Microsoft Office Access 7.0/8.0/9.0 Design Master/Replica.@If
you click OK, the database you selected will be renamed to |1 and then converted
to |2. Everyone using a replica of this database will have to upgrade to Microsoft
Access 2000 after the next synchronization.@@4@@2
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Access

2576

2002

2000

2577

2007
2003

2578

2007
2003
2002

2579

2007

2003

2580

2007

2003

2581

2007
2003

2582

2007

2003

2583

2007

Error Description
This database is a Microsoft Access 7.0/8.0/9.0 Design Master/Replica.@If you click
OK, the database you selected will be renamed to |1 and then converted to |2.
Everyone using a replica of this database will have to upgrade to Microsoft Access
2000 after the next synchronization.@@4@@2
This database is a Microsoft Access 7.0/8.0 Design Master/Replica.@If you click OK,
the database you selected will be renamed to |1 and then converted to |2.
Everyone using a replica of this database will have to upgrade to Microsoft Access
2000 after the next synchronization.@@4@@2
The database | is already open.@Close the database before carrying out the Make
MDE File command.@@1@@@1
The database | is already open.@Close the database before carrying out the Make
MDE File command.@@1@@1

Microsoft Office Access was unable to create the .accde, .mde, or .ade
file.@@@1@@@1
Microsoft Office Access was unable to create an MDE database.@@@1@@1
Microsoft Access was unable to create an MDE database.@@@1@@1
Local forms, reports, macros, and modules in this replica will not be converted. @To
retain these objects, please be sure to import them into the Design Master from the
original replica.@@1@@@1
Local forms, reports, macros, and modules in this replica will not be converted. @To
retain these objects, please be sure to import them into the Design Master from the
original replica.@@1@@1
The record source '|' specified on this form or report does not exist. @The name of
the recordsource may be misspelled, the recordsource was deleted or renamed, or
the recordsource exists in a different database.@In the Form or Report's Design
view, display the property sheet by clicking the Properties button, and then set the
RecordSource property to an existing table or query. @1@@@1
The record source '|' specified on this form or report does not exist. @You
misspelled the name, or it was deleted or renamed in the current database, or it
exists in a different database.@In the Form or Report's Design view, display the
property sheet by clicking the Properties button, and then set the RecordSource
property to an existing table or query. @1@@1
You must define a sort field or expression for the group header or footer in the
report you tried to preview or print.@@@1@1@8753@1
You must define a sort field or expression for the group header or footer in the
report you tried to preview or print.@@@1@208753@1
You cannot set the GroupInterval property to 0 when the GroupOn property is set to
Interval.@Click the Sorting and Grouping Design tab and try one of the
following:* Change the GroupInterval property setting to a number higher than
0.* Change the GroupOn property setting to Each Value.@@1@@@1
You can't set the GroupInterval property to zero when the GroupOn property is set
to Interval.@Click Sorting and Grouping on the View menu and try one of the
following:* Change the GroupInterval property setting to a number higher than
zero.* Change the GroupOn property setting to Each Value.@@1@@1
The ApplyFilter action or method can be carried out only from an Open macro or
Open event procedure.@* You may have tried to run a macro or procedure
containing the ApplyFilter action or method from a report property other than the
OnOpen property.* You may have tried to run a macro or event procedure on a
report that is already open.@To use the ApplyFilter action in a report, set the
OnOpen property to the name of the macro, close the report, and then reopen
it.@1@1@3004@1
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Access

2583

2003

The ApplyFilter action or method can be carried out only from an Open macro or
Open event procedure.@* You may have tried to run a macro or procedure
containing the ApplyFilter action or method from a report property other than the
OnOpen property.* You may have tried to run a macro or event procedure on a
report that is already open.@To use the ApplyFilter action in a report, set the
OnOpen property to the name of the macro, close the report, and then reopen
it.@1@603004@1

2584

2007

You can't use aggregate functions in a page header or footer.@The page header or
footer of the report you tried to preview contains a calculated control with an
aggregate function in its expression.@If you want to show the result of an
aggregate function in a page header or footer, create a hidden calculated control in
an appropriate section of the report. Then create an unbound text box in the page
header or footer.If you are running a macro, use the SetValue action to set the
unbound text box value to the value in the hidden control.@1@1@11839@1
You can't use aggregate functions in a page header or footer.@The page header or
footer of the report you tried to preview contains a calculated control with an
aggregate function in its expression.@If you want to show the result of an
aggregate function in a page header or footer, create a hidden calculated control in
an appropriate section of the report. Then create an unbound text box in the page
header or footer.If you are running a macro, use the SetValue action to set the
unbound text box value to the value in the hidden control.@1@411839@1

2003

2585

2007

2003

2586

2007

2003

2002

2587

2007

Error Description

This action can't be carried out while processing a form or report event.@A macro
specified as the OnOpen, OnLoad, OnClose, OnFormat, OnRetreat, OnPage, or
OnPrint property setting contains an invalid action for the property.@When you click
OK, an Action Failed dialog box will display the name of the macro that failed and its
arguments.@1@1@11909@1
This action can't be carried out while processing a form or report event.@A macro
specified as the OnOpen, OnClose, OnFormat, OnRetreat, OnPage, or OnPrint
property setting contains an invalid action for the property.@When you click OK, an
Action Failed dialog box will display the name of the macro that failed and its
arguments.@1@611909@1
Microsoft Office Access changed the MoveLayout and NextRecord properties to True
from False.@The macro or Visual Basic function run by the OnFormat property of
one of the sections of the report set both the MoveLayout and NextRecord
properties to False. Having both properties set to False can make the report print
continuously.@Revise the macro or function so that it sets these properties to the
values you want.@1@1@4656@1
Microsoft Office Access changed the MoveLayout and NextRecord properties to True
from False.@The macro or Visual Basic function run by the OnFormat property of
one of the sections of the report set both the MoveLayout and NextRecord
properties to False. Having both properties set to False can make the report print
continuously.@Revise the macro or function so that it sets these properties to the
values you want.@1@604656@1
Microsoft Access changed the MoveLayout and NextRecord properties to True from
False.@The macro or Visual Basic function run by the OnFormat property of one of
the sections of the report set both the MoveLayout and NextRecord properties to
False. Having both properties set to False can make the report print
continuously.@Revise the macro or function so that it sets these properties to the
values you want.@1@604656@1
Microsoft Office Access can't complete the Output operation.@The Visual Basic code
you entered contains a syntax error or the Output procedures are not
available.@Make sure there isn't a syntax error in your code. If the syntax is
correct, run Setup to reinstall Microsoft Office Access. If you want to preserve your
security or custom settings, back up the Microsoft Office Access workgroup
information file.For information on backing up files, search the Microsoft Windows
Help index for 'backing up files'.@1@@185309@1

Copyright (c) 2008 FMS, Inc.

fmsinc.com

Page 70 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

2587

2003

2002

Error Description
Microsoft Office Access can't complete the Output operation.@The Visual Basic code
you entered contains a syntax error or the Output procedures are not
available.@Make sure there isn't a syntax error in your code. If the syntax is
correct, run Setup to reinstall Microsoft Office Access. If you want to preserve your
security or custom settings, back up the Microsoft Office Access workgroup
information file.For information on backing up files, search the Microsoft Windows
Help index for 'backing up files'.@1@@1
Microsoft Access can't complete the Output operation.@The Visual Basic code you
entered contains a syntax error or the Output procedures are not available.@Make
sure there isn't a syntax error in your code. If the syntax is correct, run Setup to
reinstall Microsoft Access. If you want to preserve your security or custom settings,
back up the Microsoft Access workgroup information file.For information on
backing up files, search the Microsoft Windows Help index for 'backing up
files'.@1@@1

2588

2007
2003

You must select a form to save as a report.@@@1@@@1
You must select a form to save as a report.@@@1@@1

2589

2007

The expression '|' is invalid.@Aggregate functions are only allowed on output fields
of the Record Source. @@1@@@1
The expression '|' is invalid.@Aggregate functions are only allowed on output fields
of the Record Source. @@1@@1
The expression '|' is invalid.@Aggregate functions are only allowed on output fields
of the Record Source. @1@@1

2003

2000
2590

2007
2003

The Var and VarP aggregate functions are not supported in an Access
project.@@@1@@@1
The Var and VarP aggregate functions are not supported in an Access
project.@@@1@@1

2591

2007
2003

You can't change printer properties in the OnOpen event of a report.@@@1@@@1
You can't change printer properties in the OnOpen event of a report.@@@1@@1

2592

2007
2003

You cannot bind a hierarchical report to a DAO Recordset.@@@1@@1

2593

2007
2003

This feature is not available in an MDB or ACCDB.@@@1@@@1
This feature is not available in an MDB.@@@1@@1

2594

2007

You cannot Filter By Form when form record source is a recordset
object.@@@1@@@1
You cannot Filter By Form when form record source is a recordset
object.@@@1@@1

2003
2595

2007
2003
2002

Microsoft Office Access cannot set this property when DefaultSize property is set to
True.@@@1@@@1
Microsoft Office Access cannot set this property when DefaultSize property is set to
True.@@@1@@1
Microsoft Access cannot set this property when DefaultSize property is set to
True.@@@1@@1

2596

2007
2003

Printer object is not available on subforms and subreports.@@@1@@@1
Printer object is not available on subforms and subreports.@@@1@@1

2597

2007

Unable to bind the report to the specified recordset because the shape does not
match the sorting and grouping specified on the report.@@@1@@@1
Unable to bind the report to the specified recordset because the shape does not
match the sorting and grouping specified on the report.@@@1@@1

2003

2598
2599

2007
2003

Recordset property not available for natively bound reports in MDB files.@@@1@@1

2007

Report view is not available for this report.@@@1@@@1
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Access

2600

2007
2003

2601

2007

2003

2602

2007

2003

2603

2007

2003

2604

2007

2003

2605

2007

2003

2002

Error Description
Verify the new password by retyping it in the Verify box and clicking
OK.@@@1@@@1
Verify the new password by retyping it in the Verify box and clicking OK.@@@1@@1

You don't have permission to read '|.'@To read this object, you must have Read
Design permission for it. For more information on permissions and who can set
them, click Help.@@2@1@10222@1
You don't have permission to read '|.'@To read this object, you must have Read
Design permission for it. For more information on permissions and who can set
them, click Help.@@2@410222@1
You don't have permission to modify '|.'@To modify this object, you must have
Modify Design permission for it. If the object is a table, you must also have Delete
Data and Update Data permissions for it.For more information on permissions and
who can set them, click Help.@@2@1@10222@1
You don't have permission to modify '|.'@To modify this object, you must have
Modify Design permission for it. If the object is a table, you must also have Delete
Data and Update Data permissions for it.For more information on permissions and
who can set them, click Help.@@2@410222@1
You don't have permission to run '|.'@To run this object, you must have Open/Run
permission for it. For more information on permissions and who can set them, click
Help.@@2@1@10222@1
You don't have permission to run '|.'@To run this object, you must have Open/Run
permission for it. For more information on permissions and who can set them, click
Help.@@2@410222@1
You can't view this object's permissions.@To view or change permissions for this
object, you must have Administer permission for it. For more information on
permissions and who can set them, click Help.@@2@1@10222@1
You can't view this object's permissions.@To view or change permissions for this
object, you must have Administer permission for it. For more information on
permissions and who can set them, click Help.@@2@410222@1

You can't remove this user account from group '|.'@* You may have tried to remove
a user account from the default Users group. Microsoft Office Access automatically
adds all users to the default Users group. To remove a user account from the Users
group, you must first delete the account.* You may have tried to remove all users
from the Admins group. There must be at least one user in the Admins
group.@@1@1@10212@1
You can't remove this user account from group '|.'@* You may have tried to remove
a user account from the default Users group. Microsoft Office Access automatically
adds all users to the default Users group. To remove a user account from the Users
group, you must first delete the account.* You may have tried to remove all users
from the Admins group. There must be at least one user in the Admins
group.@@1@210212@1
You can't remove this user account from group '|.'@* You may have tried to remove
a user account from the default Users group. Microsoft Access automatically adds all
users to the default Users group. To remove a user account from the Users group,
you must first delete the account.* You may have tried to remove all users from
the Admins group. There must be at least one user in the Admins
group.@@1@210212@1

2606

2007
2003

The object type is invalid.@@@1@@@1
The object type is invalid.@@@1@@1

2607

2007

You don't have permission to cut '|.'@To cut this object, you must have Modify
Design permission for it. If the object is a table, you must also have Delete Data
permission for it. For more information on permissions and who can set them, click
Help.@@2@1@10222@1
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Access

2607

2003

You don't have permission to cut '|.'@To cut this object, you must have Modify
Design permission for it. If the object is a table, you must also have Delete Data
permission for it. For more information on permissions and who can set them, click
Help.@@2@410222@1

2608

2007

You don't have permission to copy '|.'@To copy this object, you must have Read
Design permission for it. If the object is a table, you must also have Read Data
permission for it. For more information on permissions and who can set them, click
Help.@@2@1@10222@1
You don't have permission to copy '|.'@To copy this object, you must have Read
Design permission for it. If the object is a table, you must also have Read Data
permission for it. For more information on permissions and who can set them, click
Help.@@2@410222@1

2003

2609

2007

2003

2610

2007

2003

2002

2611

2007
2003
2002

2612

2007
2003

2613

2007

2003

Error Description

You don't have permission to delete '|.'@To delete this object, you must have
Modify Design permission for it. If the object is a table, you must also have Delete
Data permission for it. For more information on permissions and who can set them,
click Help.@@2@1@10222@1
You don't have permission to delete '|.'@To delete this object, you must have
Modify Design permission for it. If the object is a table, you must also have Delete
Data permission for it. For more information on permissions and who can set them,
click Help.@@2@410222@1

You must enter a personal identifier (PID) consisting of at least 4 and no more than
20 characters and digits.@Microsoft Office Access uses the combination of the user
or group name and the PID to identify the user or group.Note that Microsoft Office
Access hides the PID after you create it, so make sure to write down the exact user
or group account name and the PID entries. If you ever have to re-create the
account, you must supply the same name and PID entries.@@1@@@1
You must enter a personal identifier (PID) consisting of at least 4 and no more than
20 characters and digits.@Microsoft Office Access uses the combination of the user
or group name and the PID to identify the user or group.Note that Microsoft Office
Access hides the PID after you create it, so make sure to write down the exact user
or group account name and the PID entries. If you ever have to re-create the
account, you must supply the same name and PID entries.@@1@@1
You must enter a personal identifier (PID) consisting of at least 4 and no more than
20 characters and digits.@Microsoft Access uses the combination of the user or
group name and the PID to identify the user or group.Note that Microsoft Access
hides the PID after you create it, so make sure to write down the exact user or
group account name and the PID entries. If you ever have to re-create the account,
you must supply the same name and PID entries.@@1@@1
Microsoft Office Access can't find the workgroup file '|.' Would you like to use the
default workgroup file?@@@20@@@1
Microsoft Office Access can't find the workgroup file '|.' Would you like to use the
default workgroup file?@@@20@@1
Microsoft Access can't find the workgroup file '|.' Would you like to use the default
workgroup file?@@@20@@1
The account name is invalid.@For information about naming conventions, click
Help.@@2@1@10213@1
The account name is invalid.@For information about naming conventions, click
Help.@@2@210213@1
You don't have permission to rename '|.'@To rename a database object, you must
have Modify Design permission for the object. For more information on permissions
and who can set them, click Help.@@2@1@10222@1
You don't have permission to rename '|.'@To rename a database object, you must
have Modify Design permission for the object. For more information on permissions
and who can set them, click Help.@@2@410222@1
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Access

2614

2007

2003

2615

2007

2003

2616

2007

2003

2617

2007

2003

2618

2007

2003

2619

2007
2003

2620

2007
2003

Error Description
You don't have permission to insert this form into another form.@To insert a form
into another form as a subform, you must have Read Design permission for the
form being inserted. For more information on permissions and who can set them,
click Help.@@2@1@10222@1
You don't have permission to insert this form into another form.@To insert a form
into another form as a subform, you must have Read Design permission for the
form being inserted. For more information on permissions and who can set them,
click Help.@@2@410222@1
You don't have permission to change the owner of '|.'@To change the owner of a
database object, you must have Administer permission for it. For more information
on permissions and who can set them, click Help.@@5@1@10222@1
You don't have permission to change the owner of '|.'@To change the owner of a
database object, you must have Administer permission for it. For more information
on permissions and who can set them, click Help.@@5@410222@1
You can't change permissions for '|.'@To change permissions for this object, you
must have Administer permission for it. For more information on permissions and
who can set them, click Help.@@5@1@10222@1
You can't change permissions for '|.'@To change permissions for this object, you
must have Administer permission for it. For more information on permissions and
who can set them, click Help.@@5@410222@1

You don't have permission to import, export, or link to '|.'@To
link to this object, you must have Read Design and Read Data
more information on permissions and who can set them, click
Help.@@2@1@10222@1
You don't have permission to import, export, or link to '|.'@To
link to this object, you must have Read Design and Read Data
more information on permissions and who can set them, click
Help.@@2@410222@1

import, export, or
permissions for it. For

import, export, or
permissions for it. For

You must have the database open for exclusive use to set or remove the database
password.@To open the database exclusively, close the database, and then reopen
it by clicking the Microsoft Office Button and using the Open command. In the Open
dialog box, click the arrow next to the Open button, and then select Open
Exclusive.@@1@@@1
You need to have the database open for exclusive use to set or unset the database
password.@To open the database exclusively, close the database, and then reopen
it using the Open command on the File menu. In the Open dialog box, click the
arrow to the right of the Open button, and then choose Open Exclusive.@@1@@1
You can't change permissions for '|' in a replica.@Permissions may only be changed
in the Design Master for the replica set.@@3@@@1
You can't change permissions for '|' in a replica.@Permissions may only be changed
in the Design Master for the replica set.@@3@@1

The password you entered in the Old Password box is incorrect.@Please enter the
correct password for this account.@@1@@@1
The password you entered in the Old Password box is incorrect.@Please enter the
correct password for this account.@@1@@1

2621

2007
2003

That password isn't valid.@You may have used a semicolon.@@1@@@1
That password isn't valid.@You may have used a semicolon.@@1@@1

2622

2007

You cannot save '|' because it is read-only.@To save, switch to Design View, click
the Microsoft Office Button, point to Save As, and enter a new name.@@3@@@1
You can't save '|' because it is read-only.@To save, switch to Design View and
choose Save As from the File menu.@@3@@1

2003
2623

2007
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Access

2623

2003

Saving the database to the previous version of Access will create a new database
that contains none of the security information that you have set. Are you sure you
want to proceed?

2624

2007
2003

An error has occurred while changing workgroup database.@@@1@@@1
An error has occurred while changing workgroup database.@@@1@@1

2625

2007

Workgroup Administrator couldn't create the workgroup information file. Make sure
that you have specified a valid path and file name, that you have adequate
permissions to create the file, and that you have enough disk space on the
destination drive. (|)@@@1@@@1
Workgroup Administrator couldn't create the workgroup information file. Make sure
that you have specified a valid path and file name, that you have adequate
permissions to create the file, and that you have enough disk space on the
destination drive. (|)@@@1@@1

2003

Error Description

2626

2007
2003

Reserved error (|); there is no message for this error.@@@1@@@1
Reserved error (|); there is no message for this error.@@@1@@1

2627

2007
2003

There's not enough disk space.@@@1@@@1
There's not enough disk space.@@@1@@1

2628

2007
2003

One of your parameters is invalid.@@@1@@@1
One of your parameters is invalid.@@@1@@1

2629

2007
2003

Could not open workgroup file. This is a directory.@@@1@@@1
Could not open workgroup file. This is a directory.@@@1@@1

2630

2007
2003

The specified path is invalid.@@@1@@@1
The specified path is invalid.@@@1@@1

2631

2007
2003

The specified path is too long.@@@1@@@1
The specified path is too long.@@@1@@1

2632

2007

Change Workgroup cannot proceed without your Name, PIN, and a path to the new
Workgroup Information File.

2633

2007

Microsoft Office Access cannot change the password for the logon account '|'
because the current connection is using Microsoft Windows NT integrated
security.@@@1@@@1
Microsoft Office Access cannot change the password for the logon account '|'
because the current connection is using Microsoft Windows NT integrated
security.@@@1@@1
Microsoft Access cannot change the password for the logon account '|' because the
current connection is using Microsoft Windows NT integrated security.@@@1@@1

2003

2002
2634

2007
2003

The new password doesn't match the verify password value.@@@1@@@1
The new password doesn't match the verify password value.@@@1@@1

2635

2007

Microsoft Office Access is unable to change the password because the old password
doesn't match the password of the currently logged in user.
Microsoft Access is unable to change the password because the old password
doesn't match the password of the currently logged in user.

2002

2636

2007

Workgroup file already exists.

2637

2007

Unable to start SQL Server service. To restart the SQL Server service, double-click
the SQL Server System Manager icon in the system tray and click
Start/Continue.@When the service is started, in Microsoft Office Access, click the
Microsoft Office Button, point to Server Tasks, click Connection, and then click
OK.@@19@@@2
Unable to start SQL Server service. To restart the SQL Server service, double click
on the SQL Server System Manager icon in the system tray and click
Start/Continue.@Once the service is started, point to Connection on the File menu
in Access and click OK.@@19@@2

2003
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Access

2638

2007

2003

2639

2007
2003

2646

2007

2003

2002

2648

2007
2003

2002

2649

2007

Error Description
Unable to start SQL Server service. To restart the SQL Server service, double-click
the SQL Server System Manager icon in the system tray and click Start/Continue. If
the service fails to start, go to the Services console and verify that the
MSSQLServer service Log On information is correct.@When the service is started, in
Microsoft Office Access, click the Microsoft Office Button, point to Server Tasks, click
Connection, and then click OK.@@19@@@2
Unable to start SQL Server service. To restart the SQL Server service, double click
on the SQL Server System Manager icon in the system tray and click
Start/Continue. If the service fails to start, go to the Services console and verify
that the MSSQLServer service Log On information is correct.@Once the service is
started, point to Connection on the File menu in Access and click OK.@@19@@2

Microsoft Office Access cannot open | due to security restrictions.@Security settings
restrict access to the file because it is not digitally signed.@@2@1@553714138@2
Microsoft Office Access cannot open | due to security restrictions.@Security settings
restrict access to the file because it is not digitally signed.@@2@553714138@2
Microsoft Office Access can't create this relationship and enforce referential
integrity.@Data in the table '|' violates referential integrity rules.For example,
there may be records relating to an employee in the related table, but no record for
the employee in the primary table.@Edit the data so that records in the primary
table exist for all related records.If you want to create the relationship without
following the rules of referential integrity, clear the Enforce Referential Integrity
check box.@1@1@9086@1
Microsoft Office Access can't create this relationship and enforce referential
integrity.@Data in the table '|' violates referential integrity rules.For example,
there may be records relating to an employee in the related table, but no record for
the employee in the primary table.@Edit the data so that records in the primary
table exist for all related records.If you want to create the relationship without
following the rules of referential integrity, clear the Enforce Referential Integrity
check box.@1@209086@1
Microsoft Access can't create this relationship and enforce referential
integrity.@Data in the table '|' violates referential integrity rules.For example,
there may be records relating to an employee in the related table, but no record for
the employee in the primary table.@Edit the data so that records in the primary
table exist for all related records.If you want to create the relationship without
following the rules of referential integrity, clear the Enforce Referential Integrity
check box.@1@209086@1
Microsoft Office Access created a one-to-one relationship instead of a one-to-many
relationship because there is a unique index on the field(s) specified for the related
table.@If you want to define a one-to-many relationship between these tables, try
one of the following:* Delete the one-to-one relationship, and then change the
setting of the Indexed property for the foreign key field from No Duplicates to
Duplicates OK.* Choose different matching fields.@@1@@1
Microsoft Access created a one-to-one relationship instead of a one-to-many
relationship because there is a unique index on the field(s) specified for the related
table.@If you want to define a one-to-many relationship between these tables, try
one of the following:* Delete the one-to-one relationship, and then change the
setting of the Indexed property for the foreign key field from No Duplicates to
Duplicates OK.* Choose different matching fields.@@1@@1
Microsoft Office Access can't enforce referential integrity for this relationship.@Make
sure the fields you drag are primary key fields or uniquely indexed and that the
unique index or primary key is correctly set.If you want to create the relationship
without following the rules of referential integrity, clear the Enforce Referential
Integrity check box.@@1@1@9086@1
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Access

2649

2003

2002

2650

2007

2003

2002

2651

2007

2003

Error Description
Microsoft Office Access can't enforce referential integrity for this relationship.@Make
sure the fields you drag are primary key fields or uniquely indexed and that the
unique index or primary key is correctly set.If you want to create the relationship
without following the rules of referential integrity, clear the Enforce Referential
Integrity check box.@@1@209086@1
Microsoft Access can't enforce referential integrity for this relationship.@Make sure
the fields you drag are primary key fields or uniquely indexed and that the unique
index or primary key is correctly set.If you want to create the relationship without
following the rules of referential integrity, clear the Enforce Referential Integrity
check box.@@1@209086@1
Microsoft Office Access can't create this relationship and enforce referential
integrity.@* The fields you chose may have different data types.* The fields may
have the Number data type but not the same FieldSize property setting.@Try one of
the following:* Select fields with the same data type.* Open the tables in
Design view, and change the data types and field sizes so that the fields match.If
you want to create the relationship without following the rules of referential
integrity, clear the Enforce Referential Integrity check box.@2@1@9086@1
Microsoft Office Access can't create this relationship and enforce referential
integrity.@* The fields you chose may have different data types.* The fields may
have the Number data type but not the same FieldSize property setting.@Try one of
the following:* Select fields with the same data type.* Open the tables in
Design view, and change the data types and field sizes so that the fields match.If
you want to create the relationship without following the rules of referential
integrity, clear the Enforce Referential Integrity check box.@2@209086@1
Microsoft Access can't create this relationship and enforce referential integrity.@*
The fields you chose may have different data types.* The fields may have the
Number data type but not the same FieldSize property setting.@Try one of the
following:* Select fields with the same data type.* Open the tables in Design
view, and change the data types and field sizes so that the fields match.If you
want to create the relationship without following the rules of referential integrity,
clear the Enforce Referential Integrity check box.@2@209086@1

You can't create a relationship between fields with the Memo, OLE Object, Yes/No,
or Hyperlink data type.@You tried to enforce referential integrity for a relationship,
but one or more of the fields you chose have the Memo, OLE Object, Yes/No, or
Hyperlink data type.@Select fields in the grid that don't have these data types, or
open the tables in Design view and change data types.@1@@@1
You can't create a relationship between fields with the Memo, OLE Object, Yes/No,
or Hyperlink data type.@You tried to enforce referential integrity for a relationship,
but one or more of the fields you chose have the Memo, OLE Object, Yes/No, or
Hyperlink data type.@Select fields in the grid that don't have these data types, or
open the tables in Design view and change data types.@1@@1

2652

2007
2003

You can't delete a relationship inherited from a linked database.@@@1@@@1
You can't delete a relationship inherited from a linked database.@@@1@@1

2680

2007

The form or report includes more OLE objects than Microsoft Office Access can
display at one time.@Delete some of the bound or unbound object
frames.@@1@@@1
The form or report includes more OLE objects than Microsoft Office Access can
display at one time.@Delete some of the bound or unbound object
frames.@@1@@1
The form or report includes more OLE objects than Microsoft Access can display at
one time.@Delete some of the bound or unbound object frames.@@1@@1

2003

2002
2683

2007
2003

There is no object in this control.@@@1@@@1
There is no object in this control.@@@1@@1
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Access

2684

2007

2003

2685

2007

2003

2686

2007

2003

2002

2687
2690

2007
2003
2007

2003

2691

2007
2003
2002

2694

2007

2003

Error Description
The OLE object is empty.@You can't edit a bound object frame if the field in the
underlying table doesn't contain an OLE object.@Right-click the field, click Insert
Object, and use the dialog box to locate and add the object to the
field.@1@1@9360@1
The OLE object is empty.@You can't edit a bound object frame if the field in the
underlying table doesn't contain an OLE object.@Embed or link an OLE object into
the bound object frame using the Object command on the Insert
menu.@1@109360@1
The object doesn't have an OLE object data type.@The bound object frame
containing the object you tried to edit isn't bound to a field with the OLE object
type.@If you want to display an OLE object, set the ControlSource property for
bound object frame to a field with the OLE object data type. Or use a different
control, such as a text box, to display the data.@1@1@9360@1
The object doesn't have an OLE object data type.@The bound object frame
containing the object you tried to edit isn't bound to a field with the OLE object
type.@If you want to display an OLE object, set the ControlSource property for
bound object frame to a field with the OLE object data type. Or use a different
control, such as a text box, to display the data.@1@109360@1

data
the

data
the

Microsoft Office Access is unable to save the | object.@Your computer ran out of
disk space while Microsoft Office Access was saving the OLE object.For
information on freeing disk space, search the Microsoft Windows Help index for 'disk
space, freeing'.@@1@@@1
Microsoft Office Access is unable to save the | object.@Your computer ran out of
disk space while Microsoft Office Access was saving the OLE object.For
information on freeing disk space, search the Microsoft Windows Help index for 'disk
space, freeing'.@@1@@1
Microsoft Access is unable to save the | object.@Your computer ran out of disk
space while Microsoft Access was saving the OLE object.For information on freeing
disk space, search the Microsoft Windows Help index for 'disk space,
freeing'.@@1@@1
There was a problem reading the | object.@@@1@@1

A system resource necessary for displaying the | object isn't available.@Your
computer may be low on memory.@Close unneeded programs, and try the
operation again.For more information on freeing memory, search the Microsoft
Windows Help index for 'memory, troubleshooting'.@1@@@1
A system resource necessary for displaying the | object isn't available.@Your
computer may be low on memory.@Close unneeded programs, and try the
operation again.For more information on freeing memory, search the Microsoft
Windows Help index for 'memory, troubleshooting'.@1@@1
Microsoft Office Access can't communicate with the OLE server.@The OLE server
may not be registered.@To register the OLE server, reinstall it.@1@@@1
Microsoft Office Access can't communicate with the OLE server.@The OLE server
may not be registered.@To register the OLE server, reinstall it.@1@@1
Microsoft Access can't communicate with the OLE server.@The OLE server may not
be registered.@To register the OLE server, reinstall it.@1@@1
The Clipboard isn't available.@The Clipboard may be in use by another application,
or your computer may be low on memory.@If your computer is low on memory,
close unneeded programs, and then try the operation again.For more information
on freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@1@@@1
The Clipboard isn't available.@The Clipboard may be in use by another application,
or your computer may be low on memory.@If your computer is low on memory,
close unneeded programs, and then try the operation again.For more information
on freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@1@@1
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Access

2695

2007
2003
2002

2696

2007
2003
2002

2697

2007

2003

2698

2007

2003

2699

2007

2003

2700

2007

2003

2002

2701

2007

2003

2702

2007
2003

2703

2007

Error Description
Microsoft Office Access is unable to display the converted | object.@Delete the
object in the bound object frame, and then re-create it.@@1@@@1
Microsoft Office Access is unable to display the converted | object.@Delete the
object in the bound object frame, and then re-create it.@@1@@1
Microsoft Access is unable to display the converted | object.@Delete the object in
the bound object frame, and then re-create it.@@1@@1

Microsoft Office Access can't read the OLE object.@Delete the object in the bound
object frame, and then re-create it.@@1@@@1
Microsoft Office Access can't read the OLE object.@Delete the object in the bound
object frame, and then re-create it.@@1@@1
Microsoft Access can't read the OLE object.@Delete the object in the bound object
frame, and then re-create it.@@1@@1
There was a problem loading the |
not a valid OLE object.@Re-create
again.@1@1@9360@1
There was a problem loading the |
not a valid OLE object.@Re-create
again.@1@109360@1

object.@The object you tried to create or edit is
the object, and then embed or link it
object.@The object you tried to create or edit is
the object, and then embed or link it

The | object you tried to create or edit is too large to save.@* Your database may
not contain enough space for the object.* Your computer may be out of disk
space.For information on freeing disk space, search the Microsoft Windows Help
index for 'disk space, freeing'.@@1@@@1
The | object you tried to create or edit is too large to save.@* Your database may
not contain enough space for the object.* Your computer may be out of disk
space.For information on freeing disk space, search the Microsoft Windows Help
index for 'disk space, freeing'.@@1@@1
The connection with the OLE server was lost, or the OLE server encountered an
error while you were using it.@Restart the OLE server, and then try the operation
again.@@1@@@1
The connection with the OLE server was lost, or the OLE server encountered an
error while you were using it.@Restart the OLE server, and then try the operation
again.@@1@@1
Microsoft Office Access can't find an OLE server or a dynamic-link library (DLL)
required for the OLE operation.@The OLE server or DLL may not be registered.@To
register the OLE server or DLL, reinstall it.@1@@@1
Microsoft Office Access can't find an OLE server or a dynamic-link library (DLL)
required for the OLE operation.@The OLE server or DLL may not be registered.@To
register the OLE server or DLL, reinstall it.@1@@1
Microsoft Access can't find an OLE server or a dynamic-link library (DLL) required
for the OLE operation.@The OLE server or DLL may not be registered.@To register
the OLE server or DLL, reinstall it.@1@@1

The OLE server for the OLE object you tried to create is already open.@Switch to
the OLE server window and close it. Then try to create or edit the OLE object
again.@@1@@@1
The OLE server for the OLE object you tried to create is already open.@Switch to
the OLE server window and close it. Then try to create or edit the OLE object
again.@@1@@1
The | object isn't registered.@The object may be calling an application that isn't
installed.@To register the application, reinstall it.@1@@@1
The | object isn't registered.@The object may be calling an application that isn't
installed.@To register the application, reinstall it.@1@@1
Microsoft Office Access can't read the | object because communication was
interrupted.@If the OLE server application is located on a network server, make
sure your computer is connected to it.@@1@@@1
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Access

2703

2003

2002

2704

2007
2003

2707

2007

2003

2002

2711

2007

2003

2713

2007

Error Description
Microsoft Office Access can't read the | object because communication was
interrupted.@If the OLE server application is located on a network server, make
sure your computer is connected to it.@@1@@1
Microsoft Access can't read the | object because communication was
interrupted.@If the OLE server application is located on a network server, make
sure your computer is connected to it.@@1@@1
The | object you tried to edit doesn't have any displayable
information.@@@2@1@9360@1
The | object you tried to edit doesn't have any displayable
information.@@@2@109360@1

Microsoft Office Access can't open the file containing the OLE object.@* You may
have specified an invalid file name or an invalid unit of data (such as a range of cells
from a worksheet) within the file for the OLE object.* The file you specified may
not be available because it's locked by another user or you don't have permission to
use it.@Try one of the following:* Make sure the file is available and that you
used the correct file name.* Check the OLE server's documentation for
information about the syntax to use when specifying an OLE object's
data.@1@1@9360@1
Microsoft Office Access can't open the file containing the OLE object.@* You may
have specified an invalid file name or an invalid unit of data (such as a range of cells
from a worksheet) within the file for the OLE object.* The file you specified may
not be available because it's locked by another user or you don't have permission to
use it.@Try one of the following:* Make sure the file is available and that you
used the correct file name.* Check the OLE server's documentation for
information about the syntax to use when specifying an OLE object's
data.@1@109360@1
Microsoft Access can't open the file containing the OLE object.@* You may have
specified an invalid file name or an invalid unit of data (such as a range of cells from
a worksheet) within the file for the OLE object.* The file you specified may not be
available because it's locked by another user or you don't have permission to use
it.@Try one of the following:* Make sure the file is available and that you used the
correct file name.* Check the OLE server's documentation for information about
the syntax to use when specifying an OLE object's data.@1@109360@1
The file name argument in the GetObject function of the Visual Basic procedure you
ran is invalid.@* You may not have entered, or may have misspelled, the file
name.* The unit of data (such as a range of cells from a worksheet) may not be
valid.@Try one of the following:* Make sure the file is installed on your computer
and that you used the correct file name.* Check the OLE server's documentation
for information about the syntax to use when specifying an OLE object's
data.@1@3@1010959@1
The file name argument in the GetObject function of the Visual Basic procedure you
ran is invalid.@* You may not have entered, or may have misspelled, the file
name.* The unit of data (such as a range of cells from a worksheet) may not be
valid.@Try one of the following:* Make sure the file is installed on your computer
and that you used the correct file name.* Check the OLE server's documentation
for information about the syntax to use when specifying an OLE object's
data.@1@1010959@1
A problem occurred when Microsoft Office Access tried to access the | object.@*
You may have specified an invalid file name or an invalid unit of data (such as a
range of cells from a worksheet) within the file for the OLE object.* The file you
specified may not be available because it's locked by another user or you don't have
permission to use it.@Try one of the following:* Make sure that the file is installed
on your computer and that you used the correct file name.* Check the OLE
server's documentation for information about the syntax to use when specifying an
OLE object's data.@1@1@9360@1
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Access

2713

2003

2002

2714

2007

2003

2715

2007
2003

2717

2007

2003

2719

2007

2003

2002

Error Description
A problem occurred when Microsoft Office Access tried to access the | object.@*
You may have specified an invalid file name or an invalid unit of data (such as a
range of cells from a worksheet) within the file for the OLE object.* The file you
specified may not be available because it's locked by another user or you don't have
permission to use it.@Try one of the following:* Make sure that the file is installed
on your computer and that you used the correct file name.* Check the OLE
server's documentation for information about the syntax to use when specifying an
OLE object's data.@1@109360@1
A problem occurred when Microsoft Access tried to access the | object.@* You may
have specified an invalid file name or an invalid unit of data (such as a range of cells
from a worksheet) within the file for the OLE object.* The file you specified may
not be available because it's locked by another user or you don't have permission to
use it.@Try one of the following:* Make sure that the file is installed on your
computer and that you used the correct file name.* Check the OLE server's
documentation for information about the syntax to use when specifying an OLE
object's data.@1@109360@1
The | object doesn't support verbs that can be performed on an OLE object, such as
play or edit.@Check the OLE server's documentation for information on the verbs
the OLE object supports, or use the ObjectVerbs property or the ObjectVerbsCount
property to find the verbs supported by an OLE object.@@1@1@6970@1
The | object doesn't support verbs that can be performed on an OLE object, such as
play or edit.@Check the OLE server's documentation for information on the verbs
the OLE object supports, or use the ObjectVerbs property or the ObjectVerbsCount
property to find the verbs supported by an OLE object.@@1@606970@1
The
you
The
you

index for the
entered may
index for the
entered may

Action or the Verb property for the | object is invalid.@The setting
be a negative number or may be too large.@@1@1@6967@1
Action or the Verb property for the | object is invalid.@The setting
be a negative number or may be too large.@@1@606967@1

The | object has no information that can be displayed.@You tried to perform an
operation on a bound or unbound object frame containing an OLE object, but the
OLE object is empty.@Right-click the frame, click Insert Object, and then use the
dialog box to locate and either add or link to an object from a file that is not
empty.@1@1@9360@1
The | object has no displayable information.@You tried to perform an operation on a
bound or unbound object frame containing an OLE object, but the OLE object is
empty.@Use the Object command on the Insert menu to create an OLE object or to
embed or link an OLE object from a file that isn't empty.@1@109360@1
A problem occurred while accessing the | object.@* The OLE server may not be
available because it's on a network server and you lost the connection. Try reestablishing the connection.* The OLE object may be stored in a linked file, but
the file isn't available. Activate the OLE server outside of Microsoft Office Access,
and then open the file containing the OLE object to verify that it still exists and can
be accessed.@@1@@@1
A problem occurred while accessing the | object.@* The OLE server may not be
available because it's on a network server and you lost the connection. Try reestablishing the connection.* The OLE object may be stored in a linked file, but
the file isn't available. Activate the OLE server outside of Microsoft Office Access,
and then open the file containing the OLE object to verify that it still exists and can
be accessed.@@1@@1
A problem occurred while accessing the | object.@* The OLE server may not be
available because it's on a network server and you lost the connection. Try reestablishing the connection.* The OLE object may be stored in a linked file, but
the file isn't available. Activate the OLE server outside of Microsoft Access, and then
open the file containing the OLE object to verify that it still exists and can be
accessed.@@1@@1
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Access

2723

2007

2003

2724

2007

2003

2002

Error Description
The | object doesn't support the attempted operation.@The OLE object was
changed to a picture, or the link to the object was broken.@If you want to perform
the operation, delete the OLE object, and then embed or link it
again.@1@1@9360@1
The | object doesn't support the attempted operation.@The OLE object was
changed to a picture, or the link to the object was broken.@If you want to perform
the operation, delete the OLE object, and then embed or link it
again.@1@109360@1
One or more dynamic-link libraries required for using OLE objects is an incorrect
version.@Run Setup to reinstall Microsoft Office Access. If you want to preserve
your security or custom settings, back up the Microsoft Office Access workgroup
information file.For information on backing up files, search the Microsoft Windows
Help index for 'backing up files'.@@1@@185309@1
One or more dynamic-link libraries required for using OLE objects is an incorrect
version.@Run Setup to reinstall Microsoft Office Access. If you want to preserve
your security or custom settings, back up the Microsoft Office Access workgroup
information file.For information on backing up files, search the Microsoft Windows
Help index for 'backing up files'.@@1@@1
One or more dynamic-link libraries required for using OLE objects is an incorrect
version.@Run Setup to reinstall Microsoft Access. If you want to preserve your
security or custom settings, back up the Microsoft Access workgroup information
file.For information on backing up files, search the Microsoft Windows Help index
for 'backing up files'.@@1@@1

2725

2007
2003

The OLE server isn't registered.@To register the OLE server, reinstall it.@@1@@@1
The OLE server isn't registered.@To register the OLE server, reinstall it.@@1@@1

2726

2007

Microsoft Office Access can't perform the OLE operation because it was unable to
read the Windows Registry where the OLE server is registered.@Reinstall the OLE
server, and then try the operation again. If problems continue, reinstall Microsoft
Windows and the other applications on your computer.If you reinstall Microsoft
Office Access, you may want to back up your Microsoft Office Access workgroup
information file first to preserve any custom settings. For information on backing up
files, search the Microsoft Windows Help index for 'backing up files'.For
information on the Windows Registry, search the Microsoft Windows Help index for
'registry'.@@1@@@1
Microsoft Office Access can't perform the OLE operation because it was unable to
read the Windows Registry where the OLE server is registered.@Reinstall the OLE
server, and then try the operation again. If problems continue, reinstall Microsoft
Windows and the other applications on your computer.If you reinstall Microsoft
Office Access, you may want to back up your Microsoft Office Access workgroup
information file first to preserve any custom settings. For information on backing up
files, search the Microsoft Windows Help index for 'backing up files'.For
information on the Windows Registry, search the Microsoft Windows Help index for
'registry'.@@1@@1
Microsoft Access can't perform the OLE operation because it was unable to read the
Windows Registry where the OLE server is registered.@Reinstall the OLE server,
and then try the operation again. If problems continue, reinstall Microsoft Windows
and the other applications on your computer.If you reinstall Microsoft Access, you
may want to back up your Microsoft Access workgroup information file first to
preserve any custom settings. For information on backing up files, search the
Microsoft Windows Help index for 'backing up files'.For information on the
Windows Registry, search the Microsoft Windows Help index for 'registry'.@@1@@1

2003

2002

Copyright (c) 2008 FMS, Inc.

fmsinc.com

Page 82 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

2727

2007

2003

2002

Error Description
Microsoft Office Access can't perform the OLE operation because it was unable to
write to the Windows Registry where the OLE server is registered.@Reinstall the
OLE server, and then try the operation again. If problems continue, reinstall
Microsoft Windows and the other applications on your computer.If you reinstall
Microsoft Office Access, you may want to back up your Microsoft Office Access
workgroup information file first to preserve any custom settings. For information on
backing up files, search the Microsoft Windows Help index for 'backing up files'.For
information on the Windows Registry, search the Microsoft Windows Help index for
'registry'.@@1@@@1
Microsoft Office Access can't perform the OLE operation because it was unable to
write to the Windows Registry where the OLE server is registered.@Reinstall the
OLE server, and then try the operation again. If problems continue, reinstall
Microsoft Windows and the other applications on your computer.If you reinstall
Microsoft Office Access, you may want to back up your Microsoft Office Access
workgroup information file first to preserve any custom settings. For information on
backing up files, search the Microsoft Windows Help index for 'backing up files'.For
information on the Windows Registry, search the Microsoft Windows Help index for
'registry'.@@1@@1
Microsoft Access can't perform the OLE operation because it was unable to write to
the Windows Registry where the OLE server is registered.@Reinstall the OLE server,
and then try the operation again. If problems continue, reinstall Microsoft Windows
and the other applications on your computer.If you reinstall Microsoft Access, you
may want to back up your Microsoft Access workgroup information file first to
preserve any custom settings. For information on backing up files, search the
Microsoft Windows Help index for 'backing up files'.For information on the
Windows Registry, search the Microsoft Windows Help index for 'registry'.@@1@@1

2729

2007
2003

The OLE object you tried to edit is busy.@Try again later.@@1@@@1
The OLE object you tried to edit is busy.@Try again later.@@1@@1

2730

2007

There was a problem communicating with the OLE server.@Try again later. If you
still can't access the object, try one or more of the following:* Free up system
memory. For information on freeing memory, search the Microsoft Windows Help
index for 'memory, troubleshooting'.* Reinstall the OLE server to make sure it's
registered.* Check the OLE server's documentation for information about the
syntax to use when specifying an OLE object's data.@@1@@@1
There was a problem communicating with the OLE server.@Try again later. If you
still can't access the object, try one or more of the following:* Free up system
memory. For information on freeing memory, search the Microsoft Windows Help
index for 'memory, troubleshooting'.* Reinstall the OLE server to make sure it's
registered.* Check the OLE server's documentation for information about the
syntax to use when specifying an OLE object's data.@@1@@1

2003

2731

2007
2003

2732

2007

2003

2002

2733

2007

An error occurred while accessing the OLE server.@The OLE server may not be
registered.@To register the OLE server, reinstall it.@1@@@1
An error occurred while accessing the OLE server.@The OLE server may not be
registered.@To register the OLE server, reinstall it.@1@@1

Microsoft Office Access can't read the | object.@Communication between Microsoft
Office Access and the OLE server was interrupted.@Make sure your computer is
connected to the network server on which the OLE server is located.@1@@@1
Microsoft Office Access can't read the | object.@Communication between Microsoft
Office Access and the OLE server was interrupted.@Make sure your computer is
connected to the network server on which the OLE server is located.@1@@1
Microsoft Access can't read the | object.@Communication between Microsoft Access
and the OLE server was interrupted.@Make sure your computer is connected to the
network server on which the OLE server is located.@1@@1
The OLE object you tried to edit can't be accessed.@You don't have permission to
change the object, or another user opened and locked the object.@@1@@@1
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Access

2733

2003

The OLE object you tried to edit can't be accessed.@You don't have permission to
change the object, or another user opened and locked the object.@@1@@1

2734

2007

You can't save the | object now.@The OLE server is running an operation, or
another user opened and locked the object.@Try to save the object again
later.@1@@@1
You can't save the | object now.@The OLE server is running an operation, or
another user opened and locked the object.@Try to save the object again
later.@1@@1

2003

Error Description

2735

2007
2003

This disk is write-protected. You can't save the | object to it.@@@1@@@1
This disk is write-protected. You can't save the | object to it.@@@1@@1

2737

2007

Microsoft Office Access can't find the file containing the linked OLE object you tried
to update using the OLE/DDE Links command.@You may have misspelled the file
name, or the file may have been deleted or renamed.@If the file has been moved to
a different location, use the OLE/DDE Links command to change the source. Or
delete the object, and create a new linked object.@1@@@1
Microsoft Office Access can't find the file containing the linked OLE object you tried
to update using the OLE/DDE Links command.@You may have misspelled the file
name, or the file may have been deleted or renamed.@If the file has been moved to
a different location, use the OLE/DDE Links command to change the source. Or
delete the object, and create a new linked object.@1@@1
Microsoft Access can't find the file containing the linked OLE object you tried to
update using the OLE/DDE Links command.@You may have misspelled the file
name, or the file may have been deleted or renamed.@If the file has been moved to
a different location, use the OLE/DDE Links command to change the source. Or
delete the object, and create a new linked object.@1@@1

2003

2002

2738

2007

2003

2739

2007
2003

2741

2007

2003

2002

2742

2007

2003

There isn't enough memory to complete the operation.@Close unneeded programs
and try the operation again.For more information on freeing memory, search the
Microsoft Windows Help index for 'memory, troubleshooting'.@@1@@@1
There isn't enough memory to complete the operation.@Close unneeded programs
and try the operation again.For more information on freeing memory, search the
Microsoft Windows Help index for 'memory, troubleshooting'.@@1@@1

An error occurred during the operation with an OLE object.@The object is in
use.@@1@@@1
An error occurred during the operation with an OLE object.@The object is in
use.@@1@@1
Your computer ran out of disk space while Microsoft Office Access was saving the
changes you made to the | object.@For information on freeing disk space, search
the Microsoft Windows Help index for 'disk space, freeing'.@@1@@@1
Your computer ran out of disk space while Microsoft Office Access was saving the
changes you made to the | object.@For information on freeing disk space, search
the Microsoft Windows Help index for 'disk space, freeing'.@@1@@1
Your computer ran out of disk space while Microsoft Access was saving the changes
you made to the | object.@For information on freeing disk space, search the
Microsoft Windows Help index for 'disk space, freeing'.@@1@@1
Microsoft Office Access was unable to create more files.@Your computer may be low
on memory or disk space.@Close unneeded programs and try the operation
again.For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space, freeing'.@1@@@1
Microsoft Office Access was unable to create more files.@Your computer may be low
on memory or disk space.@Close unneeded programs and try the operation
again.For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space, freeing'.@1@@1
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Access

2742

2002

Microsoft Access was unable to create more files.@Your computer may be low on
memory or disk space.@Close unneeded programs and try the operation
again.For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space, freeing'.@1@@1

2743

2007

The | object is stored in a format that is incompatible with the version of OLE on
your computer.@@@1@@@1
The | object is stored in a format that is incompatible with the version of OLE on
your computer.@@@1@@1

2003
2744

2007

2003

2002

2745

2007

2003

2002

2746

2007

2003

2747

2007

Error Description

Microsoft Office Access can't find the OLE server.@The setting for the SourceDoc
property may be invalid, or the file may have been deleted, renamed, or
moved.@@1@1@6973@1
Microsoft Office Access can't find the OLE server.@The setting for the SourceDoc
property may be invalid, or the file may have been deleted, renamed, or
moved.@@1@606973@1
Microsoft Access can't find the OLE server.@The setting for the SourceDoc property
may be invalid, or the file may have been deleted, renamed, or
moved.@@1@606973@1
Share.exe or Vshare.386 is missing from your computer; OLE support needs these
files to work correctly.@Rerun Microsoft Office Access or Microsoft Office Setup to
reinstall Microsoft Office Access, the Share program, and Vshare.386.@If you want
to preserve your security or custom settings, back up the Microsoft Office Access
workgroup information file. Then restore the file to its original location. For
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@1@@185309@3
Share.exe or Vshare.386 is missing from your computer; OLE support needs these
files to work correctly.@Rerun Microsoft Office Access or Microsoft Office Setup to
reinstall Microsoft Office Access, the Share program, and Vshare.386.@If you want
to preserve your security or custom settings, back up the Microsoft Office Access
workgroup information file. Then restore the file to its original location. For
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@1@@3
Share.exe or Vshare.386 is missing from your computer; OLE support needs these
files to work correctly.@Rerun Microsoft Access or Microsoft Office Setup to reinstall
Microsoft Access, the Share program, and Vshare.386.@If you want to preserve
your security or custom settings, back up the Microsoft Access workgroup
information file. Then restore the file to its original location. For information on
backing up files, search the Microsoft Windows Help index for 'backing up
files'.@1@@3

You can't switch to Design view because your form contains too many OLE
objects.@Close other applications, close the form, and then open the form again in
Design view. Then delete some of the OLE objects or move them to a different
form.@@1@@@1
You can't switch to Design view because your form contains too many OLE
objects.@Close other applications, close the form, and then open the form again in
Design view. Then delete some of the OLE objects or move them to a different
form.@@1@@1
The OLE server can't display the | object.@There is a problem with the file
containing the OLE object, or there isn't enough memory available.@Open the OLE
server outside of Microsoft Office Access, and then open the OLE object file.If you
can do this, then your computer may be low on memory. Close other programs, and
then try the operation again.For more information on freeing memory, search the
Microsoft Windows Help index for 'memory, troubleshooting'.@1@@@1
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Access

2747

2003

2002

2748

2007

2003

2749

2007

2003

2750

2007
2003

2751

2007

2003

2002

2753

2007

2003

2002

Error Description
The OLE server can't display the | object.@There is a problem with the file
containing the OLE object, or there isn't enough memory available.@Open the OLE
server outside of Microsoft Office Access, and then open the OLE object file.If you
can do this, then your computer may be low on memory. Close other programs, and
then try the operation again.For more information on freeing memory, search the
Microsoft Windows Help index for 'memory, troubleshooting'.@1@@1
The OLE server can't display the | object.@There is a problem with the file
containing the OLE object, or there isn't enough memory available.@Open the OLE
server outside of Microsoft Access, and then open the OLE object file.If you can do
this, then your computer may be low on memory. Close other programs, and then
try the operation again.For more information on freeing memory, search the
Microsoft Windows Help index for 'memory, troubleshooting'.@1@@1
The Automation object operation isn't available for the | object.@Check the
component's documentation for information on which operations are available for an
Automation object.@@1@@@1
The Automation object operation isn't available for the | object.@Check the
component's documentation for information on which operations are available for an
Automation object.@@1@@1
There isn't enough memory to complete the Automation object operation on the |
object.@Close unneeded programs and try the operation again.For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@@1
There isn't enough memory to complete the Automation object operation on the |
object.@Close unneeded programs and try the operation again.For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@1

The operation on the | object failed.@The OLE server may not be registered.@To
register the OLE server, reinstall it.@1@@@1
The operation on the | object failed.@The OLE server may not be registered.@To
register the OLE server, reinstall it.@1@@1
The Exit or Update operation failed.@You pressed the ESC key (or another key used
in the OLE server to stop an operation) while Microsoft Office Access was saving the
changes you made to an OLE object in a form or report.@Try to exit or update
again.@1@@@1
The Exit or Update operation failed.@You pressed the ESC key (or another key used
in the OLE server to stop an operation) while Microsoft Office Access was saving the
changes you made to an OLE object in a form or report.@Try to exit or update
again.@1@@1
The Exit or Update operation failed.@You pressed the ESC key (or another key used
in the OLE server to stop an operation) while Microsoft Access was saving the
changes you made to an OLE object in a form or report.@Try to exit or update
again.@1@@1
A problem occurred while Microsoft Office Access was communicating with the OLE
server or ActiveX Control.@Close the OLE server and restart it outside of Microsoft
Office Access. Then try the original operation again in Microsoft Office
Access.@@1@@@1
A problem occurred while Microsoft Office Access was communicating with the OLE
server or ActiveX Control.@Close the OLE server and restart it outside of Microsoft
Office Access. Then try the original operation again in Microsoft Office
Access.@@1@@1
A problem occurred while Microsoft Access was communicating with the OLE server
or ActiveX Control.@Close the OLE server and restart it outside of Microsoft Access.
Then try the original operation again in Microsoft Access.@@1@@1
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Access

2754

2007

2003

2002

2755

2007

2003

2002

2756

2007

2003

2002

2757

2007

Error Description
A problem occurred while Microsoft Office Access was communicating with the OLE
server.@Try one or more of the following:* Make sure you're connected to the
network server where the OLE server application is located.* Close the OLE server
and restart it outside of Microsoft Office Access. Then try the original operation
again from within Microsoft Office Access.* Reinstall the OLE server to ensure that
it's registered.@@1@@@1
A problem occurred while Microsoft Office Access was communicating with the OLE
server.@Try one or more of the following:* Make sure you're connected to the
network server where the OLE server application is located.* Close the OLE server
and restart it outside of Microsoft Office Access. Then try the original operation
again from within Microsoft Office Access.* Reinstall the OLE server to ensure that
it's registered.@@1@@1
A problem occurred while Microsoft Access was communicating with the OLE
server.@Try one or more of the following:* Make sure you're connected to the
network server where the OLE server application is located.* Close the OLE server
and restart it outside of Microsoft Access. Then try the original operation again from
within Microsoft Access.* Reinstall the OLE server to ensure that it's
registered.@@1@@1
There was a problem referencing a property or method of the object.@You tried to
run a Visual Basic procedure that references an object property or method.@Try
one or more of the following:* Make sure the component is properly
registered.* Make sure your computer is connected to the network server where
the component is located.* Close the component and restart it outside of
Microsoft Office Access. Then try again to run the procedure in Microsoft Office
Access.@1@@@1
There was a problem referencing a property or method of the object.@You tried to
run a Visual Basic procedure that references an object property or method.@Try
one or more of the following:* Make sure the component is properly
registered.* Make sure your computer is connected to the network server where
the component is located.* Close the component and restart it outside of
Microsoft Office Access. Then try again to run the procedure in Microsoft Office
Access.@1@@1
There was a problem referencing a property or method of the object.@You tried to
run a Visual Basic procedure that references an object property or method.@Try
one or more of the following:* Make sure the component is properly
registered.* Make sure your computer is connected to the network server where
the component is located.* Close the component and restart it outside of
Microsoft Access. Then try again to run the procedure in Microsoft Access.@1@@1
A problem occurred when Microsoft Office Access tried to access the OLE
object.@Close the Microsoft Office Access form or report that displays the OLE
object, and close the OLE server. Then reopen the form or report to see if it can
display the OLE object.@@1@@@1
A problem occurred when Microsoft Office Access tried to access the OLE
object.@Close the Microsoft Office Access form or report that displays the OLE
object, and close the OLE server. Then reopen the form or report to see if it can
display the OLE object.@@1@@1
A problem occurred when Microsoft Access tried to access the OLE object.@Close
the Microsoft Access form or report that displays the OLE object, and close the OLE
server. Then reopen the form or report to see if it can display the OLE
object.@@1@@1
There was a problem accessing a property or method of the OLE object.@Try one or
more of the following:* Verify that the OLE server is registered correctly by
reinstalling it.* Make sure your computer is connected to the server on which the
OLE server application resides.* Close the OLE server and restart it outside of
Microsoft Office Access. Then try the original operation again from within Microsoft
Office Access.@@1@@@1
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Access

2757

2003

2002

2758

2007
2003

2002

2759

2007

2003

2760

2007
2003

2761

2007

2003

Error Description
There was a problem accessing a property or method of the OLE object.@Try one or
more of the following:* Verify that the OLE server is registered correctly by
reinstalling it.* Make sure your computer is connected to the server on which the
OLE server application resides.* Close the OLE server and restart it outside of
Microsoft Office Access. Then try the original operation again from within Microsoft
Office Access.@@1@@1
There was a problem accessing a property or method of the OLE object.@Try one or
more of the following:* Verify that the OLE server is registered correctly by
reinstalling it.* Make sure your computer is connected to the server on which the
OLE server application resides.* Close the OLE server and restart it outside of
Microsoft Access. Then try the original operation again from within Microsoft
Access.@@1@@1

There was a problem initializing the dynamic-link library Msole20 when you tried to
perform the OLE operation.@* You may have too many Microsoft applications open.
Close Windows applications other than Microsoft Office Access, and try the OLE
operation again.* Your computer may have an older version of the dynamic-link
library Msole20, in which case you will need to run Setup to reinstall Microsoft Office
Access.If you need to reinstall Microsoft Office Access, you may want to preserve
your security or custom settings by backing up the Microsoft Office Access
workgroup information file.For information on backing up files, search the
Microsoft Windows Help index for 'backing up files'.@@1@@1
There was a problem initializing the dynamic-link library Msole20 when you tried to
perform the OLE operation.@* You may have too many Microsoft applications open.
Close Windows applications other than Microsoft Access, and try the OLE operation
again.* Your computer may have an older version of the dynamic-link library
Msole20, in which case you will need to run Setup to reinstall Microsoft Access.If
you need to reinstall Microsoft Access, you may want to preserve your security or
custom settings by backing up the Microsoft Access workgroup information file.For
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@@1@@1
The method you tried to invoke on an object failed.@* You may have specified too
many or too few arguments for a property or method of an object. Check the
component's documentation for information on the properties and methods it makes
available for Automation operations.* There may not be enough memory to run
the procedure. Close unneeded programs and try to run the procedure again.For
more information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@@1
The method you tried to invoke on an object failed.@* You may have specified too
many or too few arguments for a property or method of an object. Check the
component's documentation for information on the properties and methods it makes
available for Automation operations.* There may not be enough memory to run
the procedure. Close unneeded programs and try to run the procedure again.For
more information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@1
An error occurred while referencing the
procedure that improperly references a
An error occurred while referencing the
procedure that improperly references a

object.@You tried to run a Visual Basic
property or method of an object.@@1@@@1
object.@You tried to run a Visual Basic
property or method of an object.@@1@@1

There was a problem referencing a property or method of an object.@Check the
component's documentation for information on the properties and methods it makes
available for Automation operations.@@1@@@1
There was a problem referencing a property or method of an object.@Check the
component's documentation for information on the properties and methods it makes
available for Automation operations.@@1@@1
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Access

2762

2007

2003

2763

2007

2003

2764

2007

2003

2765

2007

2003

2766

2007

2003

2767

2007

2003

2768

2007

2003

Error Description
| returned an error while referencing a property of an object.@Check the
component's documentation for information on the properties and methods it makes
available for Automation operations.@@1@@@1
| returned an error while referencing a property of an object.@Check the
component's documentation for information on the properties and methods it makes
available for Automation operations.@@1@@1
|1 returned the error: |2.@Check the component's documentation for information
on the properties and methods it makes available for Automation
operations.@@1@@@1
|1 returned the error: |2.@Check the component's documentation for information
on the properties and methods it makes available for Automation
operations.@@1@@1

The object's property or method can't be set.@You tried to run a Visual Basic
procedure to set a property or apply a method for an object. However, the property
or method doesn't support named arguments.@Check the component's
documentation for information on the properties and methods it makes available to
Automation operations.@1@@@1
The object's property or method can't be set.@You tried to run a Visual Basic
procedure to set a property or apply a method for an object. However, the property
or method doesn't support named arguments.@Check the component's
documentation for information on the properties and methods it makes available to
Automation operations.@1@@1
Visual Basic can't convert the data type of one of the arguments you entered.@You
tried to run a Visual Basic procedure that executes a method or sets a property of
an object.@Check the component's documentation for information on the properties
and methods it makes available for Automation operations.@1@@@1
Visual Basic can't convert the data type of one of the arguments you entered.@You
tried to run a Visual Basic procedure that executes a method or sets a property of
an object.@Check the component's documentation for information on the properties
and methods it makes available for Automation operations.@1@@1
The object doesn't contain the Automation object '|.'@You tried to run a Visual Basic
procedure to set a property or method for an object. However, the component
doesn't make the property or method available for Automation operations.@Check
the component's documentation for information on the properties and methods it
makes available for Automation operations.@1@@@1
The object doesn't contain the Automation object '|.'@You tried to run a Visual Basic
procedure to set a property or method for an object. However, the component
doesn't make the property or method available for Automation operations.@Check
the component's documentation for information on the properties and methods it
makes available for Automation operations.@1@@1
The object doesn't support American English; it was
language.@Use a version of the object developed in
language you are using.@@1@@@1
The object doesn't support American English; it was
language.@Use a version of the object developed in
language you are using.@@1@@1

developed using a different
Visual Basic that supports the
developed using a different
Visual Basic that supports the

The number you used to reference an element in the array is outside the bounds of
the array.@For example, the array is from 0 through 10, and you entered a -1 or an
11.@Check the component's documentation for information on the properties and
methods it makes available for Automation operations.@1@@@1
The number you used to reference an element in the array is outside the bounds of
the array.@For example, the array is from 0 through 10, and you entered a -1 or an
11.@Check the component's documentation for information on the properties and
methods it makes available for Automation operations.@1@@1
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Access

2769

2007

2003

2770

2007
2003

2771

2007

2003

2774

2007

2003

2775

2007

2003

2777

2007

2003

2778

2007

2003
2002

Error Description
A property of the Automation object requires or returns a data type that isn't
supported by Visual Basic.@You tried to run a Visual Basic procedure that
references an Automation object's property. However, the value of the property
isn't supported by Visual Basic.@Check the component's documentation for
information on the properties and methods it makes available for Automation
operations.@1@@@1
A property of the Automation object requires or returns a data type that isn't
supported by Visual Basic.@You tried to run a Visual Basic procedure that
references an Automation object's property. However, the value of the property
isn't supported by Visual Basic.@Check the component's documentation for
information on the properties and methods it makes available for Automation
operations.@1@@1
The object you referenced in the Visual Basic procedure as an OLE object isn't an
OLE object.@@@1@@@1
The object you referenced in the Visual Basic procedure as an OLE object isn't an
OLE object.@@@1@@1
The bound or unbound object frame you tried to edit does not contain an OLE
object.@Right-click the frame, click Insert Object, and then use the dialog box to
locate and either add or link to an object from a file that is not
empty.@@1@1@9360@1
The bound or unbound object frame you tried to edit doesn't contain an OLE
object.@Use the Object command on the Insert menu to add an OLE object to the
bound or unbound object frame.@@1@109360@1
The component doesn't support Automation.@You tried to run a Visual Basic
procedure that references an Automation object.@Check the component's
documentation for information on whether it supports Automation.@1@@@1
The component doesn't support Automation.@You tried to run a Visual Basic
procedure that references an Automation object.@Check the component's
documentation for information on whether it supports Automation.@1@@1
You specified too many arguments in the Visual Basic procedure, or there isn't
enough memory to run the procedure.@Specify fewer arguments, or close
unneeded programs, and then try to run the procedure again.For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@@1
You specified too many arguments in the Visual Basic procedure, or there isn't
enough memory to run the procedure.@Specify fewer arguments, or close
unneeded programs, and then try to run the procedure again.For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@1
The class argument in the CreateObject function of the Visual Basic procedure
you're trying to run is invalid.@Try one of the following:* Make sure the file is
installed on your computer and that you used the correct file name.* Check the
OLE server's documentation for information about the syntax to use when specifying
an OLE object's data.@@1@3@1010851@1
The class argument in the CreateObject function of the Visual Basic procedure
you're trying to run is invalid.@Try one of the following:* Make sure the file is
installed on your computer and that you used the correct file name.* Check the
OLE server's documentation for information about the syntax to use when specifying
an OLE object's data.@@1@1010851@1
Microsoft Office Access tried to create an OLE link, but there was no source
document for this object.@@@1@@@1
Microsoft Office Access tried to create an OLE link, but there was no source
document for this object.@@@1@@1
Microsoft Access tried to create an OLE link, but there was no source document for
this object.@@@1@@1
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Access

2782

2007

2003

2783

2007

2003

2002

2784

2007
2003

2785

2007

2003

2786

2007

2003

2788

2007
2003

2790

2007

2003

2791

2007

2003

Error Description
You must specify a property or method for the object.@You tried to run a Visual
Basic procedure that references and sets a property or method for the
object.@Enter a property or method for the object.@1@1@6968@1
You must specify a property or method for the object.@You tried to run a Visual
Basic procedure that references and sets a property or method for the
object.@Enter a property or method for the object.@1@606968@1
You entered an invalid setting for the Action property.@Use one of the Microsoft
Office Access intrinsic constants for the Action property.For a list of valid settings
you can use with the Action property, click Help.@@2@1@6967@1
You entered an invalid setting for the Action property.@Use one of the Microsoft
Office Access intrinsic constants for the Action property.For a list of valid settings
you can use with the Action property, click Help.@@2@606967@1
You entered an invalid setting for the Action property.@Use one of the Microsoft
Access intrinsic constants for the Action property.For a list of valid settings you
can use with the Action property, click Help.@@2@606967@1

The path you entered for the SourceDoc property setting for a linked OLE object is
too long.@Move the file to a location with a shorter path.@@1@1@6973@1
The path you entered for the SourceDoc property setting for a linked OLE object is
too long.@Move the file to a location with a shorter path.@@1@606973@1
The OLE server wasn't able to open the object.@* The OLE server may not be
installed.* You may have specified an invalid setting for the SourceDoc or
SourceItem property in a property sheet, a macro, or a Visual Basic procedure.@To
see the valid settings for either of these properties, search the Help index for the
property topic.@1@1@6973@1
The OLE server wasn't able to open the object.@* The OLE server may not be
installed.* You may have specified an invalid setting for the SourceDoc or
SourceItem property in a property sheet, a macro, or a Visual Basic procedure.@To
see the valid settings for either of these properties, search the Help index for the
property topic.@1@606973@1
The OLE server doesn't support linking.@You tried to run a Visual Basic procedure
using the Action property. However, you provided insufficient information to
establish a link.@@1@@@1
The OLE server doesn't support linking.@You tried to run a Visual Basic procedure
using the Action property. However, you provided insufficient information to
establish a link.@@1@@1

The | object isn't a linked object.@The property you tried to set in Visual Basic
applies only to linked objects.@@1@@@1
The | object isn't a linked object.@The property you tried to set in Visual Basic
applies only to linked objects.@@1@@1
You can't embed an OLE object into a bound or unbound object frame if the
OLETypeAllowed property for the bound or unbound object frame is set to
Linked.@Insert a linked object, or set the OLETypeAllowed property to Embedded or
Either, and then embed the object.@@1@1@6439@1
You can't embed an OLE object into a bound or unbound object frame if the
OLETypeAllowed property for the bound or unbound object frame is set to
Linked.@Insert a linked object, or set the OLETypeAllowed property to Embedded or
Either, and then embed the object.@@1@606439@1
Microsoft Office Access can't link the OLE object or the bound or unbound object
frame.@The OLETypeAllowed property for the bound or unbound object frame is set
to Embedded.@Embed the object, or set the OLETypeAllowed property to Linked or
Either, and then link the object.@1@1@6439@1
Microsoft Office Access can't link the OLE object or the bound or unbound object
frame.@The OLETypeAllowed property for the bound or unbound object frame is set
to Embedded.@Embed the object, or set the OLETypeAllowed property to Linked or
Either, and then link the object.@1@606439@1
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Access

2791

2002

Microsoft Access can't link the OLE object or the bound or unbound object
frame.@The OLETypeAllowed property for the bound or unbound object frame is set
to Embedded.@Embed the object, or set the OLETypeAllowed property to Linked or
Either, and then link the object.@1@606439@1

2792

2007
2003

You can't save a locked OLE object.@@@1@@@1
You can't save a locked OLE object.@@@1@@1

2793

2007

Microsoft Office Access can't perform the operation specified in the Action property
of the Visual Basic procedure you're trying to run.@The object frame may be locked
or disabled.@Set the Locked property to No and the Enabled property to
Yes.@1@@@1
Microsoft Office Access can't perform the operation specified in the Action property
of the Visual Basic procedure you're trying to run.@The object frame may be locked
or disabled.@Set the Locked property to No and the Enabled property to
Yes.@1@@1
Microsoft Access can't perform the operation specified in the Action property of the
Visual Basic procedure you're trying to run.@The object frame may be locked or
disabled.@Set the Locked property to No and the Enabled property to Yes.@1@@1

2003

2002

2794

2007
2003

2797

2007

2003

2798

2007

2003

2000

2799

2007

Error Description

The ActiveX control you tried to insert isn't registered.@For information on
registering an ActiveX control, click Help.@@2@1@12639@1
The ActiveX control you tried to insert isn't registered.@For information on
registering an ActiveX control, click Help.@@2@212639@1
This OLE object was created in an earlier version of OLE so it can't be displayed as
an icon.@For an effect similar to displaying an object as an icon, add an image
control to your form, and add the icon for the application to the image control. Then
set the image control's OnDblClick property to a Visual Basic procedure that opens
the OLE object.@@1@@@1
This OLE object was created in an earlier version of OLE so it can't be displayed as
an icon.@For an effect similar to displaying an object as an icon, add an image
control to your form, and add the icon for the application to the image control. Then
set the image control's OnDblClick property to a Visual Basic procedure that opens
the OLE object.@@1@@1

You can't use the Action property to delete a bound OLE object from its underlying
table or query.@You tried to run a Visual Basic procedure that deletes the object in
a bound object frame by setting the Action property to acOLEDelete.@Delete the
object in a different way, such as with the DAO Delete method in Visual
Basic.@1@1@13790@1
You can't use the Action property to delete a bound OLE object from its underlying
table or query.@You tried to run a Visual Basic procedure that deletes the object in
a bound object frame by setting the Action property to acOLEDelete.@Delete the
object in a different way, such as with the DAO Delete method in Visual
Basic.@1@613790@1
You can't use the Action property to delete a bound OLE object from its underlying
table or query.@You tried to run a Visual Basic procedure that deletes the object in
a bound object frame by setting the Action property to acOLEDelete.@Delete the
object in a different way, such as with the DAO Delete method in Visual
Basic.@1@2008702@1
The OLE object can't be activated upon receiving the focus.@If you selected an OLE
object or a chart, and the AutoActivate property for that control is set to GetFocus,
the OLE object or chart should be activated automatically when it receives the
focus. However, the ActiveX component doesn't support this operation.@Check the
component's documentation for information on the properties and methods it makes
available to Automation operations.@1@@@1
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Access

2799

2003

The OLE object can't be activated upon receiving the focus.@If you selected an OLE
object or a chart, and the AutoActivate property for that control is set to GetFocus,
the OLE object or chart should be activated automatically when it receives the
focus. However, the ActiveX component doesn't support this operation.@Check the
component's documentation for information on the properties and methods it makes
available to Automation operations.@1@@1

2800

2007

This object is locked. Any changes you make will be discarded when the form is
closed.@Click the Microsoft Office Button, point to Save As, and save the object
under a different name.@@1@@@1
The object is locked, so any changes you make will be discarded when the form is
closed.@Click Save As on the File menu and save the object under a different
name.@@1@@1
The object is locked, so any changes you make will be discarded when the form is
closed.@Click Save As/Export on the File menu and save the object under a
different name.@@1@@1

2003

2000

2801

2007
2003

2802

2007
2003

2803

2007

2003

2804

2007
2003

2805

2007

2003

Error Description

The OLE object isn't loaded because the unbound ActiveX control hasn't been
initialized.@@@1@1@9015@1
The OLE object isn't loaded because the unbound ActiveX control hasn't been
initialized.@@@1@109015@1
You can't insert an ActiveX control in a
controls are automatically contained in
You can't insert an ActiveX control in a
controls are automatically contained in

bound or unbound object frame.@ActiveX
ActiveX control frames.@@1@@@1
bound or unbound object frame.@ActiveX
ActiveX control frames.@@1@@1

You don't have the license required to use this ActiveX control.@You tried to open a
form containing an OLE object or an ActiveX control or you tried to create an
ActiveX control.@To obtain the appropriate license, contact the company that
provides the licensed OLE object or ActiveX control.@1@@@1
You don't have the license required to use this ActiveX control.@You tried to open a
form containing an OLE object or an ActiveX control or you tried to create an
ActiveX control.@To obtain the appropriate license, contact the company that
provides the licensed OLE object or ActiveX control.@1@@1

You can't create an ActiveX control in an unbound object frame.@ActiveX controls
are automatically contained in ActiveX control frames.@@1@1@11711@1
You can't create an ActiveX control in an unbound object frame.@ActiveX controls
are automatically contained in ActiveX control frames.@@1@211711@1
There was an error loading an ActiveX control on one of your forms or
reports.@Make sure all the controls that you are using are properly registered. For
information on registering an ActiveX control, click Help.@@2@1@12639@1
There was an error loading an ActiveX control on one of your forms or
reports.@Make sure all the controls that you are using are properly registered. For
information on registering an ActiveX control, click Help.@@2@212639@1

2806

2007
2003
2002

Microsoft Office Access doesn't support this ActiveX control.@@@1@@@1
Microsoft Office Access doesn't support this ActiveX control.@@@1@@1
Microsoft Access doesn't support this ActiveX control.@@@1@@1

2807

2007

You can't paste this object as the type you specified.@Choose another object
type.@@1@@@1
You can't paste this object as the type you specified.@Choose another object
type.@@1@@1

2003
2808

2007
2003
2002

Microsoft Office Access can't find the Active Accessibility dynamic-link library (DLL)
OleAcc.@Rerun the Microsoft Office Access Setup program.@@1@@@3
Microsoft Office Access can't find the Active Accessibility dynamic-link library (DLL)
OleAcc.@Rerun the Microsoft Office Access Setup program.@@1@@3
Microsoft Access can't find the Active Accessibility dynamic-link library (DLL)
OleAcc.@Rerun the Microsoft Access Setup program.@@1@@3
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Access

2809

2007
2000

Error Description
An error has occurred while loading the Microsoft Access Page. Make sure you have
the linked HTML file on the file system.

2811

2007
2002

Microsoft Office Access is unable to create the data access page.
Microsoft Access is unable to create the data access page.

2812

2007

|@The path specified was invalid, or may be too long.@Please check the path and
ensure it is correct.@1@@@1
|@The path specified was invalid, or may be too long.@Please check the path and
ensure it is correct.@1@@1
Microsoft Access encountered an invalid path to a data access page. You may need
to re-create a Page link.

2003
2000
2813

2007
2003

|@The file could not be opened. It may currently be in use.@@1@@@1
|@The file could not be opened. It may currently be in use.@@1@@1

2814

2007
2003

|@Unable to save the file.@@1@@@1
|@Unable to save the file.@@1@@1

2815

2007
2003

|@Unable to save the file to an alternate location.@@1@@@1
|@Unable to save the file to an alternate location.@@1@@1

2816

2007
2003

|@Unable to close the file.@@1@@@1
|@Unable to close the file.@@1@@1

2817

2007
2002

Microsoft Office Access is unable to save (or send) the data access page.
Microsoft Access is unable to save (or send) the data access page.

2818

2007

Microsoft Office Access is unable to retrieve the file: |.@Either the file is not
available, or you do not have enough disk space to copy the file.@@1@@@
Microsoft Office Access is unable to retrieve the file: |.@Either the file is not
available, or you do not have enough disk space to copy the file.@@1@@
Microsoft Access is unable to retrieve the file: |.@Either the file is not available, or
you do not have enough disk space to copy the file.@@1@@

2003
2002
2819

2007
2002

Microsoft Office Access is unable to open the data access page.
Microsoft Access is unable to open the data access page.

2820

2007
2002

Microsoft Office Access is unable to change the BASE HREF for your document.
Microsoft Access is unable to change the BASE HREF for your document.

2821

2007

File in use

2822

2007

Microsoft Office Access encountered an unexpected error while attempting to
recover from a failed save (or send).@Your data access page may not be in a
usable state. Please attempt to save to a different location.@@1@@@
Microsoft Office Access encountered an unexpected error while attempting to
recover from a failed save (or send).@Your data access page may not be in a
usable state. Please attempt to save to a different location.@@1@@
Microsoft Access encountered an unexpected error while attempting to recover from
a failed save (or send).@Your data access page may not be in a usable state.
Please attempt to save to a different location.@@1@@

2003

2002

2823

2007

2003

The Microsoft Office Access data access page name '|' is misspelled or refers to a
Page that doesn't exist.@If the invalid Page name is in a macro, an Action Failed
dialog box will display the macro name and the macro's arguments after you click
OK. Open the Macro window, and enter the correct Page name.@@1@@@1
The Microsoft Office Access data access page name '|' is misspelled or refers to a
Page that doesn't exist.@If the invalid Page name is in a macro, an Action Failed
dialog box will display the macro name and the macro's arguments after you click
OK. Open the Macro window, and enter the correct Page name.@@1@@1
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Access

2823

2002

The Microsoft Access data access page name '|' is misspelled or refers to a Page
that doesn't exist.@If the invalid Page name is in a macro, an Action Failed dialog
box will display the macro name and the macro's arguments after you click OK.
Open the Macro window, and enter the correct Page name.@@1@@1

2824

2007
2003

|@You do not have adequate file permissions.@@1@@@1
|@You do not have adequate file permissions.@@1@@1

2825

2007
2003

|@The file does not exist, or you do not have read access to the file.@@1@@@1
|@The file does not exist, or you do not have read access to the file.@@1@@1

2827

2007
2003

|@File read error.@@1@@@1
|@File read error.@@1@@1

2828

2007
2003

|@File write error.@The disk may be full.@1@@@1
|@File write error.@The disk may be full.@1@@1

2832

2007

|@Check file permissions and delete them from their location in your computer's file
system.@@1@@@1
|@Check file permissions and delete them from their location in your computer's file
system.@@1@@1
|@One or more files were not found, or you do not permission to delete
them.@Some data access files may not have been deleted.@1@@1

2003
2000

Error Description

2833

2007
2003

|@An unexpected error has occurred.@@1@@@1
|@An unexpected error has occurred.@@1@@1

2835

2007

|@An attempt to create this file has failed.@Please select another location and retry
the operation.@1@@@1
|@An attempt to create this file has failed.@Please select another location and retry
the operation.@1@@1

2003
2837

2007
2003

|@There was not enough memory.@Please close other applications and try the
operation again.@1@@@1
|@There was not enough memory.@Please close other applications and try the
operation again.@1@@1

2838

2007
2002

Microsoft Office Access is unable to preview the selected theme.
Microsoft Access is unable to preview the selected theme.

2839

2007

|@An attempt to create a temporary file has failed.@Please confirm that you have
adequate disk space on your system drive and try the operation again.@1@@@1
|@An attempt to create a temporary file has failed.@Please confirm that you have
adequate disk space on your system drive and try the operation again.@1@@1

2003
2840

2007
2003

|@Unable to read the list of supporting files from the data access page.@@1@@@1
|@Unable to read the list of supporting files from the data access page.@@1@@1

2842

2007

Microsoft Office Access encountered an error after saving (or sending) your data
access page.
Microsoft Access encountered an error after saving (or sending) your data access
page.

2002
2845

2007
2002

2846

2007
2003

2847

2007

Microsoft Office Access is unable to open the data access page from the mail
envelope.
Microsoft Access is unable to open the data access page from the mail envelope.

|@The save destination is full.@Please clear space at the destination or save to
another location.@1@@@1
|@The save destination is full.@Please clear space at the destination or save to
another location.@1@@1
|@Unable to create a folder for the supporting files.@You may not have adequate
permissions at the save destination.@1@@@1
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2847

2003

|@Unable to create a folder for the supporting files.@You may not have adequate
permissions at the save destination.@1@@1

2848

2007

|@The maximum path length was exceeded.@Please specifiy a shorter filename, or
use a folder that is closer to the root.@1@@@1
|@The maximum path length was exceeded.@Please specifiy a shorter filename, or
use a folder that is closer to the root.@1@@1
|@The maximum path length was exceeded.@Please save your data access page
with a shorter name, or in a folder that is closer to the root.@1@@1

2003
2000

2849

2007
2003

Error Description

|@There are too many supporting files in your document.@Please remove a few
supporting files from your document, and try again.@1@@@1
|@There are too many supporting files in your document.@Please remove a few
supporting files from your document, and try again.@1@@1

2850

2007
2003

|@You do not have write permission at the save destination.@@1@@@1
|@You do not have write permission at the save destination.@@1@@1

2851

2007

|@You are saving to a server that does not support long filenames and do not have
permission to create a folder.@You must have permission to create a folder at the
save destination to complete this operation.@1@@@1
|@You are saving to a server that does not support long filenames and do not have
permission to create a folder.@You must have permission to create a folder at the
save destination to complete this operation.@1@@1

2003

2854

2007
2003
2002

Microsoft Office Access was unable to parse the document properties for this data
access page.@They may be corrupted.@@1@@@1
Microsoft Office Access was unable to parse the document properties for this data
access page.@They may be corrupted.@@1@@1
Microsoft Access was unable to parse the document properties for this data access
page.@They may be corrupted.@@1@@1

2855

2007
2002
2000

Microsoft Office Access could not delete one or more files related to the page.
Microsoft Access could not delete one or more files related to the page.
Microsoft Access was unable to delete the data access page file(s).

2859

2007

Access could not load the e-mail envelope.
connection problem or a problem with your
Access could not load the e-mail envelope.
connection problem or a problem with your
Access could not load the e-mail envelope.
connection problem or a problem with your

2003
2000

This could be caused by a network
Office installation.@@@1@@@1
This could be caused by a network
Office installation.@@@1@@1
This could be caused by a network
Office installation.@@1@@1

2860

2007
2000

You cannot insert a bound field to a caption or record navigation section.
You cannot drag a bound field to a caption or record navigation section.

2861

2007
2002

Microsoft Office Access is unable to preview the selected web page.
Microsoft Access is unable to preview the selected web page.

2862

2007

|@Access cannot open the specified file type from a Web server.@You may have
selected the wrong file.@1@@@1
|@The file you attempted to load was not recognized as HTML.@You may have
selected the wrong file, or tried to open a database file off of a web server.@1@@1

2003
2863

2007
2003

2864

2007

2003

|@Unable to create or load a file due to network or access permission
problems.@@1@@@1
|@Unable to create or load a file due to network or access permission
problems.@@1@@1
|@This file (or a supporting file) is already in use, or has the read-only attribute
set.@@1@@@1
|@This file (or a supporting file) is already in use, or has the read-only attribute
set.@@1@@1
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2865

2007
2003

|@The disk is write-protected.@@1@@@1
|@The disk is write-protected.@@1@@1

2866

2007
2003

|@Unexpected data corruption failure.@@1@@@1
|@Unexpected data corruption failure.@@1@@1

2867

2007
2003

|@Unexpected data I/O failure.@@1@@@1
|@Unexpected data I/O failure.@@1@@1

2868

2007

|@You cannot save this data access page over itself because it is read-only.@Please
select a different file for the save.@1@@@1
|@You cannot save this data access page over itself because it is read-only.@Please
select a different file for the save.@1@@1

2003
2869

2007

2003

2870

2007

2003

2002
2000

2871

2007

2003

2002

2873

2007

2003

2000

Error Description

|@The file does not exist.@You do not have adequate permission to modify the data
access page link to point to a valid file. Please contact the database
administrator.@1@@@1
|@The file does not exist.@You do not have adequate permission to modify the data
access page link to point to a valid file. Please contact the database
administrator.@1@@1
Microsoft Office Access encountered an error synchronizing the HTML from the
Microsoft Script Editor.@Please check the HTML for syntax errors and try
again.@@1@@@1
Microsoft Office Access encountered an error synchronizing the HTML from the
Microsoft Script Editor.@Please check the HTML for syntax errors and try
again.@@1@@1
Microsoft Access encountered an error synchronizing the HTML from the Microsoft
Script Editor.@Please check the HTML for syntax errors and try again.@@1@@1
Microsoft Access encountered an error synchronizing the HTML from the Microsoft
Script Editor.@Please check the HTML for syntax errors and try again.@1@@1

Microsoft Office Access is unable to create a data access page using the codepage
selected in Web Options.@The codepage may not be installed on your
system.@Please install the codepage, or select a different one in Web
Options.@1@@@1
Microsoft Office Access is unable to create a data access page using the codepage
selected in Web Options.@The codepage may not be installed on your
system.@Please install the codepage, or select a different one in Web
Options.@1@@1
Microsoft Access is unable to create a data access page using the codepage
selected in Web Options.@The codepage may not be installed on your
system.@Please install the codepage, or select a different one in Web
Options.@1@@1
|@The filename specified is a long filename, but you have the 'use long filenames'
web option turned off.@Please specify a file name that uses a maximum of eight
characters for the name and three characters for the file extension.@1@@@1
|@The filename specified is a long filename, but you have the 'use long filenames'
web option turned off.@Please specify a file name that uses a maximum of eight
characters for the name and three characters for the file extension.@1@@1
|@The filename specified is a long filename, but you have the 'use long filenames'
web option turned off.@Please specify a valid short (8.3) filename.@1@@1

2874

2007

Cannot move or paste the grouping field '|' into a section at a higher group level

2875

2007

|@Unable to complete
save to may no longer
|@Unable to complete
save to may no longer

2003
2876

2007

the save.@The drive or network connection you attempted to
be available.@1@@@1
the save.@The drive or network connection you attempted to
be available.@1@@1

The data definition of this data access page has been corrupted and can't be
repaired. You must recreate the page. Save has been disabled.
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2877

2007

2002

Error Description
In a Microsoft Office Access database (.mdb), you can't group on a control bound to
a field that has a Memo or OLE Object data type. In a Microsoft Office Access
project (.adp), you can't group on a control bound to a field that has an Image or
Text data type.
In a Microsoft Access database (.mdb), you can't group on a control bound to a field
that has a Memo or OLE Object data type. In a Microsoft Access project (.adp), you
can't group on a control bound to a field that has an Image or Text data type.

2878

2007

You cannot add a bound field to a caption or record navigation section.

2879

2007
2000

Caption and record navigation sections cannot contain bound fields.
Caption and record navigation section cannot contain bound fields.

2880

2007

Can't edit pages that contain framesets.

2881

2007

This web page contains XML namespaces that may conflict with Access
namespaces. You should edit the HTML source to ensure that all namespaces have
a unique prefix.

2882

2007

|@The folder that this Web page would use to organize supporting files is already
reserved for use in the current location.@Please choose a different name or location
for this Web page.@1@@@1
|@The folder that this Web page would use to organize supporting files is already
reserved for use in the current location.@Please choose a different name or location
for this Web page.@1@@1

2003

2883

2007

2003

2884

2007

2000

A supporting file path for this data access page has been altered outside
Access.@Please save this page to a different location and ensure that all
files are maintained.@@1@@@1
A supporting file path for this data access page has been altered outside
Access.@Please save this page to a different location and ensure that all
files are maintained.@@1@@1

of
supporting

of
supporting

Cannot find the database or some database objects that this page refers to.
Update the connection information of the page, or fix the references to the missing
database objects.
Some database objects cannot be located in the database since this page was
designed. Use Page View of the Field List to find the references to these objects
and right click the mouse to delete them or change their source.

2885

2007

This page uses a database which is not supported. You will not be able to make
data changes until you connect to a supported database

2886

2007

Components necessary for data access pages are not installed.

2887

2007

|@The path specified is not a valid absolute (non-relative) path or URL.@Please
enter a valid path.@1@@@1
|@The path specified is not a valid absolute (non-relative) path or URL.@Please
enter a valid path.@1@@1
The hyperlink base specified is not a valid path or URL.@Please correct this
entry.@@1@@1

2003
2000
2888

2007

2002

Microsoft Office Access detects some HTML elements between the banner and the
section of your data access page. Saving this page in Access will corrupt it. Close
the page without saving it, and then edit the page in another HTML editor to
remove these elements.
Microsoft Access detects some HTML elements between the banner and the section
of your data access page. Saving this page in Access will corrupt it. Close the page
without saving it, and then edit the page in another HTML editor to remove these
elements.

2889

2007

This section cannot be deleted.

2890

2007

You cannot edit this page because it contains frames.@The data access page
designer cannot edit pages with frames.@@1@@@1
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2890

2003

2891

2007
2000

Error Description
You cannot edit this page because it contains frames.@The data access page
designer cannot edit pages with frames.@@1@@1

|@You cannot save the data access page because it is in browse mode.@To save
the page, switch to edit mode and try again.@1@@1

2892

2007

You can't move the group filter control to another section. Delete the group filter
control from the current section and create it in a different section.

2893

2007

A link to this data access page could not be created because the database cannot
be exclusively locked.@To create the link later, open the page by selecting 'Edit web
page that already exists', and then save.@@1@@@1
A link to this data access page could not be created because the database cannot
be exclusively locked.@To create the link later, open the page by selecting 'Edit web
page that already exists', and then save.@@1@@1
This page was designed with a later version of the Microsoft Office Web Components
than those currently installed on your machine. If you have not been prompted to
install those components on this page, please contact the page author for the
installation location.

2003

2000

2894

2007

2003

2000

2895

2007

2002

2000

2896

2007
2003

2897

2007

2002

2898

2007

2002

The link to the data access page specified could not be updated because the
database cannot be exclusively locked.@To update the link, open this page again
when you are the only person using the database.@@1@@@1
The link to the data access page specified could not be updated because the
database cannot be exclusively locked.@To update the link, open this page again
when you are the only person using the database.@@1@@1
A link to this data access page could not be created because the database cannot
be exclusively locked.@To create the link later, open the page by selecting 'Edit web
page that already exists', and then save.@@1@@1
This page was designed with a version of the Microsoft Office Web Components that
is not currently installed on this machine. If you have not been prompted to install
those components on this page, please contact the page author for the installation
location.
This page was designed with a later version of the Microsoft Office Web Components
than those currently installed on your machine. If you have not been prompted to
install those components on this page, please contact the page author for the
installation location.
The link to the data access page specified could not be updated because the
database cannot be exclusively locked.@To update the link, open this page again
when you are the only person using the database.@@1@@1

The operation is only valid on a
switch the page to Design View
The operation is only valid on a
switch the page to Design View

data access page opened in Design View.@Please
and try the operation again.@@1@@@1
data access page opened in Design View.@Please
and try the operation again.@@1@@1

You have opened a page that was last modified using Access 2000. To be able to
edit the page, you must save it using a more recent version of the Microsoft Office
Web Components. Do you want Access to convert this page by saving it using a
more recent version of the Microsoft Office Web Components?
You have opened a page that was last designed using Access 2000. The page must
be saved using Office XP Office Web Components before you can edit this
document.Would you like to convert this page?
Microsoft Office Access has created a backup copy of your original page. This page
can be used if you want to revert to the Office 2000 Web Components.The
backup page name is: '|'
Microsoft Access has created a backup copy of your original page. This page can be
used if you want to revert to the Office 2000 Web Components.The backup page
name is: '|'
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2899

2007
2002

2900

2007
2002

Error Description
Microsoft Office Access could not create a backup copy of your original page. This
page cannot be opened.
Microsoft Access could not create a backup copy of your original page. This page
cannot be opened.
Microsoft Office Access could not upgrade the Office Web Components on your
page. This page cannot be opened.
Microsoft Access could not upgrade the Office Web Components on your page. This
page cannot be opened.

2901

2007

Error loading ActiveX control '|1' on form or report '|2'.

2902

2007

Access is unable to save the | object because it does not support persistence, or
your computer may have run out of disk space.

2903

2007

Do you want to set this folder as the default location for data access
pages?@|@@19@@@1
Do you want to set this folder as the default location for data access
pages?@|@@19@@1

2003

2904

2007
2003

You must match each field on the left with a field on the right.@@@1@@@1
You must match each field on the left with a field on the right.@@@@@1

2905

2007
2003

You must choose a linking field for every parameter.@@@1@@@1
You must choose a linking field for every parameter.@@@@@1

2906

2007

2003

'|' contains no fields that can participate in a relationship.@The contents of the
RecordSource property may be invalid, or the RecordSource may contain only fields
that are not acceptable for use in a join.@Correct the RecordSource property for
this form or report and try your field operation again.@1@@@1
'|' contains no fields that can participate in a relationship.@@@@@1

2907

2007
2003

Do you want to revert to the saved '|'?@@@19@@@1
Do you want to revert to the saved '|'?@@@19@@1

2908

2007

The Control ID '|' is already in use. Specify a different ID for the
control.@@@@@@1
The Control ID '|' is already in use. Specify a different ID for the control.@@@@@1

2003

2909

2007

2003

2910

2007
2003

2911

2007
2003

2912

2007

2003

This relationship is not valid because
fields in the second table.@To repair
each table.@@@@@1
This relationship is not valid because
fields in the second table.@To repair
each table.@@@@1

the fields in the first table do not match the
the relationship, select at least one field from
the fields in the first table do not match the
the relationship, select at least one field from

This connection file refers to a provider not supported by data access
pages.@Please select a different connection file.@@@@@1
This connection file refers to a provider not supported by data access
pages.@Please select a different connection file.@@@@1
You cannot change the data access page path while it it open.@Please close the
page and try again.@@@@@1
You cannot change the data access page path while it it open.@Please close the
page and try again.@@@@1
If you create a data access page in this version of Access, you cannot open it in
Design view in Access 2000. If you have installed the Microsoft Office XP Web
Components, however, you can open this page in Page view in Access
2000.@&Don't show this warning again@@3@@@1
If you create a data access page in this version of Access, you cannot open it in
Design view in Access 2000. If you have installed the Microsoft Office XP Web
Components, however, you can open this page in Page view in Access
2000.@&Don't show this warning again@@3@@1
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2912

2002

If you create a data access page in this version of Microsoft Access, you can't open
it in Design view in Access 2000. However, you can open the page in Page view in
Access 2000, if you have installed the Microsoft Office XP Web
Components.@&Don't show this warning again@@3@@1

2913

2007

Cannot save to a URL address with a bookmark.@Please specify a valid
path.@@@@@1
Cannot save to a URL address with a bookmark.@Please specify a valid
path.@@@@1

2003
2914

2007

2003
2002
2915

2007

2003

2002

Error Description

Microsoft Office Access could not link to a connection file.@A connection string will
be embedded in the page.@@@@@1
Microsoft Office Access could not link to a connection file.@A connection string will
be embedded in the page.@@@@1
Microsoft Access could not link to a connection file.@A connection string will be
embedded in the page.@@@@1

Microsoft Office Access is unable to connect to the data source specified in the
connection string of this page.@The server may not exist on the network, or there
may be an error in the connection string information for this page.@@1@@@1
Microsoft Office Access is unable to connect to the data source specified in the
connection string of this page.@The server may not exist on the network, or there
may be an error in the connection string information for this page.@@1@@1
Microsoft Access is unable to connect to the data source specified in the connection
string of this page.@The server may not exist on the network, or there may be an
error in the connection string information for this page.@@1@@1

2916

2007
2002

You cannot edit HTML pages created using PowerPoint in Microsoft Office Access.
You cannot edit HTML pages created using PowerPoint in Microsoft Access.

2917

2007

Invalid HTML color value.

2918

2007

Unable
the file
Unable
the file

2003

to open or read this connection file.@Either the file has been damaged or
format is not valid.@@@@@1
to open or read this connection file.@Either the file has been damaged or
format is not valid.@@@@1

2919

2007
2003

You can't place this control in the section you specified.@@@@@@1
You can't place this control in the section you specified.@@@@@1

2920

2007

Microsoft Office Access is unable to load the database schema. Save has been
disabled. Either repair or reinstall Microsoft Office.
Microsoft Access is unable to load the database schema. Save has been disabled.
Either repair or reinstall Microsoft Office XP.

2002
2921

2007

2002

Microsoft Office Access cannot open this page because it was created using a newer
version of Access. Try opening the page using a newer version of Microsoft Office
Access.
Microsoft Access cannot open this page because it was created using a newer
version of Access. Try opening the page using a newer version of Microsoft Access.

2922

2007

Microsoft Office Access has created a backup copy of your original page. This page
can be used if you want to revert to the Office XP Web Components.The backup
page name is: '|'

2923

2007

You do not have the correct permissions. Contact the server administrator.

2924

2007

You cannot compact a file that was opened from a Web Server.

2925

2007

You cannot encrypt a file that was opened from a Web Server.

2926

2007

Because of your security settings and current security policy, this control is
disabled. To modify your policy and enable the database, use the Message Bar.

3000

2007
2003

Reserved error (|); there is no message for this error.
Reserved error (|); there is no message for this error.@@@2@5363@1
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3001

2007

Invalid argument.

3002

2007

Could not start session.

3003

2007

Could not start transaction; too many transactions already nested.

3004

2007

**********

3005

2007

'|' is not a valid database name.

3006

2007

Database '|' is exclusively locked.

3007

2007

Cannot open library database '|'.

3008

2007

The table '|' is already opened exclusively by another user, or it is already open
through the user interface and cannot be manipulated programmatically.

3009

2007

You tried to lock table '|' while opening it, but the table cannot be locked because it
is currently in use. Wait a moment, and then try the operation again.

3010

2007

Table '|' already exists.

3011

2007

The Microsoft Office Access database engine could not find the object '|'. Make sure
the object exists and that you spell its name and the path name correctly.
The Microsoft Jet database engine could not find the object '|'. Make sure the
object exists and that you spell its name and the path name correctly.

2003

Error Description

3012

2007

Object '|' already exists.

3013

2007

Could not rename installable ISAM file.

3014

2007

Cannot open any more tables.

3015

2007

Index not found.

3016

2007

Field will not fit in record.

3017

2007

The size of a field is too long.

3018

2007

Could not find field.

3019

2007

Operation invalid without a current index.

3020

2007

Update or CancelUpdate without AddNew or Edit.

3021

2007

No current record.

3022

2007

The changes you requested to the table were not successful because they would
create duplicate values in the index, primary key, or relationship. Change the data
in the field or fields that contain duplicate data, remove the index, or redefine the
index to permit duplicate entries and try again.

3023

2007

AddNew or Edit already used.

3024

2007

Could not find file '|'.

3025

2007

Cannot open any more files.

3026

2007

Not enough space on disk.

3027

2007

Cannot update. Database or object is read-only.

3028

2007

Cannot start your application. The workgroup information file is missing or opened
exclusively by another user.

3029

2007

Not a valid account name or password.

3030

2007

'|' is not a valid account name.

3031

2007

Not a valid password.

3032

2007

Cannot perform this operation.

3033

2007

You do not have the necessary permissions to use the '|' object. Have your system
administrator or the person who created this object establish the appropriate
permissions for you.

3034

2007

You tried to commit or rollback a transaction without first beginning a transaction.
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3035

2007

System resource exceeded.

3036

2007

Database has reached maximum size.

3037

2007

Cannot open any more tables or queries.

3038

2007

System resource exceeded.

3039

2007

Could not create index; too many indexes already defined.

3040

2007

Disk I/O error during read.

3041

2007

Cannot open a database created with a previous version of your application.

3042

2007

Out of MS-DOS file handles.

3043

2007

Your network access was interrupted. To continue, close the database, and then
open it again.
Disk or network error.

2003

Error Description

3044

2007

'|' is not a valid path. Make sure that the path name is spelled correctly and that
you are connected to the server on which the file resides.

3045

2007

Could not use '|'; file already in use.

3046

2007

Could not save; currently locked by another user.

3047

2007

Record is too large.

3048

2007

Cannot open any more databases.

3049

2007

Cannot open database '|'. It may not be a database that your application
recognizes, or the file may be corrupt.

3050

2007

Could not lock file.

3051

2007

The Microsoft Office Access database engine cannot open or write to the file '|'. It is
already opened exclusively by another user, or you need permission to view and
write its data.
The Microsoft Jet database engine cannot open the file '|'. It is already opened
exclusively by another user, or you need permission to view its data.

2003
3052

2007

File sharing lock count exceeded. Increase MaxLocksPerFile registry entry.

3053

2007

Too many client tasks.

3054

2007

Too many Memo, OLE, or Hyperlink Object fields.

3055

2007

Not a valid file name.

3056

2007

Could not repair this database.

3057

2007

Operation not supported on linked tables.

3058

2007

Index or primary key cannot contain a Null value.

3059

2007

Operation canceled by user.

3060

2007

Wrong data type for parameter '|'.

3061

2007

Too few parameters. Expected |.

3062

2007

Duplicate output alias '|'.

3063

2007

Duplicate output destination '|'.

3064

2007

Cannot open action query '|'.

3065

2007

Cannot execute a select query.

3066

2007

Query must have at least one destination field.

3067

2007

Query input must contain at least one table or query.

3068

2007

Not a valid alias name.

3069

2007

The action query '|' cannot be used as a row source.
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3070

2007
2003

Error Description
The Microsoft Office Access database engine does not recognize '|' as a valid field
name or expression.
The Microsoft Jet database engine does not recognize '|' as a valid field name or
expression.

3071

2007

This expression is typed incorrectly, or it is too complex to be evaluated. For
example, a numeric expression may contain too many complicated elements. Try
simplifying the expression by assigning parts of the expression to variables.

3072

2007

|

3073

2007

Operation must use an updateable query.

3074

2007

Cannot repeat table name '|' in FROM clause.

3075

2007

|1 in query expression '|2'.

3076

2007

| in criteria expression.

3077

2007

| in expression.

3078

2007

The Microsoft Office Access database engine cannot find the input table or query '|'.
Make sure it exists and that its name is spelled correctly.
The Microsoft Jet database engine cannot find the input table or query '|'. Make
sure it exists and that its name is spelled correctly.

2003
3079

2007

The specified field '|' could refer to more than one table listed in the FROM clause of
your SQL statement.

3080

2007

Joined table '|' not listed in FROM clause.

3081

2007

Cannot join more than one table with the same name (|).

3082

2007

JOIN operation '|' refers to a field that is not in one of the joined tables.

3083

2007

Cannot use internal report query.

3084

2007

Cannot insert data with action query.

3085

2007

Undefined function '|' in expression.

3086

2007

Could not delete from specified tables.

3087

2007

Too many expressions in GROUP BY clause.

3088

2007

Too many expressions in ORDER BY clause.

3089

2007

Too many expressions in DISTINCT output.

3090

2007

Resultant table not allowed to have more than one AutoNumber field.

3091

2007

HAVING clause (|) without grouping or aggregation.

3092

2007

Cannot use HAVING clause in TRANSFORM statement.

3093

2007

ORDER BY clause (|) conflicts with DISTINCT.

3094

2007

ORDER BY clause (|) conflicts with GROUP BY clause.

3095

2007

Cannot have aggregate function in expression (|).

3096

2007

Cannot have aggregate function in WHERE clause (|).

3097

2007

Cannot have aggregate function in ORDER BY clause (|).

3098

2007

Cannot have aggregate function in GROUP BY clause (|).

3099

2007

Cannot have aggregate function in JOIN operation (|).

3100

2007

Cannot set field '|' in join key to Null.

3101

2007

The Microsoft Office Access database engine cannot find a record in the table '|2'
with key matching field(s) '|1'.
The Microsoft Jet database engine cannot find a record in the table '|2' with key
matching field(s) '|1'.

2003
3102

2007

Circular reference caused by '|'.
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3103

2007

Circular reference caused by alias '|' in query definition's SELECT list.

3104

2007

Cannot specify fixed column heading '|' in a crosstab query more than once.

3105

2007

Missing destination field name in SELECT INTO statement (|).

3106

2007

Missing destination field name in UPDATE statement (|).

3107

2007

Record(s) cannot be added; no insert permission on '|'.

3108

2007

Record(s) cannot be edited; no update permission on '|'.

3109

2007

Record(s) cannot be deleted; no delete permission on '|'.

3110

2007

Could not read definitions; no read definitions permission for table or query '|'.

3111

2007

Could not create; no modify design permission for table or query '|'.

3112

2007

Record(s) cannot be read; no read permission on '|'.

3113

2007

Cannot update '|'; field not updateable.

3114

2007

Cannot include Memo, OLE, or Hyperlink Object when you select unique values (|).

3115

2007

Cannot have Memo, OLE, or Hyperlink Object fields in aggregate argument (|).

3116

2007

Cannot have Memo, OLE, or Hyperlink Object fields in criteria (|) for aggregate
function.

3117

2007

Cannot sort on Memo, OLE, or Hyperlink Object (|).

3118

2007

Cannot join on Memo, OLE, or Hyperlink Object (|).

3119

2007

Cannot group on Memo, OLE, or Hyperlink Object (|).

3120

2007

Cannot group on fields selected with '*' (|).

3121

2007

Cannot group on fields selected with '*'.

3122

2007

You tried to execute a query that does not include the specified expression '|' as
part of an aggregate function.

3123

2007

Cannot use '*' in crosstab query.

3124

2007

Cannot input from internal report query (|).

3125

2007

'|' is not a valid name. Make sure that it does not include invalid characters or
punctuation and that it is not too long.

3126

2007

Invalid bracketing of name '|'.

3127

2007

The INSERT INTO statement contains the following unknown field name: '|'. Make
sure you have typed the name correctly, and try the operation again.

3128

2007

Specify the table containing the records you want to delete.

3129

2007

Invalid SQL statement; expected 'DELETE', 'INSERT', 'PROCEDURE', 'SELECT', or
'UPDATE'.

3130

2007

Syntax error in DELETE statement.

3131

2007

Syntax error in FROM clause.

3132

2007

Syntax error in GROUP BY clause.

3133

2007

Syntax error in HAVING clause.

3134

2007

Syntax error in INSERT INTO statement.

3135

2007

Syntax error in JOIN operation.

3136

2007

The LEVEL clause includes a reserved word or argument that is misspelled or
missing, or the punctuation is incorrect.

3137

2007

Missing semicolon (;) at end of SQL statement.

3138

2007

Syntax error in ORDER BY clause.

3139

2007

Syntax error in PARAMETER clause.

3140

2007

Syntax error in PROCEDURE clause.
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3141

2007

The SELECT statement includes a reserved word or an argument name that is
misspelled or missing, or the punctuation is incorrect.

3142

2007

Characters found after end of SQL statement.

3143

2007

Syntax error in TRANSFORM statement.

3144

2007

Syntax error in UPDATE statement.

3145

2007

Syntax error in WHERE clause.

3146

2007

ODBC--call failed.

3151

2007

ODBC--connection to '|' failed.

3154

2007

ODBC--could not find DLL '|'.

3155

2007

ODBC--insert on a linked table '|' failed.

3156

2007

ODBC--delete on a linked table '|' failed.

3157

2007

ODBC--update on a linked table '|' failed.

3158

2007

Could not save record; currently locked by another user.

3159

2007

Not a valid bookmark.

3160

2007

Table is not open.

3161

2007

Could not decrypt file.

3162

2007

You tried to assign the Null value to a variable that is not a Variant data type.

3163

2007

The field is too small to accept the amount of data you attempted to add. Try
inserting or pasting less data.

3164

2007

Field cannot be updated.

3165

2007

Could not open .inf file.

3166

2007

Cannot locate the requested Xbase memo file.

3167

2007

Record is deleted.

3168

2007

Invalid .inf file.

3169

2007

The Microsoft Office Access database engine could not execute the SQL statement
because it contains a field that has an invalid data type.
The Microsoft Jet database engine could not execute the SQL statement because it
contains a field that has an invalid data type.

2003

Error Description

3170

2007

Could not find installable ISAM.

3171

2007

Could not find network path or user name.

3172

2007

Could not open Paradox.net.

3173

2007

Could not open table 'MSysAccounts' in the workgroup information file.

3174

2007

Could not open table 'MSysGroups' in the workgroup information file.

3175

2007

Date is out of range or is in an invalid format.

3176

2007

Could not open file '|'.

3177

2007

Not a valid table name.

3179

2007

Encountered unexpected end of file.

3180

2007

Could not write to file '|'.

3181

2007

Invalid range.

3182

2007

Invalid file format.

3183

2007

The query cannot be completed. Either the size of the query result is larger than the
maximum size of a database (2 GB), or there is not enough temporary storage
space on the disk to store the query result.
Not enough space on temporary disk.

2003
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3184

2007

Could not execute query; could not find linked table.

3185

2007

SELECT INTO on a remote database tried to produce too many fields.

3186

2007

Could not save; currently locked by user '|2' on machine '|1'.

3187

2007

Could not read; currently locked by user '|2' on machine '|1'.

3188

2007

Could not update; currently locked by another session on this machine.

3189

2007

Table '|1' is exclusively locked by user '|3' on machine '|2'.

3190

2007

Too many fields defined.

3191

2007

Cannot define field more than once.

3192

2007

Could not find output table '|'.

3193

2007

(unknown)

3194

2007

(unknown)

3195

2007

(expression)

3196

2007

The database '|' is already in use by another person or process. When the database
is available, try the operation again.

3197

2007

The Microsoft Office Access database engine stopped the process because you and
another user are attempting to change the same data at the same time.
The Microsoft Jet database engine stopped the process because you and another
user are attempting to change the same data at the same time.

2003

Error Description

3198

2007

Could not start session. Too many sessions already active.

3199

2007

Could not find reference.

3200

2007

The record cannot be deleted or changed because table '|' includes related records.

3201

2007

You cannot add or change a record because a related record is required in table '|'.

3202

2007

Could not save; currently locked by another user.

3203

2007

Subqueries cannot be used in the expression (|).

3204

2007

Database already exists.

3205

2007

Too many crosstab column headers (|).

3206

2007

Cannot create a relationship between a field and itself.

3207

2007

Operation not supported on a Paradox table with no primary key.

3208

2007

Invalid Deleted setting in the Xbase key of the Windows Registry.

3209

2007

**********

3210

2007

The connection string is too long. The connection string cannot exceed 255
characters.
The connection string is too long.

2003

3211

2007

The database engine could not lock table '|' because it is already in use by another
person or process.

3212

2007

Could not lock table '|1'; currently in use by user '|3' on machine '|2'.

3213

2007

Invalid Date setting in the Xbase key of the Windows Registry.

3214

2007

Invalid Mark setting in the Xbase key of the Windows Registry.

3215

2007

Too many Btrieve tasks.

3216

2007

Parameter '|' specified where a table name is required.

3217

2007

Parameter '|' specified where a database name is required.

3218

2007

Could not update; currently locked.

3219

2007

Invalid operation.

3220

2007

Incorrect collating sequence.
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3221

2007

Invalid settings in the Btrieve key of the Windows Registry.

3222

2007

Query cannot contain a Database parameter.

3223

2007

'|' is invalid because it is too long, or contains invalid characters.

3224

2007

Cannot read Btrieve data dictionary.

3225

2007

Encountered a record locking deadlock while performing a Btrieve operation.

3226

2007

Errors encountered while using the Btrieve DLL.

3227

2007

Invalid Century setting in the Xbase key of the Windows Registry.

3228

2007

Selected collating sequence not supported by the operating system.

3229

2007

Btrieve--cannot change field.

3230

2007

Out-of-date Paradox lock file.

3231

2007

ODBC--field would be too long; data truncated.

3232

2007

ODBC--could not create table.

3234

2007

ODBC--remote query timeout expired.

3235

2007

ODBC--data type not supported on server.

3238

2007

ODBC--data out of range.

3239

2007

Too many active users.

3240

2007

Btrieve--missing Btrieve engine.

3241

2007

Btrieve--out of resources.

3242

2007

Invalid reference in SELECT statement.

3243

2007

None of the import field names match fields in the appended table.

3244

2007

Cannot import password-protected spreadsheet.

3245

2007

Could not parse field names from the first row of the import table.

3246

2007

Operation not supported in transactions.

3247

2007

ODBC--linked table definition has changed.

3248

2007

Invalid NetworkAccess setting in the Windows Registry.

3249

2007

Invalid PageTimeout setting in the Windows Registry.

3250

2007

Could not build key.

3251

2007

Operation is not supported for this type of object.

3252

2007

Cannot open a form whose underlying query contains a user-defined function that
attempts to set or get the form's RecordsetClone property.

3254

2007

ODBC--Cannot lock all records.

3256

2007

Index file not found.

3257

2007

Syntax error in WITH OWNERACCESS OPTION declaration.

3258

2007

The SQL statement could not be executed because it contains ambiguous outer
joins. To force one of the joins to be performed first, create a separate query that
performs the first join and then include that query in your SQL statement.

3259

2007

Invalid field data type.

3260

2007

Could not update; currently locked by user '|2' on machine '|1'.

3261

2007

Table '|' is exclusively locked by user '|2' on machine '|1'.

3262

2007

Could not lock table

3263

2007

Invalid Database object.

3264

2007

No field defined--cannot append TableDef or Index.
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3265

2007

Item not found in this collection.

3266

2007

Cannot append a Field that is already a part of a Fields collection.

3267

2007

Property can be set only when the Field is part of a Recordset object's Fields
collection.

3268

2007

Cannot set this property once the object is part of a collection.

3269

2007

Cannot append an Index that is already a part of an Indexes collection.

3270

2007

Property not found.

3271

2007

Invalid property value.

3272

2007

Object is not a collection.

3273

2007

Method not applicable for this object.

3274

2007

External table is not in the expected format.

3275

2007

Unexpected error from external database driver (|).

3276

2007

Invalid database object reference.

3277

2007

Cannot have more than 10 fields in an index.

3278

2007
2003

The Microsoft Office Access database engine has not been initialized.
The Microsoft Jet database engine has not been initialized.

3279

2007
2003

The Microsoft Office Access database engine has already been initialized.
The Microsoft Jet database engine has already been initialized.

3280

2007

Cannot delete a field that is part of an index or is needed by the system.

3281

2007

Cannot delete this index or table. It is either the current index or is used in a
relationship.

3282

2007

Operation not supported on a table that contains data.

3283

2007

Primary key already exists.

3284

2007

Index already exists.

3285

2007

Invalid index definition.

3286

2007

Format of memo file does not match specified external database format.

3287

2007

Cannot create index on the given field.

3288

2007

Paradox index is not primary.

3289

2007

Syntax error in CONSTRAINT clause.

3290

2007

Syntax error in CREATE TABLE statement.

3291

2007

Syntax error in CREATE INDEX statement.

3292

2007

Syntax error in field definition.

3293

2007

Syntax error in ALTER TABLE statement.

3294

2007

Syntax error in DROP INDEX statement.

3295

2007

Syntax error in DROP TABLE or DROP INDEX.

3296

2007

JOIN expression not supported.

3297

2007

Could not import table or query. No records found, or all records contain errors.

3298

2007

There are several tables with that name. Please specify owner in the format
'owner.table'.

3299

2007

ODBC Specification Conformance Error (|). Report this error to the developer of
your application.

3300

2007

Cannot create a relationship.

3301

2007

Cannot perform this operation; features in this version are not available in
databases with older formats.
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3302

2007

Cannot change a rule while the rules for this table are in use.

3303

2007

Cannot delete this field. It is part of one or more relationships.

3304

2007

You must enter a personal identifier (PID) consisting of at least 4 and no more than
20 characters and digits.

3305

2007

Invalid connection string in pass-through query.

3306

2007

You have written a subquery that can return more than one field without using the
EXISTS reserved word in the main query's FROM clause. Revise the SELECT
statement of the subquery to request only one field.

3307

2007

The number of columns in the two selected tables or queries of a union query do not
match.

3308

2007

Invalid TOP argument in select query.

3309

2007

Property value is too large.

3310

2007

This property is not supported for external data sources or for databases created
with a previous version of Microsoft Jet.

3311

2007

Property specified already exists.

3312

2007

Validation rules and default values cannot be placed on system or linked tables.

3313

2007

Cannot place this validation expression on this field.

3314

2007
2003

You must enter a value in the '|' field.
The field '|' cannot contain a Null value because the Required property for this field
is set to True. Enter a value in this field.

3315

2007

Field '|' cannot be a zero-length string.

3316

2007

|

3317

2007

One or more values are prohibited by the validation rule '|2' set for '|1'. Enter a
value that the expression for this field can accept.

3318

2007

Values specified in a TOP clause are not allowed in delete queries or reports.

3319

2007

Syntax error in union query.

3320

2007

| in table-level validation expression.

3321

2007

No database specified in connection string or IN clause.

3322

2007

Crosstab query contains one or more invalid fixed column headings.

3323

2007

The query cannot be used as a row source.

3324

2007

The query is a DDL query and cannot be used as a row source.

3325

2007

Pass-through query with ReturnsRecords property set to True did not return any
records.

3326

2007

This Recordset is not updateable.

3327

2007

Field '|' is based on an expression and cannot be edited.

3328

2007

Table '|2' is read-only.

3329

2007

Record in table '|' was deleted by another user.

3330

2007

Record in table '|' is locked by another user.

3331

2007

To make changes to this field, first save the record.

3332

2007

Cannot enter value into blank field on 'one' side of outer join.

3333

2007

Records in table '|' would have no record on the 'one' side.

3334

2007

Can be present only in version 1.0 format.

3335

2007

DeleteOnly called with non-zero cbData.

3336

2007

Btrieve: Invalid IndexDDF option in initialization setting.
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3337

2007

Invalid DataCodePage option in initialization setting.

3338

2007

Btrieve: Xtrieve options are not correct in initialization setting.

3339

2007

Btrieve: Invalid IndexDeleteRenumber option in initialization setting.

3340

2007

Query '|' is corrupt.

3341

2007

The current field must match the join key '|' in the table that serves as the 'one'
side of one-to-many relationship. Enter a record in the 'one' side table with the
desired key value, and then make the entry with the desired join key in the 'manyonly' table.

3342

2007

Invalid Memo, OLE, or Hyperlink Object in subquery '|'.

3343

2007

Unrecognized database format '|'.

3344

2007

The database engine does not recognize either the field '|1' in a validation
expression, or the default value in the table '|2'.

3345

2007

Unknown or invalid field reference '|'.

3346

2007

Number of query values and destination fields are not the same.

3347

2007

Cannot add record(s); primary key for table '|' not in recordset.

3348

2007

Cannot add record(s); join key of table '|' not in recordset.

3349

2007

2003

You cannot record your changes because a value you entered violates the settings
defined for this table or list (for example, a value is less than the minimum or
greater than the maximum). Correct the error and try again.
Numeric field overflow.

3350

2007

Object is invalid for operation.

3351

2007

The ORDER BY expression (|) includes fields that are not selected by the query.
Only those fields requested in the first query can be included in an ORDER BY
expression.

3352

2007

No destination field name in INSERT INTO statement (|).

3353

2007

Btrieve: Cannot find file Field.ddf.

3354

2007

At most one record can be returned by this subquery.

3355

2007

Syntax error in default value.

3356

2007

You attempted to open a database that is already opened exclusively by user '|2' on
machine '|1'. Try again when the database is available.

3357

2007

This query is not a properly formed data-definition query.

3358

2007
2003

Cannot open the Microsoft Office Access database engine workgroup information file.
Cannot open the Microsoft Jet engine workgroup information file.

3359

2007

Pass-through query must contain at least one character.

3360

2007

Query is too complex.

3361

2007

Unions not allowed in a subquery.

3362

2007

Single-row update/delete affected more than one row of a linked table. Unique
index contains duplicate values.

3363

2007

Record(s) cannot be added; no corresponding record on the 'one' side.

3364

2007

Cannot use Memo, OLE, or Hyperlink Object field '|' in the SELECT clause of a union
query.

3365

2007

Property value not valid for REMOTE objects.

3366

2007

Cannot append a relation with no fields defined.

3367

2007

Cannot append. An object with that name already exists in the collection.

3368

2007

Relationship must be on the same number of fields with the same data types.
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3369

2007

**********

3370

2007

Cannot modify the design of table '|'. It is in a read-only database.

3371

2007

Cannot find table or constraint.

3372

2007

No such index '|2' on table '|1'.

3373

2007

Cannot create relationship. Referenced table '|' does not have a primary key.

3374

2007

The specified fields are not uniquely indexed in table '|'.

3375

2007

Table '|1' already has an index named '|2'.

3376

2007

Table '|' does not exist.

3377

2007

No such relationship '|2' on table '|1'.

3378

2007

There is already a relationship named '|' in the current database.

3379

2007

Cannot create relationships to enforce referential integrity. Existing data in table
'|2' violates referential integrity rules in table '|1'.

3380

2007

Field '|2' already exists in table '|1'.

3381

2007

There is no field named '|2' in table '|1'.

3382

2007

Size of field '|' is too long.

3383

2007

Cannot delete field '|'. It is part of one or more relationships.

3384

2007

Cannot delete a built-in property.

3385

2007

User-defined properties do not support a Null value.

3386

2007

Property '|' must be set before using this method.

3387

2007

Cannot find TEMP directory.

3388

2007

Unknown function '|2' in validation expression or default value on '|1'.

3389

2007

Query support unavailable.

3390

2007

Account name already exists.

3391

2007

An error has occurred. Properties were not saved.

3392

2007

**********

3393

2007

Cannot perform join, group, sort, or indexed restriction. A value being searched or
sorted on is too long.

3394

2007

Cannot save property; property is a schema property.

3395

2007

**********

3396

2007

Cannot perform cascading operation. Since related records exist in table '|',
referential integrity rules would be violated.

3397

2007

Cannot perform cascading operation. There must be a related record in table '|'.

3398

2007

Cannot perform cascading operation. It would result in a null key in table '|'.

3399

2007

Cannot perform cascading operation. It would result in a duplicate key in table '|'.

3400

2007

Cannot perform cascading operation. It would result in two updates to field '|2' in
table '|1'.

3401

2007

Cannot perform cascading operation. It would cause field '|' to become Null, which
is not allowed.

3402

2007

Cannot perform cascading operation. It would cause field '|' to become a zerolength string, which is not allowed.

3403

2007

Cannot perform cascading operation: '|'.

3404

2007

Cannot perform cascading operation. The value entered is prohibited by the
validation rule '|2' set for '|1'.

3405

2007

Error '|' in validation rule.
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3406

2007

The expression you are trying to use for the DefaultValue property is invalid
because '|'. Use a valid expression to set this property.

3407

2007

The server's MSysConf table exists, but is in an incorrect format. Contact your
system administrator.

3408

2007

Too many FastFind Sessions were invoked.

3409

2007

Invalid field definition '|' in definition of index or relationship.

3411

2007

Invalid entry. Cannot perform cascading operation in table '|1' because the value
entered is too large for field '|2'.

3412

2007

Cannot perform cascading update on the table because it is currently in use by
another user.

3413

2007

Cannot perform cascading operation on table '|1' because it is currently in use by
user '|3' on machine '|2'.

3414

2007

Cannot perform cascading operation on table '|1' because it is currently in use.

3415

2007

Zero-length string is valid only in a Text or Memo field.

3416

2007

|

3417

2007

An action query cannot be used as a row source.

3418

2007

Cannot open '|'. Another user has the table open using a different network control
file or locking style.

3419

2007

Cannot open this Paradox 4.x or 5.x table because ParadoxNetStyle is set to 3.x in
the Windows Registry.

3420

2007

Object invalid or no longer set.

3421

2007

Data type conversion error.

3422

2007

Cannot modify table structure. Another user has the table open.

3423

2007

You cannot use ODBC to import from, export to, or link an external Microsoft Office
Access or ISAM database table to your database.
You cannot use ODBC to import from, export to, or link an external Microsoft Jet or
ISAM database table to your database.

2003

Error Description

3424

2007

Cannot create database because the locale is invalid.

3425

2007

This method or property is not currently available on this Recordset.

3426

2007

This action was cancelled by an associated object.

3427

2007

Error in DAO automation.

3428

2007

A problem occurred in your database. Correct the problem by repairing and
compacting the database.

3429

2007

Incompatible version of an installable ISAM.

3430

2007

While loading the Microsoft Excel installable ISAM, OLE was unable to initialize.

3431

2007

This is not a Microsoft Excel 5.0 file.

3432

2007

Error opening a Microsoft Excel 5.0 file.

3433

2007

Invalid setting in Excel key of the Engines section of the Windows Registry.

3434

2007

Cannot expand named range.

3435

2007

Cannot delete spreadsheet cells.

3436

2007

Failure creating file.

3437

2007

Spreadsheet is full.

3438

2007

The data being exported does not match the format described in the Schema.ini file.

3439

2007

You attempted to link or import a Microsoft Word mail merge file. Although you can
export such files, you cannot link or import them.
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3440

2007

An attempt was made to import or link an empty text file. To import or link a text
file, the file must contain data.

3441

2007

Text file specification field separator matches decimal separator or text delimiter.

3442

2007

In the text file specification '|1', the |2 option is invalid.

3443

2007

The fixed width specification '|1' contains no column widths.

3444

2007

In the fixed width specification '|1', column '|2' does not specify a width.

3445

2007

Incorrect version of the DLL file '|' was found.

3446

2007

The VBA file (VBAJET.dll for 16-bit versions, or VBAJET32.dll for 32-bit versions) is
missing. Try reinstalling the application that returned the error.
Jet VBA file (VBAJET.dll for 16-bit versions, or VBAJET32.dll for 32-bit versions) is
missing. Try reinstalling the application that returned the error.

2003
3447

2007
2003

Error Description

The VBA file (VBAJET.dll for 16-bit versions, or VBAJET32.dll for 32-bit versions)
failed to initialize when called. Try reinstalling the application that returned the error.
The Jet VBA file (VBAJET.dll for 16-bit versions, or VBAJET32.dll for 32-bit versions)
failed to initialize when called. Try reinstalling the application that returned the error.

3448

2007

A call to an OLE system function was not successful. Try reinstalling the application
that returned the error.

3449

2007
2003

No country/region code found in connection string for a linked table.
No country code found in connection string for a linked table.

3450

2007

Syntax error in query. Incomplete query clause.

3451

2007

Illegal reference in query.

3452

2007

You cannot make changes to the design of the database at this replica.

3453

2007

You cannot establish or maintain an enforced relationship between a replicated
table and a local table.

3455

2007

Cannot make the database replicable.

3456

2007

Cannot make the |2 object in |1 container replicable.

3457

2007

You cannot set the KeepLocal property for an object that is already replicated.

3458

2007

The KeepLocal property cannot be set on a database; it can be set only on the
objects in a database.

3459

2007

After a database has been replicated, you cannot remove the replication features
from the database.

3460

2007

The operation you attempted conflicts with an existing operation involving this
member of the replica set.

3461

2007

The replication property you are attempting to set or delete is read-only and cannot
be changed.

3462

2007

Failure to load a DLL.

3463

2007

Cannot find the .dll '|2'.

3464

2007

Data type mismatch in criteria expression.

3465

2007

The disk drive you are attempting to access is unreadable.

3468

2007

Access was denied while accessing dropbox folder '|2'.

3469

2007

The disk for dropbox folder '|2' is full.

3470

2007

Disk failure accessing dropbox folder '|2'.

3471

2007

Failure to write to the Synchronizer log file.

3472

2007

Disk full for path '|1'.

3473

2007

Disk failure while accessing log file '|1'.

3474

2007

Cannot open the log file '|1' for writing.
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3475

2007

Sharing violation while attempting to open log file '|1' in Deny Write mode.

3476

2007

Invalid dropbox path '|2'.

3477

2007

Dropbox address '|2' is syntactically invalid.

3478

2007

The replica is not a partial replica.

3479

2007

Cannot designate a partial replica as the Design Master for the replica set.

3480

2007

The relationship '|' in the partial filter expression is invalid.

3481

2007

The table name '|' in the partial filter expression is invalid.

3482

2007

The filter expression for the partial replica is invalid.

3483

2007

The password supplied for the dropbox folder '|2' is invalid.

3484

2007

The password used by the Synchronizer to write to a destination dropbox folder is
invalid.

3485

2007

The object cannot be replicated because the database is not replicated.

3486

2007

You cannot add a second Replication ID AutoNumber field to a table.

3487

2007

The database you are attempting to replicate cannot be converted.

3488

2007

The value specified is not a ReplicaID for any member in the replica set.

3489

2007

The object specified cannot be replicated because it is missing a necessary
resource.

3490

2007

Cannot create a new replica because the '|2' object in '|1' container could not be
replicated.

3491

2007

The database must be opened in exclusive mode before it can be replicated.

3492

2007

The synchronization failed because a design change could not be applied to one of
the replicas.

3493

2007

Cannot set the specified Registry parameter for the Synchronizer.

3494

2007

Unable to retrieve the specified Registry parameter for the Synchronizer.

3495

2007

There are no scheduled synchronization's between the two Synchronizers.

3496

2007

Replication Manager cannot find the ExchangeID in the MSysExchangeLog table.

3497

2007

Unable to set a schedule for the Synchronizer.

3499

2007

Cannot retrieve the full path information for a member of the replica set.

3500

2007

You cannot specify two different Synchronizers to manage the same replica.

3502

2007

The Design Master or replica is not being managed by a Synchronizer.

3503

2007

The Synchronizer's Registry has no value set for the key you queried.

3504

2007

The Synchronizer ID does not match an existing ID in the MSysTranspAddress table.

3505

2007

You attempted to delete or get information about a partial filter that does not exist
in MSysFilters.

3506

2007

The Synchronizer is unable to open the Synchronizer log.

3507

2007

Failure writing to the Synchronizer log.

3508

2007

There is no active transport for the Synchronizer.

3509

2007

Could not find a valid transport for this Synchronizer.

3510

2007

The member of the replica set you are attempting to synchronize is currently being
used in another synchronization.

3512

2007

Failed to read the dropbox folder.

3513

2007

Failed to write to the dropbox folder.

3514

2007

Synchronizer could not find any scheduled or on-demand synchronization's to
process.
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3515

2007
2003

Error Description
The Microsoft Office Access database engine could not read the system clock on
your computer.
The Microsoft Jet database engine could not read the system clock on your
computer.

3516

2007

Destination synchronizer is not configured to support indirect synchronronization,
and the destination replica is unavailable for direct synchronization.

3517

2007

Synchronizer could not find any messages to process.

3518

2007

Could not find Synchronizer in the MSysTranspAddress table.

3519

2007

Failed to send a message.

3520

2007

The replica name or ID does not match a currently managed member of the replica
set.

3521

2007

Two members of the replica set cannot be synchronized because there is no
common point to start the synchronization.

3522

2007

Synchronizer cannot find the record of a specific synchronization in the
MSysExchangeLog table.

3523

2007

Synchronizer cannot find a specific version number in the MSysSchChange table.

3524

2007

The history of design changes in the replica does not match the history in the
Design Master.

3525

2007

Synchronizer could not access the message database.

3526

2007

The name selected for the system object is already in use.

3527

2007

The Synchronizer or Replication Manager could not find the system object.

3528

2007

There is no new data in shared memory for the Synchronizer or Replication Manager
to read.

3529

2007

The Synchronizer or Replication Manager found unread data in the shared memory.
The existing data will be overwritten.

3530

2007

The Synchronizer is already serving a client.

3531

2007

The wait period for an event has timed out.

3532

2007

Synchronizer could not be initialized.

3533

2007

The system object used by a process still exists after the process has stopped.

3534

2007

Synchronizer looked for a system event but did not find one to report to the client.

3535

2007

Client has asked the Synchronizer to terminate operation.

3536

2007

Synchronizer received an invalid message for a member of the replica set that it
manages.

3537

2007

The Synchronizer's client is no longer present and cannot be notified.

3538

2007

Cannot initialize Synchronizer because there are too many applications running.

3539

2007

A system error has occurred or your swap file has reached its limit.

3540

2007

Your swap file has reached its limit or is corrupted.

3541

2007

Synchronizer could not be shut down properly and is still active.

3542

2007

Process stopped when attempting to terminate Synchronizer client.

3543

2007

Synchronizer has not been set up.

3544

2007

Synchronizer is already running.

3545

2007

The two replicas you are attempting to synchronize are from different replica sets.

3546

2007

The type of synchronization you are attempting is not valid.

3547

2007

Synchronizer could not find a replica from the correct set to complete the
synchronization.
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3548

2007

GUIDs do not match or the requested GUID could not be found.

3549

2007

The file name you provided is too long.

3550

2007

There is no index on the GUID column.

3551

2007

Unable to delete the specified Registry parameter for the Synchronizer.

3552

2007

The size of the Registry parameter exceeds the maximum allowed.

3553

2007

The GUID could not be created.

3555

2007

All valid nicknames for replicas are already in use.

3556

2007

Invalid path for destination dropbox folder.

3557

2007

Invalid address for destination dropbox folder.

3558

2007

Disk I/O error at destination dropbox folder.

3559

2007

Failure to write because destination disk is full.

3560

2007

The two members of the replica set you are attempting to synchronize have the
same ReplicaID.

3561

2007

The two members of the replica set you are attempting to synchronize are both
Design Masters.

3562

2007

Access denied at destination dropbox folder.

3563

2007

Fatal error accessing a local dropbox folder.

3564

2007

Synchronizer cannot find the source file for messages.

3565

2007

There is a sharing violation in the source dropbox folder because the message
database is open in another application.

3566

2007

Network I/O error.

3567

2007

Message in dropbox folder belongs to the wrong Synchronizer.

3568

2007

Synchronizer could not delete a file.

3569

2007

This member of the replica set has been logically removed from the set and is no
longer available.

3570

2007

The filters defining a partial replica have been changed. The partial replica must be
repopulated.

3571

2007

The attempt to set a column in a partial replica violated a rule governing partial
replicas.

3572

2007

A disk I/O error occurred while reading or writing to the TEMP directory.

3573

2007

The directory you queried for a list of replicas is not a managed directory.

3574

2007

The ReplicaID for this member of the replica set was reassigned during a move or
copy procedure.

3575

2007

The disk drive you are attempting to write to is full.

3576

2007

The database you are attempting to open is already in use by another application.

3577

2007

Cannot update replication system column.

3578

2007

Failure to replicate database; cannot determine whether the database is open in
exclusive mode.

3579

2007

Could not create replication system tables needed to make the database replicable.

3580

2007

Could not add rows needed to make the database replicable.

3581

2007

Cannot open replication system table '|' because the table is already in use.

3582

2007

Cannot make a new replica because the |2 object in |1 container could not be made
replicable.

3583

2007

Cannot make the |2 object in |1 container replicable.
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3584

2007

Insufficient memory to complete operation.

3585

2007

Cannot replicate the table; the number of columns exceeds the maximum allowed.

3586

2007

Syntax error in partial filter expression on table |1.

3587

2007

Invalid expression in the ReplicaFilter property.

3588

2007

Error when evaluating the partial filter expression.

3589

2007

The partial filter expression contains an unknown function.

3590

2007

Violates the rules for partial replicas.

3591

2007

Log file path '|1' is invalid.

3592

2007

You cannot replicate a password-protected database or set password protection on
a replicated database.

3593

2007

You cannot change the data master attribute for the replica set.

3594

2007

You cannot change the data master attribute for the replica set. It allows data
changes only at the Design Master.

3595

2007

The system tables in your replica are no longer reliable and the replica should not
be used.

3600

2007

Aggregation expressions cannot use GUIDs.

3605

2007

Synchronizing with a non-replicated database is not allowed. The '|' database is not
a Design Master or replica.

3607

2007

The replication property you are attempting to delete is read-only and cannot be
removed.

3608

2007

Record length is too long for an indexed Paradox table.

3609

2007

No unique index found for the referenced field of the primary table.

3610

2007

Same table '|' referenced as both the source and destination in make-table query.

3611

2007

Cannot execute data definition statements on linked data sources.

3612

2007

Multi-level GROUP BY clause is not allowed in a subquery.

3613

2007

Cannot create a relationship on linked ODBC tables.

3614

2007

GUID not allowed in Find method criteria expression.

3615

2007

Type mismatch in expression.

3616

2007

Updating data in a linked table is not supported by this ISAM.

3617

2007

Deleting data in a linked table is not supported by this ISAM.

3618

2007

Exceptions table could not be created on import/export.

3619

2007

Records could not be added to exceptions table.

3620

2007

The connection for viewing your linked Microsoft Excel worksheet was lost.

3621

2007

Cannot change password on a shared open database.

3622

2007

You must use the dbSeeChanges option with OpenRecordset when accessing a SQL
Server table that has an IDENTITY column.

3623

2007

Cannot access the FoxPro 3.0 bound DBF file '|'.

3624

2007

Could not read the record; currently locked by another user.

3625

2007

The text file specification '|' does not exist. You cannot import, export, or link using
the specification.

3626

2007

The operation failed. There are too many indexes on table '|'. Delete some of the
indexes on the table and try the operation again.

3627

2007

Cannot find the executable file for the Synchronizer (mstran40.exe).

3628

2007

Partner replica is not managed by a Synchronizer.
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3629

2007

Synchronizer '|1' is also using the same File System dropbox '|2'.

3630

2007

Synchronizer '|1' is also using the same File System dropbox '|2'.

3631

2007

Invalid Table Name In Filter

3632

2007

Internet Transport not enabled on the remote Synchronizer.

3633

2007

Cannot load DLL: '|'

3634

2007

Cannot create a replica using a partial replica.

3635

2007

Cannot create partial replica of a system database.

3636

2007

Cannot populate the replica or change the replica's filter because the replica has
conflicts or data errors.

3637

2007

Cannot use the crosstab of a non-fixed column as a subquery.

3638

2007

A Source Controlled database cannot be made replicable.

3639

2007

Cannot create a replica of a System database.

3640

2007

The fetch buffer was too small for the amount of data you requested.

3641

2007

There are fewer records remaining in the recordset than you requested.

3642

2007

A cancel was performed on the operation.

3643

2007

One of the records in the recordset was deleted by another process.

3645

2007

One of the binding parameters is incorrect.

3646

2007

The specified row length is shorter than the sum of the column lengths.

3647

2007

A column requested is not being returned to the recordset.

3648

2007

Cannot synchronize a partial replica with another partial replica.

3649

2007

The language-specific code page was not specified or could not be found.

3650

2007

Either the Internet is very slow or there is some problem in the replication manager
setup on the internet server machine.

3651

2007

Invalid internet address.

3652

2007

Internet login failure.

3653

2007

Internet not set up.

3654

2007

Internal internet failure.

3655

2007

The wininet.dll cannot be loaded or initialized.

3656

2007

Error in evaluating a partial expression

3657

2007

Error in evaluating the boolean filter expression for table '|1'.

3658

2007

Binary column '|' cannot be used in a boolean filter.

3659

2007

Relationship '|1' is unenforced. Relationship in a partial filter expression must be
enforced.

3660

2007

Requested exchange failed because '|1'.

3661

2007

Requested exchange failed because '|1'

3663

2007

This operation requires a different cursor library.

3664

2007

An asynchronous OpenConnection call is not yet complete; you cannot yet reference
the returned connection object until it is complete.

3665

2007

You cannot modify the replication system object '|'.

3666

2007

You cannot modify the replication system object '|'.

3667

2007

3668

2007

Cannot perform this operation because there is no active connection.

3669

2007

Execution cancelled.

A different operation is preventing this operation from being executed.
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3670

2007

Cursor is not valid.

3671

2007

Cannot find table to update.

3672

2007

Failed to load RDOCURS.DLL.

3673

2007

This table contains cells that are outside the range of cells defined in this
spreadsheet.

3674

2007

Internet dll (wininet.dll) could not be found or loaded.

3675

2007

Failure to read from an internet handle. Try the operation again.

3676

2007

Failure to write to an internet handle. Try the operation again.

3677

2007

Failure to execute the HTTP request to start internet synchronizer on the internet
server. Use Replication Manager to configure internet synchronizer on the internet
server.

3678

2007

Failure to connect to the FTP service on the internet server. Make sure that FTP
service is running properly on the server and supports anonymous connections.

3679

2007

Failure to do open file using FTP service. Make sure that FTP dropbox has read
permissions.

3680

2007

Failure in getting a file from the server using FTP. Make sure that FTP dropbox has
read permissions.

3681

2007

Failure in putting a file to the server using FTP. Make sure that FTP dropbox has
write permissions.

3682

2007

Failure to delete a file on the server using FTP. Make sure that FTP dropbox has
read and write permissions.

3683

2007

Internet synchronizer exited unexpectedly on the server. Look at the partner replica
exchange history on the internet server to figure out the problem.

3684

2007

There is no suitable replica with which to exchange.

3685

2007

Invalid HTTP address.

3686

2007

Invalid replica path or name.

3687

2007

Invalid SQL syntax - expected token: Option.

3688

2007

Invalid SQL syntax - expected token: For.

3689

2007

Invalid SQL syntax - expected token: Privileges.

3690

2007

Invalid SQL syntax - expected a table right/privilege.

3691

2007

Invalid SQL syntax - expected an object name.

3692

2007

Invalid SQL syntax - related tokens did not match. Microsoft Office Access database
engine expected GRANT...TO, REVOKE...FROM, ADD...TO, or DROP...FROM.
Invalid SQL syntax - related tokens did not match. Jet expected GRANT...TO,
REVOKE...FROM, ADD...TO, or DROP...FROM.

2003
3693

2007

Invalid SQL syntax - expected user or group name.

3694

2007

Invalid SQL syntax - expected token: Grant.

3695

2007

Invalid SQL syntax - GRANT/REVOKE syntax error.

3696

2007

Invalid SQL syntax - expected token: User (or) Group.

3697

2007

Invalid SQL syntax - expected token: Password.

3698

2007

Invalid SQL syntax - expected password.

3699

2007

Invalid SQL syntax - expected token: User.

3700

2007

Invalid precision for decimal data type.

3701

2007

Invalid scale for decimal data type.

3702

2007

The width of a Unicode text column must be an even number of bytes.
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3703

2007

Operation not supported on replicable databases that have not been converted to
the current version.

3704

2007

You attempted to open a database that is already opened by user '|2' on machine
'|1'. Try again when the database is available.

3705

2007

Cannot make the |2 table replicable - too many columns.

3706

2007

Cannot make the |2 table replicable - too many indexes.

3707

2007

The cascading options for the new reference conflict with existing reference '|'.

3708

2007

Syntax error in Transaction statement. Expected TRANSACTION, WORK, or nothing.

3709

2007

The search key was not found in any record.

3710

2007

MAPI folder or address book not found.

3711

2007

Recovered replicable data. This row was recovered from a corrupted replicable
database. Verify that the record contents are correct and then reinsert the record,
or delete this conflict record.

3712

2007

Other. This record was rejected due to an undefined replication conflict problem.

3713

2007

Update/update conflict. Another replica also updated this record. This record lost
the conflict. Either resubmit your update or delete this conflict record.

3714

2007

Locked table. This record could not be applied during synchronization since the table
was locked by another user. Resubmit this conflict record.

3715

2007

Unique key violation. This record has the same key value as another record,
whereas only unique values are permitted. Either change the key value in this
conflict record or the winning record and then resubmit this record, or delete this
conflict record.

3716

2007

TLV violation. This record contains a field value that does not meet the table level
validation constraint. Either update the field value that is violating the validation
rule and then resubmit this conflict record, or delete this conflict record.

3717

2007

Delete/RI conflict. The primary key record has been deleted by another replica,
therefore this referencing record has been rejected. Either create a new primary
key record that satisfies the referential integrity constraint and then resubmit your
update, or delete this conflict record.

3718

2007

Update/RI conflict. The primary key record has been updated by another replica,
therefore this referencing record has been rejected. Either create a new primary
key record that satisfies the referential integrity constraint, modify the foreign key
value in this conflict record to match a valid primary key value and then resubmit
your update, or delete this conflict record.

3719

2007

Foreign key violation resulting from an invalid primary key record that was involved
in a replication conflict. Either create a new primary key record that satisfies the
referential integrity constraint, modify the foreign key value in this conflict record to
match a valid primary key value and then resubmit this conflict record, or delete
this conflict record.

3720

2007

Cannot change field '|'. It is part of one or more relationships.

3721

2007

Invalid SQL syntax - expected constraint name.

3722

2007

Invalid SQL syntax - expected token: DEFAULT.

3723

2007

Invalid SQL syntax - expected token: COMPRESSION to follow WITH.

3724

2007

Invalid SQL syntax - expected token: UPDATE or DELETE.

3725

2007

Invalid SQL syntax - expected token: CASCADE, SET NULL, or NO ACTION.

3726

2007

Invalid SQL syntax - expected token: NULL.

3727

2007

Invalid SQL syntax - only one update rule and/or one delete rule allowed.

3728

2007

Invalid SQL syntax - expected token: AS.
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3729

2007

Invalid SQL syntax - expected token: SELECT.

3730

2007

VIEW cannot contain a parameter.

3731

2007

The number of aliases specified shall be the same as the number of output columns.

3732

2007

Expected query name after EXECUTE.

3733

2007

The database has been placed in a state by an unknown user that prevents it from
being opened or locked.

3734

2007

The database has been placed in a state by user '|2' on machine '|1' that prevents it
from being opened or locked.

3735

2007

Too many columns in inverted index.

3736

2007

Update/delete conflict. This updated record was deleted at another replica. Either
reinsert this conflict record or delete it.

3737

2007

Cannot create this type of replica from the given source replica.

3738

2007

Local or Anonymous replicas must synch only to their designated hub replica.

3739

2007

The proxy replica has been removed.

3740

2007

Cannot add a new column to conflict table '|'. Delete obsolete columns and
compact the database.

3741

2007

Invalid partner synchronizer. Local or anonymous replica must synchronize with
designated hub replica.

3742

2007

An internet function timed out.

3743

2007

Replica has not been synchronized within the replica set retention period.

3744

2007

Counter columns in replicable tables cannot be modified.

3745

2007

The combined length of Internet Server Name, HTTP Share name, and FTP alias
name should not be greater than 252 characters.

3746

2007

Syntax error in parameters clause. Make sure the parameter exists and that you
typed its value correctly.

3747

2007

Parameter has no default value.

3748

2007

Parameter | has no default value.

3749

2007

The object is not a stored procedure.

3750

2007

Object | is not a stored procedure.

3751

2007

Requested row locking, but DB is in page lock mode.

3752

2007

Requested page locking, but DB is in row lock mode.

3753

2007
2003

Cannot create replica of a Microsoft Office Access database engine SQL replica.
Cannot create replica of a Jet SQL replica.

3754

2007

Cannot delete from a Prevent Deletes Replica.

3755

2007

CHECK constraint '|' does not exist.

3756

2007

CHECK constraint '|' already exists.

3757

2007
2003

The Microsoft Office Access database engine sorting DLLs could not be loaded
properly.
The Jet sorting DLLs could not be loaded properly.

3758

2007

Scaling of decimal value resulted in data truncation.

3759

2007

Scaling of decimal value resulted in data truncation.

3760

2007

Scaling of decimal value resulted in data overflow.

3761

2007

The decimal field's precision is too small to accept the numeric you attempted to
add.

3762

2007

Invalid SQL syntax - expected token: ACTION.
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3763

2007

Concurrent schema changes caused the create replica operation to fail. Try again.

3764

2007

Failed to re-create one or more indexes.

3765

2007

Syntax error in CHECK constraint clause.

3766

2007

Only simple SELECT queries are allowed in VIEWS.

3767

2007

Table '|' could not be made replicable because it could not be opened exclusively.

3768

2007

FastFind cannot search on non-column references.

3769

2007

Conflict tables cannot be renamed.

3770

2007

Counter definition not in valid range.

3771

2007

Local or Anonymous replicas cannot be made the design master.

3772

2007

Without Administer permission, replica priority must be in the range 0 - |.

3773

2007

Cannot delete one or more objects: |.

3774

2007

Pin value is not valid.

3775

2007

Unable to load Microsoft Office Access database SQL Server Reconciler MSRPJT40.dll.
Unable to load Jet SQL Server Reconciler - MSRPJT40.dll.

2003
3776

2007
2003

3777

2007
2003

3778

2007
2003

Error Description

Unable to exchange between two Microsoft Office Access database SQL Server
Replicas.
Unable to exchange between two Jet SQL Server Replicas.

Illegal Operation performed on a Microsoft Office Access database SQL Server
Replica.
Illegal Operation performed on a Jet SQL Server Replica.
The Microsoft Office Access database is wrong or missing for this SQL/Microsoft
Office Access database replica set.
The Jet database is wrong or missing for this SQL/Jet replica set.

3779

2007

Unable to change Column Level Tracking Property on objects that are already
Replicable.

3780

2007

Invalid SQL syntax - expected a view name.

3781

2007

Invalid SQL syntax - expected a procedure name.

3782

2007

Invalid SQL syntax - currently only one column-level CHECK constraint is allowed.

3783

2007

Invalid SQL syntax - cannot use multiple columns in a column-level CHECK
constraint.

3784

2007

Database is already replicable.

3785

2007

Invalid SQL syntax - expected token: Database.

3786

2007

Invalid SQL syntax - expected a database privilege, such as CREATEDB or CONNECT.

3787

2007

This operation is not allowed in subqueries.

3788

2007

Cannot create an index on this MAPI folder/addressbook.

3789

2007

Illegal column-level constraint.

3790

2007
2003

This object requires a newer version of the Microsoft Office Access database engine.
This object requires a newer version of the Microsoft Jet database engine.

3791

2007
2003

This index requires Microsoft Office Access database engine |.
This index requires Microsoft Jet database engine |.

3792

2007
2003

The index '|2' requires Microsoft Office Access database engine |1.
The index '|2' requires Microsoft Jet database engine |1.

3793

2007
2003

The column '|2' requires Microsoft Office Access database engine |1.
The column '|2' requires Microsoft Jet database engine |1.
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3794

2007
2003

This table requires Microsoft Office Access database engine |.
This table requires Microsoft Jet database engine |.

3795

2007
2003

The table '|2' requires Microsoft Office Access database engine |1.
The table '|2' requires Microsoft Jet database engine |1.

3796

2007

The version of AceRecr.DLL that was loaded was too old. Run setup again to get the
correct version of this file.
The version of MSRECR40.DLL that was loaded was too old. Run setup again to get
the correct version of this file.

2003
3797

2007

Error Description

2003

The SQL/Microsoft Office Access database engine exchange failed, look in the
SQLServer Agent history for details.
The SQL/Jet exchange failed, look in the SQLServer Agent history for details.

3798

2007

CHECK constraints are not allowed on replicable databases.

3799

2007

Could not find field '|'.

3800

2007

'|' is not an index in this table.

3801

2007

The object (|) cannot be used in a CHECK constraint clause.

3802

2007

Error evaluating | CHECK constraint. |

3803

2007

DDL cannot be completed on this table because it is referenced by constraint | on
table |.

3804

2007

There are no MAPI clients installed on this machine. Install a MAPI client (like
Outlook) on this machine.

3805

2007

CHECK constraints on table | will not be transferred to this table. CHECK
constraints can only be created via SQL DDL statements.

3806

2007

Cannot set multiple NULL, NOT NULL attributes.

3807

2007

Query | contains an ambiguous column name that is conflicting with the correlation
(alias) name |. Either fully qualify the column name or change the correlation
(alias) name.

3808

2007

Need a version 4.x or greater format system database to perform this operation.

3809

2007

Query | was created with a later release of Microsoft Office Access database engine
and may have syntax that this version of Microsoft Office Access database engine
cannot execute. This query can only be executed with the version of Microsoft Office
Access database that created it.

3810

2007

Unrecognized keyword WHEN.

3811

2007

Query could not be executed.

3812

2007

You cannot update this field because the value you're trying to apply is not valid or
would break a data integrity rule. Please correct and try again.

3813

2007

SQL pass through queries are disabled.

3814

2007

Columns that accept multiple values for a record cannot be included in a multiplecolumn relationship.

3815

2007

Columns that accept multiple values for a record cannot be included in a multiplecolumn index.

3816

2007

The unique index on the '|' column cannot be deleted.

3817

2007

The multi-valued field '|' is not valid in a CROSSTAB query.

3818

2007

Operation cannot be completed on this database because it uses attachements or
multi-valued lookup fields.

3819

2007

Find cannot be executed on columns that accept multiple values for a record.

3820

2007

You cannot enter that value because it duplicates an existing value in the multivalued lookup or attachment field. Multi-valued lookup or attachment fields cannot
contain duplicate values.
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3821

2007

You cannot change a multi-valued lookup field to the selected data type.

3822

2007

The value cannot be added to this new row until the row has been committed.
Commit the row first, and then try adding the value.

3823

2007

You cannot edit this field because it resides in a linked Excel spreadsheet. The
ability to edit data in a linked Excel spreadsheet has been disabled in this Access
release.

3824

2007

An INSERT INTO query cannot contain a multi-valued field.

3825

2007

SELECT * cannot be used in an INSERT INTO query when the source or destination
table contains a multi-valued field.

3826

2007

An UPDATE or DELETE query cannot contain a multi-valued field.

3827

2007

Cannot perform an aggregate function on a multi-valued column when a JOIN
clause contains a different multi-valued column.

3828

2007

Cannot reference a table with a multi-valued field using an IN clause that refers to
another database.

3829

2007

The multi-valued field '|' cannot be used in an ORDER BY clause.

3830

2007

The multi-valued field '|' cannot be used in an GROUP BY clause.

3831

2007

The multi-valued field '|' cannot be used in a WHERE or HAVING clause.

3832

2007

The current file format no longer supports user-level security. The conversion or
compaction process has removed any user-level permissions.

3833

2007

The multi-valued field '|' is not valid in the specified JOIN clause.

3834

2007

The multi-valued field '|1' is not valid in the expression '|2'.

3835

2007

The DISTINCT keyword cannot be used with the multi-valued field '|'.

3836

2007

You are attempting to work with a Paradox file that requires the Borland Database
Engine (BDE). Microsoft Office Access cannot load the BDE, or the BDE is not
correctly installed. To correct this, run the setup program for the BDE.

3837

2007

The multi-valued field '|' cannot be used in a UNION query.

3838

2007

Multi-valued fields are not allowed in SELECT INTO statements.

3839

2007

The specified file exists already.

3840

2007

The attachment you are adding exceeds the system resources available.

3841

2007

Cannot connect to the Sharepoint site '|'. Try again later.

3842

2007

The expression '|' must be part of an aggregate function.

3843

2007

An INSERT INTO query that contains a multivalued field cannot contain another field.

3844

2007

Cannot reference a multi-valued field in an UPDATE or DELETE statement that
contains other fields.

3845

2007

Microsoft Office Access does not support linking to an Access database or Microsoft
Office Excel workbook saved in a format that is a later version than the current
database format.

3846

2007

The multi-valued field '|' in an ORDER BY must also appear in the SELECT list.

3847

2007

ODBCDirect is no longer supported. Rewrite the code to use ADO instead of DAO.

3848

2007

You cannot record your changes because a value you entered violates the settings
defined for field '|' (for example, a value is less than the minimum or greater than
the maximum). Correct the error and try again.

3849

2007

Replication is only supported on Access 2000 or Access 2002-2003 format
databases. Use the conversion feature in your application to convert the database
to the proper format.
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3850

2007

This file was created in a previous beta version of Excel 2007. Open the file with
Excel 2007 to save it to the most recent version of the Excel 2007 file format before
opening the file in Access 2007.

3851

2007

The schema for this table has changed. You must refresh the table before editing or
adding new records

3852

2007

Cannot update a multivalued field if its parent recordset is not in edit mode. To
place the parent recordset in edit mode use the AddNew or Edit method.

3853

2007

Microsoft Office Access cannot create the database in the specified format because
of a Group Policy set by your administrator. Create the database using a different
file format or contact your administrator.

3854

2007

This operation will fail because the text file you are about to import contains more
than 255 columns. We recommend that you first make a backup copy of your
source file, reduce the number of columns to 255 or less, and then try again.

6000

2007
2003

Errors were encountered during the save operation.@@@1@@@1
Errors were encountered during the save operation.@@@1@@1

6001

2007

A form or report cannot be the subdatasheet of a table or query.@Only a table or
query can be inserted into another table or query.@@1@@@1
A form or report cannot be the subdatasheet of a table or query.@Only a table or
query can be inserted into another table or query.@@1@@1

2003
6002

2007

2003

2002

Error Description

Microsoft Office Access cannot expand this subdatasheet because all of the records
are locked. @Either the RecordLocks property of the form or report or the Default
Record Locking option in the Advanced section of the Access Options dialog box
(click the Microsoft Office Button, and then click Access Options) is set to All
Records.@Reset the value to No Locks or Edited Record, as
appropriate.@1@1@472@1
Microsoft Office Access cannot expand this subdatasheet because all of the records
are locked. @The RecordLocks property of the form or report or the Default Record
Locking option on the Advanced tab of the Options dialog box (Tools menu) is set to
All Records.@Reset the value to No Locks or Edited Record as appropriate.@1@@1
Microsoft Access cannot expand this subdatasheet because all of the records are
locked. @The RecordLocks property of the form or report or the Default Record
Locking option on the Advanced tab of the Options dialog box (Tools menu) is set to
All Records.@Reset the value to No Locks or Edited Record as appropriate.@1@@1

6003

2007
2003

The setting for the Precision property must be from 1 through 28.@@@1@@@1
The setting for the Precision property must be from 1 through 28.@@@1@@1

6004

2007
2003

The setting for the Scale property must be from 0 through 28.@@@1@@@1
The setting for the Scale property must be from 0 through 28.@@@1@@1

6005

2007

The table or query name '|' you entered in either the property sheet or macro is
misspelled or refers to a table or query that doesn't exist.@If the invalid name is in
a macro, an Action Failed dialog box will display the macro name and the macro's
arguments after you click OK. Open the Macro window, and enter the correct
name.@@1@@@1
The table or query name '|' you entered in either the property sheet or macro is
misspelled or refers to a table or query that doesn't exist.@If the invalid name is in
a macro, an Action Failed dialog box will display the macro name and the macro's
arguments after you click OK. Open the Macro window, and enter the correct
name.@@1@@1

2003

6006

2007
2003

6007

2007

Filter by selection of a partial value is only supported for fields containing character
data.@@@1@@@1
Filter by selection of a partial value is only supported for fields containing character
data.@@@1@@1
Cannot open a form bound to a stored procedure in server filter by form
mode.@@@1@@@1
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6007

2003

Cannot open a form bound to a stored procedure in server filter by form
mode.@@@1@@1

6008

2007

Microsoft Office Access encountered an error closing your connection. @Please close
all of your application windows before trying again.@@1@@@1
Microsoft Office Access encountered an error closing your connection. @Please close
all of your application windows before trying again.@@1@@1
Microsoft Access encountered an error closing your connection. @Please close all of
your application windows before trying again.@@1@@1

2003
2002

6009

2007
2003

6010

2007

Error Description

Invalid connection string.@You may need to specify a valid connection string and
try it again.@@1@@@1
Invalid connection string.@You may need to specify a valid connection string and
try it again.@@1@@1

2000

Invalid use of Move method.@The Move method is not applicable to subforms or
subreports.@@1@@@1
Invalid use of Move method.@The Move method is not applicable to subforms or
subreports.@@1@@1
Property cannot be changed when Form.Recordset has been set.@@@1@@1

6011

2007
2003
2000

Do you want to save the data changes on form '|'?@@@13@@@4
Do you want to save the data changes on form '|'?@@@13@@4
Method cannot be called when Form.Recordset has been set.@@@1@@1

6012

2007

Microsoft Office Access can't set this property to No right now.@You cannot set the
Allow Form View, Allow Datasheet View, Allow PivotTable View, and Allow PivotChart
View properties to No at the same time.@Set one of the other properties to Yes
before changing this one to No.@1@@@1
Microsoft Office Access can't set this property to No right now.@You cannot set the
Allow Form View, Allow Datasheet View, Allow PivotTable View, and Allow PivotChart
View properties to No at the same time.@Set one of the other properties to Yes
before changing this one to No.@1@@1
Microsoft Access can't set this property to No right now.@You cannot set the Allow
Form View, Allow Datasheet View, Allow PivotTable View, and Allow PivotChart View
properties to No at the same time.@Set one of the other properties to Yes before
changing this one to No.@1@@1

2003

2003

2002

6013

2007
2003

Unable to remove item. '|' not found in list.@@@1@@@1
Unable to remove item. '|' not found in list.@@@1@@1

6014

2007

The RowSourceType property must be set to 'Value List' to use this
method.@@@1@@@1
The RowSourceType property must be set to 'Value List' to use this
method.@@@1@@1

2003
6015

2007
2003

6016

2007
2003

2002

6017

2007

Can't add this item. The index is too large.@@@1@@@1
Can't add this item. The index is too large.@@@1@@1
Microsoft Office Access is unable to switch to PivotTable or PivotChart view right
now.@You must set the Record Source property of the form before attempting to
PivotTable or PivotChart view.@@1@@1
Microsoft Access is unable to switch to PivotTable or PivotChart view right
now.@You must set the Record Source property of the form before attempting to
PivotTable or PivotChart view.@@1@@1
Microsoft Office Access doesn't support the requested property for this type of
database object.@The DateCreated and DateModified properties are not supported
for Tables, Queries, Stored Procedures, Database Diagrams, and Functions in a
Client Server database.@@1@@@1
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6017

2003

2002

6018

2007
2003

6019

6020

2007
2003
2007
2003
2002

6021

2007

2003

6022

Error Description
Microsoft Office Access doesn't support the requested property for this type of
database object.@The DateCreated and DateModified properties are not supported
for Tables, Queries, Stored Procedures, Database Diagrams, and Functions in a
Client Server database.@@1@@1
Microsoft Access doesn't support the requested property for this type of database
object.@The DateCreated and DateModified properties are not supported for Tables,
Queries, Stored Procedures, Database Diagrams, and Functions in a Client Server
database.@@1@@1
The form or report template is open in Design view. Before creating a new form or
report, close the corresponding template.@@@1@@@1
The form or report template is open in Design view. Before creating a new form or
report, close the corresponding template.@@@1@@1

You must save new or dirty objects in the database before you can save them to
this external format.@@@1@@1
This format does not support objects named '|'. Rename the object and try
again.@@@1@@@1
This format does not support objects named '|'. Rename the object and try
again.@@@1@@1
This format does not support objects named 'Schema'. Rename the object and try
again.@@@1@@1
Microsoft Office Access cannot build a form or report based on the data returned by
the function object that you have currently selected. @Select a table, query, form,
or report, and try again.@@1@@@1
You cannot create a form with AutoForm or a report with AutoReport by using a
scalar function; you can use a table, view, stored procedure, inline function, or table
function.@@@1@@1

2007
2003

This option cannot be changed in an Access Project file.@@@1@@1

6023

2007
2003

The Maximum Record Count setting cannot be a negative number.@@@1@@@1
The Maximum Record Count setting cannot be a negative number.@@@1@@1

6024

2007

The Maximum Record Count setting cannot contain text - please enter a
number.@@@1@@@1
The Maximum Record Count setting cannot contain text - please enter a
number.@@@1@@1

2003
6025

2007
2003

The Requery action cannot be used on a control bound to a Recordset.@@@1@@@1
The Requery action cannot be used on a control bound to a Recordset.@@@1@@1

6026

2007

The RowSourceType property must be set to 'Table/Query' to use this
method.@@@1@@@1
The RowSourceType property must be set to 'Table/Query' to use this
method.@@@1@@1

2003
6027

6028

2007
2003

2007
2003

6029

2007

You can't save or undo the record at this time. The form's BatchUpdates property is
set to Yes, but the form is not bound to a record source. Either set the form's
BatchUpdates property to No, or bind the form to a record source by setting a value
in the RecordSource property.@@@1@@1
The OLE object failed to persist itself. You will not be able to undo this
operation.@@@1@@@1
The OLE object failed to persist itself. You will not be able to undo this
operation.@@@1@@1

|@@@1@@@1

Copyright (c) 2008 FMS, Inc.

fmsinc.com

Page 128 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

Error Description

6030

2007

The current record in |1 |2 must be saved before you can complete this
operation.@Do you want to save the current record in |1 |2?@@3@@@1

6031

2007

You can't modify the structure of table '|', because it is already in use by another
person or process.@@@1@@@1

6032

2007

The value you entered isn't valid for this field.@For example, you may have entered
a null value.@@1@@@1

6033

2007

The '|1' form does not exist.@Enter the name of an existing form in the List Items
Edit Form property of the '|2' control or leave the property empty.@@1@@@1

6034

2007

This property is only available for attachment controls bound to attachment
fields.@@@1@@@1

6035

2007

Layout view is unavailable for this |.@@@1@@@1

6036

2007

You cannot add a form to another form that shows multiple items.@@@1@@@1

6037

2007

This object was saved in an invalid format and cannot be read.@@@1@@@1

6038

2007

Microsoft Office Access was not able to update the value list.@The table may be
locked by another user, it may be read-only, or you may not have permission to
modify the table.@@1@@@1

6039

2007

Do you want to save the datasheet so that it will be available for use by other forms
and reports?@@@33@1@151798@4

6040

2007

Because dependency checking is not enabled on this database, Access cannot verify
whether this datasheet is used on other forms or reports.@Do you want to save the
datasheet so that it will be available for use by other forms and
reports?@@33@1@151798@4

6041

2007

Grouping information can only be changed in Layout View and Design
View.@@@1@2@5054@1

6042

2007

Deleting the |1 control will permanently remove filter, grouping, or sort order
settings that are based on the control from the form or report. Are you sure you
want to delete the |1 control?.@@@20@1@5833@4

6043

2007

Deleting the selected controls will permanently remove filter, grouping, or sort order
settings that are based on those controls from the form or report. Are you sure you
want to delete the controls?.@@@20@1@5833@4

6044

2007

You will not be able to undo the creation or deletion of this object.@Do you still
want to continue?@@20@1@@4

6045

2007

Microsoft Office Access cannot save the form or report, because it displays
characters from a language that cannot be saved in your current system
locale.@Switch your system locale to the language in the form or report, and then
try again.@@1@2@5054@1

6046

2007

Your changes cannot be saved because the field '|' has been updated by another
user.@@@1@@@1

6047

2007

The number of fields from your currently selected table or query exceeds the
maximum height in Microsoft Office Access forms.@Microsoft Office Access will
create a new form with no fields and open the field list so you can individually select
fields to add to this object.@@3@@@2

6048

2007

The number of fields from your currently selected table or query exceeds the
maximum width in Microsoft Office Access forms and reports.@Microsoft Office
Access will create a new form or report with no fields and open the field list so you
can individually select fields to add to this object.@@3@@@2

6049

2007

Because databases in the current format do not support the Attachment control,
you will not be able to complete this operation.@@@1@@@1

7700

2007

Microsoft Office Access is unable to complete the operation.@Try the operation
again. If the error persists, restart Microsoft Office Access.@@1@@@1
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7700

2003
2002

7701

2007

2003

2002

7702

2007

2003

Error Description
Microsoft Office Access is unable to complete the operation.@Try the operation
again. If the error persists, restart Microsoft Office Access.@@1@@1
Microsoft Access is unable to complete the operation.@Try the operation again. If
the error persists, restart Microsoft Access.@@1@@1
Microsoft Office Access can't synchronize with Synchronizer '|1.'@A possible reason
for the failure to synchronize with '|1' is that both the Synchronizer and Microsoft
Office Access were trying to write to the current database at the same time.Try
synchronizing with '|1' again.@Do you want to continue synchronizing with the
remaining Synchronizers?@19@@@2
Microsoft Office Access can't synchronize with Synchronizer '|1.'@A possible reason
for the failure to synchronize with '|1' is that both the Synchronizer and Microsoft
Office Access were trying to write to the current database at the same time.Try
synchronizing with '|1' again.@Do you want to continue synchronizing with the
remaining Synchronizers?@19@@2
Microsoft Access can't synchronize with Synchronizer '|1.'@A possible reason for the
failure to synchronize with '|1' is that both the Synchronizer and Microsoft Access
were trying to write to the current database at the same time.Try synchronizing
with '|1' again.@Do you want to continue synchronizing with the remaining
Synchronizers?@19@@2

The user-supplied function named '|', the program to assist you in resolving
conflicts, could not be found.@Contact the author of this customized database
application.@@1@@@3
The user-supplied function named '|', the program to assist you in resolving
conflicts, could not be found.@Contact the author of this customized database
application.@@1@@3

7703

2007
2003

There are no synchronization conflicts to resolve.@@@1@@@1
There are no synchronization conflicts to resolve.@@@1@@1

7704

2007

You can't modify the design of '|' at a replica.@Design changes to replicated objects
can be made only at the Design Master.Do you want to open it as readonly?@@19@@@2
You can't modify the design of '|' at a replica.@Design changes to replicated objects
can be made only at the Design Master.Do you want to open it as readonly?@@19@@2

2003

7705

2007
2003

7706

7707

7708

2007
2003
2007
2003

2007

This member of the replica set has conflicts from synchronizing changes with other
members.@Do you want to resolve these conflicts now?@@19@@@2
This member of the replica set has conflicts from synchronizing changes with other
members.@Do you want to resolve these conflicts now?@@19@@2
This member of the replica set has errors from synchronizing changes with another
member.@Do you want to see the errors now?@@19@@2

This member of the replica set has both errors and conflicts from synchronizing
changes with another member.@Do you want to see the errors and resolve the
conflicts now?@@19@@2
'|1' was the last designated Design Master for the replica set. Has '|2' been moved,
renamed, deleted, or corrupted?@You should never have more than one Design
Master for each replica set. Having more than one Design Master in a replica set
prevents the members of the set from synchronizing correctly.@Use Windows
Explorer to determine whether the file has been moved or deleted. Open the file to
determine whether it has been corrupted.@13@@@2
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Access

7708

2003

'|1' was the last designated Design Master for the replica set. Has '|2' been moved,
renamed, deleted, or corrupted?@You should never have more than one Design
Master for each replica set. Having more than one Design Master in a replica set
prevents the members of the set from synchronizing correctly.@Use Windows
Explorer to determine whether the file has been moved or deleted. Open the file to
determine whether it has been corrupted.@13@@2

7709

2007

To make this replica the Design Master for the replica set, on the Database Tools
tab, in the Database Tools group, click Replication Options, click Synchronize Now,
enter the path to '|' (the current Design Master), and then select the Make ... The
Design Master check box.@@@1@@@1
To make this replica the Design Master for the replica set, point to Replication on
the Tools menu, click Synchronize Now, enter the path to '|' (the current Design
Master), and select the Make ... The Design Master check box.@@@1@@1

2003

7710

2007

2003

7711

2007

2003

2002
7712

2007

2003

7713

2007

2003

7714

2007

2003

2002

Error Description

To make this replica the Design Master for the replica set, first synchronize this
replica with all other replicas in the set.@This ensures that this replica includes all
design changes made at the previous Design Master.If you have already
synchronized this replica, do you want to make it the Design Master?@@19@@@2
To make this replica the Design Master for the replica set, first synchronize this
replica with all other replicas in the set.@This ensures that this replica includes all
design changes made at the previous Design Master.If you have already
synchronized this replica, do you want to make it the Design Master?@@19@@2
This member of the replica set is now the Design Master. Microsoft Office Access will
now close and reopen the database in order for the changes to take
effect.@@@1@@@1
This member of the replica set is now the Design Master. Microsoft Office Access will
now close and reopen the database in order for the changes to take
effect.@@@1@@1
This member of the replica set is now the Design Master. Microsoft Access will now
close and reopen the database in order for the changes to take effect.@@@1@@1
This member of the replica set has exceeded the maximum number of days allowed
between synchronizations and can't be synchronized with any other member of the
replica set.@Delete this replica set member and create a new replica.@@1@@@1
This member of the replica set has exceeded the maximum number of days allowed
between synchronizations and can't be synchronized with any other member of the
replica set.@Delete this replica set member and create a new replica.@@1@@1
This member of the replica set will expire in | days because it has not been
synchronized with another member of the replica set.@If the member is allowed to
expire, it can no longer be synchronized with any other member of the replica
set.@You should synchronize this member with another member as soon as
possible. To synchronize, on the the Database Tools tab, in the Database Tools
group, click Replication Options, and then click Synchronize Now.@1@@@1
This member of the replica set will expire in | days because it hasn't been
synchronized with another member of the replica set.@If the member is allowed to
expire, it can no longer be synchronized with any other member of the replica
set.@Synchronize with another member as soon as possible. To synchronize, point
to Replication on the Tools menu, and click Synchronize Now.@1@@1

Microsoft Office Access cannot close the database at this time.@Make sure there is
no Visual Basic code executing in the current database. You may need to run Setup
again to properly install Briefcase Replication.@@1@@@1
Microsoft Office Access cannot close the database at this time.@Make sure there is
no Visual Basic code executing in the current database. You may need to run Setup
again to properly install Briefcase Replication.@@1@@1
Microsoft Access cannot close the database at this time.@Make sure there is no
Visual Basic code executing in the current database. You may need to run Setup
again to properly install Briefcase Replication.@@1@@1
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Access

7715

2007

2003

2002

7716

2007
2003
2002

7717

2007
2003
2002

7718

2007

2003

2002

7719

2007
2003

7720

2007

2003

Error Description
Microsoft Office Access cannot complete this operation because it can't find or
initialize the dynamic-link library AceRclr.@Rerun Microsoft Office Access or
Microsoft Office Setup again to reinstall Microsoft Briefcase Replication. During
Setup, click Add/Remove, and select Microsoft Briefcase Replication.If you want to
preserve your security or custom settings, back up the Microsoft Office Access
workgroup information file.For information on backing up files, search the
Microsoft Windows Help index for 'backing up files'.@@1@@@3
Microsoft Office Access cannot complete this operation because it can't find or
initialize the dynamic-link library Msrclr40.@Rerun Microsoft Office Access or
Microsoft Office Setup again to reinstall Microsoft Briefcase Replication. During
Setup, click Add/Remove, and select Microsoft Briefcase Replication.If you want to
preserve your security or custom settings, back up the Microsoft Office Access
workgroup information file.For information on backing up files, search the
Microsoft Windows Help index for 'backing up files'.@@1@@3
Microsoft Access cannot complete this operation because it can't find or initialize the
dynamic-link library Msrclr40.@Rerun Microsoft Access or Microsoft Office Setup
again to reinstall Microsoft Briefcase Replication. During Setup, click Add/Remove,
and select Microsoft Briefcase Replication.If you want to preserve your security or
custom settings, back up the Microsoft Access workgroup information file.For
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@@1@@3

The database must be closed prior to synchronization.@Do you want Microsoft
Office Access to close the database and synchronize with '|'?@@19@@@2
The database must be closed prior to synchronization.@Do you want Microsoft
Office Access to close the database and synchronize with '|'?@@19@@2
The database must be closed prior to synchronization.@Do you want Microsoft
Access to close the database and synchronize with '|'?@@19@@2
All open objects must be closed before synchronizing.@Do you want Microsoft Office
Access to close the objects?@@19@@@2
All open objects must be closed before synchronizing.@Do you want Microsoft Office
Access to close the objects?@@19@@2
All open objects must be closed before synchronizing.@Do you want Microsoft
Access to close the objects?@@19@@2
Microsoft Office Access can't synchronize this member of the replica set because
one or more objects are open.@Because synchronizing may involve updating the
data in or design of the database, all objects must be closed before you
synchronize.@Close all objects and try again.@1@@@1
Microsoft Office Access can't synchronize this member of the replica set because
one or more objects are open.@Because synchronizing may involve updating the
data in or design of the database, all objects must be closed before you
synchronize.@Close all objects and try again.@1@@1
Microsoft Access can't synchronize this member of the replica set because one or
more objects are open.@Because synchronizing may involve updating the data in or
design of the database, all objects must be closed before you synchronize.@Close
all objects and try again.@1@@1
You can't save
objects can be
You can't save
objects can be

design changes to '|' at a replica.@Design changes to replicated
made only at the Design Master.@@1@@@1
design changes to '|' at a replica.@Design changes to replicated
made only at the Design Master.@@1@@1

You can't save design changes to '|1' at a replica.@Design changes to replicated
objects can be made only at the Design Master. Do you want to save it as a new,
local object?@@19@@@2
You can't save design changes to '|1' at a replica.@Design changes to replicated
objects can be made only at the Design Master. Do you want to save it as a new,
local object?@@19@@2
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Access

7721

2007
2003

7722

2007
2003

2002
7723

2007
2003

2002
7724

2007

2003

2002

7725

2007

2003

2002

Error Description
You can't delete or rename '|' at a replica.@These operations can't be performed on
a replica; they can be performed only at the Design Master.@@1@@@1
You can't delete or rename '|' at a replica.@These operations can't be performed on
a replica; they can be performed only at the Design Master.@@1@@1

All open objects must be closed before creating a replica.@Do you want Microsoft
Office Access to close the objects?@@19@@2
All open objects must be closed before creating a replica.@Do you want Microsoft
Access to close the objects?@@19@@2
Microsoft Office Access couldn't close one or more objects.@Close all objects
manually and try again.@@1@@1
Microsoft Access couldn't close one or more objects.@Close all objects manually and
try again.@@1@@1
Microsoft Office Access has converted '|1' to the Design Master for the replica
set.@Only the Design Master can accept changes to the database structure;
however, data changes can be made at the Design Master or any
replica.@@1@@@1
Microsoft Office Access has converted '|1' to the Design Master for the replica
set.@Only the Design Master can accept changes to the database structure;
however, data changes can be made at the Design Master or any replica.@@1@@1
Microsoft Access has converted '|1' to the Design Master for the replica set.@Only
the Design Master can accept changes to the database structure; however, data
changes can be made at the Design Master or any replica.@@1@@1
Microsoft Office Access has converted '|1' to the Design Master for the replica set
and has created a replica at '|2'.@Only the Design Master can accept changes to
the database structure; however, data changes can be made at the Design Master
or any replica.@@1@@@1
Microsoft Office Access has converted '|1' to the Design Master for the replica set
and has created a replica at '|2'.@Only the Design Master can accept changes to
the database structure; however, data changes can be made at the Design Master
or any replica.@@1@@1
Microsoft Access has converted '|1' to the Design Master for the replica set and has
created a replica at '|2'.@Only the Design Master can accept changes to the
database structure; however, data changes can be made at the Design Master or
any replica.@@1@@1

7726

2007
2003
2002

Microsoft Office Access has created a replica at '|2'.@@@1@@@1
Microsoft Office Access has created a replica at '|2'.@@@1@@1
Microsoft Access has created a replica at '|2'.@@@1@@1

7727

2007

Microsoft Office Access can't create a replica because this database is already open
in exclusive mode.@Do you want Microsoft Office Access to close the
database?@@19@@@2
Microsoft Office Access can't create a replica because this database is already open
in exclusive mode.@Do you want Microsoft Office Access to close the
database?@@19@@2
Microsoft Access can't create a replica because this database is already open in
exclusive mode.@Do you want Microsoft Access to close the database?@@19@@2

2003

2002
7728

2007

2003

Microsoft Office Access can't overwrite '|': the replica can't be created at this
location.@The file you are trying to overwrite may be open.@Close any other
applications that might be using this file.@1@@@1
Microsoft Office Access can't overwrite '|': the replica can't be created at this
location.@The file you are trying to overwrite may be open.@Close any other
applications that might be using this file.@1@@1
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Access

7728

2002

Microsoft Access can't overwrite '|': the replica can't be created at this
location.@The file you are trying to overwrite may be open.@Close any other
applications that might be using this file.@1@@1

7729

2007

Microsoft Office Access can't make a new replica at '|' because the source has the
same path and file name.@Choose a different path or file name for the new
replica.@@1@@@1
Microsoft Office Access can't make a new replica at '|' because the source has the
same path and file name.@Choose a different path or file name for the new
replica.@@1@@1
Microsoft Access can't make a new replica at '|' because the source has the same
path and file name.@Choose a different path or file name for the new
replica.@@1@@1

2003

2002

Error Description

7730

2007
2003

The synchronization was completed successfully.@@@1@@@1
The synchronization was completed successfully.@@@1@@1

7731

2007

Microsoft Office Access cannot synchronize this member of the replica set because it
is open in Exclusive mode. @To open the database in Shared mode, close and
reopen the database.@@1@@@1
Microsoft Office Access can't synchronize this member of the replica set because it
is open in exclusive mode. @To open the database in shared mode, close the
database, click Open Database on the File menu, and clear the Exclusive check box.
Then select the database.@@1@@1
Microsoft Access can't synchronize this member of the replica set because it is open
in exclusive mode. @To open the database in shared mode, close the database,
click Open Database on the File menu, and clear the Exclusive check box. Then
select the database.@@1@@1

2003

2002

7732

2007

2003

7733

2007

2003

7734

2007
2003
2002

7735

2007

2003

'|' is saved as a local table. Changes made to the table will not be sent to the
replicas in the set.@To make this table available to other members of the replica
set, close the table, right-click it in the Navigation Pane, click Table Properties on
the shortcut menu, and then select the Replicated check box.@@1@@@1
'|' is saved as a local table. Changes made to it won't be sent to the replicas in the
set.@To make this table available to other members of the replica set, close the
table, select it in the Database window, click Properties on the View menu, and then
select the Replicated check box.@@1@@1

The synchronization request has been received, and the Synchronizer will complete
the process as resources become available.@Make sure that the Synchronizer for
this member of the replica set is running. It may be several minutes before the
synchronization will occur.@@1@@@1
The synchronization request has been received, and the Synchronizer will complete
the process as resources become available.@Make sure that the Synchronizer for
this member of the replica set is running. It may be several minutes before the
synchronization will occur.@@1@@1
Microsoft Office Access has saved the design of table '|,' but it will not be made
replicable until the Table window is closed.@@@1@@@1
Microsoft Office Access has saved the design of table '|,' but it will not be made
replicable until the Table window is closed.@@@1@@1
Microsoft Access has saved the design of table '|,' but it will not be made replicable
until the Table window is closed.@@@1@@1
Changes to this object can be made only at the Design Master.@Any changes you
make will be discarded when the form is closed.@To save your changes, click the
Microsoft Office Button, point to Save As, and then save the object under a different
name.@1@@@1
Changes to this object can be made only at the Design Master.@Any changes you
make will be discarded when the form is closed.@To save your changes, click Save
As on the File menu and save the object under a different name.@1@@1
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Access

7735

2000

7736

2007
2003

2002

7737

2007

2003

2002

7738

2007

2003

2002

7739

2007

2003

2002

7740

2007

2003

2002

7741

2007

Error Description
Changes to this object can be made only at the Design Master.@Any changes you
make will be discarded when the form is closed.@To save your changes, click Save
As/Export on the File menu and save the object under a different name.@1@@1
Microsoft Office Access has deleted '|' and removed it from the replica set.@This
change isn't reflected until the database is closed and reopened.@Do you want
Microsoft Office Access to close and reopen the database now?@19@@2
Microsoft Access has deleted '|' and removed it from the replica set.@This change
isn't reflected until the database is closed and reopened.@Do you want Microsoft
Access to close and reopen the database now?@19@@2

Microsoft Office Access has converted '|1' to the Design Master for the replica set
and has created a replica at '|2'.@The new replica will not appear in the list of
potential synchronization partners until this database is closed and reopened.@Do
you want Microsoft Office Access to close and reopen the database now?@19@@@2
Microsoft Office Access has converted '|1' to the Design Master for the replica set
and has created a replica at '|2'.@The new replica will not appear in the list of
potential synchronization partners until this database is closed and reopened.@Do
you want Microsoft Office Access to close and reopen the database now?@19@@2
Microsoft Access has converted '|1' to the Design Master for the replica set and has
created a replica at '|2'.@The new replica will not appear in the list of potential
synchronization partners until this database is closed and reopened.@Do you want
Microsoft Access to close and reopen the database now?@19@@2
Microsoft Office Access has successfully created a replica at '|2'.@However, the new
replica will not appear in the list of potential synchronization partners until this
database is closed and reopened.@Do you want Microsoft Office Access to close and
reopen the database now?@19@@@2
Microsoft Office Access has successfully created a replica at '|2'.@However, the new
replica will not appear in the list of potential synchronization partners until this
database is closed and reopened.@Do you want Microsoft Office Access to close and
reopen the database now?@19@@2
Microsoft Access has successfully created a replica at '|2'.@However, the new
replica will not appear in the list of potential synchronization partners until this
database is closed and reopened.@Do you want Microsoft Access to close and
reopen the database now?@19@@2
Microsoft Office Access has deleted '|' and removed it from the replica set.@This
change isn't reflected until the database is closed and reopened.@Please close and
reopen the database when you are finished synchronizing replicas.@1@@@1
Microsoft Office Access has deleted '|' and removed it from the replica set.@This
change isn't reflected until the database is closed and reopened.@Please close and
reopen the database when you are finished synchronizing replicas.@1@@1
Microsoft Access has deleted '|' and removed it from the replica set.@This change
isn't reflected until the database is closed and reopened.@Please close and reopen
the database when you are finished synchronizing replicas.@1@@1
Microsoft Office Access cannot synchronize with a database from a previous
version.@Convert the database you are trying to synchronize with, before
synchronizing.@@1@@@1
Microsoft Office Access cannot synchronize with a database from a previous
version.@Convert the database you are trying to synchronize with, before
synchronizing.@@1@@1
Microsoft Access cannot synchronize with a database from a previous
version.@Convert the database you are trying to synchronize with, before
synchronizing.@@1@@1
Microsoft Office Access can't make a new replica at '|' because the value entered for
priority is out of range.@Priority for new replicas should be in the range of 0100.@@1@@@1
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Access

7741

2003

2002

Error Description
Microsoft Office Access can't make a new replica at '|' because the value entered for
priority is out of range.@Priority for new replicas should be in the range of 0100.@@1@@1
Microsoft Access can't make a new replica at '|' because the value entered for
priority is out of range.@Priority for new replicas should be in the range of 0100.@@1@@1

7742

2007
2003
2002

Microsoft Office Access cannot replicate a password-protected database.
Microsoft Office Access can't make a password-protected database replicable
Microsoft Access can't make a password-protected database replicable

7743

2007

Backup, restore, and drop database operations are available only when you have at
least Microsoft SQL Server 2000 installed on your local computer.
Backup, restore, and drop database operations are only available for Microsoft SQL
Server version 7.0 or later running on your local computer.
Backup, Restore, and Drop SQL Database operations are only available for SQL
Server 7.0 running on the local machine.

2003
2000
7744

2007
2003
2002

Microsoft Office Access can't make a new replica at '|' because the value entered for
priority is out of range.@Priority for anonymous replicas should be 0.@@1@@@1
Microsoft Office Access can't make a new replica at '|' because the value entered for
priority is out of range.@Priority for anonymous replicas should be 0.@@1@@1
Microsoft Access can't make a new replica at '|' because the value entered for
priority is out of range.@Priority for anonymous replicas should be 0.@@1@@1

7745

2007

You can't copy local objects in a replica. Design changes to replicated objects can
be made only at the Design Master.

7746

2007

The Database administrative components failed to load or initialize. Verify that the
components are installed and registered locally.

7747

2007
2002

Database Replicas cannot be converted to prior versions of Microsoft Office Access.
Database Replicas cannot be converted to prior versions of Microsoft Access.

7748

2007

This stage of the conversion process is finished. To complete the conversion
process, synchronize this replica to the (converted) Design Master.

7749

2007

Open the Design Master and sync to this replica before opening.

7750

2007

In Datasheet view, you can't set a control property if the control is part of an option
group.@@@1@@@1
In Datasheet view, you can't set a control property if the control is part of an option
group.@@@1@@1

2003
7751

2007

2003

2002

In Design view, you can't retrieve the value of the ObjectPalette property for an OLE
object contained in a bound object frame.@Microsoft Office Access doesn't display
the OLE object in the object frame in Design view.@Remove the reference to the
ObjectPalette property, or switch to Form view before you run the macro or Visual
Basic code that references the ObjectPalette property.@1@@@1
In Design view, you can't retrieve the value of the ObjectPalette property for an OLE
object contained in a bound object frame.@Microsoft Office Access doesn't display
the OLE object in the object frame in Design view.@Remove the reference to the
ObjectPalette property, or switch to Form view before you run the macro or Visual
Basic code that references the ObjectPalette property.@1@@1
In Design view, you can't retrieve the value of the ObjectPalette property for an OLE
object contained in a bound object frame.@Microsoft Access doesn't display the OLE
object in the object frame in Design view.@Remove the reference to the
ObjectPalette property, or switch to Form view before you run the macro or Visual
Basic code that references the ObjectPalette property.@1@@1
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Access

7752

2007

2003

2002

Error Description
Microsoft Office Access cannot apply the filter because all of the records are
locked.@Either the RecordLocks property of the form or report or the Default Record
Locking option in the Advanced section of the Access Options dialog box (click the
Microsoft Office Button, and then click Access Options) is set to All Records.@Reset
the value to No Locks or Edited Record, as appropriate.@1@1@472@1
Microsoft Office Access can't apply the filter because all the records are
locked.@The RecordLocks property of the form or report or the Default Record
Locking option on the Advanced tab of the Options dialog box (Tools menu) is set to
All Records.@Reset the value to No Locks or Edited Record as
appropriate.@1@600472@1
Microsoft Access can't apply the filter because all the records are locked.@The
RecordLocks property of the form or report or the Default Record Locking option on
the Advanced tab of the Options dialog box (Tools menu) is set to All
Records.@Reset the value to No Locks or Edited Record as
appropriate.@1@600472@1

7753

2007
2003

|@@@1@2@7236@1
|@@@1@7236@1

7754

2007

You cannot position columns between two frozen columns in a datasheet.@To
unfreeze all columns, on the Home tab, in the Records group, click More, and then
click Unfreeze All Columns.@@1@1@9174@1
You can't move columns between two frozen columns in a datasheet.@To unfreeze
all columns, click Unfreeze All Columns on the Format menu.@@1@209174@1

2003
7755

2007

2003

2002

2000

7756

7757

7758

2007
2003

2007
2003
2007
2003

Microsoft Office Access can't start the Chart Wizard.@The wizard may not be
installed, or this wizard has been disabled.@To install the Chart Wizard, rerun the
Microsoft Office Access or the Microsoft Office Setup program, click Add/Remove,
and then select the Wizards check box. To reenable this wizard, click the Microsoft
Office Button, and then click Access Options. Click Add-Ins, and then in the Manage
list, click Disabled Items, and then click Go.@1@@@3
Microsoft Office Access can't start the Chart Wizard.@The wizard may not be
installed, or this wizard has been disabled.@To install the Chart Wizard, rerun the
Microsoft Office Access or Microsoft Office Setup program, click Add/Remove, and
then select the Wizards check box. To reenable this wizard, click About Microsoft
Office Access on the Help menu, and then click the Disabled Items button to view a
list of addins which you can enable.@1@@3
Microsoft Access can't start the Chart Wizard.@The wizard may not be installed, or
this wizard has been disabled.@To install the Chart Wizard, rerun the Microsoft
Access or Microsoft Office Setup program, click Add/Remove, and then select the
Wizards check box. To reenable this wizard, click About Microsoft Access on the
Help menu, and then click the Disabled Items button to view a list of addins which
you can enable.@1@@3
Microsoft Access can't start the Chart Wizard.@The wizard may not be installed.@To
install the Chart Wizard, rerun the Microsoft Access or Microsoft Office Setup
program, click Add/Remove, and then select the Wizards check box.@1@@3
The form can't display the What's This button if the Minimize button or the Maximize
button is displayed.@Set the WhatsThisButton property to No, or set the
MinMaxButtons property to None.@@1@@1
The form can't display the Minimize button or the Maximize button if the What's This
button is displayed.@@@1@@1
This ActiveX control isn't enabled in Form view.@You can't set the Enabled or
TabStop properties to True.@@1@@@1
This ActiveX control isn't enabled in Form view.@You can't set the Enabled or
TabStop properties to True.@@1@@1
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Access

7759

2007
2003

Error Description
This ActiveX control isn't visible in Form view.@You can't set the Visible or TabStop
properties to True.@@1@@@1
This ActiveX control isn't visible in Form view.@You can't set the Visible or TabStop
properties to True.@@1@@1

7760

2007
2003

This property is locked and can't be changed.@@@1@@@1
This property is locked and can't be changed.@@@1@@1

7761

2007
2003

An error occurred when you changed the control.@@@1@@@1
An error occurred when you changed the control.@@@1@@1

7762

2007
2003

The pattern string is invalid.@@@2@1@10109@1
The pattern string is invalid.@@@2@210109@1

7763

2007

This feature isn't installed, or has been disabled.@To install this feature, rerun the
Microsoft Office Access or the Microsoft Office Setup program or, if you're using a
third-party add-in, reinstall the add-in. To reenable this wizard, click the Microsoft
Office Button, and then click Access Options. Click Add-Ins, and then in the Manage
list, click Disabled Items, and then click Go.@@1@@@3
This feature isn't installed, or has been disabled.@To install this feature, rerun the
Microsoft Office Access or Microsoft Office Setup program or, if you're using a thirdparty add-in, reinstall the add-in. To reenable this wizard, click About Microsoft
Office Access on the Help menu, and then click the Disabled Items button to view a
list of addins which you can enable.@@1@@3
This feature isn't installed, or has been disabled.@To install this feature, rerun the
Microsoft Access or Microsoft Office Setup program or, if you're using a third-party
add-in, reinstall the add-in. To reenable this wizard, click About Microsoft Access on
the Help menu, and then click the Disabled Items button to view a list of addins
which you can enable.@@1@@3
This feature isn't installed.@To install this feature, rerun the Microsoft Access or
Microsoft Office Setup program or, if you're using a third-party add-in, reinstall the
add-in.@@1@@3

2003

2002

2000

7764

2007
2003

2002

2000

7765

2007
2003

2002

This feature isn't installed, or has been disabled.@To install this feature, rerun the
Microsoft Office Access or Microsoft Office Setup program, click Add/Remove, and
then select the Wizards check box. To reenable this wizard, click About Microsoft
Office Access on the Help menu, and then click the Disabled Items button to view a
list of addins which you can enable.@@1@@3
This feature isn't installed, or has been disabled.@To install this feature, rerun the
Microsoft Access or Microsoft Office Setup program, click Add/Remove, and then
select the Wizards check box. To reenable this wizard, click About Microsoft Access
on the Help menu, and then click the Disabled Items button to view a list of addins
which you can enable.@@1@@3
This feature isn't installed.@To install this feature, rerun the Microsoft Access or
Microsoft Office Setup program, click Add/Remove, and then select the Wizards
check box.@@1@@3
This feature isn't installed, or has been disabled.@To install this feature, rerun the
Microsoft Office Access or Microsoft Office Setup program, click Add/Remove, and
then click the Additional Wizards check box. To reenable this wizard, click About
Microsoft Office Access on the Help menu, and then click the Disabled Items button
to view a list of addins which you can enable.@@1@@3
This feature isn't installed, or has been disabled.@To install this feature, rerun the
Microsoft Access or Microsoft Office Setup program, click Add/Remove, and then
click the Additional Wizards check box. To reenable this wizard, click About Microsoft
Access on the Help menu, and then click the Disabled Items button to view a list of
addins which you can enable.@@1@@3
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Access

7765

2000

This feature isn't installed.@To install this feature, rerun the Microsoft Access or
Microsoft Office Setup program, click Add/Remove, and then click the Advanced
Wizards check box.@@1@@3

7766

2007
2003

This control can't be changed to the type you requested.@@@1@@@1
This control can't be changed to the type you requested.@@@1@@1

7767

2007
2003
2002

An error occurred while Microsoft Office Access was creating a section.@@@1@@@1
An error occurred while Microsoft Office Access was creating a section.@@@1@@1
An error occurred while Microsoft Access was creating a section.@@@1@@1

7768

2007

In order to change data through this form, the focus must be in a bound field that
can be modified.@@@1@@@1
In order to change data through this form, the focus must be in a bound field that
can be modified.@@@1@@1

2003

Error Description

7769

2007
2003

The filter operation was canceled. The filter would be too long.@@@1@@@1
The filter operation was canceled. The filter would be too long.@@@1@@1

7770

2007

Microsoft Office Access didn't apply the filter.@Microsoft Office Access may not be
able to apply the filter if you entered an invalid data type in one of the fields.Do
you want to close the filter anyway?@If you click Yes, Microsoft Office Access will
build the filter, but won't apply it to the recordset. Then it will close the Filter By
Form window.@19@@@2
Microsoft Office Access didn't apply the filter.@Microsoft Office Access may not be
able to apply the filter if you entered an invalid data type in one of the fields.Do
you want to close the filter anyway?@If you click Yes, Microsoft Office Access will
build the filter, but won't apply it to the recordset. Then it will close the Filter By
Form window.@19@@2
Microsoft Access didn't apply the filter.@Microsoft Access may not be able to apply
the filter if you entered an invalid data type in one of the fields.Do you want to
close the filter anyway?@If you click Yes, Microsoft Access will build the filter, but
won't apply it to the recordset. Then it will close the Filter By Form window.@19@@2

2003

2002

7771

2007
2003

7773

2007

2003

2002

7774

2007
2003

You can't set the ColumnOrder property when you are in Form view or Print
Preview.@@@1@@@1
You can't set the ColumnOrder property when you are in Form view or Print
Preview.@@@1@@1

Microsoft Office Access can't set the LimitToList property to No right now.@The first
visible column, which is determined by the ColumnWidths property, isn't equal to
the bound column.@Adjust the ColumnWidths property first, and then set the
LimitToList property.@1@1@929@1
Microsoft Office Access can't set the LimitToList property to No right now.@The first
visible column, which is determined by the ColumnWidths property, isn't equal to
the bound column.@Adjust the ColumnWidths property first, and then set the
LimitToList property.@1@600929@1
Microsoft Access can't set the LimitToList property to No right now.@The first visible
column, which is determined by the ColumnWidths property, isn't equal to the
bound column.@Adjust the ColumnWidths property first, and then set the
LimitToList property.@1@600929@1
You can't set the MenuBar property while an OLE object is in-place
active.@@@1@@@1
You can't set the MenuBar property while an OLE object is in-place
active.@@@1@@1

7775

2007
2003

There are too many controls on the form to allow Filter By Form.@@@1@@@1
There are too many controls on the form to allow Filter By Form.@@@1@@1

7777

2007
2003

You've used the ListIndex property incorrectly.@@@2@1@6997@1
You've used the ListIndex property incorrectly.@@@2@606997@1
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Access

7778

2007
2003

Error Description
You can't save an object when you are in the Filter By Form window.@Switch to
Form view, and then save the object.@@1@@@1
You can't save an object when you are in the Filter By Form window.@Switch to
Form view, and then save the object.@@1@@1

7779

2007
2003

You cannot set a form's MenuBar property from its menu bar macro.@@1@@@1
You can't set a form's MenuBar property from its menu bar macro.@Right-click the
Form selector button (located to the left of the horizontal ruler) on the form in
Design view. Click Properties, click the Other tab, and then set the MenuBar
property.@@1@@1

7780

2007

You're trying to insert into a section that can't grow enough for the control you're
trying to add.@The maximum total height for all sections in a report, including the
section headers, is 200 inches (508 cm).@Remove, or reduce the height of, at least
one section. Then try to add the control again.@1@@@1
You're trying to insert into a section that can't grow enough for the control you're
trying to add.@The maximum total height for all sections in a report, including the
section headers, is 200 inches (508 cm).@Remove, or reduce the height of, at least
one section. Then try to add the control again.@1@@1

2003

7782

2007
2003

7784

2007

2003

2000
7785

2007

2003

2002

7788

You can't create a new instance of this form or report while it is in Design
view.@@@1@@@1
You can't create a new instance of this form or report while it is in Design
view.@@@1@@1
The object you have selected is already open for design as a subform or subreport.
To open this object in Design view, select the subform or subreport in the object in
which it is already open, and then on the Design tab, in the Tools group, click
Subform in New Window.
This form or report is already being designed as a subform or subreport. To open
this form in Design view, select the subform or subreport and click Subform in New
Window on the View menu.
You can't open a form or report while it is being designed as a subform or subreport.

Microsoft Office Access didn't build the filter.@There is an error in the current
field. Do you want to close the filter anyway?@If you click Yes, Microsoft Office
Access will undo the changes to the filter, and then close the Filter By Form
window.@19@@@2
Microsoft Office Access didn't build the filter.@There is an error in the current
field. Do you want to close the filter anyway?@If you click Yes, Microsoft Office
Access will undo the changes to the filter, and then close the Filter By Form
window.@19@@2
Microsoft Access didn't build the filter.@There is an error in the current field. Do
you want to close the filter anyway?@If you click Yes, Microsoft Access will undo the
changes to the filter, and then close the Filter By Form window.@19@@2

2007
2003

Compile error.@@@1@@1

7789

2007
2003

Type mismatch.@@@1@@@1
Type mismatch.@@@1@@1

7790

2007

Microsoft Office Access can't create the |1.@Either there was an error getting
information from the table or query you selected, or a new |2 could not be
created.@@1@@@1
Microsoft Office Access can't create the |1.@Either there was an error getting
information from the table or query you selected, or a new |2 could not be
created.@@1@@1
Microsoft Access can't create the |1.@Either there was an error getting information
from the table or query you selected, or a new |2 could not be created.@@1@@1

2003

2002
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Access

7791

2007

2003

7792

2007

Error Description
There was an error creating your |1.@Some fields may have been skipped because
there was an error getting information about them or because they didn't fit on the
|2.@@1@@@1
There was an error creating your |1.@Some fields may have been skipped because
there was an error getting information about them or because they didn't fit on the
|2.@@1@@1

2003

You can't open a subform or subreport when it is also open in Design
view.@@@1@@@1
You can't open a subform when it is also open in Design view.@@@1@@1

7793

2007
2003

You must save the form '|' before you can embed it.@@@1@@@1
You must save the form '|' before you can embed it.@@@1@@1

7794

2007
2003
2002

Microsoft Office Access couldn't find the toolbar '|'.@@@1@@@1
Microsoft Office Access couldn't find the toolbar '|'.@@@1@@1
Microsoft Access couldn't find the toolbar '|'.@@@1@@1

7795

2007

The custom toolbar '|' is the wrong type (menu, shortcut menu, or toolbar) for the
property it's being used in.@@@1@@@1
The custom toolbar '|' is the wrong type (menu, shortcut menu, or toolbar) for the
property it's being used in.@@@1@@1

2003
7796

2007

2003

2002

7797

2007
2003

The process failed because there is no printer installed.@Because Microsoft Office
Access saves the printer settings with each form or report, a printer is needed to
convert, enable, copy and paste, import, or export your forms or reports. To install
a printer: In Microsoft Windows XP, click Start, and then click Printers and Faxes.
Under Printer Tasks, click Add a printer.In Microsoft Windows 2000, click Start,
point to Settings, and then click Printers. Double-click Add Printer.Follow the
instructions in the wizard.@@1@@@1
The process failed because there is no printer installed.@Because Microsoft Office
Access saves the printer settings with each form or report, a printer is needed to
convert, enable, copy and paste, import, or export your forms or reports. To install
a printer, point to Settings on the Windows Start menu, click Printers, and then
double-click Add Printer. Follow the instructions in the wizard.@@1@@1
The process failed because there is no printer installed.@Because Microsoft Access
saves the printer settings with each form or report, a printer is needed to convert,
enable, copy and paste, import, or export your forms or reports. To install a printer,
point to Settings on the Windows Start menu, click Printers, and then double-click
Add Printer. Follow the instructions in the wizard.@@1@@1

You must save new objects in the database before you can save them to this
external format.@@@1@@@1
You must save new objects in the database before you can save them to this
external format.@@@1@@1

7798

2007
2003

You can only save select, crosstab, and union queries to this format.@@@1@@@1
You can only save select, crosstab, and union queries to this format.@@@1@@1

7799

2007

This form or report is
record.@Exclude any
types to Memo in the
This form or report is
record.@Exclude any
types to Memo in the

2003

7800

2007

2003

based on a query that exceeds the
unnecessary fields from the query,
original tables.@@1@@@1
based on a query that exceeds the
unnecessary fields from the query,
original tables.@@1@@1

limit for data in a single
or change some of the field

limit for data in a single
or change some of the field

You can't create a Microsoft Office Access MDE database from a database in an old
format.@Close the database and convert it to the current version of Microsoft Office
Access. Then create the MDE database.@@1@@@1
You can't create a Microsoft Office Access MDE database from a database in an old
format.@Close the database and convert it to the current version of Microsoft Office
Access. Then create the MDE database.@@1@@1
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Access

7800

2002

You can't create a Microsoft Access MDE database from a database in an old
format.@Close the database and convert it to the current version of Microsoft
Access. Then create the MDE database.@@1@@1

7801

2007

This database is in an unrecognized format.@The database may have been created
with a later version of Microsoft Office Access than the one you are using. Upgrade
your version of Microsoft Office Access to the current one, then open this
database.@@1@@@1
This database is in an unrecognized format.@The database may have been created
with a later version of Microsoft Office Access than the one you are using. Upgrade
your version of Microsoft Office Access to the current one, then open this
database.@@1@@1
This database is in an unrecognized format.@The database may have been created
with a later version of Microsoft Access than the one you are using. Upgrade your
version of Microsoft Access to the current one, then open this database.@@1@@1

2003

2002

7802

2007

2003
2000
7803

2007
2003
2002

7804

2007
2000

Error Description

The command you specified is not available in an .mde, .accde, or .ade
database.@@@1@@@1
That command isn't available in an MDE/ADE database.@@@1@@1
That command isn't available in an MDE database.@@@1@@1

Microsoft Office Access can't rename |1 to |2. The convert operation
failed.@@@1@@@1
Microsoft Office Access can't rename |1 to |2. The convert operation
failed.@@@1@@1
Microsoft Access can't rename |1 to |2. The convert operation failed.@@@1@@1
Microsoft Access can't open this replica created with a previous version of
Access.@Do one of the following:* Convert the Design Master and associated
replicas to Microsoft Access 97.* Open the database using the previous version
first, then try to open it in the current version.@@1@@1

7805

2007
2003

This is already an MDE database.@@@1@@@1
This is already an MDE database.@@@1@@1

7806

2007

This database does not have a Visual Basic project, so it can't be made into an MDE
file.@Open the database in Microsoft Office Access to create the Visual Basic
project.@@1@@@1
This database does not have a Visual Basic project, so it can't be made into an MDE
file.@Open the database in Microsoft Office Access to create the Visual Basic
project.@@1@@1
This database does not have a Visual Basic project, so it can't be made into an MDE
file.@Open the database in Microsoft Access to create the Visual Basic
project.@@1@@1

2003

2002

7807

2007

2003

7808

2007
2003
2002

7809

2007

You cannot convert the open database to an MDE file by running a macro or Visual
Basic code.@Instead of using a macro or code, on the Database Tools tab, in the
Database Tools group, click Make MDE.@@1@@@1
You can't make the open database into an MDE file while running a macro or Visual
Basic code.@Instead of using a macro or code, on the Tools menu, point to
Database Utilities, and then click Make MDE File.@@1@@1
Microsoft Office Access can't replace an existing file as a result of converting the
Microsoft Office Access database. You must select a new file name.@@@1@@@1
Microsoft Office Access can't replace an existing file as a result of converting the
Microsoft Office Access database. You must select a new file name.@@@1@@1
Microsoft Access can't replace an existing file as a result of converting the Microsoft
Access database. You must select a new file name.@@@1@@1

You can't rename a | object in the client/server version of Microsoft Office
Access.@@@1@@@1
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Access

7809

2003
2002

7810

2007

2003

7811

2007

2003

2002

2000
7812

2007
2002

7813

2007
2003

2000

7814

2007
2003

2000

Error Description
You can't rename a | object in the client/server version of Microsoft Office
Access.@@@1@@1
You can't rename a | object in the client/server version of Microsoft
Access.@@@1@@1
You cannot compact the open database by running a macro or Visual Basic
code.@Instead of using a macro or code, click the Microsoft Office Button, point to
Manage, and then click Compact and Repair Database.@@1@@@1
You can't compact the open database while running a macro or Visual Basic
code.@Instead of using a macro or code, on the Tools menu, point to Database
Utilities, and then click Compact/Repair Database.@@1@@1

Microsoft Office Access requires Microsoft SQL Server 6.5 or later for Access
projects. You need to upgrade the selected SQL database to Microsoft SQL Server
6.5 or later.@@@1@@@1
Microsoft Office Access requires Microsoft SQL Server 6.5 or later for Access
projects. You need to upgrade the selected SQL database to Microsoft SQL Server
6.5 or later.@@@1@@1
Microsoft Access requires Microsoft SQL Server 6.5 or later for Access projects.
You need to upgrade the selected SQL database to Microsoft SQL Server 6.5 or
later.@@@1@@1
Microsoft Access requires SQL Server 6.5 or later for Access projects. You need to
upgrade the selected SQL database to SQL Server 6.5 or later.@@@1@@1
Microsoft Office Access projects can only be connected to Microsoft SQL Server
Microsoft Access projects can only be connected to Microsoft SQL Server

Restoring a database requires that no one is currently using the database.@Do you
want to close all objects, select a backup file, and restore the database from
backup?@@1@@1
Restoring a database requires that no one is currently using the database.@Do you
want to close all objects, select a backup file, and restore the database from
backup.@@1@@1
Dropping a database requires that no one is currently using the database.@Do you
want to close all open objects and drop the database?@@1@@1
Dropping a database requires that no one is currently using the database.@Do you
want to close all open objects, and drop the database.@@1@@1

7815

2007
2003
2002

Microsoft Office Access was unable to create an ADE database.@@@1@@@1
Microsoft Office Access was unable to create an ADE database.@@@1@@1
Microsoft Access was unable to create an ADE database.@@@1@@1

7816

2007

Microsoft Office Access requires this Microsoft SQL Server 6.5 installation to be
upgraded to service pack 5 in order to successfully connect to this server.
@@@1@@@1
Microsoft Office Access requires this Microsoft SQL Server 6.5 installation to be
upgraded to service pack 5 in order to successfully connect to this server.
@@@1@@1
Microsoft Access requires this Microsoft SQL Server 6.5 installation to be upgraded
to service pack 5 in order to successfully connect to this server. @@@1@@1
Microsoft Access requires this SQL 6.5 installation to be upgraded to SP5 in order to
successfully connect to this server. @@@1@@1

2003

2002
2000
7817

2007
2003

The database file '|' is already open.
file.@@@1@@@1
The database file '|' is already open.
file.@@@1@@1

Copyright (c) 2008 FMS, Inc.

You cannot encode to an open
You cannot encode to an open

fmsinc.com

Page 143 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

7817

2002

7818

2007
2003

2002
7819

2007

2003

2002

7820

7821

2007
2003
2002

2007
2003
2002

7822

2007

2003

2002

7823

2007
2003

7824

2007
2003

Error Description
The database file '|' is already open.
file.@@@1@@1

You cannot encrypt to an open

Microsoft Office Access was unable to create the Database window.@Please upgrade
to a newer version of Microsoft Internet Explorer.@@1@@1
Microsoft Access was unable to create the Database window.@Please upgrade to a
newer version of Microsoft Internet Explorer.@@1@@1
You have chosen a database template file that is not supported in the current
version of Microsoft Office Access.@To create a database using the Database
Wizard, click the Databases tab in the New dialog box and then double-click a
database icon.@@1@@@1
You have chosen a database template file that is not supported in the current
version of Microsoft Office Access.@To create a database using the Database
Wizard, click the Databases tab in the New dialog box and then double-click a
database icon.@@1@@1
You have chosen a database template file that is not supported in the current
version of Microsoft Access.@To create a database using the Database Wizard, click
the Databases tab in the New dialog box and then double-click a database
icon.@@1@@1
Microsoft Office Access no longer supports Pages as startup documents.
Microsoft Access no longer supports Pages as startup documents.
The TEMP environment variable isn't defined. Microsoft Office Access can't find the
temporary file directory.@@@1@@@1
The TEMP environment variable isn't defined. Microsoft Office Access can't find the
temporary file directory.@@@1@@1
The TEMP environment variable isn't defined. Microsoft Access can't find the
temporary file directory.@@@1@@1
Microsoft Office Access can't initialize the transfer object. Make sure you have
Microsoft SQL Server or the Microsoft SQL Server Desktop Engine installed on the
local machine.@@@1@@@1
Microsoft Office Access can't initialize the transfer object. Make sure you have
Microsoft SQL Server or the Microsoft SQL Server Desktop Engine installed on the
local machine.@@@1@@1
Microsoft Access can't initialize the transfer object. Make sure you have Microsoft
SQL Server or the Microsoft SQL Server Desktop Engine installed on the local
machine.@@@1@@1

The source or destination database name is missing. The transfer operation can't
continue.@@@1@@@1
The source or destination database name is missing. The transfer operation can't
continue.@@@1@@1
The source or destination server name is missing. The transfer operation can't
continue.@@@1@@@1
The source or destination server name is missing. The transfer operation can't
continue.@@@1@@1

7825

2007
2003
2002

Microsoft Office Access can't find the server '|'.@@@1@@@1
Microsoft Office Access can't find the server '|'.@@@1@@1
Microsoft Access can't find the server '|'.@@@1@@1

7826

2007

The database object type isn't supported by the Microsoft Office Access transfer
operation.@@@1@@@1
The database object type isn't supported by the Microsoft Office Access transfer
operation.@@@1@@1

2003
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Access

7826

2002

The database object type isn't supported by the Microsoft Access transfer
operation.@@@1@@1

7827

2007

The current database '|1' has |2 active connections. Microsoft Office Access must
disconnect all applications before you can copy the database file. What do you want
to do to all the active connections? &Disconnect Cancel@@@35@@@
The current database '|1' has |2 active connections. Microsoft Office Access must
disconnect all applications before you can copy the database file. What do you want
to do to all the active connections? &Disconnect Cancel@@@35@@
The current database '|1' has |2 active connections. Microsoft Access must
disconnect all applications before you can copy the database file. What do you want
to do to all the active connections? &Disconnect Cancel@@@35@@

2003

2002

7828

2007
2003
2002

7829

2007
2003
2002

7830

2007
2003
2002

Error Description

The object '|' is not a valid Microsoft SQL Server database object. Microsoft Office
Access can't transfer this object.@@@1@@@1
The object '|' is not a valid Microsoft SQL Server database object. Microsoft Office
Access can't transfer this object.@@@1@@1
The object '|' is not a valid Microsoft SQL Server database object. Microsoft Access
can't transfer this object.@@@1@@1
The SQL script used to create database objects is corrupted. Microsoft Office Access
can't create the new objects.@@@1@@@1
The SQL script used to create database objects is corrupted. Microsoft Office Access
can't create the new objects.@@@1@@1
The SQL script used to create database objects is corrupted. Microsoft Access can't
create the new objects.@@@1@@1

The SQL script used to create database object '|' is corrupted. Microsoft Office
Access can't create the new object.@@@1@@@1
The SQL script used to create database object '|' is corrupted. Microsoft Office
Access can't create the new object.@@@1@@1
The SQL script used to create database object '|' is corrupted. Microsoft Access
can't create the new object.@@@1@@1

7831

2007
2003
2002

Microsoft Office Access can't create the file '|'.@@@1@@@1
Microsoft Office Access can't create the file '|'.@@@1@@1
Microsoft Access can't create the file '|'.@@@1@@1

7832

2007

The current database '|' is replicated and can't be copied until you disable
replication. Use Microsoft SQL Server Enterprise Manager to remove publications
and subscriptions before copying the database file.@@@1@@@1
The current database '|' is replicated and can't be copied until you disable
replication. Use Microsoft SQL Server Enterprise Manager to remove publications
and subscriptions before copying the database file.@@@1@@1

2003

7833

2007
2003

7834

2007
2003

7835

2007
2003
2002

The current database '|' has more than one data file and can't be
copied.@@@1@@@1
The current database '|' has more than one data file and can't be
copied.@@@1@@1
The Transfer Database Wizard didn't provide enough information to perform the
transfer operation.@@@1@@@1
The Transfer Database Wizard didn't provide enough information to perform the
transfer operation.@@@1@@1
Microsoft Office Access can't copy the database file because one or more objects are
open. Do you want to close all the objects?@@@1@@@1
Microsoft Office Access can't copy the database file because one or more objects are
open. Do you want to close all the objects?@@@1@@1
Microsoft Access can't copy the database file because one or more objects are open.
Do you want to close all the objects?@@@1@@1
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Access

7836

2007
2003
2002

Error Description
Microsoft Office Access can't copy the database file because one or more objects are
open. Close all objects and try again.@@@1@@@1
Microsoft Office Access can't copy the database file because one or more objects are
open. Close all objects and try again.@@@1@@1
Microsoft Access can't copy the database file because one or more objects are open.
Close all objects and try again.@@@1@@1

7837

2007
2003

Invalid argument in script.@@@1@@@1
Invalid argument in script.@@@1@@1

7838

2007

There were errors during the database transfer operation. Open the transfer log file
for details.@@@1@@@1
There were errors during the database transfer operation. Open the transfer log file
for details.@@@1@@1

2003
7839

2007
2003

Errors occurred during the database transfer operation.@@@1@@@1
Errors occurred during the database transfer operation.@@@1@@1

7840

2007

The database transfer operation failed. The destination database '|' was created and
is in an unknown state. What would you like to do with the destination
database? &Keep &Delete@@@35@@@
The database transfer operation failed. The destination database '|' was created and
is in an unknown state. What would you like to do with the destination
database? &Keep &Delete@@@35@@

2003

7841

2007
2003

7842

2007
2003

2002

7843

2007

2003

7844

2007
2003
2002

The destination file '|' already exists. Set the Overwrite flag to TRUE if you want to
replace the existing file.@@@1@@@1
The destination file '|' already exists. Set the Overwrite flag to TRUE if you want to
replace the existing file.@@@1@@1

This operation requires at least Microsoft SQL Server 2000 to be installed on your
local computer.@@@1@@@1
This operation requires Microsoft SQL Server version 7.0 or later on your local
computer. You can install Microsoft SQL Server 2000 Desktop Engine from the
MSDE2000 folder on the Microsoft Office CD-ROM.@@@1@@1
This operation requires Microsoft SQL Server version 7.0 or later on your local
computer. You can install Microsoft SQL Server 2000 Desktop Engine from the
MSDE2000 folder on the Microsoft Office XP CD-ROM.@@@1@@1
You can only copy a database that is on your local computer. To make a copy of a
database on a remote computer, click the Microsoft Office Button, point to Server
Tasks, and then click Transfer Database.@@@1@@@1
You can only copy the database file when the current database is on your local
computer. If you want to make a copy of a database on a remote server point to
Database Utilities on the Tools menu, and then click Transfer Database.@@@1@@1
Microsoft Office Access can't copy the database file because there are active
connections to the current database.@@@1@@@1
Microsoft Office Access can't copy the database file because there are active
connections to the current database.@@@1@@1
Microsoft Access can't copy the database file because there are active connections
to the current database.@@@1@@1

7845

2007
2003

|@@@1@@@1
|@@@1@@1

7846

2007
2003
2002

Microsoft Office Access can't compact and repair the current database.@@@1@@@1
Microsoft Office Access can't compact and repair the current database.@@@1@@1
Microsoft Access can't compact and repair the current database.@@@1@@1

7847

2007

'|' already exists. Microsoft Office Access must create a backup of your file before
performing the repair operation. Enter a name for the backup file.@@@1@@@1
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Access

7847

2003
2002

7848

2007

2003

7849

2007

2003

2002

7850

2007

2003

2002

2000

7851

2007
2003

7852

2007

Error Description
'|' already exists. Microsoft Office Access must create a backup of your file before
performing the repair operation. Enter a name for the backup file.@@@1@@1
'|' already exists. Microsoft Access must create a backup of your file before
performing the repair operation. Enter a name for the backup file.@@@1@@1
The transfer operation has been cancelled. The destination database '|' was created
and is in an unknown state. What would you like to do with the destination
database? &Keep &Delete@@@35@@@
The transfer operation has been cancelled. The destination database '|' was created
and is in an unknown state. What would you like to do with the destination
database? &Keep &Delete@@@35@@

The repair operation has been canceled because Microsoft Office Access could not
create a backup of the file. You might not have adequate permissions or enough
disk space to create the backup file. To repair the file manually, click the Microsoft
Office Button, point to Manage, and then click Compact and Repair
Database.@@@1@@@1
The repair operation has been cancelled because Microsoft Office Access couldn't
create a backup of the file. You might not have adequate permissions or enough
disk space to create the backup file. To repair the file manually, point to Database
Utilities on the Tools menu, and then click Compact and Repair
Database.@@@1@@1
The repair operation has been cancelled because Microsoft Access couldn't create a
backup of the file. You might not have adequate permissions or enough disk space
to create the backup file. To repair the file manually, point to Database Utilities on
the Tools menu, and then click Compact and Repair Database.@@@1@@1
The wizard you've requested is not installed or is in a bad state. Please install or
reinstall the wizard. If you do not have permission to do this on your computer,
please contact your help desk representative.@@@1@1@153723@1
Microsoft Office Access can't find the wizard, or the wizard has not been installed, or
there is a syntax error in the Declarations section of a Visual Basic module.@The
wizard you need may be missing from the Libraries key of the Microsoft Office
Access section of the Windows Registry, or the wizard has been disabled.@To make
sure that the wizard is in the Windows Registry, run Setup to reinstall Microsoft
Office Access, and then compile all Visual Basic modules in the database. To
reenable this wizard, click About Microsoft Office Access on the Help menu, and
then click the Disabled Items button to view a list of addins which you can enable.
@1@@3
Microsoft Access can't find the wizard, or the wizard has not been installed, or there
is a syntax error in the Declarations section of a Visual Basic module.@The wizard
you need may be missing from the Libraries key of the Microsoft Access section of
the Windows Registry, or the wizard has been disabled.@To make sure that the
wizard is in the Windows Registry, run Setup to reinstall Microsoft Access, and then
compile all Visual Basic modules in the database. To reenable this wizard, click
About Microsoft Access on the Help menu, and then click the Disabled Items button
to view a list of addins which you can enable. @1@@3
Microsoft Access can't find the wizard, or there is a syntax error in the Declarations
section of a Visual Basic module.@The wizard you need may be missing from the
Libraries key of the Microsoft Access section of the Windows Registry.@To make
sure that the wizard is in the Windows Registry, run Setup to reinstall Microsoft
Access, and then compile all Visual Basic modules in the database.@1@@3
The toolbar name '|' you entered already exists.@Enter a unique name for this
toolbar.@@1@@@1
The toolbar name '|' you entered already exists.@Enter a unique name for this
toolbar.@@1@@1
The toolbar name '|' you entered doesn't follow Microsoft Office Access objectnaming rules.@For more information about naming objects, click
Help.@@2@1@11734@1
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Access

7852

2003

2002

Error Description
The toolbar name '|' you entered doesn't follow Microsoft Office Access objectnaming rules.@For more information about naming objects, click
Help.@@2@611734@1
The toolbar name '|' you entered doesn't follow Microsoft Access object-naming
rules.@For more information about naming objects, click Help.@@2@611734@1

7853

2007
2003

The default column width must be at least 0.1 inch.@@@1@@@1
The default column width must be at least 0.1 inch.@@@1@@1

7854

2007

You can't export database objects (except tables) from the current version of
Microsoft Office Access to earlier versions of Microsoft Office Access.@@@1@@@1
You can't export database objects (except tables) from the current version of
Microsoft Office Access to earlier versions of Microsoft Office Access.@@@1@@1
You can't export database objects (except tables) from the current version of
Microsoft Access to earlier versions of Microsoft Access.@@@1@@1

2003
2002
7855

2007
2003

You must have a database open to create custom toolbars, and the database can't
be read-only.@@@1@@@1
You must have a database open to create custom toolbars, and the database can't
be read-only.@@@1@@1

7856

2007
2003

'|' cannot be imported, exported, or copied to Access project files.@@@1@@@1
'|' cannot be imported, exported, or copied to Access project files.@@@1@@1

7858

2007

The Tab Width setting in the Options dialog box (Tools menu) for the Module or
Debug window must be from 1 through 32.@@@1@@@1
The Tab Width setting in the Options dialog box (Tools menu) for the Module or
Debug window must be from 1 through 32.@@@1@@1

2003
7859

2007
2002

Microsoft Office Access can't start because there is no license for it on this machine.
Microsoft Access can't start because there is no license for it on this machine.

7860

2007

The profile '|' that you specified on the command line doesn't exist in the Windows
Registry.@@@1@@@1
The profile '|' that you specified on the command line doesn't exist in the Windows
Registry.@@@1@@1

2003
7861

2007
2003

'|' cannot be imported, exported, or copied to Access database files.@@@1@@@1
'|' cannot be imported, exported, or copied to Access database files.@@@1@@1

7862

2007

Microsoft Office Access can't find the wizard. This wizard has not been installed, or
there is an incorrect setting in the Windows Registry, or this wizard has been
disabled. @To reenable this wizard, click the Microsoft Office Button, and click
Access Options. Click Add-Ins, and then in the Manage list, click Disabled Items,
and then click Go. Rerun Microsoft Office Access or Microsoft Office Setup program
to reinstall the wizards. If the missing wizard is not a Microsoft Office Access wizard,
reinstall it using the Add-in Manager.@@1@@@3
Microsoft Office Access can't find the wizard. This wizard has not been installed, or
there is an incorrect setting in the Windows Registry, or this wizard has been
disabled. @To reenable this wizard, click About Microsoft Office Access on the Help
menu, and then click the Disabled Items button to view a list of addins which you
can enable. Rerun Microsoft Office Access or Microsoft Office Setup to reinstall the
wizards. If the missing wizard is not a Microsoft Office Access wizard, reinstall it
using the Add-in Manager.@@1@@3
Microsoft Access can't find the wizard. This wizard has not been installed, or there
is an incorrect setting in the Windows Registry, or this wizard has been disabled.
@To reenable this wizard, click About Microsoft Access on the Help menu, and then
click the Disabled Items button to view a list of addins which you can enable. Rerun
Microsoft Access or Microsoft Office Setup to reinstall the wizards. If the missing
wizard is not a Microsoft Access wizard, reinstall it using the Add-in
Manager.@@1@@3

2003

2002
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Access

Error Description

7862

2000

Microsoft Access can't find the wizard, or there is an incorrect setting in the
Windows Registry.@Rerun Microsoft Access or Microsoft Office Setup to reinstall the
wizards. If the missing wizard is not a Microsoft Access wizard, reinstall it using the
Add-in Manager.@@1@@3

7863

2007
2002

Links can only be created between Microsoft Office Access database files.
Links can only be created between Microsoft Access database files.

7864

2007
2003
2002

Microsoft Office Access doesn't allow empty strings.@@@1@@1
Microsoft Access doesn't allow empty strings.@@@1@@1

7865

2007

There is already an existing database with the name you entered. Give the new
database a unique name.

7866

2007

Microsoft Office Access can't open the database because it is missing, or opened
exclusively by another user, or it is not an ADP file.
Microsoft Office Access can't open the database because it is missing, or opened
exclusively by another user.
Microsoft Access can't open the database because it is missing, or opened
exclusively by another user.

2003
2002
7867

2007

You already have the database open.

7868

2007

You can't use a SetMenuItem macro action on a default menu.@SetMenuItem is for
custom menus only.@@1@@@1
You can't use a SetMenuItem macro action on a default menu.@SetMenuItem is for
custom menus only.@@1@@1

2003

7869

2007
2003

7870

2007
2003
2002

7871

2007
2003
2002

The SetMenuItem action does not have enough information to be carried out.@An
argument is invalid, or there are not enough arguments.@@1@@@1
The SetMenuItem action does not have enough information to be carried out.@An
argument is invalid, or there are not enough arguments.@@1@@1
Microsoft Office Access can't find the database '|.'@Check the database name (and
path, if specified) to make sure you entered it correctly.@@1@@@1
Microsoft Office Access can't find the database '|.'@Check the database name (and
path, if specified) to make sure you entered it correctly.@@1@@1
Microsoft Access can't find the database '|.'@Check the database name (and path, if
specified) to make sure you entered it correctly.@@1@@1
The table name you entered doesn't follow Microsoft Office Access object-naming
rules.@For more information about naming objects, click Help.@@2@1@11734@1
The table name you entered doesn't follow Microsoft Office Access object-naming
rules.@For more information about naming objects, click Help.@@2@611734@1
The table name you entered doesn't follow Microsoft Access object-naming
rules.@For more information about naming objects, click Help.@@2@611734@1

7872

2007

This recordset is not updatable.

7873

2007

'|' cannot be imported, exported, or copied to another database or project
file.@@@1@@@1
'|' cannot be imported, exported, or copied to another database or project
file.@@@1@@1

2003
7874

2007

Microsoft Office Access can't find the object '|'.@* You misspelled the object name.
Check for missing underscores ( _ ) or other punctuation, and make sure you didn't
enter leading spaces.* You tried to open a linked table, but the file containing the
table isn't on the path you specified. Use the Linked Table Manager to update the
link and point to the correct path.@@1@@@1
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Access

7874

2003

2002

7875

2007

2003

2002

7876

2007

2003

7877

2007

2003

2002

7878

2007
2003

7879

2007
2003
2002

7880

2007
2003

Error Description
Microsoft Office Access can't find the object '|.'@* You misspelled the object name.
Check for missing underscores ( _ ) or other punctuation, and make sure you didn't
enter leading spaces.* You tried to open a linked table, but the file containing the
table isn't on the path you specified. Use the Linked Table Manager to update the
link and point to the correct path.@@1@@1
Microsoft Access can't find the object '|.'@* You misspelled the object name. Check
for missing underscores ( _ ) or other punctuation, and make sure you didn't enter
leading spaces.* You tried to open a linked table, but the file containing the table
isn't on the path you specified. Use the Linked Table Manager to update the link and
point to the correct path.@@1@@1
The table '|' already exists.@You created or renamed a table, and then tried to save
it. Before Microsoft Office Access could save the table, another user created or
renamed one using the same name.@@1@@@1
The table '|' already exists.@You created or renamed a table, and then tried to save
it. Before Microsoft Office Access could save the table, another user created or
renamed one using the same name.@@1@@1
The table '|' already exists.@You created or renamed a table, and then tried to save
it. Before Microsoft Access could save the table, another user created or renamed
one using the same name.@@1@@1

There isn't enough temporary disk space to complete the operation.@Free disk
space, and then try the operation again.For more information on freeing
temporary disk space, search the Microsoft Windows Help index for 'disk space,
freeing'.For information on compacting a database to free disk space, click
Help.@@2@1@9009@3
There isn't enough temporary disk space to complete the operation.@Free disk
space, and then try the operation again.For more information on freeing
temporary disk space, search the Microsoft Windows Help index for 'disk space,
freeing'.For information on compacting a database to free disk space, click
Help.@@2@209009@3
Microsoft Office Access can't sort on the Memo, OLE Object, or Hyperlink '|'.@The
ORDER BY clause of an SQL statement can't include any Memo, OLE Object, or
Hyperlink fields.@@1@@@1
Microsoft Office Access can't sort on the Memo, OLE Object, or Hyperlink '|'.@The
ORDER BY clause of an SQL statement can't include any Memo, OLE Object, or
Hyperlink fields.@@1@@1
Microsoft Access can't sort on the Memo, OLE Object, or Hyperlink '|'.@The ORDER
BY clause of an SQL statement can't include any Memo, OLE Object, or Hyperlink
fields.@@1@@1

The data has been changed.@Another user edited this record and saved the
changes before you attempted to save your changes.@Re-edit the record.@1@@@1
The data has been changed.@Another user edited this record and saved the
changes before you attempted to save your changes.@Re-edit the record.@1@@1
An invalid IDA has been passed to Microsoft Office Access error handling.@Please
report this error and the steps that caused it.@@1@@@1
An invalid IDA has been passed to Microsoft Office Access error handling.@Please
report this error and the steps that caused it.@@1@@1
An invalid IDA has been passed to Microsoft Access error handling.@Please report
this error and the steps that caused it.@@1@@1
The value you entered is the wrong data type for this field.@Enter an
integer.@@1@@@1
The value you entered is the wrong data type for this field.@Enter an
integer.@@1@@1
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Access

7881

2007

2003

2002

2000

Error Description
The Macro Conversion Wizard can't be started.@This wizard may not be installed, or
this wizard has been disabled.@To reenable this wizard, click the Microsoft Office
Button, and then click Access Options. Click Add-Ins, and then in the Manage list,
click Disabled Items, and then click Go. Rerun Microsoft Office Access or the
Microsoft Office Setup program to reinstall this wizard. If you want to preserve your
security or custom settings, back up the Microsoft Office Access workgroup
information file.For more information on backing up files, search for 'backing up
files' in Microsoft Windows Help.@1@@@3
The Macro Conversion Wizard can't be started.@This wizard may not be installed, or
this wizard has been disabled.@To reenable this wizard, click About Microsoft Office
Access on the Help menu, and then click the Disabled Items button to view a list of
addins which you can enable. Rerun Microsoft Office Access or Microsoft Office
Setup to reinstall this wizard. If you want to preserve your security or custom
settings, back up the Microsoft Office Access workgroup information file.For more
information on backing up files, search the Microsoft Windows Help index for
'backing up files'.@1@@3
The Macro Conversion Wizard can't be started.@This wizard may not be installed, or
this wizard has been disabled.@To reenable this wizard, click About Microsoft
Access on the Help menu, and then click the Disabled Items button to view a list of
addins which you can enable. Rerun Microsoft Access or Microsoft Office Setup to
reinstall this wizard. If you want to preserve your security or custom settings, back
up the Microsoft Access workgroup information file.For more information on
backing up files, search the Microsoft Windows Help index for 'backing up
files'.@1@@3
The Macro Conversion Wizard can't be started.@This wizard may not be
installed.@Rerun Microsoft Access or Microsoft Office Setup to reinstall this wizard.
If you want to preserve your security or custom settings, back up the Microsoft
Access workgroup information file.For more information on backing up files,
search the Microsoft Windows Help index for 'backing up files'.@1@@3

7882

2007
2003
2002

You can't convert, enable, or encode an Access Project file.@@@1@@@1
You can't convert, enable, or encode an Access Project file.@@@1@@1
You can't convert, enable, or encrypt an Access Project file.@@@1@@1

7883

2007
2003

You can't set the MenuBar property unless a database is open.@@@1@@@1
You can't set the MenuBar property unless a database is open.@@@1@@1

7884

2007

You can't export an object to itself.@Select a different database to export to, or
give the object a new name.@@1@@@1
You can't export an object to itself.@Select a different database to export to, or
give the object a new name.@@1@@1

2003
7885
7886

2007
2003
2007
2003
2002
2000

The source database has no import/export specifications to copy.@@@1@@1
Microsoft Office Access can't find the dynamic-link library (DLL) Mso.@Rerun the
Microsoft Office Access or Microsoft Office Setup program.@@1@@@3
Microsoft Office Access can't find the dynamic-link library (DLL) Mso.@Rerun the
Microsoft Office Access or Microsoft Office Setup program.@@1@@3
Microsoft Access can't find the dynamic-link library (DLL) Mso.@Rerun the Microsoft
Access or Microsoft Office Setup program.@@1@@3
Microsoft Access can't find the dynamic-link library (DLL) Mso9.@Rerun the
Microsoft Access or Microsoft Office Setup program.@@1@@3

7887

2007
2003

A unique record identifier can't consist of more than 10 fields.@@@1@@@1
A unique record identifier can't consist of more than 10 fields.@@@1@@1

7888

2007

You must set the default font size to a number from |1 through |2.@For more
information on the FontSize property, click Help.@@2@2@5477@1
You must set the default font size to a number from |1 through |2.@For more
information on the FontSize property, click Help.@@2@5477@1

2003
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Access

7888

2002

You must set the default font size to a number from |1 through |2.@For more
information on the FontSize property, click Help.@@2@612551@1

7889

2007
2003

The file '|' does not exist.@@@1@@@1
The file '|' does not exist.@@@1@@1

7890

2007

The file '|' doesn't contain any data.@You can't import from, or link to, an empty
spreadsheet.@@1@@@1
The file '|' doesn't contain any data.@You can't import from, or link to, an empty
spreadsheet.@@1@@1

2003
7891

7892

2007
2003
2007

2003
7893

2007

2003

2002

7895

2007

2003

2002

Error Description

This database is read-only.@The conditional compilation argument option can't be
saved.@@1@@1
An error occurred while saving module options.@You may be running Visual Basic in
break mode.@Reset the running code before changing the module
options.@1@@@1
An error occurred while saving module options.@You may be running Visual Basic in
break mode.@Reset the running code before changing the module options.@1@@1
You cannot import objects into a database created in an earlier version of Microsoft
Office Access.@To convert the database to the current version of Microsoft Office
Access, click the Microsoft Office Button, and then click Convert@@1@1@9029@1
You can't import objects into a database created in an earlier version of Microsoft
Office Access.@Convert the database to the current version of Microsoft Office
Access using the Convert Database command (Tools menu, Database Utilities
submenu).@@1@209029@1
You can't import objects into a database created in an earlier version of Microsoft
Access.@Convert the database to the current version of Microsoft Access using the
Convert Database command (Tools menu, Database Utilities
submenu).@@1@209029@1

Microsoft Office Access was unable to create a window.@The system is out of
resources or memory.@Close unneeded programs and try again.For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@1@@@3
Microsoft Office Access was unable to create a window.@The system is out of
resources or memory.@Close unneeded programs and try again.For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@1@@3
Microsoft Access was unable to create a window.@The system is out of resources or
memory.@Close unneeded programs and try again.For more information on
freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@1@@3

7896

2007
2003

Error '|' in the validation rule.@@@2@1@687@1
Error '|' in the validation rule.@@@2@600687@1

7897

2007
2003

Error '|' in the default value.@@@2@1@2264@1
Error '|' in the default value.@@@2@602264@1

7898

2007

Execution of this application has stopped due to a run-time error.@The application
can't continue and will be shut down.@@1@@@3
Execution of this application has stopped due to a run-time error.@The application
can't continue and will be shut down.@@1@@3

2003
7899

2007

2003

Microsoft Office Access can't be started.@Microsoft Office Access was unable to
initialize the Windows Registry.@Rerun Microsoft Office Access or Microsoft Office
Setup to reinstall Microsoft Office Access.@1@@185309@3
Microsoft Office Access can't be started.@Microsoft Office Access was unable to
initialize the Windows Registry.@Rerun Microsoft Office Access or Microsoft Office
Setup to reinstall Microsoft Office Access.@1@@3
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Access

7899

2002

Microsoft Access can't be started.@Microsoft Access was unable to initialize the
Windows Registry.@Rerun Microsoft Access or Microsoft Office Setup to reinstall
Microsoft Access.@1@@3

7900

2007

Microsoft Office Access can't convert the database because it can't create an error
table.@@@1@@@1
Microsoft Office Access can't convert the database because it can't create an error
table.@@@1@@1
Microsoft Access can't convert the database because it can't create an error
table.@@@1@@1

2003
2002
7901

2007
2003
2002

7902

2007
2003

7903

2007
2003
2002

7904

2007

2003

2002

7905

2007

2003

2002

7906

2007

2003

Error Description

Microsoft Office Access can't convert the database because it can't write to the error
table.@@@1@@@1
Microsoft Office Access can't convert the database because it can't write to the error
table.@@@1@@1
Microsoft Access can't convert the database because it can't write to the error
table.@@@1@@1
Errors occurred converting |1 validation rules and default values.@See error table
'|2' for a list of errors.@@1@@@1
Errors occurred converting |1 validation rules and default values.@See error table
'|2' for a list of errors.@@1@@1

Microsoft Office Access can't insert this field.@There are too many fields in the
table. The limit is 255.@@1@@@1
Microsoft Office Access can't insert this field.@There are too many fields in the
table. The limit is 255.@@1@@1
Microsoft Access can't insert this field.@There are too many fields in the table. The
limit is 255.@@1@@1
An error occurred in the Field Builder.@You've replaced or modified the default Field
Builder, and Microsoft Office Access is unable to run the new version. Reinstall
Microsoft Office Access to correct the error.@@1@@185309@1
An error occurred in the Field Builder.@You've replaced or modified the default Field
Builder, and Microsoft Office Access is unable to run the new version. Reinstall
Microsoft Office Access to correct the error.@@1@@1
An error occurred in the Field Builder.@You've replaced or modified the default Field
Builder, and Microsoft Access is unable to run the new version. Reinstall Microsoft
Access to correct the error.@@1@@1
Microsoft Office Access can't change these field data types.@Some data in this table
violates the record validation rule.@Before any data types can be changed, remove
the record validation rule or correct the data.@1@@@1
Microsoft Office Access can't change these field data types.@Some data in this table
violates the record validation rule.@Before any data types can be changed, remove
the record validation rule or correct the data.@1@@1
Microsoft Access can't change these field data types.@Some data in this table
violates the record validation rule.@Before any data types can be changed, remove
the record validation rule or correct the data.@1@@1
Microsoft Office Access couldn't launch the Lookup Wizard, or this wizard has been
disabled.@Rerun the Microsoft Office Access or the Microsoft Office Setup program,
click Add/Remove, and select the Wizards check box. To reenable this wizard, click
the Microsoft Office Button, and then click Access Options. Click Add-Ins, and then
in the Manage list, click Disabled Items, and then click Go.@@1@@@1
Microsoft Office Access couldn't launch the Lookup Wizard, or this wizard has been
disabled.@Rerun the Microsoft Office Access or Microsoft Office Setup program, click
Add/Remove, and select the Wizards check box. To reenable this wizard, click About
Microsoft Office Access on the Help menu, and then click the Disabled Items button
to view a list of addins which you can enable.@@1@@1
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Access

7906

2002

2000

7907

2007
2003

Error Description
Microsoft Access couldn't launch the Lookup Wizard, or this wizard has been
disabled.@Rerun the Microsoft Access or Microsoft Office Setup program, click
Add/Remove, and select the Wizards check box. To reenable this wizard, click About
Microsoft Access on the Help menu, and then click the Disabled Items button to
view a list of addins which you can enable.@@1@@1
Microsoft Access couldn't launch the Lookup Wizard.@Rerun the Microsoft Access or
Microsoft Office Setup program, click Add/Remove, and select the Wizards check
box.@@1@@1
You don't have permission to modify the design of this table.@For more information
on permissions and who can set them, click Help.@@2@1@10222@1
You don't have permission to modify the design of this table.@For more information
on permissions and who can set them, click Help.@@2@410222@1

7908

2007
2003

You can't modify this table now because someone else is using it.@@@1@@@1
You can't modify this table now because someone else is using it.@@@1@@1

7909

2007

Microsoft Office Access can't add another column to this table.@You can have up to
255 columns in your table.@@1@@@1
Microsoft Office Access can't add another column to this table.@You can have up to
255 columns in your table.@@1@@1
Microsoft Access can't add another column to this table.@You can have up to 255
columns in your table.@@1@@1

2003
2002
7910

2007
2003
2002

7911

2007

2003

2002
7912

2007

2003

7913

2007

2003

Microsoft Office Access can't delete this column.@Tables must have at least one
column.@@1@@@1
Microsoft Office Access can't delete this column.@Tables must have at least one
column.@@1@@1
Microsoft Access can't delete this column.@Tables must have at least one
column.@@1@@1
Microsoft Office Access can't delete this index.@This table participates in one or
more relationships.@Delete its relationships in the Relationships window
first.@1@@@1
Microsoft Office Access can't delete this index.@This table participates in one or
more relationships.@Delete its relationships in the Relationships window
first.@1@@1
Microsoft Access can't delete this index.@This table participates in one or more
relationships.@Delete its relationships in the Relationships window first.@1@@1
Once you save the change to the data type of this column, you will not be able to
change back to the previous data type.@Are you sure you want change the data
type?@@20@@@2
Once you save the change to the data type of this column, you will not be able to
change back to the previous data type.@Are you sure you want change the data
type?@@20@@2

You can't change a random-valued AutoNumber field to an incremental AutoNumber
field.@The values of random-valued AutoNumber fields aren't
continuous.@@1@@@1
You can't change a random-valued AutoNumber field to an incremental AutoNumber
field.@The values of random-valued AutoNumber fields aren't continuous.@@1@@1

7914

2007
2003

You can't convert ReplicationID values to other data types.@@@1@@@1
You can't convert ReplicationID values to other data types.@@@1@@1

7915

2007

You can't delete the field '|'; it is a replication system field.@Use a make-table
query to create a new table that contains all the fields in the table except system
fields. For information on make-table queries, click Help.@@2@1@9993@1
You can't delete the field '|'; it is a replication system field.@Use a make-table
query to create a new table that contains all the fields in the table except system
fields. For information on make-table queries, click Help.@@2@209993@1

2003
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Access

7916

2007
2003
2002

7917

2007
2003
2000

7918

7919

2007
2003

2007

2003

Error Description
Microsoft Office Access is unable to start the Lookup Wizard.@The Lookup Wizard
doesn't apply to fields of this data type.@@1@@@1
Microsoft Office Access is unable to start the Lookup Wizard.@The Lookup Wizard
doesn't apply to fields of this data type.@@1@@1
Microsoft Access is unable to start the Lookup Wizard.@The Lookup Wizard doesn't
apply to fields of this data type.@@1@@1
'|' cannot be created because the project is disconnected.@To connect the project
to a database, click Connection under Server Tasks on the File menu.@@1@@@1
'|' cannot be created due to the project being disconnected.@Use the Connection...
command under the File menu to connect the project to a database.@@1@@1
'|' can not be opened due to a dropped server connection.@@@1@@1

The Object Name argument for the 'Save' macro action is not supported within an
Access Project for Table or Query objects.@You cannot save these objects with a
new name in an Access Project.@@1@@1
The default data type you selected is not supported in all versions of Microsoft SQL
Server.@If the server doesn't support the data type you have chosen, the varchar
data type will be used in its place.@@1@@@1
The default data type you selected is not supported in all versions of Microsoft SQL
Server.@If the server doesn't support the data type you have chosen, the varchar
data type will be used in its place.@@1@@1

7920

2007

The '|' lookup column was changed to store multiple values. You cannot reverse this
setting.@@@1@@@1

7921

2007

You have changed the '|' lookup column to store multiple values. You will not be
able to undo this change once you save the table.@Do you want to change '|' to
store multiple values?@@19@@@2

7922

2007

You have changed the '|' lookup column to be displayed by a text box. After you
save the table, this change will make the column read-only and lose the lookup
properties.@Do you want to change '|' to be displayed by a text box?@@19@@@2

7923

2007

The data type for field '|' is of type Attachment and cannot be
changed.@@@1@@@1

7924

2007

You cannot set '|' to the Attachment data type. You can only set a column to the
Attachment data type when that column is first created.@@@1@@@1

7925

2007

The table or query you are exporting contains more than one attachment column.
Microsoft Windows SharePoint Services only supports one attachment column.
Remove all but one attachment column, and then retry exporting the table or query.

7926

2007

You can't change the column '|' to store multiple values; it is part of a multiple
column relationship.@If you want to change the column to store multiple values,
first delete the relationship in the Relationships window.@@1@@@1

7927

2007

You can't change the column '|' to store multiple values; it is part of an enforced
relationship.@If you want to change the column to store multiple values, first delete
the relationship in the Relationships window.@@1@@@1

7950

2007
2003

7951

2007

2003

You can't refer to the RecordsetClone property of a form when the form is open in
Design view.@@@1@607393@1
You entered an expression that has an invalid reference to the RecordsetClone
property.@For example, you may have used the RecordsetClone property with a
form or report that isn't based on a table or query.@@1@1@7393@1
You entered an expression that has an invalid reference to the RecordsetClone
property.@For example, you may have used the RecordsetClone property with a
form or report that isn't based on a table or query.@@1@607393@1
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Access

7952

2007
2003

7953

2007

2003

7954

2007

2003

Error Description
You made an illegal function call.@Check the syntax of the function you are trying to
use.@@1@@@1
You made an illegal function call.@Check the syntax of the function you are trying to
use.@@1@@1
The value you entered doesn't match the type required.@* The variable, property,
or object may not be of the correct type.* You may have used an If TypeOf
construct with something other than a control.@@1@@@1
The value you entered doesn't match the type required.@* The variable, property,
or object may not be of the correct type.* You may have used an If TypeOf
construct with something other than a control.@@1@@1

The expression you entered requires the control to be in the active window.@Try
one of the following:* Open or select a form or report containing the control.*
Create a new control in the active window, and try the operation again.@@1@@@1
The expression you entered requires the control to be in the active window.@Try
one of the following:* Open or select a form or report containing the control.*
Create a new control in the active window, and try the operation again.@@1@@1

7955

2007
2003

There is no current code context object.@@@1@@@1
There is no current code context object.@@@1@@1

7956

2007

The syntax
syntax and
The syntax
syntax and

2003
7957

7958

7959

7960

2007
2003

2007
2003

2007
2003

2007
2003

7961

2007

2003

2002

7962

2007

2003

of the subquery in this expression is incorrect.@Check the subquery's
enclose the subquery in parentheses.@@2@1@9989@1
of the subquery in this expression is incorrect.@Check the subquery's
enclose the subquery in parentheses.@@2@209989@1

You used a Like operator with an incorrect pattern.@Make sure the comparison
value is enclosed in quotation marks.@@1@1008961@1
The Replication ID you entered is invalid.@Make sure the Replication ID you enter
contains only digits or letters for hexadecimal numbers, that the Replication ID is
the correct length, and that it is in a canonical SQL form.@@1@@1

The expression contains an ambiguous name.@You may have two or more functions
with the same name in different modules.@Rename the functions so that each one
has a unique name.@1@@1
There was an error compiling this function.@The Visual Basic module contains a
syntax error.@Check the code, and then recompile it.@1@@@1
There was an error compiling this function.@The Visual Basic module contains a
syntax error.@Check the code, and then recompile it.@1@@1
Microsoft Office Access can't find the module '|' referred to in a macro expression or
Visual Basic code.@The module you referenced may be closed or may not exist in
this database, or the name may be misspelled.@@1@@@1
Microsoft Office Access can't find the module '|' referred to in a macro expression or
Visual Basic code.@The module you referenced may be closed or may not exist in
this database, or the name may be misspelled.@@1@@1
Microsoft Access can't find the module '|' referred to in a macro expression or Visual
Basic code.@The module you referenced may be closed or may not exist in this
database, or the name may be misspelled.@@1@@1
The index number you used to refer to the module is invalid.@Use the Count
property to count the open modules and make sure that the module number is not
greater than the number of open modules minus 1.@@1@@@1
The index number you used to refer to the module is invalid.@Use the Count
property to count the open modules and make sure that the module number is not
greater than the number of open modules minus 1.@@1@@1
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Access

7963

2007
2003
2002

7964

2007

2003

7965

2007
2003
2000

7966

2007

2003

Error Description
Microsoft Office Access can't run the macro or callback function '|'.@Make sure the
macro or function exists and takes the correct parameters.@@1@@@1
Microsoft Office Access can't run the macro or callback function '|'.@Make sure the
macro or function exists and takes the correct parameters.@@1@@1
Microsoft Access can't run the macro or callback function '|'.@Make sure the macro
or function exists and takes the correct parameters.@@1@@1
You entered an expression that has an
property.@You can only use a dynaset
property.@@1@1@7393@1
You entered an expression that has an
property.@You can only use a dynaset
property.@@1@607393@1

invalid reference to the Recordset
or snapshot recordset to set this

invalid reference to the Recordset
or snapshot recordset to set this

The object you entered is not a valid Recordset property.@For example, you may
have used a forward-only recordset, or tried to set it to null.@@1@1@7393@1
The object you entered is not a valid Recordset property.@For example, you may
have used a forward-only recordset, or tried to set it to null.@@1@607393@1
The object your entered is not a valid Recordset property.@For example, you may
have used a forward-only recordset, or tried to set it to null.@@1@607393@1
The format condition number you specified is greater than the number of format
conditions.@Use the Count property to count the format conditions for the control
and then check that the format condition number you cite is within the range of
existing format conditions.@@1@@@1
The format condition number you specified is greater than the number of format
conditions.@Use the Count property to count the format conditions for the control
and then check that the format condition number you cite is within the range of
existing format conditions.@@1@@1

7967

2007
2003

A required minimum or maximum value is missing.@@@1@@@1
A required minimum or maximum value is missing.@@@1@@1

7968

2007

The format condition Type
property are 0 to 2 for the
conditions.@@1@@@1
The format condition Type
property are 0 to 2 for the
conditions.@@1@@1

2003

7969

2007
2003

7970

2007
2003
2002

7971

2007
2003
2002

7972

2007
2003

you specified is invalid.@Valid values for the Type
first condition, and 0 to 1 for all other format

you specified is invalid.@Valid values for the Type
first condition, and 0 to 1 for all other format

The format condition Operator you specified is invalid.@Valid values for the
Operator property are 0 to 7.@@1@@@1
The format condition Operator you specified is invalid.@Valid values for the
Operator property are 0 to 7.@@1@@1
Microsoft Office Access can't open the file '|.'@It may not be a database, or it may
be a database you are unable to open.@@1@@1
Microsoft Access can't open the file '|.'@It may not be a database, or it may be a
database you are unable to open.@@1@@1
Microsoft Office Access can't follow the hyperlink to '|'.@Please verify the
destination.@@1@@@1
Microsoft Office Access can't follow the hyperlink to '|'.@Please verify the
destination.@@1@@1
Microsoft Access can't follow the hyperlink to '|'.@Please verify the
destination.@@1@@1

Microsoft Office Access encountered an error while trying to show the Hyperlink
dialog.@@@1@@@1
Microsoft Office Access encountered an error while trying to show the Hyperlink
dialog.@@@1@@1
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Access

7972

2002

7973

2007
2003

2002

7974

2007
2003
2002

7975

2007
2003

Error Description
Microsoft Access encountered an error while trying to show the Hyperlink
dialog.@@@1@@1

The hyperlink address or subaddress text you entered was too long for Microsoft
Office Access to store.@The text was truncated to fit in the available space, so the
link may not work as expected.@@1@@1
The hyperlink address or subaddress text you entered was too long for Microsoft
Access to store.@The text was truncated to fit in the available space, so the link
may not work as expected.@@1@@1
Microsoft Office Access failed to insert a hyperlink at the current
location.@@@1@@@1
Microsoft Office Access failed to insert a hyperlink at the current
location.@@@1@@1
Microsoft Access failed to insert a hyperlink at the current location.@@@1@@1
You chose an invalid control type for use with hyperlinks.@You can only use
hyperlinks with labels, images, command buttons, or bound text boxes.@@1@@@1
You chose an invalid control type for use with hyperlinks.@You can only use
hyperlinks with labels, images, command buttons, or bound text boxes.@@1@@1

7976

2007
2003

There is no stored hyperlink in this control.@@@1@@@1
There is no stored hyperlink in this control.@@@1@@1

7977

2007

Microsoft Office Access is unable to paste the data on the clipboard as a
hyperlink.@@@1@@@1
Microsoft Office Access is unable to paste the data on the clipboard as a
hyperlink.@@@1@@1
Microsoft Access is unable to paste the data on the clipboard as a
hyperlink.@@@1@@1

2003
2002

7978

2007
2003
2002

7979

2007
2003

7980

2007
2003

7981

2007

2003

7982

7983

2007
2000

2007
2003

Microsoft Office Access is unable to add the current hyperlink to the favorites
folder.@@@1@@@1
Microsoft Office Access is unable to add the current hyperlink to the favorites
folder.@@@1@@1
Microsoft Access is unable to add the current hyperlink to the favorites
folder.@@@1@@1
You can't use the hyperlink property builder with more than one control
selected.@@@1@@@1
You can't use the hyperlink property builder with more than one control
selected.@@@1@@1
The HyperlinkAddress or HyperlinkSubAddress property is read-only for this
hyperlink.@@@1@@@1
The HyperlinkAddress or HyperlinkSubAddress property is read-only for this
hyperlink.@@@1@@1
The values for 'File or web page name' and/or 'Text to Display' are too long.@The
values will be truncated. To keep your original values, click Cancel in the Edit
Hyperlink dialog.@@1@@@1
The values for 'File or web page name' and/or 'Text to Display' are too long.@The
values will be truncated. To keep your original values, click Cancel in the Edit
Hyperlink dialog.@@1@@1

An error occurred while saving the output of the form.@@@1@@1
Microsoft Office Access can't follow the hyperlink.@@@1@@@1
Microsoft Office Access can't follow the hyperlink because it couldn't create the
hyperlink object.@@@1@@1
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Access

7983

2002

Microsoft Access can't follow the hyperlink because it couldn't create the hyperlink
object.@@@1@@1

7990

2007

You entered an invalid project name.@You may have deleted the default project
name and forgotten to specify a new one.@@1@@@3
You entered an invalid project name.@You may have deleted the default project
name and forgotten to specify a new one.@@1@@3

2003

7991

2007
2003
2002

7992

2007
2003
2002

7993

2007
2003

7994

2007
2003

7995

2007

2003

2002

7996

2007

2003

Error Description

The Microsoft Office Access Source Code Control Add-in is not available; this object
will be opened read-only.@@@1@@@3
The Microsoft Office Access Source Code Control Add-in is not available; this object
will be opened read-only.@@@1@@3
The Microsoft Access Source Code Control Add-in is not available; this object will be
opened read-only.@@@1@@3
The Microsoft Office Access Source Code Control Add-in could not be
started.@@@1@@@3
The Microsoft Office Access Source Code Control Add-in could not be
started.@@@1@@3
The Microsoft Access Source Code Control Add-in could not be started.@@@1@@3
The object | is currently checked in and is therefore read-only.@To modify the
object, close it first, then check it out and reopen it.@@1@@@1
The object | is currently checked in and is therefore read-only.@To modify the
object, close it first, then check it out and reopen it.@@1@@1
There was a problem communicating with the Source Code Control Addin.@@@1@@@3
There was a problem communicating with the Source Code Control Addin.@@@1@@3
The menus on your form or report that are based on Microsoft Office Access macros
will not be visible while the Customize dialog box is open.@To have the full power of
menu or toolbar customization, convert your macro-based menus to menus or
toolbars. With the macro selected in the Navigation Pane, point to Macro on the
Tools menu, and create a menu, a toolbar, or a shortcut menu from that
macro.@@1@@@1
The menus on your form or report that are based on Microsoft Office Access macros
will not be visible while the Customize dialog box is open.@To have the full power of
menu or toolbar customization, convert your macro-based menus to menus or
toolbars. With the macro selected in the Database window, point to Macro on the
Tools menu, and create a menu, a toolbar, or a shortcut menu from that
macro.@@1@@1
The menus on your form or report that are based on Microsoft Access macros will
not be visible while the Customize dialog box is open.@To have the full power of
menu or toolbar customization, convert your macro-based menus to menus or
toolbars. With the macro selected in the Database window, point to Macro on the
Tools menu, and create a menu, a toolbar, or a shortcut menu from that
macro.@@1@@1
Microsoft Office Access could not create the Data and Misc. objects because the
linked table '|' could not be found.@To create the data and miscellaneous objects,
use the Linked Table Manager (on the Database Tools tab, in the Database Tools
group) to update the link to the source table or file, or delete the link from your
current database.@@1@@@1
Microsoft Office Access couldn't create the Data and Misc. Objects because the
linked table '|' could not be found.@To create the Data and Misc. Objects, use the
Linked Table Manager (Tools menu, Add-ins submenu) to update the link to the
source table or file, or delete the link from your current database.@@1@@1
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Access

7996

2002

Microsoft Access couldn't create the Data and Misc. Objects because the linked table
'|' could not be found.@To create the Data and Misc. Objects, use the Linked Table
Manager (Tools menu, Add-ins submenu) to update the link to the source table or
file, or delete the link from your current database.@@1@@1

7997

2007

You can't save the standard module '|' over a class module with the same
name.@Save the standard module to a different name, or delete the class module
first.@@1@@@1
You can't save the standard module '|' over a class module with the same
name.@Save the standard module to a different name, or delete the class module
first.@@1@@1

2003

7998

2007

2003

7999

2007

2003

2002

8000

2007
2003

8001

2007

2003

8002

8003

2007
2003

2007
2003

8004

2007

Error Description

You can't save the class module '|' over a standard module with the same
name.@Save the class module to a different name, or delete the standard module
first.@@1@@@1
You can't save the class module '|' over a standard module with the same
name.@Save the class module to a different name, or delete the standard module
first.@@1@@1

Microsoft Office Access can't delete this relationship because you don't have the
Data and Misc. Objects checked out.@Check out the Data and Misc. Objects and
then delete the relationship.@@1@@@1
Microsoft Office Access can't delete this relationship because you don't have the
Data and Misc. Objects checked out.@Check out the Data and Misc. Objects and
then delete the relationship.@@1@@1
Microsoft Access can't delete this relationship because you don't have the Data and
Misc. Objects checked out.@Check out the Data and Misc. Objects and then delete
the relationship.@@1@@1
The name you entered already exists for another object of the same type in this
database.@Do you want to replace the existing |?@@20@@@2
The name you entered already exists for another object of the same type in this
database.@Do you want to replace the existing |?@@20@@2

'|' has been changed since the last time you opened it, either by another user or
because another instance of it was opened on your own machine.@Do you want to
replace the changes that you or another user made?@* To save your most recent
changes and discard the other user's changes or your previous changes, click
Yes.* To save this version of the object with another name, click No.@19@@@2
'|' has been changed since the last time you opened it, either by another user or
because another instance of it was opened on your own machine.@Do you want to
replace the changes that you or another user made?@* To save your most recent
changes and discard the other user's changes or your previous changes, click
Yes.* To save this version of the object with another name, click No.@19@@2
'|' has been changed since the last time you opened it, either by another user or
because another instance of it was opened on your own machine.@Do you want to
replace the changes that you or another user made?@* To save your most recent
changes and discard the other user's changes or your previous changes, click
Yes.* To cancel saving this version of the object, click No.@19@@2

You must save the | before you can create a new object based on it.@Do you want
to save the | and create a new object?@@13@@@2
You must save a table or query before you can create a new object based on it.@Do
you want to save and use the table or query to create a new object?@@13@@2
The layout of '|' has been changed since the last time you opened it, either by
another user or because another instance of it was opened on your own
machine.@Do you want to replace the changes that you or another user made?@*
To save your most recent changes and discard the other user's changes or your
previous changes, click Yes.* To cancel saving this version of the object, click
No.@19@@@2
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Access

8004

2003

2000

8005

8006

2007
2003

2007

2003

8007

2007

2003

Error Description
The layout of '|' has been changed since the last time you opened it, either by
another user or because another instance of it was opened on your own
machine.@Do you want to replace the changes that you or another user made?@*
To save your most recent changes and discard the other user's changes or your
previous changes, click Yes.* To cancel saving this version of the object, click
No.@19@@2
The layout of '|' has been changed by another user on your network since the last
time you opened it.@Do you want to replace the other user's changes with your
changes?* To save your changes and discard the other user's changes, click
Yes.* To cancel the save, click No.@@19@@2

You can't save this object.@You must have Administer permission for the Database
object in order to save modules, forms, or reports in a Design Master.@@1@@1
The name you entered already exists for another object of the same type in this
database.@Do you want to replace the existing |? You will not be able to undo this
operation.@@20@@@2
The name you entered already exists for another object of the same type in this
database.@Do you want to replace the existing |? You will not be able to undo this
operation.@@20@@2
You cannot get into Exclusive Mode right now because this database is opened by
other users or because you do not have permissions to open
exclusively.@@@1@@@1
You cannot get into Exclusive Mode right now because this database is opened by
other users or because you do not have permissions to open exclusively.@@@1@@1

8008

2007

The stored procedure executed successfully but did not return records.

8050

2007
2003

Do you want to save changes to the design of |?@@@13@@@2
Do you want to save changes to the design of |?@@@13@@2

8051

2007
2003

Do you want to save changes to |?@@@19@@2

8052

2007

2003

2002

8053

2007

2003

Do you want to delete the | and empty the Clipboard?@You tried to delete a
database object that is currently on the Microsoft Office Access Clipboard. If you
delete it from your database, you won't be able to paste it later.@@20@@@2
Do you want to delete the | and empty the Clipboard?@You tried to delete a
database object that is currently on the Microsoft Office Access Clipboard. If you
delete it from your database, you won't be able to paste it later.@@20@@2
Do you want to delete the | and empty the Clipboard?@You tried to delete a
database object that is currently on the Microsoft Access Clipboard. If you delete it
from your database, you won't be able to paste it later.@@20@@2
Do you want to delete the |? Deleting this object will remove it from all groups.@For
more information on how to prevent this message from displaying every time you
delete an object, click Help.@@21@1@9058@2
Do you want to delete the |?@For more information on how to prevent this message
from displaying every time you delete an object, click Help.@@21@209058@2

8054

2007
2003
2002

Do you want to exit Microsoft Office Access and empty the Clipboard?@@@19@@@2
Do you want to exit Microsoft Office Access and empty the Clipboard?@@@19@@2
Do you want to exit Microsoft Access and empty the Clipboard?@@@19@@2

8055

2007

Microsoft Office Access can't change the working directory to '|.'@Verify that the
drive is valid and the path is 260 characters or less in length.@@1@@@1
Microsoft Office Access can't change the working directory to '|.'@Verify that the
drive is valid and the path is 260 characters or less in length.@@1@@1
Microsoft Access can't change the working directory to '|.'@Verify that the drive is
valid and the path is 260 characters or less in length.@@1@@1

2003
2002
8057

2007

|
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Access

8058

2007
2003

Do you want to save changes to the layout of |?@@@13@@@2
Do you want to save changes to the layout of |?@@@13@@2

8059

2007

Do you want to remove the link to the |?@If you delete the link, you delete only the
information Microsoft Office Access uses to open the table, not the table
itself.@@19@@@2
Do you want to remove the link to the |?@If you delete the link, you delete only the
information Microsoft Office Access uses to open the table, not the table
itself.@@19@@2
Do you want to remove the link to the |?@If you delete the link, you delete only the
information Microsoft Access uses to open the table, not the table itself.@@19@@2

2003

2002

8060

2007

2003

2002

8061

2007

2003

2002

8063

2007

2003

Error Description

The toolbar '|' is partly unreadable.@ Microsoft Office Access can't display all the
toolbar buttons. The specified toolbar may be in a different format than the toolbars
in the current version of Microsoft Office Access.@Click OK to close the dialog box,
and then add the buttons missing from the toolbar. Microsoft Office Access will then
update the toolbar to the latest format.@1@1@10064@1
The toolbar '|' is partly unreadable.@ Microsoft Office Access can't display all the
toolbar buttons. The specified toolbar may be in a different format than the toolbars
in the current version of Microsoft Office Access.@Click OK to close the dialog box,
and then add the buttons missing from the toolbar. Microsoft Office Access will then
update the toolbar to the latest format.@1@210064@1
The toolbar '|' is partly unreadable.@ Microsoft Access can't display all the toolbar
buttons. The specified toolbar may be in a different format than the toolbars in the
current version of Microsoft Access.@Click OK to close the dialog box, and then add
the buttons missing from the toolbar. Microsoft Access will then update the toolbar
to the latest format.@1@210064@1
Are you sure you want to restore the default settings to the built-in toolbar or menu
bar |?@If you previously customized, moved, changed the visibility, or otherwise
altered the toolbar or menu bar, or any of the menus that cascade from it, Microsoft
Office Access removes your changes, returns the original buttons to their original
order, and shows or hides the toolbar based on the original setting.To return the
built-in toolbar or menu bar to its original state, click Yes.@@19@@@2
Are you sure you want to restore the default settings to the built-in toolbar or menu
bar |?@If you previously customized, moved, changed the visibility, or otherwise
altered the toolbar or menu bar, or any of the menus that cascade from it, Microsoft
Office Access removes your changes, returns the original buttons to their original
order, and shows or hides the toolbar based on the original setting.To return the
built-in toolbar or menu bar to its original state, click Yes.@@19@@2
Are you sure you want to restore the default settings to the built-in toolbar or menu
bar |?@If you previously customized, moved, changed the visibility, or otherwise
altered the toolbar or menu bar, or any of the menus that cascade from it, Microsoft
Access removes your changes, returns the original buttons to their original order,
and shows or hides the toolbar based on the original setting.To return the built-in
toolbar or menu bar to its original state, click Yes.@@19@@2
The source application is not responding. Do you want to continue waiting?@The
DDE channel has been established, but the data exchange was not completed in the
amount of time specified in the OLE/DDE Timeout setting in the Access Options
dialog box (click the Microsoft Office Button and then click Access Options).@* To
continue waiting for the data exchange to be completed, click Yes.* To cancel the
data exchange and try again later, click No .@20@@@2
The source application isn't responding. Do you want to continue waiting?@The DDE
channel is established, but the data exchange wasn't completed in the amount of
time specified in the OLE/DDE Timeout setting in the Options dialog box (Tools
menu).@* To continue waiting for the data exchange to be completed, click
Yes.* To cancel the data exchange and try again later, click No .@20@@2
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Access

8064

2007

2003

8065

2007

2003

2002
8067

2007
2003

Error Description
This linked table has indexes that use an unsupported sort order.@If you modify
this table, the Microsoft Office Access database engine can't correctly maintain the
table's indexes. As a result, your data may appear in the wrong order, and functions
that use the table's indexes may have unexpected results.@Try one of the
following:* Cancel this operation. Use the application in which the table was
created to re-create the indexes, making sure to specify an ASCII or International
sort order. Then try again to link the tables.* Use this table on a read-only
basis.@1@1@9057@1
This linked table has indexes that use an unsupported sort order.@If you modify
this table, the Microsoft Jet database engine can't correctly maintain the table's
indexes. As a result, your data may appear in the wrong order, and functions that
use the table's indexes may have unexpected results.@Try one of the following:*
Cancel this operation. Use the application in which the table was created to recreate the indexes, making sure to specify an ASCII or International sort order.
Then try again to link the tables.* Use this table on a read-only
basis.@1@209057@1
You can't delete the table '|' until its relationships to other tables have been
deleted.@Do you want Microsoft Office Access to delete the relationships
now?@@19@@@2
You can't delete the table '|' until its relationships to other tables have been
deleted.@Do you want Microsoft Office Access to delete the relationships
now?@@19@@2
You can't delete the table '|' until its relationships to other tables have been
deleted.@Do you want Microsoft Access to delete the relationships now?@@19@@2
Do you want to permanently delete the |?@If you click Yes, you won't be able to
undo the deletion.@@19@@@2
Do you want to permanently delete the |?@If you click Yes, you won't be able to
undo the deletion.@@19@@2

8069

2007
2003
2002

Microsoft Office Access couldn't create the custom toolbar '|.'@@@1@@@3
Microsoft Office Access couldn't create the custom toolbar '|.'@@@1@@3
Microsoft Access couldn't create the custom toolbar '|.'@@@1@@3

8071

2007

Would you like to remove the compacted database from Source Code
Control?@@@19@@@2
Would you like to remove the compacted database from Source Code
Control?@@@19@@2

2003

8072

2007
2003
2002

8073

2007

2003

2002

8074

2007

Microsoft Office Access must close the | in order to complete this operation.@Would
you like Microsoft Office Access to close it now?@@19@@@1
Microsoft Office Access must close the | in order to complete this operation.@Would
you like Microsoft Office Access to close it now?@@19@@1
Microsoft Access must close the | in order to complete this operation.@Would you
like Microsoft Access to close it now?@@19@@1
You do not have the | checked out.@Microsoft Office Access can't check out an
object while it is open, and you can't make design changes until you check it
out.@If you want to make design changes to this object, first close it, check it out,
and then reopen it.@1@@@1
You do not have the | checked out.@Microsoft Office Access can't check out an
object while it is open, and you can't make design changes until you check it
out.@If you want to make design changes to this object, first close it, check it out,
and then reopen it.@1@@1
You do not have the | checked out.@Microsoft Access can't check out an object
while it is open, and you can't make design changes until you check it out.@If you
want to make design changes to this object, first close it, check it out, and then
reopen it.@1@@1
Microsoft Office Access must save the | in order to complete this operation.@Would
you like Microsoft Office Access to save it now?@@19@@@1
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Access

8074

2003
2002

8075

2007
2003
2000

8076

2007
2003
2000

Error Description
Microsoft Office Access must save the | in order to complete this operation.@Would
you like Microsoft Office Access to save it now?@@19@@1
Microsoft Access must save the | in order to complete this operation.@Would you
like Microsoft Access to save it now?@@19@@1
You do not have the Data and Misc. Objects checked out. You can't create a new
table or save changes to a data access page.@@@1@@@1
You do not have the Data and Misc. Objects checked out. You can't create a new
table or save changes to a data access page.@@@1@@1
You do not have the Data and Misc. Objects checked out. You can't create a new
table or save a link to a WebPage.@@@1@@1

To import tables, relationships, menus, toolbars, import/export specs or data access
pages you must have the Data and Misc. Objects checked out.@@@1@@@2
To import tables, relationships, menus, toolbars, import/export specs or data access
pages you must have the Data and Misc. Objects checked out.@@@1@@2
To import tables, relationships, menus, toolbars, or import/export specs you must
have the Data and Misc. Objects checked out.@@@1@@2

8077

2007
2003
2000

Are you sure you want to cut the |?@@@19@@@2
Are you sure you want to cut the |?@@@19@@2
Are you sure you want to cut the |?@You will not be able to undo this
operation.@@19@@2

8078

2007

This object will be removed from your local database, but not from source code
control.@The next time you get this database from source code control, the object
will reappear. Are you sure that you want to delete the local object?@@20@@@2
This object will be removed from your local database, but not from source code
control.@The next time you get this database from source code control, the object
will reappear. Are you sure that you want to delete the local object?@@20@@2

2003

8079

2007

2003

2002

8080

2007

2003

8081

2007

2003

Microsoft Office Access was not able to add a reference to the type library for this
control because Data and Misc. Objects is not checked out.@Check out the Data
and Misc. Objects and add a reference to the library '|'.@@1@@@1
Microsoft Office Access was not able to add a reference to the type library for this
control because Data and Misc. Objects is not checked out.@Check out the Data
and Misc. Objects and add a reference to the library '|'.@@1@@1
Microsoft Access was not able to add a reference to the type library for this control
because Data and Misc. Objects is not checked out.@Check out the Data and Misc.
Objects and add a reference to the library '|'.@@1@@1

An error occurred while trying to create the linked table '|'.@Check to make
that the source table or file is available, and then retry the operation on the
and Misc. Objects.@@1@@@1
An error occurred while trying to create the linked table '|'.@Check to make
that the source table or file is available, and then retry the operation on the
and Misc. Objects.@@1@@1

sure
Data
sure
Data

You have set |1's Type property to Popup, which changes the toolbar to a shortcut
menu.@The shortcut menu disappears because Microsoft Office Access adds |2 to
the Shortcut Menus toolbar. To complete the shortcut menu, close the Toolbar
Properties sheet, display the Shortcut Menus toolbar, click the Custom category,
and then add the commands you want.@@1@@@1
You have set |1's Type property to Popup, which changes the toolbar to a shortcut
menu.@The shortcut menu disappears because Microsoft Office Access adds |2 to
the Shortcut Menus toolbar. To complete the shortcut menu, close the Toolbar
Properties sheet, display the Shortcut Menus toolbar, click the Custom category,
and then add the commands you want.@@1@@1
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Access

8081

2002

You have set |1's Type property to Popup, which changes the toolbar to a shortcut
menu.@The shortcut menu disappears because Microsoft Access adds |2 to the
Shortcut Menus toolbar. To complete the shortcut menu, close the Toolbar
Properties sheet, display the Shortcut Menus toolbar, click the Custom category,
and then add the commands you want.@@1@@1

8082

2007

Microsoft Office Access must save the | to the current database in order to complete
this operation.@Would you like Microsoft Office Access to save it now?@@19@@@2
Microsoft Office Access must save the | to the current database in order to complete
this operation.@Would you like Microsoft Office Access to save it now?@@19@@2
Microsoft Access must save the | to the current database in order to complete this
operation.@Would you like Microsoft Access to save it now?@@19@@2

2003
2002
8086

2007

2003

8087

2007

2003

8088

2007
2003

8090

2007
2003

8091

2007
2003

8092

2007

2003

8093

2007
2003

Error Description

An error occured trying to add one or more references from the source code control
project.@The library may not be registered on your computer. Check your project
references and add any missing references after registering the missing
components that this database requires.@@1@@@1
An error occured trying to add one or more references from the source code control
project.@The library may not be registered on your computer. Check your project
references and add any missing references after registering the missing
components that this database requires.@@1@@1
Restoring a database requires that no one is currently using the database.@Do you
want to close all objects, select a backup file, and restore the database from
backup?@@19@@@2
Restoring a database requires that no one is currently using the database.@Do you
want to close all objects, select a backup file, and restore the database from
backup?@@19@@2
Dropping a database requires that no one is currently using the database.@Do you
want to close all open objects, and drop the database?@@19@@@2
Dropping a database requires that no one is currently using the database.@Do you
want to close all open objects, and drop the database?@@19@@2

Are you sure you want to delete the conflict table |?@You will not be able to undo
this operation.@@19@@@2
Are you sure you want to delete the conflict table |?@You will not be able to undo
this operation.@@19@@2
This database is enabled for publication.@Do you want to delete existing
publications and drop the database?@@19@@@2
This database is enabled for publication.@Do you want to delete existing
publications and drop the database?@@19@@2
Access could not save your project.@Do you want to cancel the close
operation?*To cancel the close operation, click Yes.*To close without saving,
click No.@@19@@@2
Access could not save your project.@Do you want to cancel the close
operation?*To cancel the close operation, click Yes.*To close without saving,
click No.@@19@@2
Send a pointer to the data access page?@To send an e-mail message that contains
a pointer to your data access page, click Send Pointer. This is the recommended
method. The e-mail recipient must have access to the server or public share to view
the page. To send a copy of the page, click Send Copy. To cancel sending the page,
click Cancel. For more information, click Help. Send Pointer Send
Copy Cancel@@28@613792@4
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Numbe

Access

8093

2000

8094

2007
2003

2000

8095

8096

2007
2003
2007

2003
2002
8097

2007

2003

2002

8098

2007

2003

2002

Error Description
Create a message that points to your saved data access page?@To create an e-mail
message that points to a page you have saved to an absolute path (a URL, or a UNC
path such as \\server\share\path\filename), click Yes. This option is generally more
secure. To create an e-mail message that contains a copy of the page, click No. The
copy won't be allowed to connect to data across domains unless the recipient or
administrator has changed default Internet Web content zone security
settings.@@16@@4
Send a copy of the data access page?@The contents of the page will be copied into
the body of the email message, however the page will connect to the data source
when the recipient views the message. If this is correct, click OK. Otherwise, click
Cancel, save the page to a server or public share, and resend a pointer to the
page. It is generally more secure to send a pointer to the page than to send a copy
of the page. For more information, click Help.@@6@613791@4
Create a message that contains a copy of your data access page?@To create a
message that contains a copy of your data access page, click OK. The copy you
create won't be allowed to connect to data across domains unless the recipient or
administrator has changed default Internet Web content zone security settings.
Sending an e-mail message that points to a page you have saved to an absolute
path (a URL, or a UNC path such as \\server\share\path\filename) is generally more
secure. To send a message that points to a page saved to an absolute path, click
Cancel. Save the page to a server or public share, and then resend the e-mail
message displaying your page.@@6@@4
You tried to create a group filter based on a column type which cannot be used in a
filter.
Microsoft Office Access can't change the working directory to '|.'@Please enter a
non-Internet location.@@1@@@1
Microsoft Office Access can't change the working directory to '|.'@Please enter a
non-Internet location.@@1@@1
Microsoft Access can't change the working directory to '|.'@Please enter a nonInternet location.@@1@@1

The connection string of this page specifies an absolute path. The page might not
be able to connect to data through the network. To connect through a network,
edit the connection string to specify a network (UNC) path.@&Don't show this
warning again@553714119@@@@1
The connection string of this page specifies an absolute path. The page might not
be able to connect to data through the network. To connect through a network,
edit the connection string to specify a network (UNC) path.@&Don't show this
warning again@553714119@@@1
The connection string of this page specifies an absolute path. The page might not
be able to connect to data through the network. To connect through a network,
edit the connection string to specify a network (UNC) path.@&Don't show this
warning again@5073@@@1
Your computer has resumed operation after Critical Suspend mode. Any unsaved
changes might have been lost. To ensure proper operation, close and reopen any
files. Restarting Microsoft Office Access is recommended.@@@1@@@1
Your computer has resumed operation after Critical Suspend mode. Any unsaved
changes might have been lost. To ensure proper operation, close and reopen any
files. Restarting Microsoft Office Access is recommended.@@@1@@1
Your computer has resumed operation after Critical Suspend mode. Any unsaved
changes might have been lost. To ensure proper operation, close and reopen any
files. Restarting Microsoft Access is recommended.@@@1@@1
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Access

8100

2007

2003

8101

2007

2003

Error Description
The report is still more than one page wide.@To fit the report on one page decrease
the report width or increase the page width.@You can decrease the report width by
selecting each control that is farthest to the right, moving it to the left, and
removing the extra report space. You may need to repeat this multiple times.You
can increase the page width by adjusting the page setup options.@1@@@1
The report is still more than one page wide.@To fit the report on one page decrease
the report width or increase the page width.@You can decrease the report width by
selecting each control that is farthest to the right, moving it to the left, and
removing the extra report space. You may need to repeat this multiple times.You
can increase the page width by adjusting the page setup options.@1@@1
The report is still more than one page wide.@To fit the report on one page decrease
the report width or increase the page width.@You can decrease the report width by
selecting each control that is farthest to the left, moving it to the right, and
removing the extra report space. You may need to repeat this multiple times.You
can increase the page width by adjusting the page setup options.@1@@@1
The report is still more than one page wide.@To fit the report on one page decrease
the report width or increase the page width.@You can decrease the report width by
selecting each control that is farthest to the left, moving it to the right, and
removing the extra report space. You may need to repeat this multiple times.You
can increase the page width by adjusting the page setup options.@1@@1

8103

2007

Do you want to discard the pending changes and delete the link to the list |?@The
linked list you are attempting to delete has changes that have not been saved to
the server. Do you still want to delete the linked list and lose these pending
changes?@@19@@@2

8104

2007

The name you supplied is a reserved word. Reserved words have a specific meaning
to Microsoft Office Access or to the Microsoft Office Access database engine. @If you
use a reserved word, you may receive an error when referring to this
field.@@5@1@141675@1

8105

2007

You must close and reopen the current database for the specified option to take
effect.

8400

2007

The database '|' is read-only.@You won't be able to save changes made to data or
object definitions in this database.@@3@1@9033@1
The database '|' is read-only.@You won't be able to save changes made to data or
object definitions in this database.@@1@209033@1

2003
8401

2007

2003

2002

8402

2007

2003

You cannot make changes to the database objects in the database '|.'@This
database was created in an earlier version of Microsoft Office Access.@To convert
this database to the current version of Microsoft Office Access, click the Microsoft
Office Button, and then click Convert.@3@1@9029@1
You can't make changes to the database objects in the database '|.'@This database
was created in an earlier version of Microsoft Office Access.@To convert this
database to the current version of Microsoft Office Access, close the database, point
to Database Utilities on the Tools menu, and then click Convert
Database.@1@209029@1
You can't make changes to the database objects in the database '|.'@This database
was created in an earlier version of Microsoft Access.@To convert this database to
the current version of Microsoft Access, close the database, point to Database
Utilities on the Tools menu, and then click Convert Database.@1@209029@1
The file '|' already exists.@Do you want to replace the existing file?If you want to
compact or convert to a different file name, click No. Enter the new file name after
the /compact or /convert option in the command line, and run the command
again.@@20@@@2
The file '|' already exists.@Do you want to replace the existing file?If you want to
compact or convert to a different file name, click No. Enter the new file name after
the /compact or /convert option in the command line, and run the command
again.@@20@@2
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Access

8403

2007

2003

8404

2007

2003

2002

8405

2007

2003

2002

8406

2007
2003

8407

2007
2003

2002

8408

8409

2007
2003

2007

Error Description
The setting you entered is invalid.@The database's sort order cannot be
updated.The setting you entered for the New database sort order option
(Personalize category) of the Access Options dialog box (click the Microsoft Office
Button and then click Access Options) is not a valid sort order for the version of the
database you are compacting.@@1@@@1
The setting you entered is invalid.@The database's sort order can't be
updated.The setting you entered in the New Database Sort Order option of the
Options dialog box (Tools menu) isn't a valid sort order for the version of the
database you are compacting.@@1@@1

You can't open '|' for exclusive use because another user has the database open or
because you do not have permissions to open exclusively.@Microsoft Office Access
will open the database for shared access.@@3@@@1
You can't open '|' for exclusive use because another user has the database open or
because you do not have permissions to open exclusively.@Microsoft Office Access
will open the database for shared access.@@1@@1
You can't open '|' for exclusive use because another user has the database open or
because you do not have permissions to open exclusively.@Microsoft Access will
open the database for shared access.@@1@@1
This database was created using a previous version of Microsoft Office Access.@You can share the database with users of previous versions of Microsoft Office
Access, however some enhancements will be unavailable.- You can open the
database, view objects and modify records using this release of Microsoft Office
Access, but design changes will be disabled.- To make design changes you must
use an earlier version of Microsoft Office Access that supports the old database
format, or upgrade the database.@@1@@@1
You can't make changes to the database objects in the database '|.'@This database
was created in an earlier version of Microsoft Office Access.@To convert this
database to the current version of Microsoft Office Access, close the database, point
to Database Utilities on the Tools menu, and then click Convert Database.@1@@1
You can't make changes to the database objects in the database '|.'@This database
was created in an earlier version of Microsoft Access.@To convert this database to
the current version of Microsoft Access, close the database, point to Database
Utilities on the Tools menu, and then click Convert Database.@1@@1
Does the first row of your data contain column headings?@@@20@@@1
Does the first row of your data contain column headings?@@@20@@1

This database is a replica created in a previous version of Microsoft Office
Access.@You can view objects in this database, but you can't modify their design. If
you want to modify objects in this database, convert the Design Master for this
replica set to the current version of Microsoft Office Access and synchronize this
replica.@Do you want to open the database anyway?@19@@1
This database is a replica created in a previous version of Microsoft Access.@You
can view objects in this database, but you can't modify their design. If you want to
modify objects in this database, convert the Design Master for this replica set to the
current version of Microsoft Access and synchronize this replica.@Do you want to
open the database anyway?@19@@1
The name you entered already exists for another custom group in this
database.@Do you want to replace the existing custom group |? You will not be
able to undo this operation.@@20@@2
Microsoft Office Access has made a backup of database |1 at |2. Note: Only serverrelated objects have been backed up. To back up your project, click Back Up Project
on the File menu
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Access

8409

2002

Microsoft Access has made a backup of database |1 at |2. Note: Only server-related
objects have been backed up. To protect other objects, back up the .ADP file
manually

8410

2007
2002

Microsoft Office Access successfully restored database |1 from its backup at |2
Microsoft Access successfully restored database |1 from its backup at |2

8411

2007
2003

8412

2007
2003

8413

8414

2007
2003
2007
2003
2002

8415

2007
2003

8416

2007
2003

Error Description

Do you want to permanently delete the custom group '|'?@If you click Yes, all
shortcuts in the custom group will be deleted as well, and you won't be able to undo
the deletion.@@20@@2
The name you entered already exists for another shortcut in this group. @Do you
want to replace the existing shortcut '|?'@@20@@@2
The name you entered already exists for another shortcut in this group. @Do you
want to replace the existing shortcut '|?'@@20@@2

The project '|' is read-only.@You won't be able to save changes made to object
definitions in this project.@@1@209033@1
Microsoft Office Access encountered one or more errors during conversion. To view
a summary of these errors, open the '|' table.@@@2@1@553714191@1
Microsoft Office Access encountered one or more errors during conversion. To view
a summary of these errors, open the '|' table.@@@2@553714191@1
Microsoft Access encountered one or more errors during conversion. To view a
summary of these errors, open the '|' table.@@@2@5257@1
The HTML file associated with this link has been moved, renamed, or deleted.@File:
'|' &Update Link... Cancel@@35@@@2
The HTML file associated with this link has been moved, renamed, or deleted.@File:
'|' &Update Link... Cancel@@35@@2

Renaming this user-defined function removes any existing permissions and
extended properties.@Do you want to complete the rename action?@@20@@@2
Renaming this user-defined function removes any existing permissions and
extended properties.@Do you want to complete the rename action?@@20@@2

8417

2007

The file '|' cannot be opened because it has been locked by another user.@Try
again when the file is available.@@3@@@1

8500

2007

A form with a subform object can't have its DefaultView property set to Continuous
Forms.@You tried to add a subform to a form in Design view.Microsoft Office
Access will reset the property to Single Form.@@1@@@1
A form with a subform object can't have its DefaultView property set to Continuous
Forms.@You tried to add a subform to a form in Design view.Microsoft Office
Access will reset the property to Single Form.@@1@@1
A form with a subform object can't have its DefaultView property set to Continuous
Forms.@You tried to add a subform to a form in Design view.Microsoft Access will
reset the property to Single Form.@@1@@1

2003

2002

8501

2007

2003

8502

2007
2003
2002

You can't modify this field because it is read-only.@Some fields, such as a
calculated field, are read-only by design. However, any field can be read-only if its
Locked property is set to Yes.@@1@1@865@1
You can't modify this field because it is read-only.@Some fields, such as a
calculated field, are read-only by design. However, any field can be read-only if its
Locked property is set to Yes.@@1@600865@1
Microsoft Office Access has reached the end of the records.@Do you want to
continue searching from the beginning?@@19@@@2
Microsoft Office Access has reached the end of the records.@Do you want to
continue searching from the beginning?@@19@@2
Microsoft Access has reached the end of the records.@Do you want to continue
searching from the beginning?@@19@@2
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Access

8503

2007
2003
2002

8504

2007
2003
2002

8505

2007
2003

8506

2007
2003

8507

2007

2003

2002

8508

2007

2003

2002

8509

2007
2003

8510

2007
2003
2002

Error Description
Microsoft Office Access has reached the beginning of the records.@Do you want to
continue searching from the end?@@19@@@2
Microsoft Office Access has reached the beginning of the records.@Do you want to
continue searching from the end?@@19@@2
Microsoft Access has reached the beginning of the records.@Do you want to
continue searching from the end?@@19@@2
Microsoft Office Access finished searching the records. The search item was not
found.@@@1@@@1
Microsoft Office Access finished searching the records. The search item was not
found.@@@1@@1
Microsoft Access finished searching the records. The search item was not
found.@@@1@@1

Do you want to continue to search or replace?@@@19@@@2
Do you want to continue to search or replace?@@@19@@2
There isn't enough memory to save the current filter.@Close unneeded programs.
Return to the form or datasheet, and then redefine and reapply the filter.For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@@1@@3

There isn't enough memory to execute the macro that updates the active
filter.@Microsoft Office Access is closing the Filter window.Close unneeded
programs. Then try again to open the Filter window.For more information on
freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@@3
There isn't enough memory to execute the macro that updates the active
filter.@Microsoft Office Access is closing the Filter window.Close unneeded
programs. Then try again to open the Filter window.For more information on
freeing memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@3
There isn't enough memory to execute the macro that updates the active
filter.@Microsoft Access is closing the Filter window.Close unneeded programs.
Then try again to open the Filter window.For more information on freeing
memory, search the Microsoft Windows Help index for 'memory,
troubleshooting'.@@1@@3
Microsoft Office Access can't find '|.'@The text string you entered in the Find What
box can't be evaluated against the current field.@Reenter the text string so that it
conforms to the data type of the field.@1@@@1
Microsoft Office Access can't find '|.'@The text string you entered in the Find What
box can't be evaluated against the current field.@Reenter the text string so that it
conforms to the data type of the field.@1@@1
Microsoft Access can't find '|.'@The text string you entered in the Find What box
can't be evaluated against the current field.@Reenter the text string so that it
conforms to the data type of the field.@1@@1

You won't be able to undo this Replace operation.@There isn't enough free memory
to use the Undo command.Do you want to continue?@@19@@@2
You won't be able to undo this Replace operation.@There isn't enough free memory
to use the Undo command.Do you want to continue?@@19@@2
Microsoft Office Access can't save the current record.@Do you want to undo the
changes to the record and continue the Paste operation?@@19@@@2
Microsoft Office Access can't save the current record.@Do you want to undo the
changes to the record and continue the Paste operation?@@19@@2
Microsoft Access can't save the current record.@Do you want to undo the changes
to the record and continue the Paste operation?@@19@@2
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Access

8511

2007

2003

2002

8512

2007

2003

2002

8513

2007

2003

2002

8514

2007

2003

8515

2007

Error Description
Records that Microsoft Office Access was unable to paste have been inserted into a
new table called '|.'@In the Navigation Pane, open the new table to see the
unpasted records.After you fix the problems that resulted in the paste errors,
copy and paste the records from the new table.@@1@@@1
Records that Microsoft Office Access was unable to paste have been inserted into a
new table called '|.'@In the Database window, open the new table to see the
unpasted records.After you fix the problems that resulted in the paste errors,
copy and paste the records from the new table.@@1@@1
Records that Microsoft Access was unable to paste have been inserted into a new
table called '|.'@In the Database window, open the new table to see the unpasted
records.After you fix the problems that resulted in the paste errors, copy and
paste the records from the new table.@@1@@1
None of the field names you pasted onto the Clipboard match the field names on
the form.@Microsoft Office Access treats the data in the first row on the Clipboard
as field names. If you copied the data from another application, the first row of data
may have taken the place of the field names.Do you want to paste the field
names in the order you defined with the Tab Order command?@@21@1@11022@2
None of the field names you pasted onto the Clipboard match the field names on
the form.@Microsoft Office Access treats the data in the first row on the Clipboard
as field names. If you copied the data from another application, the first row of data
may have taken the place of the field names.Do you want to paste the field
names in the order you defined with the Tab Order command?@@21@311022@2
None of the field names you pasted onto the Clipboard match the field names on
the form.@Microsoft Access treats the data in the first row on the Clipboard as field
names. If you copied the data from another application, the first row of data may
have taken the place of the field names.Do you want to paste the field names in
the order you defined with the Tab Order command?@@21@311022@2

Some of the field names for the data you tried to paste don't match field names on
the form.@Microsoft Office Access treats data in the first row on the Clipboard as
field names. In this case, some of those field names don't match the field names on
the form.Do you want to paste only that data whose names match the field names
on the Clipboard?@@19@1@11022@2
Some of the field names for the data you tried to paste don't match field names on
the form.@Microsoft Office Access treats data in the first row on the Clipboard as
field names. In this case, some of those field names don't match the field names on
the form.Do you want to paste only that data whose names match the field names
on the Clipboard?@@19@311022@2
Some of the field names for the data you tried to paste don't match field names on
the form.@Microsoft Access treats data in the first row on the Clipboard as field
names. In this case, some of those field names don't match the field names on the
form.Do you want to paste only that data whose names match the field names on
the Clipboard?@@19@311022@2
Do you want to suppress further error messages telling you why
pasted?@If you click No, a message will appear for every record
pasted.@@13@@@2
Do you want to suppress further error messages telling you why
pasted?@If you click No, a message will appear for every record
pasted.@@13@@2

records can't be
that can't be

records can't be
that can't be

You copied a large amount of data onto the Clipboard.@When you copy data onto
the Clipboard, only the reference to the object is copied. If you close the source
document, however, Microsoft Office Access must paste all the data from its source.
Depending on the amount of data, this can take some time.Do you want to save
this data on the Clipboard?@@19@@@2
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Access

8515

2003

2002

8516

2007

2003

8517

2007

2003

8518

2007
2003

8519

2007
2003

8520

2007
2003

8521

2007

2003

8522

2007
2003

8523

2007
2003

8524

2007
2003

Error Description
You copied a large amount of data onto the Clipboard.@When you copy data onto
the Clipboard, only the reference to the object is copied. If you close the source
document, however, Microsoft Office Access must paste all the data from its source.
Depending on the amount of data, this can take some time.Do you want to save
this data on the Clipboard?@@19@@2
You copied a large amount of data onto the Clipboard.@When you copy data onto
the Clipboard, only the reference to the object is copied. If you close the source
document, however, Microsoft Access must paste all the data from its source.
Depending on the amount of data, this can take some time.Do you want to save
this data on the Clipboard?@@19@@2
You selected more records than can be copied onto the Clipboard at one
time.@Divide the records into two or more groups, and then copy and paste one
group at a time.The maximum number of records you can paste at one time is
approximately 65,000.@@1@@@1
You selected more records than can be copied onto the Clipboard at one
time.@Divide the records into two or more groups, and then copy and paste one
group at a time.The maximum number of records you can paste at one time is
approximately 65,000.@@1@@1
Do you want to suppress further error messages telling you why records can't be
deleted?@If you click No, a message will appear for every record that can't be
deleted.@@13@@@2
Do you want to suppress further error messages telling you why records can't be
deleted?@If you click No, a message will appear for every record that can't be
deleted.@@13@@2

You won't be able to undo this Replace operation.@Do you want to
continue?@@19@@@2
You won't be able to undo this Replace operation.@Do you want to
continue?@@19@@2
You are about to delete | record(s).@If you click Yes, you won't be able to undo this
Delete operation.Are you sure you want to delete these records?@@19@@@2
You are about to delete | record(s).@If you click Yes, you won't be able to undo this
Delete operation.Are you sure you want to delete these records?@@19@@2
You are about to paste | record(s).@Are you sure you want to paste these
records?@@19@@@2
You are about to paste | record(s).@Are you sure you want to paste these
records?@@19@@2
You won't be able to undo this Delete operation.@The Undo command won't be
available because this operation is too large, or there isn't enough free
memory.Do you want to delete these items?@@19@@@2
You won't be able to undo this Delete operation.@The Undo command won't be
available because this operation is too large, or there isn't enough free
memory.Do you want to delete these items?@@19@@2
All timers are in use.@Set the TimerInterval property back to zero so that you can
start another timer.@@2@1@6342@1
All timers are in use.@Set the TimerInterval property back to zero so that you can
start another timer.@@2@606342@1

Do you want
revert to the
Do you want
revert to the

to delete the custom palette information from this form or report and
default palette?@@@20@@@2
to delete the custom palette information from this form or report and
default palette?@@@20@@2

Do you want to remove this picture from this control?@@@20@@@2
Do you want to delete the graphic from this button?@@@20@@2
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Access

8525

2007

2003

8526

2007
2003
2002

8527

2007

2003

2000

8528

2007
2003
2000

8529

2007

2003

8530

2007

2003

8531

2007

2003

Error Description
The remote data isn't accessible.@You tried to open a form or report that includes a
DDE or DDESend function in a calculated control that specifies an OLE server
application.Do you want to start the application |?@@19@@@2
The remote data isn't accessible.@You tried to open a form or report that includes a
DDE or DDESend function in a calculated control that specifies an OLE server
application.Do you want to start the application |?@@19@@2
Microsoft Office Access encountered a problem while trying to switch views and
must close this window.@@@1@@@1
Microsoft Office Access encountered a problem while trying to switch views and
must close this window.@@@1@@1
Microsoft Access encountered a problem while trying to switch views and must close
this window.@@@1@@1

Do you want to delete the group section for the database object '|' and its
contents?@The group header or footer you want to delete contains controls which
will be deleted along with the section.@@20@@@2
Do you want to delete the group section for the database object '|' and its contents?
You will not be able to undo this action.@The group header or footer you want to
delete contains controls and will be deleted along with the section.@@20@@2
Do you want to delete the group section for the database object '|' and its
contents?@The group header or footer you want to delete contains controls and will
be deleted along with the section.@@20@@2
Deleting these sections will also delete all controls in them. You will not be able to
undo this action.@Do you want to delete these sections anyway?@@20@@@2
Deleting these sections will also delete all controls in them. You will not be able to
undo this action.@Do you want to delete these sections anyway?@@20@@2
Deleting these sections will also delete all controls in them.@Do you want to delete
these sections anyway?@@20@@2

The grouping level that you are trying to delete has a group header or group footer
section. The section contains controls that will also be deleted.@Do you want to
continue?@@20@@@2
Do you want to delete the selected group level(s) and all associated sections and
their controls?@The field or expression you're deleting from the Sorting and
Grouping box has an associated section (a header or footer) containing controls that
will be deleted along with the section.@@20@@2
Relationships that specify cascading deletes are about to cause | record(s) in this
table and in related tables to be deleted.@Are you sure you want to delete these
records?@@21@1@9096@2
Relationships that specify cascading deletes are about to cause | record(s) in this
table and in related tables to be deleted.@Are you sure you want to delete these
records?@@21@409096@2
The section width is greater than the page width, and there are no items in the
additional space, so some pages may be blank.@For example, the report width may
be wider than the page width.@@3@@@1
The section width is greater than the page width, and there are no items in the
additional space, so some pages may be blank.@For example, the report width may
be wider than the page width.@@3@@1

8532

2007
2003

Do you want to remove this picture from the form?@@@20@@@2
Do you want to remove this picture from the form?@@@20@@2

8533

2007

Some data may not be displayed.@There is not enough horizontal space on the
page for the number of columns and column spacing you specified.@Click Page
Setup on the File menu, click the Columns tab, and then reduce the number of
columns or the size of the columns.@3@@@1
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Access

8533

2003

2000

8534

2007

2003

8538

2007
2003

2000

8539

2007

2003

8540

2007

2003

8541

2007
2002

2000
8542

2007
2003
2002

8543

2007
2003

Error Description
Some data may not be displayed.@There is not enough horizontal space on the
page for the number of columns and column spacing you specified.@Click Page
Setup on the File menu, click the Columns tab, and then reduce the number of
columns or the size of the columns.@3@@1
Some data may not be displayed.@There is not enough horizontal space on the
page for the number of columns and column spacing you specified.@Click Page
Setup on the File menu, click the Layout tab, and then reduce the number of
columns or the size of the columns.@3@@1
When you save this form or report, any code behind it will be deleted.@You have
set the HasModule property to No, creating a form or report that opens more
quickly. Any macros associated with this form or report will not be affected, nor will
code in separate modules that is called from this property sheet.@Are you sure you
want to do this?@20@@@2
When you save this form or report, any code behind it will be deleted.@You have
set the HasModule property to No, creating a form or report that opens more
quickly. Any macros associated with this form or report will not be affected, nor will
code in separate modules that is called from this property sheet.@Are you sure you
want to do this?@20@@2

You are about to delete this section. @If you click Yes, the controls you placed in
this section will be deleted. Are you sure you want to delete these
controls?@@20@@2
You are about to delete this section. @If you click Yes, the controls you placed in
this section will be deleted and you won't be able to undo this operation. Are you
sure you want to delete these controls?@@20@@2
Relationships that specify cascading deletes are about to cause record(s) in this
table and in related tables to be deleted.@Are you sure you want to delete these
records?@@21@1@9096@2
Relationships that specify cascading deletes are about to cause record(s) in this
table and in related tables to be deleted.@Are you sure you want to delete these
records?@@21@409096@2
You are about to delete one or
undo this Delete operation.Are
records?@@19@@@2
You are about to delete one or
undo this Delete operation.Are
records?@@19@@2

more records.@If you click Yes, you won't be able to
you sure you want to delete these

more records.@If you click Yes, you won't be able to
you sure you want to delete these

Microsoft Office Access could not perform the delete operation. An error occurred
during the delete operation, no records were deleted.
Microsoft Access could not perform the delete operation. An error occurred during
the delete operation, no records were deleted.
Microsoft Access Could not perform the delete operation.An error occurred during
the delete operation, no records were deleted.

Microsoft Office Access did not detect a relationship between the fields you have
chosen. @Do you want a relationship to be created for you now?@@19@@@3
Microsoft Office Access did not detect a relationship between the fields you have
chosen. @Do you want a relationship to be created for you now?@@19@@3
Microsoft Access did not detect a relationship between the fields you have chosen.
@Do you want a relationship to be created for you now?@@19@@3
You are about to delete this section and all related sections. @If you click Yes, the
controls you placed in these sections will be deleted. Are you sure you want to
delete these controls?@@20@@2
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Access

8543

2000

You are about to delete this section and all related sections. @If you click Yes, the
controls you placed in these sections will be deleted and you won't be able to undo
this operation. Are you sure you want to delete these controls?@@20@@2

8544

2007

You won't be able to undo this paste operation.@Do you want to
continue?@@19@@@2
You won't be able to undo this paste operation.@Do you want to
continue?@@19@@2

2003
8545

2007
2003

2002

8546

2007
2003

Error Description

Microsoft Office Access can't save the filter criteria you entered in the Insert
Hyperlink dialog box. Make sure that the data access page is bound to a record
source before you set the filter criteria. Also make sure that the criteria is in the
form of a WHERE clause; for example, EmployeeID=[EmployeeID].
Microsoft Access can't save the filter criteria you entered in the Insert Hyperlink
dialog box. Make sure that the data access page is bound to a record source before
you set the filter criteria. Also make sure that the criteria is in the form of a WHERE
clause; for example, EmployeeID=[EmployeeID].
Current object must first be saved before exporting data to XML. @Would you like
to save '|' and then continue?@@19@@@2
Current object must first be saved before exporting data to XML. @Would you like
to save '|' and then continue?@@19@@2

8547

2007

Do you want to save the changes made to the macro and update the
property?@@@13@1@4309@2

8548

2007

To complete this operation, Access must modify the RecordSource property of the
current form or report.@Access will create a new query and embed it directly into
the form's or report's RecordSource property. The form or report will no longer be
based on the '|' query.@Do you want to accept this change?@19@@@2

8549

2007

This table contains one or more Lookup fields. Display values for Lookup fields
cannot be changed by using the Replace operation.@@@1@1@865@1

8550

2007

A table or query needed in order to create the new form, report, or query is
currently open in Design view.@Save or discard the changes to this table or query
and open it in Datasheet view, then try again.@@1@@@1

8551

2007

Do you want to remove this picture from the report?@@@20@@@2

9502

2007

Microsoft Office Access won't be able to undo this action or subsequent actions. To
make more resources available so that Access can record further design actions,
close and reopen this window. @Do you want to continue anyway?@@19@@@2
Microsoft Office Access won't be able to undo this action or subsequent actions. To
make more resources available so that Access can record further design actions,
close and reopen this window. @Do you want to continue anyway?@@19@@2
Microsoft Access won't be able to undo this action or subsequent actions. To make
more resources available so that Access can record further design actions, close and
reopen this window. @Do you want to continue anyway?@@19@@2
You won't be able to undo this operation.@Do you want to continue
anyway?@@19@@2

2003

2002

2000
9504

2007

2003

9505

2007

The file '|' is not readable by the Access database engine. @If you think you have a
valid Access database, this is most likely because of the recent file format change.
Do you want to attempt to upgrade the database format?@@19@@@2
The file '|' is not readable by JET. @If you think you have a valid JET file then this is
most likely due to the recent file format change. Do you want to attempt to upgrade
the database format?@@19@@2

Microsoft Office Access has detected that this database is in an inconsistent state,
and will attempt to recover the database. During this process, a backup copy of the
database will be made and all recovered objects will be placed in a new database.
Access will then open the new database. The names of objects that were not
successfully recovered will be logged in the "Recovery Errors" table.@@@1@@@2
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Access

9505

2003

2002

Error Description
The database '|' needs to be repaired or isn't a database file.@You or another user
may have unexpectedly quit Microsoft Office Access while a Microsoft Office Access
database was open.Do you want Microsoft Office Access to attempt to repair the
database?@@19@209010@2
The database '|' needs to be repaired or isn't a database file.@You or another user
may have unexpectedly quit Microsoft Access while a Microsoft Access database was
open.Do you want Microsoft Access to attempt to repair the
database?@@19@209010@2

9507

2007
2003
2002

Microsoft Office Access was unable to load all the library modules.@@@1@@@1
Microsoft Office Access was unable to load all the library modules.@@@1@@1
Microsoft Access was unable to load all the library modules.@@@1@@1

9508

2007

Microsoft Office Access couldn't close database '|.'@Your last change may not have
been saved because an internal buffer was locked by another user (whose name
was given in the previous message).To avoid losing data, wait for the other user
to finish using the record, and then click OK again.If you click Cancel, you may
lose changes that haven't been saved.@@3@@@2
Microsoft Office Access couldn't close database '|.'@Your last change may not have
been saved because an internal buffer was locked by another user (whose name
was given in the previous message).To avoid losing data, wait for the other user
to finish using the record, and then click OK again.If you click Cancel, you may
lose changes that haven't been saved.@@3@@2
Microsoft Access couldn't close database '|.'@Your last change may not have been
saved because an internal buffer was locked by another user (whose name was
given in the previous message).To avoid losing data, wait for the other user to
finish using the record, and then click OK again.If you click Cancel, you may lose
changes that haven't been saved.@@3@@2

2003

2002

9509

2007
2003

9510

You
this
You
this

can't undo this command and, once it's completed, you won't be able to edit
object.@Do you want to continue anyway?@@19@@@2
can't undo this command and, once it's completed, you won't be able to edit
object.@Do you want to continue anyway?@@19@@2

2007
2003
2002

Microsoft Office Access can't open the file '|'.@@@1@@1
Microsoft Access can't open the file '|'.@@@1@@1

9511

2007
2003

|@@@1@@@1
|@@@1@@1

9512

2007
2003

Successfully repaired the '|' database.@@@1@@1

9513

2007

2003

2002

Microsoft Office Access was unable to completely repair the '|' table and deleted
some Memo, OLE Object, or Hyperlink field values.@To recover the data, restore
from your backup copy of the database.Note that the data in the deleted field
may have been damaged by a bad sector on your hard disk. For more information
on checking your disk's surface, files, and folders for errors, search the Windows
Help index for 'checking for disk errors'.@@1@@@1
Microsoft Office Access was unable to completely repair the '|' table and deleted
some Memo, OLE Object, or Hyperlink field values.@To recover the data, restore
from your backup copy of the database.Note that the data in the deleted field
may have been damaged by a bad sector on your hard disk. For more information
on checking your disk's surface, files, and folders for errors, search the Windows
Help index for 'checking for disk errors'.@@1@@1
Microsoft Access was unable to completely repair the '|' table and deleted some
Memo, OLE Object, or Hyperlink field values.@To recover the data, restore from
your backup copy of the database.Note that the data in the deleted field may
have been damaged by a bad sector on your hard disk. For more information on
checking your disk's surface, files, and folders for errors, search the Windows Help
index for 'checking for disk errors'.@@1@@1
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Access

9513

2000

Microsoft Access was unable to completely repair the '|' table and deleted some
Memo, OLE Object, or Hyperlink field values.@To recover the data, restore from
your backup copy of the database.Note that the data in the deleted field may
have been damaged by a bad sector on your hard disk. For more information on
checking your disk's surface, files, and folders for errors, search the Windows Help
index for 'checking for errors, in disks'.@@1@@1

9514

2007

One or more records were unrecoverable and were deleted from the '|'
table.@@@1@@@1
One or more records were unrecoverable and were deleted from the '|'
table.@@@1@@1

2003

Error Description

9515

2007
2003

The '|' table was truncated; data was lost.@@@1@@@1
The '|' table was truncated; data was lost.@@@1@@1

9516

2007

One or more indexes from the '|' table couldn't be repaired and were
deleted.@@@1@@@1
One or more indexes from the '|' table couldn't be repaired and were
deleted.@@@1@@1

2003
9517

2007
2003

9518

2007
2003

9519

2007
2003

9520

2007
2003

The
you
The
you

Save
want
Save
want

As command can't process any subforms contained in your report.@Do
to proceed anyway?@@19@@@2
As command can't process any subforms contained in your report.@Do
to proceed anyway?@@19@@2

An error occurred while adding this word to the custom dictionary.@* The dictionary
file may be read-only.* There may be a disk error.@@1@@@1
An error occurred while adding this word to the custom dictionary.@* The dictionary
file may be read-only.* There may be a disk error.@@1@@1
An error occurred while adding this word to the Change All list.@The dictionary may
be full.@@1@@@1
An error occurred while adding this word to the Change All list.@The dictionary may
be full.@@1@@1

An error occurred while adding the word to the Ignore All list.@The dictionary may
be full.@@1@@@1
An error occurred while adding the word to the Ignore All list.@The dictionary may
be full.@@1@@1

9521

2007
2003

The specified word is too large.@Words can't exceed 64 characters.@@1@@@1
The specified word is too large.@Words can't exceed 64 characters.@@1@@1

9523

2007
2003
2002

Microsoft Office Access can't open the '|' custom dictionary.@@@1@@@1
Microsoft Office Access can't open the '|' custom dictionary.@@@1@@1
Microsoft Access can't open the '|' custom dictionary.@@@1@@1

9524

2007

Microsoft Office Access can't start the spelling checker because it isn't
installed.@@@1@@@1
Microsoft Office Access can't start the spelling checker because it isn't
installed.@@@1@@1
Microsoft Access can't start the spelling checker because it isn't
installed.@@@1@@1

2003
2002
9525

2007
2003
2002

9526

2007

Microsoft Office Access can't open the main dictionary file.@Verify that this file has
been correctly installed.@@1@@@1
Microsoft Office Access can't open the main dictionary file.@Verify that this file has
been correctly installed.@@1@@1
Microsoft Access can't open the main dictionary file.@Verify that this file has been
correctly installed.@@1@@1
The spelling checker only works on text fields that contain text data.@You're trying
to check a field with a data type other than Text or Memo.@@1@@@1

Copyright (c) 2008 FMS, Inc.

fmsinc.com

Page 177 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

9526

2003

The spelling checker only works on text fields that contain text data.@You're trying
to check a field with a data type other than Text or Memo.@@1@@1

9527

2007

The spelling checker can't proceed; you must first select data from a table, query,
view, stored procedure, or form.@@@1@@@1
The spelling checker can't proceed; you must first select data from a table, query,
view, stored procedure, or form.@@@1@@1

2003

9529

2007
2003

9530

2007

2003

9531

Error Description

Microsoft Office Access cannot run the spell checker because the data in this form or
query is not updatable.@@@2@1@9932@1
The spelling checker can't proceed; form data is not updatable.@The form may be
based on a query that isn't updatable or is only partly updatable. For information on
when a query is updatable, click Help.@@2@409932@1
An error occurred while trying to modify the contents of field '|.'@The field may be
locked or read-only, or you may not have permissions to change it. For information
on security permissions and who can change them, click Help.@@2@1@10222@1
An error occurred while trying to modify the contents of field '|.'@The field may be
locked or read-only, or you may not have permissions to change it. For information
on security permissions and who can change them, click Help.@@2@410222@1

2007
2003

An error occurred while trying to save spelling preferences.@@@1@@1

9532

2007
2003

The '|' field can't be modified because it's a read-only field.@@@1@@@1
The '|' field can't be modified because it's a read-only field.@@@1@@1

9533

2007

An error occurred while trying to add the word pair to the AutoCorrect
list.@@@1@@@1
An error occurred while trying to add the word pair to the AutoCorrect
list.@@@1@@1

2003
9534

2007

2003

The current selection does not contain any fields that can be checked for spelling
errors.@You can check the spelling of text box controls with Text or Memo data
types.@@1@@@1
The current selection does not contain any fields that can be checked for spelling
errors.@You can check the spelling of text box controls with Text or Memo data
types.@@1@@1

9535

2007
2003

You entered an invalid main dictionary.@Please select a valid entry.@@1@@@1
You entered an invalid main dictionary.@Please select a valid entry.@@1@@1

9536

2007
2003

The spelling check is complete.@@@1@@@1
The spelling check is complete.@@@1@@1

9537

2007

You must restart the spelling checker for the dictionary change to take
effect.@@@1@@@1
You must restart the spelling checker for the dictionary change to take
effect.@@@1@@1

2003
9538
9539

2007
2003
2007
2003
2000

9540

2007
2003

The '|' custom dictionary doesn't exist.@Do you want to create it?@@20@@1
You have specified a word that isn't found in the main or custom dictionary.@Do
you want to use this word and continue checking?@@20@@@1
You have specified a word that isn't found in the main or custom dictionary.@Do
you want to use this word and continue checking?@@20@@1
The Change To box contains a word that isn't found in the main or custom
dictionary.@Do you want to use this word and continue checking?@@20@@1

The main dictionary you selected can't be used.@It has not been correctly
installed.@@1@@1
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Access

9541

2007
2003

9542

2007

2003

2002

9543

2007
2003

Error Description
The spelling checker can't
modified by another user.
The spelling checker can't
modified by another user.

undo your last change.@The data in field '|' has been
To resume the spelling check, click OK.@@1@@@1
undo your last change.@The data in field '|' has been
To resume the spelling check, click OK.@@1@@1

This database must be closed before you can create a replica.@Do you want
Microsoft Office Access to close this database and create the replica?If you
proceed, Microsoft Office Access will close your database and convert it to a Design
Master. The database may increase in size.@@19@@@2
This database must be closed before you can create a replica.@Do you want
Microsoft Office Access to close this database and create the replica?If you
proceed, Microsoft Office Access will close your database and convert it to a Design
Master. The database may increase in size.@@19@@2
This database must be closed before you can create a replica.@Do you want
Microsoft Access to close this database and create the replica?If you proceed,
Microsoft Access will close your database and convert it to a Design Master. The
database may increase in size.@@19@@2

The Hangul Hanja Converter can't proceed. There is no Hangul or Hanja data to
convert.@@@1@@@1
The Hangul Hanja Converter can't proceed. There is no Hangul or Hanja data to
convert.@@@1@@1

9544

2007
2003
2002

Microsoft Office Access can't register the '|' custom dictionary.@@@1@@@1
Microsoft Office Access can't register the '|' custom dictionary.@@@1@@1
Microsoft Access can't register the '|' custom dictionary.@@@1@@1

9545

2007

After you have converted this file to Access 2002 - 2003 File Format, the new file
cannot be shared with Access 2000 users or Access 97 users.@For more
information about conversion, click Help.@@2@1@553714162@1
After you have converted this file to Access 2002 - 2003 File Format, the new file
cannot be shared with Access 2000 users or Access 97 users.@For more
information about conversion, click Help.@@2@553714162@1
After you have converted this file to Access 2002 File Format, the new file cannot be
shared with Access 2000 users or Access 97 users.@For more information about
conversion, click Help.@@2@5254@1

2003

2002

9546

2007
2003

2002

9547

2007

2003

2002

This data access page was created in a previous version of Microsoft Office Access.
To open this page in Design view, you must convert it to the current version of
Access. Once you have converted this page, you can't open it in Design view in a
previous version of Access. Con&vert Cancel@@@35@@
This data access page was created in a previous version of Microsoft Access. To
open this page in Design view, you must convert it to the current version of Access.
Once you have converted this page, you can't open it in Design view in a previous
version of Access. Con&vert Cancel@@@35@@
After you have converted this file to Access 2000 File Format, the new file cannot be
shared with Access 97 users. @Any functionality specific to Access 2002 or later will
not be available in Access 2000.@For more information about conversion, click
Help.@2@1@553714162@1
After you have converted this file to Access 2000 File Format, the new file cannot be
shared with Access 97 users. @Any functionality specific to Access 2002 or later will
not be available in Access 2000.@For more information about conversion, click
Help.@2@553714162@1
After you have converted this file to Access 2000 File Format, the new file cannot be
shared with Access 97 users. @Any functionality specific to Access 2002 will not be
available in Access 2000.@For more information about conversion, click
Help.@2@5255@1
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Access

9548

2007

2003

2002

Error Description
After you have converted this file to Access 97 File Format, any functionality specific
to Access 2000 or later will be lost.@For more information about conversion, click
Help.@@2@1@553714162@1
After you have converted this file to Access 97 File Format, any functionality specific
to Access 2000 or later will be lost.@For more information about conversion, click
Help.@@2@553714162@1
After you have converted this file to Access 97 File Format, any functionality specific
to Access 2000 or Access 2002 will be lost.@For more information about conversion,
click Help.@@2@5256@1

9549

2007

This Database has been upgraded to the Access 2007 File Format. The new
database cannot be shared with users of Access 2003 or earlier versions.@For more
information about conversion, click Help.@@2@1@553714162@1

9550

2007

The Text Format property of the bound field '|' is not currently Rich Text. You should
change the Text Format property of the table field before you change the property
of this control. If you change the Text Format property of this control to Rich Text
before you change the property of the bound field, some data that is not valid HTML
might not be displayed.@Do you want to continue?@@19@@@2

9551

2007

The Text Format property of the bound field '|' is not currently Plain Text. You
should change the Text Format property of the table field before you change the
property of this control. If you change the Text Format property of this control to
Plain Text before you change the property of the bound field, some data might be
displayed as HTML tags.@Do you want to continue?@@19@@@2

10000

2007
2003

You must first save the table.@Do you want to save the table now?@@19@@@1
You must first save the table.@Do you want to save the table now?@@19@@1

10001

2007
2003

You must first save the view.@Do you want to save the view now?@@19@@@1
You must first save the view.@Do you want to save the view now?@@19@@1

10002

2007

You must first save the stored procedure.@Do you want to save the stored
procedure now?@@19@@@1
You must first save the stored procedure.@Do you want to save the stored
procedure now?@@19@@1

2003
10003

2007
2003

You must first save the query.@Do you want to save the query now?@@19@@@1
You must first save the query.@Do you want to save the query now?@@19@@1

10004

2007

Do you want
field(s)?@To
Do you want
field(s)?@To

2003
10005

2007

2003

10006

2007

2003

to permanently delete the selected field(s) and all the data in the
permanently delete the field(s), click Yes.@@19@@@2
to permanently delete the selected field(s) and all the data in the
permanently delete the field(s), click Yes.@@19@@2

There is no primary key defined.@Although a primary key isn't required, it's highly
recommended. A table must have a primary key for you to define a relationship
between this table and other tables in the database.Do you want to create a
primary key now?@@13@@@2
There is no primary key defined.@Although a primary key isn't required, it's highly
recommended. A table must have a primary key for you to define a relationship
between this table and other tables in the database.Do you want to create a
primary key now?@@13@@2
Changing to this data type requires removal of one or more indexes.@You can't use
indexes on fields with a Memo, OLE Object, or Hyperlink data type. If you click Yes,
Microsoft Office Access will delete the indexes that include that field.Do you want
to continue anyway?@@20@@@2
Changing to this data type requires removal of one or more indexes.@You can't use
indexes on fields with a Memo, OLE Object, or Hyperlink data type. If you click Yes,
Microsoft Office Access will delete the indexes that include that field.Do you want
to continue anyway?@@20@@2
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Numbe

Access

10006

2002

Changing to this data type requires removal of one or more indexes.@You can't use
indexes on fields with a Memo, OLE Object, or Hyperlink data type. If you click Yes,
Microsoft Access will delete the indexes that include that field.Do you want to
continue anyway?@@20@@2

10007

2007

Deleting field '|' requires Microsoft Office Access to delete the primary key.@Do you
want to delete this field anyway?@@19@@@2
Deleting field '|' requires Microsoft Office Access to delete the primary key.@Do you
want to delete this field anyway?@@19@@2
Deleting field '|' requires Microsoft Access to delete the primary key.@Do you want
to delete this field anyway?@@19@@2

2003
2002

10008

2007

2003

2002

10009

2007

2003

10010

2007

2003

10011

2007

2003
2002
10012

2007

Error Description

Deleting field '|' requires Microsoft Office Access to delete one or more indexes.@If
you click Yes, Microsoft Office Access will delete the field and all its indexes.Do
you want to delete this field anyway?@@19@@@2
Deleting field '|' requires Microsoft Office Access to delete one or more indexes.@If
you click Yes, Microsoft Office Access will delete the field and all its indexes.Do
you want to delete this field anyway?@@19@@2
Deleting field '|' requires Microsoft Access to delete one or more indexes.@If you
click Yes, Microsoft Access will delete the field and all its indexes.Do you want to
delete this field anyway?@@19@@2
Either an object bound to table '|' is open or another user has the table open. Do
you want to open the table as read-only?@To open the table as read-only, click
Yes.@To open the table as read/write, click No, make sure the table and all objects
bound to it are closed, and then try opening it again in Design view.@19@@@2
You can't open the table '|' for modification.@A query or form bound to the table is
open, you may not have permission to open this table in Design view, or another
user has the table open.Do you want to open this table as read-only?@If you have
opened a query or form bound to this table, close it, and then try again to open the
table in Design view.@19@@2

Table '|' is a linked table whose design can't be modified. If you want to add or
remove fields or change their properties or data types, you must do so in the source
database.@Do you want to open it anyway?@@19@@@2
Table '|' is a linked table with some properties that can't be modified.@Do you want
to open it anyway?@@19@@2
Microsoft Office Access encountered errors while converting the data.@The contents
of fields in |1 record(s) were deleted.Do you want to proceed
anyway?@@19@@@2
Microsoft Office Access encountered errors while converting the data.@The contents
of fields in |1 record(s) were deleted.Do you want to proceed anyway?@@19@@2
Microsoft Access encountered errors while converting the data.@The contents of
fields in |1 record(s) were deleted.Do you want to proceed anyway?@@19@@2
Microsoft Office Access cannot retrieve field properties from the system
tables.@This database needs to be repaired. If you click Yes, Microsoft Office Access
will open the table in Design view. The settings of the FieldName, DataType,
FieldSize, Indexed, and Primary properties will remain intact, but the settings of
other field properties will be lost.You can attempt to redefine the lost properties,
but we recommend that you restore the database from a backup copy, or close it
and use the Compact and Repair Database command (click the Microsoft Office
Button and point to Manage).Do you want to continue?@@20@@@2
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Numbe

Access

10012

2003

2002

10013

2007
2003
2002

10014

2007

2003

2002

10015

2007
2003

10016

2007

2003

Error Description
Microsoft Office Access can't retrieve field properties from the system tables.@The
database needs to be repaired. If you click Yes, Microsoft Office Access will open the
table in Design view. The settings of the FieldName, DataType, FieldSize, Indexed,
and Primary properties will remain intact, but the settings of other field properties
will be lost.You can attempt to redefine the lost properties, but it is recommended
that you restore the database from a backup copy, or close it and use the Repair
Database command on the Tools menu (Database Utilities submenu).Do you want
to continue anyway?@@20@@2
Microsoft Access can't retrieve field properties from the system tables.@The
database needs to be repaired. If you click Yes, Microsoft Access will open the table
in Design view. The settings of the FieldName, DataType, FieldSize, Indexed, and
Primary properties will remain intact, but the settings of other field properties will
be lost.You can attempt to redefine the lost properties, but it is recommended
that you restore the database from a backup copy, or close it and use the Repair
Database command on the Tools menu (Database Utilities submenu).Do you want
to continue anyway?@@20@@2
Microsoft Office Access can't save property changes for linked tables.@Do you want
to continue anyway?@@19@@@2
Microsoft Office Access can't save property changes for linked tables.@Do you want
to continue anyway?@@19@@2
Microsoft Access can't save property changes for linked tables.@Do you want to
continue anyway?@@19@@2
Microsoft Office Access was unable to append all the data to the table.@The
contents of fields in |1 record(s) were deleted, and |2 record(s) were lost due to
key violations.* If data was deleted, the data you pasted or imported doesn't
match the field data types or the FieldSize property in the destination table.* If
records were lost, either the records you pasted contain primary key values that
already exist in the destination table, or they violate referential integrity rules for a
relationship defined between tables.Do you want to proceed
anyway?@@22@1@922@1
Microsoft Office Access was unable to append all the data to the table.@The
contents of fields in |1 record(s) were deleted, and |2 record(s) were lost due to
key violations.* If data was deleted, the data you pasted or imported doesn't
match the field data types or the FieldSize property in the destination table.* If
records were lost, either the records you pasted contain primary key values that
already exist in the destination table, or they violate referential integrity rules for a
relationship defined between tables.Do you want to proceed
anyway?@@22@600922@1
Microsoft Access was unable to append all the data to the table.@The contents of
fields in |1 record(s) were deleted, and |2 record(s) were lost due to key
violations.* If data was deleted, the data you pasted or imported doesn't match
the field data types or the FieldSize property in the destination table.* If records
were lost, either the records you pasted contain primary key values that already
exist in the destination table, or they violate referential integrity rules for a
relationship defined between tables.Do you want to proceed
anyway?@@22@600922@1
Changing to this data type requires removal of the primary key.@Do you want to
continue anyway?@@19@@@2
Changing to this data type requires removal of the primary key.@Do you want to
continue anyway?@@19@@2

Some data may be lost.@The setting for the FieldSize property of one or more fields
has been changed to a shorter size. If data is lost, validation rules may be violated
as a result.Do you want to continue anyway?@@20@@@2
Some data may be lost.@The setting for the FieldSize property of one or more fields
has been changed to a shorter size. If data is lost, validation rules may be violated
as a result.Do you want to continue anyway?@@20@@2
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Access

10017

2007
2003

10018

2007

2003

2002

10019

2007

2003

2002

10020

2007

2003

10021

2007

2003

10022

2007

2003

Error Description
Your computer is out of disk space.@You won't be able to undo this paste append.
Do you want to continue anyway?@@19@@@2
Your computer is out of disk space.@You won't be able to undo this paste append.
Do you want to continue anyway?@@19@@2
Microsoft Office Access was unable to append all the data to the table.@The
contents of fields in |1 record(s) were deleted, and |2 record(s) were lost due to
key violations.* If data was deleted, the data you pasted or imported doesn't
match the field data types or the FieldSize property in the destination table.* If
records were lost, the records you pasted contain primary key values that already
exist in the destination table, or they violate referential integrity rules for a
relationship defined between tables.@@2@1@922@1
Microsoft Office Access was unable to append all the data to the table.@The
contents of fields in |1 record(s) were deleted, and |2 record(s) were lost due to
key violations.* If data was deleted, the data you pasted or imported doesn't
match the field data types or the FieldSize property in the destination table.* If
records were lost, the records you pasted contain primary key values that already
exist in the destination table, or they violate referential integrity rules for a
relationship defined between tables.@@2@600922@1
Microsoft Access was unable to append all the data to the table.@The contents of
fields in |1 record(s) were deleted, and |2 record(s) were lost due to key
violations.* If data was deleted, the data you pasted or imported doesn't match
the field data types or the FieldSize property in the destination table.* If records
were lost, the records you pasted contain primary key values that already exist in
the destination table, or they violate referential integrity rules for a relationship
defined between tables.@@2@600922@1

Microsoft Office Access can't find the database containing the linked table '|.'@The
properties set in Microsoft Office Access for the linked table will be lost.Do you
want to continue with the conversion anyway?@@19@@@2
Microsoft Office Access can't find the database containing the linked table '|.'@The
properties set in Microsoft Office Access for the linked table will be lost.Do you
want to continue with the conversion anyway?@@19@@2
Microsoft Access can't find the database containing the linked table '|.'@The
properties set in Microsoft Access for the linked table will be lost.Do you want to
continue with the conversion anyway?@@19@@2
Data integrity rules have been changed; existing data may not be valid for the new
rules.@This process may take a long time. Do you want the existing data to be
tested with the new rules?@@13@@@2
Data integrity rules have been changed; existing data may not be valid for the new
rules.@This process may take a long time. Do you want the existing data to be
tested with the new rules?@@13@@2
Existing data violates the new record validation rule.@Do you want to keep testing
with the new rule?* To keep the new rule and continue testing, click Yes.* To
revert to the old rule and continue testing, click No.* To stop testing, click
Cancel.@@13@@@1
Existing data violates the new record validation rule.@Do you want to keep testing
with the new rule?* To keep the new rule and continue testing, click Yes.* To
revert to the old rule and continue testing, click No.* To stop testing, click
Cancel.@@13@@1
Existing data violates the new setting for the '|1' property for field '|2.'@Do you
want to keep testing with the new setting?* To keep the new setting and continue
testing, click Yes.* To revert to the old setting and continue testing, click No.*
To stop testing, click Cancel.@@13@@@2
Existing data violates the new setting for the '|1' property for field '|2.'@Do you
want to keep testing with the new setting?* To keep the new setting and continue
testing, click Yes.* To revert to the old setting and continue testing, click No.*
To stop testing, click Cancel.@@13@@2
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Access

10023

2007
2003
2002

10024

2007

2003

2002

10025

2007

2003

Error Description
Microsoft Office Access deleted | indexes on the converted fields.@Some data did
not convert properly.@@1@@@1
Microsoft Office Access deleted | indexes on the converted fields.@Some data did
not convert properly.@@1@@1
Microsoft Access deleted | indexes on the converted fields.@Some data did not
convert properly.@@1@@1
You must save the table first.@Microsoft Office Access can't test your data until you
save the design changes you made.Do you want to save the table
now?@@19@@@2
You must save the table first.@Microsoft Office Access can't test your data until you
save the design changes you made.Do you want to save the table
now?@@19@@2
You must save the table first.@Microsoft Access can't test your data until you save
the design changes you made.Do you want to save the table now?@@19@@2

This operation will test the table's record and field validation rules, as well as the
Required and AllowZeroLength properties, for all data in the table.@This process
may take a long time.Do you want to continue anyway?@@19@@@2
This operation will test the table's record and field validation rules, as well as the
Required and AllowZeroLength properties, for all data in the table.@This process
may take a long time.Do you want to continue anyway?@@19@@2

10026

2007
2003

All data was valid for all rules.@@@1@@@1
All data was valid for all rules.@@@1@@1

10027

2007

Existing data violates the new record validation rule.@Do you want to continue
testing data with this new rule?* To continue testing for other new rule violations,
click Yes.* To continue to test only the old validation rules, click No.* To stop
testing, click Cancel.@@13@@@2
Existing data violates the new record validation rule.@Do you want to continue
testing data with this new rule?* To continue testing for other new rule violations,
click Yes.* To continue to test only the old validation rules, click No.* To stop
testing, click Cancel.@@13@@2

2003

10028

2007

2003

2002

10029

10030

2007
2003

2007

2003

10031

2007

The existing data violates the '|1' property for field '|2.'@If you continue testing,
Microsoft Office Access will inform you if data violates any other property settings in
the table.Would you like to continue testing?@@19@@@2
The existing data violates the '|1' property for field '|2.'@If you continue testing,
Microsoft Office Access will inform you if data violates any other property settings in
the table.Would you like to continue testing?@@19@@2
The existing data violates the '|1' property for field '|2.'@If you continue testing,
Microsoft Access will inform you if data violates any other property settings in the
table.Would you like to continue testing?@@19@@2
There is no primary key defined.@Although a primary key isn't required, it's highly
recommended. A table must have a primary key for you to add data to this table or
to define relationships between this table and other tables in the database.Do you
want to return to table design and add a primary key now?@@13@@2

There is no primary key defined.@Although a primary key isn't required, it's highly
recommended. A table must have a primary key for you to define relationships
between this table and other tables in the database.Do you want to return to
table design and add a primary key now?@@13@@@2
There is no primary key defined.@Although a primary key isn't required, it's highly
recommended. A table must have a primary key for you to define relationships
between this table and other tables in the database.Do you want to return to
table design and add a primary key now?@@13@@2
You must first save the function.@Do you want to save the function
now?@@19@@@1
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Access

10031

2003

You must first save the function.@Do you want to save the function now?@@19@@1

10032

2007

This field will be converted to Plain Text and all the formatting in the field will be
removed.@Do you want to convert the column to Plain Text?@@20@@@2

10033

2007

This field will be converted to Rich Text, and all the data it contains will be HTML
encoded.@If your data already contains valid HTML Rich Text, you can remove any
extra HTML encoding by using the PlainText function in an update query. Do you
want to convert the column to Rich Text?@@20@@@2

10250

2007

You can't print the scrollable (unfrozen) columns on the datasheet.@The frozen
columns are wider than the page. Do you want to print just the frozen columns?@If
you want to print the unfrozen columns, try one or more of the following:*
Decrease the column width and increase the row height of the frozen columns.*
Change the page orientation to Landscape in the printer Properties dialog box.*
Decrease the size of the left and right page margins in the Page Setup dialog
box.@21@1@9172@2
You can't print the scrollable (unfrozen) columns on the datasheet.@The frozen
columns are wider than the page. Do you want to print just the frozen columns?@If
you want to print the unfrozen columns, try one or more of the following:*
Decrease the column width and increase the row height of the frozen columns.*
Change the page orientation to Landscape in the printer Properties dialog box.*
Decrease the size of the left and right page margins in the Page Setup dialog
box.@21@209172@2

2003

10251

2007

2003

10252

2007

2003

10253

2007

2003

Error Description

The column heading is too tall to fit on the page. Part of the heading will be cut
off.@Do you want to print the incomplete heading?@To prevent headings from
being cut off, try one or more of the following:* Change the page orientation to
Portrait in the printer Properties dialog box.* Decrease the size of the top and
bottom page margins in the Page Setup dialog box.@19@@@2
The column heading is too tall to fit on the page. Part of the heading will be cut
off.@Do you want to print the incomplete heading?@To prevent headings from
being cut off, try one or more of the following:* Change the page orientation to
Portrait in the printer Properties dialog box.* Decrease the size of the top and
bottom page margins in the Page Setup dialog box.@19@@2
At least one column is too wide to fit on the page. Data in that column will be cut
off.@Do you want to print the column with incomplete data?@To prevent data from
being cut off, try one or more of the following:* Decrease the column width and
increase the row height.* Change the page orientation to Landscape in the printer
Properties dialog box.* Decrease the size of the left and right page margins in the
Page Setup dialog box.@19@@@2
At least one column is too wide to fit on the page. Data in that column will be cut
off.@Do you want to print the column with incomplete data?@To prevent data from
being cut off, try one or more of the following:* Decrease the column width and
increase the row height.* Change the page orientation to Landscape in the printer
Properties dialog box.* Decrease the size of the left and right page margins in the
Page Setup dialog box.@19@@2
The row height exceeds the space between the top and bottom margins.@Do you
want to print the columns with incomplete data?@To prevent data from being cut
off, try one or more of the following:* Increase the column width and decrease
the row height.* Change the page orientation to Portrait in the printer Properties
dialog box.* Decrease the size of the top and bottom page margins in the Page
Setup dialog box.@19@@@2
The row height exceeds the space between the top and bottom margins.@Do you
want to print the columns with incomplete data?@To prevent data from being cut
off, try one or more of the following:* Increase the column width and decrease
the row height.* Change the page orientation to Portrait in the printer Properties
dialog box.* Decrease the size of the top and bottom page margins in the Page
Setup dialog box.@19@@2
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Access

10500

2007

2003

10501

2007

2003

10502

2007

2003

10503

2007

2003

10504

2007

2003

10505

2007

2003

10506

2007

2003

10507

2007

2003

Error Description
You are about to run an update query that will modify data in your table.@Are you
sure you want to run this type of action query?For information on how to prevent
this message from displaying every time you run an action query, click
Help.@@21@1@9058@2
You are about to run an update query that will modify data in your table.@Are you
sure you want to run this type of action query?For information on how to prevent
this message from displaying every time you run an action query, click
Help.@@21@209058@2
You are about to run an append query that will modify data in your table.@Are you
sure you want to run this type of action query?For information on turning off
confirmation messages for document deletions, click Help.@@21@1@9058@2
You are about to run an append query that will modify data in your table.@Are you
sure you want to run this type of action query?For information on turning off
confirmation messages for document deletions, click Help.@@21@209058@2
You are about to run a make-table query that will modify data in your table.@Are
you sure you want to run this type of action query?For information on how to
prevent this message from displaying every time you run an action query, click
Help.@@21@1@9058@2
You are about to run a make-table query that will modify data in your table.@Are
you sure you want to run this type of action query?For information on how to
prevent this message from displaying every time you run an action query, click
Help.@@21@209058@2

You are about to run a delete query that will modify data in your table.@Are you
sure you want to run this type of action query?For information on how to prevent
this message from displaying every time you run an action query, click
Help.@@21@1@9058@2
You are about to run a delete query that will modify data in your table.@Are you
sure you want to run this type of action query?For information on how to prevent
this message from displaying every time you run an action query, click
Help.@@21@209058@2
You are about to run a data-definition query that may modify data in your
table.@Are you sure you want to run this type of an SQL query?If not, click No
and then modify the query or close it to run later.@@19@@@2
You are about to run a data-definition query that may modify data in your
table.@Are you sure you want to run this type of an SQL query?If not, click No
and then modify the query or close it to run later.@@19@@2
You are about to update | row(s).@Once you click Yes, you can't use the Undo
command to reverse the changes.Are you sure you want to update these
records?@@19@@@2
You are about to update | row(s).@Once you click Yes, you can't use the Undo
command to reverse the changes.Are you sure you want to update these
records?@@19@@2
You are about to append | row(s).@Once you click Yes, you can't use the Undo
command to reverse the changes.Are you sure you want to append the selected
rows?@@19@@@2
You are about to append | row(s).@Once you click Yes, you can't use the Undo
command to reverse the changes.Are you sure you want to append the selected
rows?@@19@@2
You are about to paste | row(s) into a new table.@Once you click Yes, you can't use
the Undo command to reverse the changes.Are you sure you want to create a
new table with the selected records?@@19@@@2
You are about to paste | row(s) into a new table.@Once you click Yes, you can't use
the Undo command to reverse the changes.Are you sure you want to create a
new table with the selected records?@@19@@2

Copyright (c) 2008 FMS, Inc.

fmsinc.com

Page 186 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

10508

2007

2003

10509

2007

2003

2002

10510

2007

2003

2002

10511

2007

2003

Error Description
You are about to delete | row(s) from the specified table.@Once you click Yes, you
can't use the Undo command to reverse the changes.Are you sure you want to
delete the selected records?@@19@@@2
You are about to delete | row(s) from the specified table.@Once you click Yes, you
can't use the Undo command to reverse the changes.Are you sure you want to
delete the selected records?@@19@@2
Microsoft Office Access can't update all the records in the update query.@Microsoft
Office Access didn't update |1 field(s) due to a type conversion failure, |2 record(s)
due to key violations, |3 record(s) due to lock violations, and |4 record(s) due to
validation rule violations.Do you want to continue running this type of action query
anyway?To ignore the error(s) and run the query, click Yes.For an explanation
of the causes of the violations, click Help.@@21@1@10019@2
Microsoft Office Access can't update all the records in the update query.@Microsoft
Office Access didn't update |1 field(s) due to a type conversion failure, |2 record(s)
due to key violations, |3 record(s) due to lock violations, and |4 record(s) due to
validation rule violations.Do you want to continue running this type of action query
anyway?To ignore the error(s) and run the query, click Yes.For an explanation
of the causes of the violations, click Help.@@21@310019@2
Microsoft Access can't update all the records in the update query.@Microsoft Access
didn't update |1 field(s) due to a type conversion failure, |2 record(s) due to key
violations, |3 record(s) due to lock violations, and |4 record(s) due to validation rule
violations.Do you want to continue running this type of action query anyway?To
ignore the error(s) and run the query, click Yes.For an explanation of the causes
of the violations, click Help.@@21@310019@2
Microsoft Office Access can't append all the records in the append query.@Microsoft
Office Access set |1 field(s) to Null due to a type conversion failure, and it didn't add
|2 record(s) to the table due to key violations, |3 record(s) due to lock violations,
and |4 record(s) due to validation rule violations.Do you want to run the action
query anyway?To ignore the error(s) and run the query, click Yes.For an
explanation of the causes of the violations, click Help.@@21@1@10020@2
Microsoft Office Access can't append all the records in the append query.@Microsoft
Office Access set |1 field(s) to Null due to a type conversion failure, and it didn't add
|2 record(s) to the table due to key violations, |3 record(s) due to lock violations,
and |4 record(s) due to validation rule violations.Do you want to run the action
query anyway?To ignore the error(s) and run the query, click Yes.For an
explanation of the causes of the violations, click Help.@@21@310020@2
Microsoft Access can't append all the records in the append query.@Microsoft
Access set |1 field(s) to Null due to a type conversion failure, and it didn't add |2
record(s) to the table due to key violations, |3 record(s) due to lock violations, and
|4 record(s) due to validation rule violations.Do you want to run the action query
anyway?To ignore the error(s) and run the query, click Yes.For an explanation
of the causes of the violations, click Help.@@21@310020@2
Microsoft Office Access can't add all the records in the update or append query.@It
set |1 field(s) to Null due to a type conversion failure.A type conversion failure is
caused when the data in one or more fields doesn't match the DataType or FieldSize
property in the destination table. For example, leaving blank fields in a Yes/No field
or entering text in a numeric field will cause this error.Do you want to ignore the
errors and run the update or append query anyway?To ignore the error(s) and run
the query, click Yes.@@19@1@922@2
Microsoft Office Access can't add all the records in the update or append query.@It
set |1 field(s) to Null due to a type conversion failure.A type conversion failure is
caused when the data in one or more fields doesn't match the DataType or FieldSize
property in the destination table. For example, leaving blank fields in a Yes/No field
or entering text in a numeric field will cause this error.Do you want to ignore the
errors and run the update or append query anyway?To ignore the error(s) and run
the query, click Yes.@@19@600922@2
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Access

10511

2002

Microsoft Access can't add all the records in the update or append query.@It set |1
field(s) to Null due to a type conversion failure.A type conversion failure is caused
when the data in one or more fields doesn't match the DataType or FieldSize
property in the destination table. For example, leaving blank fields in a Yes/No field
or entering text in a numeric field will cause this error.Do you want to ignore the
errors and run the update or append query anyway?To ignore the error(s) and run
the query, click Yes.@@19@600922@2

10512

2007

Microsoft Office Access can't delete |2 record(s) in the delete query due to key
violations and |3 record(s) due to lock violations.@Do you want to run this action
query anyway?To ignore the error(s) and run the query, click Yes.For an
explanation of the causes of the violations, click Help.@@21@1@10016@2
Microsoft Office Access can't delete |2 record(s) in the delete query due to key
violations and |3 record(s) due to lock violations.@Do you want to run this action
query anyway?To ignore the error(s) and run the query, click Yes.For an
explanation of the causes of the violations, click Help.@@21@310016@2
Microsoft Access can't delete |2 record(s) in the delete query due to key violations
and |3 record(s) due to lock violations.@Do you want to run this action query
anyway?To ignore the error(s) and run the query, click Yes.For an explanation
of the causes of the violations, click Help.@@21@310016@2

2003

2002

10513

2007
2003

10514

2007

2003

10515

2007

2003

2002

10516

2007

2003

Error Description

The existing | will be deleted before you run the query.@Do you want to continue
anyway?@@20@@@2
The existing | will be deleted before you run the query.@Do you want to continue
anyway?@@20@@2
You won't be able to undo the changes this action query is about to make to the
data in a linked table or tables.@Do you want to run this action query
anyway?@@19@@@2
You won't be able to undo the changes this action query is about to make to the
data in a linked table or tables.@Do you want to run this action query
anyway?@@19@@2
Microsoft Office Access was unable to update all the records in the update
query.@Microsoft Office Access didn't update |1 field(s) due to a type conversion
failure, |2 record(s) due to key violations, |3 record(s) due to lock violations, and |4
record(s) due to validation rule violations.For an explanation of the causes of the
violations, click Help.@@2@1@10019@1
Microsoft Office Access was unable to update all the records in the update
query.@Microsoft Office Access didn't update |1 field(s) due to a type conversion
failure, |2 record(s) due to key violations, |3 record(s) due to lock violations, and |4
record(s) due to validation rule violations.For an explanation of the causes of the
violations, click Help.@@2@310019@1
Microsoft Access was unable to update all the records in the update
query.@Microsoft Access didn't update |1 field(s) due to a type conversion failure,
|2 record(s) due to key violations, |3 record(s) due to lock violations, and |4
record(s) due to validation rule violations.For an explanation of the causes of the
violations, click Help.@@2@310019@1

Microsoft Office Access can't append all the records to the table.@Microsoft Office
Access set |1 field(s) to Null due to a type conversion failure, and it didn't add |2
record(s) due to key violations, |3 record(s) due to lock violations, and |4 record(s)
due to validation rule violations.For an explanation of the causes of the violations,
click Help.@@2@1@10020@1
Microsoft Office Access can't append all the records to the table.@Microsoft Office
Access set |1 field(s) to Null due to a type conversion failure, and it didn't add |2
record(s) due to key violations, |3 record(s) due to lock violations, and |4 record(s)
due to validation rule violations.For an explanation of the causes of the violations,
click Help.@@2@310020@1
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Access

10516

2002

Microsoft Access can't append all the records to the table.@Microsoft Access set |1
field(s) to Null due to a type conversion failure, and it didn't add |2 record(s) due to
key violations, |3 record(s) due to lock violations, and |4 record(s) due to validation
rule violations.For an explanation of the causes of the violations, click
Help.@@2@310020@1

10517

2007

Microsoft Office Access can't add all the records in the make-table query.@It set |1
field(s) to Null due to a type conversion failure.A type conversion failure is caused
when the data in one or more fields doesn't match the DataType or FieldSize
property in the destination table. For example, leaving blank fields in a Yes/No field
or adding text in numeric field will cause this error.@@1@1@922@1
Microsoft Office Access can't add all the records in the make-table query.@It set |1
field(s) to Null due to a type conversion failure.A type conversion failure is caused
when the data in one or more fields doesn't match the DataType or FieldSize
property in the destination table. For example, leaving blank fields in a Yes/No field
or adding text in numeric field will cause this error.@@1@600922@1
Microsoft Access can't add all the records in the make-table query.@It set |1 field(s)
to Null due to a type conversion failure.A type conversion failure is caused when
the data in one or more fields doesn't match the DataType or FieldSize property in
the destination table. For example, leaving blank fields in a Yes/No field or adding
text in numeric field will cause this error.@@1@600922@1

2003

2002

10518

2007

2003

2002

10519

2007

2003

10520

2007

2003

2000

Error Description

Microsoft Office Access can't delete all the records in the delete query.@Microsoft
Office Access didn't delete |2 record(s) due to key violations and |3 record(s) due to
lock violations.For an explanation of the causes of the violation, click
Help.@@2@1@10016@1
Microsoft Office Access can't delete all the records in the delete query.@Microsoft
Office Access didn't delete |2 record(s) due to key violations and |3 record(s) due to
lock violations.For an explanation of the causes of the violation, click
Help.@@2@310016@1
Microsoft Access can't delete all the records in the delete query.@Microsoft Access
didn't delete |2 record(s) due to key violations and |3 record(s) due to lock
violations.For an explanation of the causes of the violation, click
Help.@@2@310016@1

There isn't enough disk space or memory to undo the data changes this action
query is about to make.@Do you want to run this action query anyway?For
information on freeing disk space or freeing memory, search the Microsoft Windows
Help index for 'disk space, freeing' or 'memory, troubleshooting'.@@19@@@2
There isn't enough disk space or memory to undo the data changes this action
query is about to make.@Do you want to run this action query anyway?For
information on freeing disk space or freeing memory, search the Microsoft Windows
Help index for 'disk space, freeing' or 'memory, troubleshooting'.@@19@@2
Do you want to save the changes made to the SQL statement and update the
property?@The RecordSource or RowSource property contained an SQL statement
when you invoked the Query Builder, so the original SQL statement was
modified.@To close the Query Builder without changing the original SQL statement,
click No.@13@1@4309@2
Do you want to save the changes made to the SQL statement and update the
property?@The RecordSource or RowSource property contained a SQL statement
when you invoked the Query Builder, so the original SQL statement was
modified.@To close the Query Builder without changing the original SQL statement,
click No.@13@604309@2
Do you want to save the changes made to the SQL statement and update the
property?@The RecordSource or RowSource property contained an SQL statement
when you invoked the Query Builder, so the original SQL statement was
modified.@To close the Query Builder without changing the original SQL statement,
click No.@13@604309@2
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Access

10521

2007

2003

10522

2007
2003

10523

2007

2003

10524

2007
2003

10526

2007

2003

10600

2007
2003

10601

2007
2003

10602

2007

2003

10603

2007

Error Description
Do you want to save the changes made to the query and update the property?@The
RecordSource or RowSource property contained the name of a query when you
invoked the Query Builder, so the original query was modified.@To close the Query
Builder without changing the original query, click No.@13@1@4309@2
Do you want to save the changes made to the query and update the property?@The
RecordSource or RowSource property contained the name of a query when you
invoked the Query Builder, so the original query was modified.@To close the Query
Builder without changing the original query, click No.@13@604309@2
You invoked the Query Builder on a table.@Do you want to create a query based on
the table?@@19@@@2
You invoked the Query Builder on a table.@Do you want to create a query based on
the table?@@19@@2

You are about to run a pass-through query that may modify data in your table.@Are
you sure you want to run this type of an SQL query?For information on how to
prevent this message from displaying every time you run an SQL query, click
Help.@@21@1@9058@2
You are about to run a pass-through query that may modify data in your table.@Are
you sure you want to run this type of an SQL query?For information on how to
prevent this message from displaying every time you run an SQL query, click
Help.@@21@209058@2
| output column(s) in the query were unnamed and will not show any
data.@@@1@@@1
| output column(s) in the query were unnamed and will not show any
data.@@@1@@1
Do you want to save the changes made to the SQL Statement and update the text
editor?@The Stored Procedure or Function contained an SQL statement when you
invoked the Query Builder, so the original SQL statement was modified.@To close
the Query Builder without changing the original SQL statement, click
No.@13@1@4309@2
Do you want to save the changes made to the SQL Statement and update the text
editor?@The Stored Procedure or Function contained an SQL statement when you
invoked the Query Builder, so the original SQL statement was modified.@To close
the Query Builder without changing the original SQL statement, click
No.@13@604309@2
Are you sure you want to permanently delete the selected relationship from your
database?@@@19@@@2
Are you sure you want to permanently delete the selected relationship from your
database?@@@19@@2
A relationship already exists.@Do you want to edit the existing relationship? To
create a new relationship, click No.@@13@@@2
A relationship already exists.@Do you want to edit the existing relationship? To
create a new relationship, click No.@@13@@2
The field name is missing in row |.@You haven't selected a matching field for this
relationship in each row of the grid.@Select fields so that the grid has the same
number of fields on the left and right sides, and then try to create the relationship
again.@1@@@1
The field name is missing in row |.@You haven't selected a matching field for this
relationship in each row of the grid.@Select fields so that the grid has the same
number of fields on the left and right sides, and then try to create the relationship
again.@1@@1

This relationship has been modified or deleted by another user since you opened
the Relationships window.@Do you want to edit the relationship and overwrite the
other user's changes? To update your Relationships window to include the other
user's changes, click No.@@19@@@2
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Access

10603

2003

This relationship has been modified or deleted by another user since you opened
the Relationships window.@Do you want to edit the relationship and overwrite the
other user's changes? To update your Relationships window to include the other
user's changes, click No.@@19@@2

10604

2007

This relationship has already been deleted by another user.@To update your view,
click OK.@@1@@@1
This relationship has already been deleted by another user.@To update your view,
click OK.@@1@@1

2003
10605

2007

2003
10606

2007

2003

2002

10607

2007

2003

10608

2007
2003

10700

2007
2003
2002

10701

2007

2003

2002

Error Description

The layout of the Relationships window will be cleared.@Do you want to
continue?@@19@@@2
The layout of the Relationships window will be cleared.@Do you want to
continue?@@19@@2

You cannot display queries or linked tables in the Relationships window for this
database.@The database '|' was created in an earlier version of Microsoft Office
Access.To convert this database to the current version of Microsoft Office Access,
click the Microsoft Office Button, and then click Convert.@@3@1@9029@1
You can't display queries or linked tables in the Relationships window for this
database.@The database '|' was created in an earlier version of Microsoft Office
Access.If you want to convert this database to the current version of Microsoft
Office Access, use the Convert Database command on the Tools menu (Database
Utilities submenu).@@1@@1
You can't display queries or linked tables in the Relationships window for this
database.@The database '|' was created in an earlier version of Microsoft
Access.If you want to convert this database to the current version of Microsoft
Access, use the Convert Database command on the Tools menu (Database Utilities
submenu).@@1@@1
The relationship has been created as a one-to-many relationship because there are
duplicate entries in the related field.@You've tried to create a one-to-one
relationship, but the data in the tables suggests that a one-to-many relationship is
more appropriate.@@2@1@11617@1
The relationship has been created as a one-to-many relationship because there are
duplicate entries in the related field.@You've tried to create a one-to-one
relationship, but the data in the tables suggests that a one-to-many relationship is
more appropriate.@@2@411617@1
To create a relationship, use the mouse to drag a field from one table to
another.@@@1@@@1
To create a relationship, use the mouse to drag a field from one table to
another.@@@1@@1
This document was previously formatted for the printer |1 on |2, but that printer
isn't available. Do you want to use the default printer |3?@@@19@@@1
This document was previously formatted for the printer |1 on |2, but that printer
isn't available. Do you want to use the default printer |3?@@@19@@1
This document was previously formatted for the printer |1 on |2, but that printer
isn't available. Do you want to use the default printer |3 on |4?@@@19@@1
This document was previously formatted for the printer '|1 on |2', but that printer
isn't available. The page settings shown in the Print Setup dialog box are for the
current default printer '|3'.@Do you want to continue?@@19@@@1
This document was previously formatted for the printer '|1 on |2', but that printer
isn't available. The page settings shown in the Print Setup dialog box are for the
current default printer '|3'.@Do you want to continue?@@19@@1
This document was previously formatted for the printer '|1 on |2', but that printer
isn't available. The page settings shown in the Print Setup dialog box are for the
current default printer '|3 on |4'.@Do you want to continue?@@19@@1
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Access

10702

2007

2003

2002

10750

2007

2003

10751

2007

2003

2000

10800

2007
2003
2002

10801

2007

2003

2002

Error Description
Previewing or printing this PivotTable view might take a long time because it
displays a large amount of detail data. Microsoft Office Access might not respond
for some time.@Do you want to continue?@* To reduce the amount of time
required, hide most or all of the detail data in the view.* For more information,
consult Microsoft Knowledge Base article Q282315.@3@@@1
Previewing or printing this PivotTable view might take a long time because it
displays a large amount of detail data. Microsoft Office Access might not respond
for some time.@Do you want to continue?@* To reduce the amount of time
required, hide most or all of the detail data in the view.* For more information,
consult Microsoft Knowledge Base article Q282315.@3@@1
Previewing or printing this PivotTable view might take a long time because it
displays a large amount of detail data. Microsoft Access might not respond for
some time.@Do you want to continue?@* To reduce the amount of time required,
hide most or all of the detail data in the view.* For more information, consult
Microsoft Knowledge Base article Q282315.@3@@1

You must save the macro before you run it.@Do you want to save the macro
now?* To save the macro and then run it, click Yes.* To return to the Macro
window for this macro or to the window you executed the Run Macro command
from, click No.@@19@@@2
You must save the macro before you run it.@Do you want to save the macro
now?* To save the macro and then run it, click Yes.* To return to the Macro
window for this macro or to the window you executed the Run Macro command
from, click No.@@19@@2
Some of the macro actions you are trying to save cannot be performed in Access
97. These actions will be permanently deleted from the macro in the Access 97
version of your database.@@@1@@@1
Some of the macro actions you are trying to save cannot be performed in Access
97. These actions will be permanently deleted from the macro in the Access 97
version of your database.@@@1@@1
You are trying to save some actions which cannot perform in Microsoft Access97.
These actions will be permanently deleted from the Access97 version of your
macro.@@@1@@1
Microsoft Office Access finished adding the index '|.'@Add another index from the
Select Index Files dialog box, or click Close.@@1@@@1
Microsoft Office Access finished adding the index '|.'@Add another index from the
Select Index Files dialog box, or click Close.@@1@@1
Microsoft Access finished adding the index '|.'@Add another index from the Select
Index Files dialog box, or click Close.@@1@@1
The Microsoft Office Access index information (.inf) file for '|' already exists.@Do
you want to replace the existing Microsoft Office Access .inf file for the dBASE or
Microsoft FoxPro file you're linking?@* To create a new .inf file, click Yes.* To use
the existing file, click No.If the .inf file contains invalid or outdated information,
you must click Yes to create a new .inf file before you can link the
table.@17@1@9186@2
The Microsoft Office Access index information (.inf) file for '|' already exists.@Do
you want to replace the existing Microsoft Office Access .inf file for the dBASE or
Microsoft FoxPro file you're linking?@* To create a new .inf file, click Yes.* To use
the existing file, click No.If the .inf file contains invalid or outdated information,
you must click Yes to create a new .inf file before you can link the
table.@17@209186@2
The Microsoft Access index information (.inf) file for '|' already exists.@Do you want
to replace the existing Microsoft Access .inf file for the dBASE or Microsoft FoxPro
file you're linking?@* To create a new .inf file, click Yes.* To use the existing file,
click No.If the .inf file contains invalid or outdated information, you must click Yes
to create a new .inf file before you can link the table.@17@209186@2
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Access

10803

2007

2003

10804

2007

2003

10805

Error Description
The object '|' already exists.@Do you want to replace the existing object with the
one you are exporting?If you want to export this object without replacing the
existing object, click No. You can then choose a new name in the Export dialog
box.@@20@@@2
The database object '|' already exists.@Do you want to replace the existing
database object with the one you are exporting?If you want to export this object
without replacing the existing database object, click No. You can then export the
object again and rename it in the Export dialog box.@@20@@2
Not all of the import specifications could be imported due to name conflicts.
Conflicts existed in | of the specifications.@Rename the conflicting import
specifications, and try the import operation again.@@1@@@1
Not all of the import specifications could be imported due to name conflicts.
Conflicts existed in | of the specifications.@Rename the conflicting import
specifications, and try the import operation again.@@1@@1

2007
2003

Invalid CDF file name

10806

2007

Related data is not supported with the live data option.

10807

2007

Please specify XML export location.

10808

2007

The current record was not unique. All identical records were exported.

10892

2007

A form with a bound ActiveX control or an embedded object bound to a data source
can't have its DefaultView property set to Continuous Forms.@You tried to add a
bound ActiveX control to a form in Design view.Microsoft Office Access will reset
the DefaultView property to Single Form.@@1@@@1
A form with a bound ActiveX control or an embedded object bound to a data source
can't have its DefaultView property set to Continuous Forms.@You tried to add a
bound ActiveX control to a form in Design view.Microsoft Office Access will reset
the DefaultView property to Single Form.@@1@@1
A form with a bound ActiveX control or an embedded object bound to a data source
can't have its DefaultView property set to Continuous Forms.@You tried to add a
bound ActiveX control to a form in Design view.Microsoft Access will reset the
DefaultView property to Single Form.@@1@@1

2003

2002

10893

2007
2003

2000
10894

10895

2007
2003

2007
2003
2000

10896

2007
2003

2000

Either the data access page file has been opened by another user or you don't have
write permission to the file. If you make changes, you will have to save them to
another file.
You do not have write permission to this data access page. If you make any
changes, you will have to save them to an alternate file.

An unexpected error occurred while saving document properties to the data access
page.
You tried to drop an OLE or binary column onto your data access page. There is no
HTML control which binds correctly to this column type.
You tried to drop an OLE or Long Binary column onto your data access page. There
is no HTML control which binds correctly to this column type.

You have chosen to permanently delete the link to the data access page.@ Delete
&Link Cancel@@27@@@
You have chosen to permanently delete the data access page.@Do you want to
delete both the link and page file(s), or delete just the link? &Delete Link and
Files Delete &Link Only Cancel@@27@@
You have chosen to delete the data access page.@Choose Yes to permanently
delete the link and page file(s), No to delete just the link.@@17@@
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Access

10897

2007
2003

10898

2007

2003

2002

10899

2007
2003

10900

10901

10902

2007
2003

2007
2003
2007
2003

2000

10903

10904

2007
2003

2007
2003
2002

10905

2007
2003

2002

10950

2007

Error Description
|@There is a problem with Internet Explorer registry settings.@Please reinstall
Internet Explorer.@1@@@1
|@There is a problem with Internet Explorer registry settings.@Please reinstall
Internet Explorer.@1@@1
Microsoft Office Access data access pages can only be viewed in Windows Internet
Explorer, but it is not your default Browser.@Do you want to open Internet Explorer
to view this page?@@19@@@
Microsoft Office Access data access pages can only be viewed in Microsoft Internet
Explorer, but it is not your default Browser.@Do you want to open Internet Explorer
to view this page?@@19@@
Microsoft Access data access pages can only be viewed in Microsoft Internet
Explorer, but it is not your default Browser.@Do you want to open Internet Explorer
to view this page?@@19@@

A link to this data access page could not be created because the Data and Misc.
Objects are not checked out.@@@1@@@1
A link to this data access page could not be created because the Data and Misc.
Objects are not checked out.@@@1@@1
The save operation was successful.@A folder was created for your supporting files
at the save destination.@This directory had to be created because the server does
not support long file names.@1@@1
You must save your data access page before you can preview it.@Do you want to
save now?@@19@@
The data access page has been saved, but one or more of the supporting files (i.e.,
image, sound, video files) are missing.@You may need to:*Delete and recreate
the HTML object(s) on the page.*Reapply the theme, if the page has a
theme.@@1@@1
The save completed, but one or more of the supporting files are missing (i.e.,
image, sound, video files).@You may want to remove the HTML object(s) from this
page.@@1@@1
The save completed, but files for the selected theme are missing.@Please apply a
new theme to your data access page, and save again.@@1@@1
Do you want Microsoft Office Access to set the DataPageSize property of this group
level to All?@@@19@@
Do you want Microsoft Access to set the DataPageSize property of this group level
to All?@@@19@@
You have opened a page that was designed using Access 2000. To be able to edit
the page, you must save it using a more recent version of the Microsoft Office Web
Components. Do you want Access to convert this page by saving it using a more
recent version of the Microsoft Office Web
Components? &Convert Cancel@@@35@@
You have opened a page that was last designed using Access 2000. The page must
be saved using Office XP Office Web Components before you can edit this
document.Would you like to convert this page? &Convert Cancel@@@35@@
Are you sure you want to delete this account?@You can't undo the deletion of a
user or group account. To restore a user or group account that has been deleted,
you must recreate the account using the same name and personal identifier
(PID).@@20@@@2
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Access

10950

2003

Are you sure you want to delete this account?@You can't undo the deletion of a
user or group account. To restore a user or group account that has been deleted,
you must recreate the account using the same name and personal identifier
(PID).@@20@@2

10951

2007

You don't have permission to modify '|.'@To modify this object, you must have
Modify Design permission for it. If the object is a table, you must also have Delete
Data and Update Data permissions for it.Do you want to save a copy of the object
as a new object?@@21@1@10222@1
You don't have permission to modify '|.'@To modify this object, you must have
Modify Design permission for it. If the object is a table, you must also have Delete
Data and Update Data permissions for it.Do you want to save a copy of the object
as a new object?@@21@410222@1

2003

10952

2007

2003

10953

2007

2003

10954

2007
2003

10955

2007

2003

2002

Error Description

You don't have permission to view this macro.@To view a macro, you must have
Read Design permission for it.Do you want to continue to run the
macro?@@21@1@10222@2
You don't have permission to view this macro.@To view a macro, you must have
Read Design permission for it.Do you want to continue to run the
macro?@@21@410222@2

You don't have permission to modify '|.'@To modify this object, you must have
Modify Design permission for it. If the object is a table, you must also have Delete
Data and Update Data permissions for it.Do you want to open it as readonly?@@21@1@10222@1
You don't have permission to modify '|.'@To modify this object, you must have
Modify Design permission for it. If the object is a table, you must also have Delete
Data and Update Data permissions for it.Do you want to open it as readonly?@@21@410222@1
You changed the permissions of '|1' for '|2.'@Do you want to assign these
permissions now?@@19@@@2
You changed the permissions of '|1' for '|2.'@Do you want to assign these
permissions now?@@19@@2
You don't have permission to open '|' for exclusive use.@Microsoft Office Access is
opening the database for shared access.To open a database for exclusive access,
you must have Open Exclusive permission for it. For more information on
permissions and who can set them, click Help.@@5@1@10222@1
You don't have permission to open '|' for exclusive use.@Microsoft Office Access is
opening the database for shared access.To open a database for exclusive access,
you must have Open Exclusive permission for it. For more information on
permissions and who can set them, click Help.@@2@410222@1
You don't have permission to open '|' for exclusive use.@Microsoft Access is opening
the database for shared access.To open a database for exclusive access, you
must have Open Exclusive permission for it. For more information on permissions
and who can set them, click Help.@@2@410222@1

10956

2007

;LCID=0x0409

10957

2007

You haven't entered a workgroup ID. To ensure that your workgroup information file
is unique, enter a unique workgroup ID of up to 20 numbers or letters. Continue
without a workgroup ID?@@@20@@@1
You haven't entered a workgroup ID. To ensure that your workgroup information file
is unique, enter a unique workgroup ID of up to 20 numbers or letters. Continue
without a workgroup ID?@@@20@@1

2003

10958

2007
2003

The file '|' already exists. Replace existing file?@@@20@@@1
The file '|' already exists. Replace existing file?@@@20@@1

10959

2007

Workgroup Files (*.mdw)

10960

2007

Select Workgroup Information File

Copyright (c) 2008 FMS, Inc.

fmsinc.com

Page 195 of 227

Microsoft Access Error Number and Descriptions for Access 2007, 2003, 2002, and 2000
Numbe

Access

10961

2007

Open

10962

2007
2003

You have successfully created the workgroup information file '|.'@@@1@@@4
You have successfully created the workgroup information file '|.'@@@1@@4

10963

2007
2003

Could not find file: '|'

10964

2007
2003

10965

10966
10967

10968

2007
2003

2007
2003
2007
2003

2007

2003

10969

10970

10971

10972

10973

10974

2007
2003

2007
2003

2007
2003

2007
2003

2007
2003
2007

Error Description

You have successfully joined the workgroup defined by the workgroup information
file '|'@@@1@@@2
You have successfully joined the workgroup defined by the workgroup information
file '|'@@@1@@2

It is strongly recommended that you change the system administrator (SA)
password when this operation is complete. To change the SA password point to
Security on the Tools menu, and then click Set Login Password.
You must restart the application for the new security level to take effect.@@@1@@1
Microsoft Office Access cannot change the registry setting that controls whether or
not unsafe expressions are blocked.@Your account is not authorized to change this
registry setting. To change this setting, contact your system
administrator.@@2@553714182@2

Microsoft Office Access cannot add a digital signature to your file because Access
cannot gain exclusive access to the file. @Make sure no other person or program
has the file open and try to add the digital signature again.@@1@@@2
Microsoft Office Access cannot add a digital signature to your file because Access
cannot gain exclusive access to the file. @Make sure no other person or program
has the file open and try to add the digital signature again.@@1@@2
For the Medium or High macro security levels to function properly, your computer
must also be configured to block unsafe expressions.@Blocking unsafe expressions
affects all users on this computer.@Do you want to block unsafe
expressions?@21@553714182@2

Unsafe expressions are blocked. You can configure your computer to allow all
expressions to be evaluated.@Allowing all expressions to be evaluated affects all
users on this computer.@Do you want to allow the evaluation of potentially unsafe
expressions?@22@553714182@2
Security Warning: Unsafe expressions are not blocked.@To block unsafe
expressions, Microsoft Jet 4.0 Service Pack 8 or later must be installed. To get the
latest version of Jet 4.0, go to http://windowsupdate.microsoft.com.@'|' may not be
safe to open if it contains expressions that were intended to harm your computer.
Do you want to open this file?@20@553714182@2
Security Warning: Unsafe expressions are not blocked.@Do you want to block
unsafe expressions?@@21@553714182@2
'|' cannot be opened because you must restart the application for the new security
level to take effect.@@@1@553714182@1

Modifications to the database or project have invalidated the associated digital
signature.@This may require you to make a trust decision the next time you open
the database or project. @@2@1@553714150@1
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Access

29000

2007

2003

29001

2007

2003

2002

29002

2007

2003

2002
29003

2007
2003
2002

Error Description
There isn't enough memory to create an input area.@Close unneeded programs.
Then try to create the input area again.For more information on freeing memory,
search the Microsoft Windows Help index for 'memory, troubleshooting'.@@1@@@1
There isn't enough memory to create an input area.@Close unneeded programs.
Then try to create the input area again.For more information on freeing memory,
search the Microsoft Windows Help index for 'memory, troubleshooting'.@@1@@1
Microsoft Office Access failed to save module '|.'@Your computer may be low on
disk space.For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space,
freeing'.@@1@@@3
Microsoft Office Access failed to save module '|.'@Your computer may be low on
disk space.For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space, freeing'.@@1@@3
Microsoft Access failed to save module '|.'@Your computer may be low on disk
space.For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space, freeing'.@@1@@3

Microsoft Office Access failed to create the Visual Basic module '|.'@If your
database is on a network drive, check your network connection, and then try
again.@@1@@@1
Microsoft Office Access failed to create the Visual Basic module '|.'@If your
database is on a network drive, check your network connection, and then try
again.@@1@@1
Microsoft Access failed to create the Visual Basic module '|.'@If your database is on
a network drive, check your network connection, and then try again.@@1@@1
Microsoft Office Access failed to convert or enable your code modules.@Your
computer may be low on disk space or memory.@@1@@@1
Microsoft Office Access failed to convert or enable your code modules.@Your
computer may be low on disk space or memory.@@1@@1
Microsoft Access failed to convert or enable your code modules.@Your computer
may be low on disk space or memory.@@1@@1

29004

2007
2003

The new procedure name you provided is invalid.@@@2@1@11738@1
The new procedure name you provided is invalid.@@@2@611738@1

29005

2007
2003

The procedure '|' already exists.@Choose another procedure name.@@1@@@1
The procedure '|' already exists.@Choose another procedure name.@@1@@1

29006

2007

Microsoft Office Access failed to create a Debug window toolbar.@The system may
be out of resource memory.@Close unneeded programs and try again. For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@1@@@1
Microsoft Office Access failed to create a Debug window toolbar.@The system may
be out of resource memory.@Close unneeded programs and try again. For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@1@@1
Microsoft Access failed to create a Debug window toolbar.@The system may be out
of resource memory.@Close unneeded programs and try again. For more
information on freeing memory, search the Microsoft Windows Help index for
'memory, troubleshooting'.@1@@1

2003

2002

29007

2007

2003

During the paste or import operation, Microsoft Office Access failed to convert the '|'
module from an earlier version of a Microsoft Office Access database.@Your
computer may be low on disk space or memory.@@1@@@1
During the paste or import operation, Microsoft Office Access failed to convert the '|'
module from an earlier version of a Microsoft Office Access database.@Your
computer may be low on disk space or memory.@@1@@1
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Access

29007

2002

During the paste or import operation, Microsoft Access failed to convert the '|'
module from an earlier version of a Microsoft Access database.@Your computer may
be low on disk space or memory.@@1@@1

29008

2007

Microsoft Office Access couldn't create storage space for a Visual Basic module.@If
your database is on a network drive, check your network connection, and then try
again.@@1@@@3
Microsoft Office Access couldn't create storage space for a Visual Basic module.@If
your database is on a network drive, check your network connection, and then try
again.@@1@@3
Microsoft Access couldn't create storage space for a Visual Basic module.@If your
database is on a network drive, check your network connection, and then try
again.@@1@@3

2003

2002

29009

2007

2003

2002

29010

2007
2003
2002

29011

2007

2003

2002

29012

29013

2007
2000

2007

2003

29014

2007

2003
2002

Error Description

Microsoft Office Access couldn't open the storage space for a Visual Basic
module.@Your computer may be low on disk space.For information on freeing
memory or disk space, search the Microsoft Windows Help index for 'memory,
troubleshooting' or 'disk space, freeing'.@@1@@@3
Microsoft Office Access couldn't open the storage space for a Visual Basic
module.@Your computer may be low on disk space.For information on freeing
memory or disk space, search the Microsoft Windows Help index for 'memory,
troubleshooting' or 'disk space, freeing'.@@1@@3
Microsoft Access couldn't open the storage space for a Visual Basic module.@Your
computer may be low on disk space.For information on freeing memory or disk
space, search the Microsoft Windows Help index for 'memory, troubleshooting' or
'disk space, freeing'.@@1@@3
The function name is too long.@Microsoft Office Access will truncate the function
name to 255 characters.@@1@1@11738@1
The function name is too long.@Microsoft Office Access will truncate the function
name to 255 characters.@@1@411738@1
The function name is too long.@Microsoft Access will truncate the function name to
255 characters.@@1@411738@1
Microsoft Office Access failed to save the database.@Your computer may be low on
disk space.For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space,
freeing'.@@1@@@3
Microsoft Office Access failed to save the database.@Your computer may be low on
disk space.For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space, freeing'.@@1@@3
Microsoft Access failed to save the database.@Your computer may be low on disk
space.For information on freeing memory or disk space, search the Microsoft
Windows Help index for 'memory, troubleshooting' or 'disk space, freeing'.@@1@@3
Microsoft Access failed to save the database information; database references may
be lost.@@@1@@1
This action will reset the current code in break mode.@Do you want to stop the
running code?@* To halt the execution of the program so the Module window can
be closed, select Yes.* To leave the code in the current state, select
No.@20@@@1
This action will reset the current code in break mode.@Do you want to stop the
running code?@* To halt the execution of the program so the Module window can
be closed, select Yes.* To leave the code in the current state, select No.@20@@1
You can't add a reference to a Microsoft Office Access
workgroup.@@@2@1@13780@1
You can't add a reference to a Microsoft Office Access
workgroup.@@@2@613780@1
You can't add a reference to a Microsoft Access workgroup.@@@2@613780@1
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Access

29015

2007
2003
2002

Error Description
You can't remove this reference.@Microsoft Office Access needs this reference in
order to work properly.@@1@@@1
You can't remove this reference.@Microsoft Office Access needs this reference in
order to work properly.@@1@@1
You can't remove this reference.@Microsoft Access needs this reference in order to
work properly.@@1@@1

29016

2007
2003

You can't add a reference to the open database.@@@1@@@1
You can't add a reference to the open database.@@@1@@1

29017

2007

The database | was created in an earlier version of Microsoft Office
Access.@Convert this database to the current version of Microsoft Office Access by
using the Convert Database command on the Tools menu (Database Utilities
submenu).@@1@@@1
The database | was created in an earlier version of Microsoft Office
Access.@Convert this database to the current version of Microsoft Office Access by
using the Convert Database command on the Tools menu (Database Utilities
submenu).@@1@@1
The database | was created in an earlier version of Microsoft Access.@Convert this
database to the current version of Microsoft Access by using the Convert Database
command on the Tools menu (Database Utilities submenu).@@1@@1

2003

2002

29018

2007
2003

You can't use a standard module for this operation.@@@1@@@1
You can't use a standard module for this operation.@@@1@@1

29019

2007

The module name '|' is invalid.@* The module name may start with the prefix
Form_ or Report_.* The module can't be named Forms, Reports, Modules,
Application, Screen, Assistant, CommandBars, References, or DoCmd.* The
module name may have too many characters.@@2@1@11734@1
The module name '|' is invalid.@* The module name may start with the prefix
Form_ or Report_.* The module can't be named Forms, Reports, Modules,
Application, Screen, Assistant, CommandBars, References, or DoCmd.* The
module name may have too many characters.@@2@611734@1

2003

29020

2007
2003

29021

2007
2003

29022

2007

2003

2002

Another user has modified this database.@To see the current version, close the
database and open it again.@@1@@@1
Another user has modified this database.@To see the current version, close the
database and open it again.@@1@@1
This operation isn't available while there is a module in break mode.@Reset the
executing code and try the operation again.@@1@@@1
This operation isn't available while there is a module in break mode.@Reset the
executing code and try the operation again.@@1@@1
There were compilation errors during the conversion or enabling of this
database.@The database has not been saved in a compiled state. The performance
of this database will be impaired because Microsoft Office Access will need to
recompile the database for each session.For information on improving
performance, click Help.@@2@1@11705@1
There were compilation errors during the conversion or enabling of this
database.@The database has not been saved in a compiled state. The performance
of this database will be impaired because Microsoft Office Access will need to
recompile the database for each session.For information on improving
performance, click Help.@@2@611705@1
There were compilation errors during the conversion or enabling of this
database.@The database has not been saved in a compiled state. The performance
of this database will be impaired because Microsoft Access will need to recompile
the database for each session.For information on improving performance, click
Help.@@2@611705@1
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Access

29023

2007

2003

29024

2007

2003

29025

2007

2003

29026

2007

2003

2002

29027

2007

Error Description
There are calls to 16-bit dynamic-link libraries (.dll) in modules in this
database.@These won't work under Microsoft Windows 95 or Microsoft Windows
NT.@Change your code to call equivalent 32-bit dynamic-link libraries
(.dll).@2@1@11961@1
There are calls to 16-bit dynamic-link libraries (.dll) in modules in this
database.@These won't work under Microsoft Windows 95 or Microsoft Windows
NT.@Change your code to call equivalent 32-bit dynamic-link libraries
(.dll).@2@611961@1
The current user account doesn't have permission to convert or enable this
database.@To convert or enable a database, ensure the following:* You must join
the workgroup that defines the user accounts used to access the database.* Your
user account must have Open/Run and Open Exclusive permissions for the database
object.* Your user account must have Modify Design or Administer permissions
for all tables in the database, or it must be the owner of all tables in the
database.* Your user account must have Read Design permission for all objects in
the database.* Request that other users close the database.@@2@2@77316@
The current user account doesn't have permission to convert or enable this
database.@To convert or enable a database, ensure the following:* You must join
the workgroup that defines the user accounts used to access the database.* Your
user account must have Open/Run and Open Exclusive permissions for the database
object.* Your user account must have Modify Design or Administer permissions
for all tables in the database, or it must be the owner of all tables in the
database.* Your user account must have Read Design permission for all objects in
the database.* Request that other users close the database.@@2@77316@
There are calls to 16-bit dynamic-link libraries (.dll) in modules in this
database.@These won't work under Microsoft Windows 95 or Microsoft Windows
NT.@Translate these calls to equivalent 32-bit dynamic-link
libraries.@2@1@11961@
There are calls to 16-bit dynamic-link libraries (.dll) in modules in this
database.@These won't work under Microsoft Windows 95 or Microsoft Windows
NT.@Translate these calls to equivalent 32-bit dynamic-link libraries.@2@611961@

The database that you are trying to open or convert is currently in use, or you do
not have permission to open it exclusively.@When you convert a database, or the
first time you open an earlier version database, another user can't have the
database open.@Try one of the following:* Request that other users close the
database.* Using the version of Microsoft Office Access in which the database is
written, have your workgroup administrator grant you the permission to open the
database exclusively.Multiple users can share the database after you convert it, or
after you open it for the first time.@1@1@9027@1
The database that you are trying to open or convert is currently in use, or you do
not have permission to open it exclusively.@When you convert a database, or the
first time you open an earlier version database, another user can't have the
database open.@Try one of the following:* Request that other users close the
database.* Using the version of Microsoft Office Access in which the database is
written, have your workgroup administrator grant you the permission to open the
database exclusively.Multiple users can share the database after you convert it, or
after you open it for the first time.@1@109027@1
The database that you are trying to open or convert is currently in use, or you do
not have permission to open it exclusively.@When you convert a database, or the
first time you open an earlier version database, another user can't have the
database open.@Try one of the following:* Request that other users close the
database.* Using the version of Microsoft Access in which the database is written,
have your workgroup administrator grant you the permission to open the database
exclusively.Multiple users can share the database after you convert it, or after you
open it for the first time.@1@109027@1
Microsoft Office Access was unable to save the project.@Another user is saving the
project now.Do you want to retry?@@23@@@1
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Access

29027

2003
2002

Error Description
Microsoft Office Access was unable to save the project.@Another user is saving the
project now.Do you want to retry?@@23@@1
Microsoft Access was unable to save the project.@Another user is saving the project
now.Do you want to retry?@@23@@1

29028

2007
2003

The Save operation failed.@@@1@@@1
The Save operation failed.@@@1@@1

29029

2007

You are trying to open a read-only database.@The first time you open an earlier
version database, you must be able to write changes to the database.* The
database file's read-only attribute may be set; clear this attribute.* You may have
chosen the Open Read Only command in the Open dialog box. Don't choose this
command the first time you open the database.* Your license to use this
application may have expired.@@1@@@1
You are trying to open a read-only database.@The first time you open an earlier
version database, you must be able to write changes to the database.* The
database file's read-only attribute may be set; clear this attribute.* You may have
chosen the Open Read Only command in the Open dialog box. Don't choose this
command the first time you open the database.* Your license to use this
application may have expired.@@1@@1
You are trying to open a read-only database.@The first time you open an earlier
version database, you must be able to write changes to the database.* The
database file's read-only attribute may be set; clear this attribute.* You may have
chosen the Open Read Only command in the Open dialog box. Don't choose this
command the first time you open the database.@@1@@1

2003

2000

29030

2007

2003

2002

29031

2007
2003
2002

29032

2007
2003
2002

29033

2007
2003

Microsoft Office Access can't establish a reference to the specified database.@The
referenced database can't be found, or it's locked exclusively by another user so it
can't be opened.@Restore the referenced database from a backup copy or ask the
user that has the database locked to open the database in nonexclusive
mode.@1@@@1
Microsoft Office Access can't establish a reference to the specified database.@The
referenced database can't be found, or it's locked exclusively by another user so it
can't be opened.@Restore the referenced database from a backup copy or ask the
user that has the database locked to open the database in nonexclusive
mode.@1@@1
Microsoft Access can't establish a reference to the specified database.@The
referenced database can't be found, or it's locked exclusively by another user so it
can't be opened.@Restore the referenced database from a backup copy or ask the
user that has the database locked to open the database in nonexclusive
mode.@1@@1

Microsoft Office Access can't create or open the requested database now.@The
database may be locked exclusively by another user.@@1@@@1
Microsoft Office Access can't create or open the requested database now.@The
database may be locked exclusively by another user.@@1@@1
Microsoft Access can't create or open the requested database now.@The database
may be locked exclusively by another user.@@1@@1
The '|' module is open; Microsoft Office Access can't set the permissions on an
open module.@@@1@@@1
The '|' module is open; Microsoft Office Access can't set the permissions on an
open module.@@@1@@1
The '|' module is open; Microsoft Access can't set the permissions on an open
module.@@@1@@1
Microsoft Office Access can't add references to a replicated database; changes will
be ignored.@@@1@@@1
Microsoft Office Access can't add references to a replicated database; changes will
be ignored.@@@1@@1
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29033

2002

Microsoft Access can't add references to a replicated database; changes will be
ignored.@@@1@@1

29034

2007

Microsoft Office Access is unable to import the module from the source
replica.@Synchronize the source database.@@1@@@1
Microsoft Office Access is unable to import the module from the source
replica.@Synchronize the source database.@@1@@1
Microsoft Access is unable to import the module from the source
replica.@Synchronize the source database.@@1@@1

2003
2002

29040

2007

2003

2002

29041

2007

2003

29042

2007

2003

29043

2007

2003

2002

29044

2007

2003

2002

29045

2007

2003

Error Description

Microsoft Office Access is currently unable to rename the form, report, or module to
'|'.@Close the database, reopen it, and then try the rename operation
again.@@1@@@1
Microsoft Office Access is currently unable to rename the form, report, or module to
'|'.@Close the database, reopen it, and then try the rename operation
again.@@1@@1
Microsoft Access is currently unable to rename the form, report, or module to
'|'.@Close the database, reopen it, and then try the rename operation
again.@@1@@1
One or more forms or reports contains an ActiveX control that could not be
loaded.@These controls will not function properly until you register them, open the
forms or reports in Design view, and save the forms or reports.@@1@@@1
One or more forms or reports contains an ActiveX control that could not be
loaded.@These controls will not function properly until you register them, open the
forms or reports in Design view, and save the forms or reports.@@1@@1
One or more forms or reports contains an ActiveX control that could not be
loaded.@These controls will not function properly until you register them, open the
forms or reports in Design view, and save the forms or reports.@@1@@@1
One or more forms or reports contains an ActiveX control that could not be
loaded.@These controls will not function properly until you register them, open the
forms or reports in Design view, and save the forms or reports.@@1@@1

Microsoft Office Access has converted the code in '|' to your current version of
Visual Basic.@To improve the performance of this database, do the following:1.
Open any module in this database in Design view.2. On the Debug menu, click
Compile And Save All Modules.@@1@@@1
Microsoft Office Access has converted the code in '|' to your current version of
Visual Basic.@To improve the performance of this database, do the following:1.
Open any module in this database in Design view.2. On the Debug menu, click
Compile And Save All Modules.@@1@@1
Microsoft Access has converted the code in '|' to your current version of Visual
Basic.@To improve the performance of this database, do the following:1. Open
any module in this database in Design view.2. On the Debug menu, click Compile
And Save All Modules.@@1@@1
DAO version 3.0 is not compatible with this version of Microsoft Office
Access.@Create a reference to DAO version 3.5. For information on setting
references, click Help.@@2@1@13780@1
DAO version 3.0 is not compatible with this version of Microsoft Office
Access.@Create a reference to DAO version 3.5. For information on setting
references, click Help.@@2@613780@1
DAO version 3.0 is not compatible with this version of Microsoft Access.@Create a
reference to DAO version 3.5. For information on setting references, click
Help.@@2@613780@1
You can't import, export, create, modify, or rename any forms, reports, pages or
modules in an ACCDE, MDE or ADE database.@@@1@@@1
You can't import, export, create, modify, or rename any forms, reports, pages or
modules in an MDE database.@@@1@@1
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29046

2007
2003

29047

2007

2003

2002

29048

2007
2003

29049

2007
2003

29050

2007

2003

2002

29051

2007

2003

29052

2007

Error Description
You can't create a module for a form or report if it is read-only, or if the database is
read-only.@@@1@@@1
You can't create a module for a form or report if it is read-only, or if the database is
read-only.@@@1@@1
Microsoft Office Access was unable to open the Visual Basic project for this
database.@Another user is saving the project now. Do you want to
retry?@@23@@@1
Microsoft Office Access was unable to open the Visual Basic project for this
database.@Another user is saving the project now. Do you want to
retry?@@23@@1
Microsoft Access was unable to open the Visual Basic project for this
database.@Another user is saving the project now. Do you want to
retry?@@23@@1

MDE databases can't reference MDB databases.@MDE databases can only reference
other MDE databases or type libraries.@@1@@@1
MDE databases can't reference MDB databases.@MDE databases can only reference
other MDE databases or type libraries.@@1@@1
To add a code module to a form or report, you must switch to Design view and set
the HasModule property of the form or report to Yes.@@@1@@@1
You can't refer to a form or report module from Form view or Report preview if the
form's or report's HasModule property is set to No.@Switch to Design view or set
the HasModule property to Yes in order to refer to the module.@@1@@1

Microsoft Office Access couldn't compile this database because one or more
references couldn't be resolved.@The database has not been saved in a compiled
state. The performance of this database will be slower because Microsoft Office
Access will need to recompile the database for each session.@For information on
improving performance, click Help.@2@1@11705@1
Microsoft Office Access couldn't compile this database because one or more
references couldn't be resolved.@The database has not been saved in a compiled
state. The performance of this database will be slower because Microsoft Office
Access will need to recompile the database for each session.@For information on
improving performance, click Help.@2@611705@1
Microsoft Access couldn't compile this database because one or more references
couldn't be resolved.@The database has not been saved in a compiled state. The
performance of this database will be slower because Microsoft Access will need to
recompile the database for each session.@For information on improving
performance, click Help.@2@611705@1
The current user account doesn't have permission to make an MDE file from this
database.@To make an MDE file, do the following:* Join the workgroup that
defines the user accounts used to access the database.* Make sure the user
account has Open/Run and Open Exclusive permissions for the database object.*
Make sure the user account has Modify Design or Administer permissions for the
MSysModules2 table in the database.* Request that other users close the
database.@@1@@@1
The current user account doesn't have permission to make an MDE file from this
database.@To make an MDE file, do the following:* Join the workgroup that
defines the user accounts used to access the database.* Make sure the user
account has Open/Run and Open Exclusive permissions for the database object.*
Make sure the user account has Modify Design or Administer permissions for the
MSysModules2 table in the database.* Request that other users close the
database.@@1@@1
The Visual Basic for Applications project in the database '|' can't be converted to the
current Visual Basic format.@If the database is an MDE, you will need to rebuild the
MDE from the source MDB. If you don't have the source MDB, you will need to
obtain a new version of the MDE that is compatible with the current version of Visual
Basic.@@1@@@1
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29052

2003

The Visual Basic for Applications project in the database '|' can't be converted to the
current Visual Basic format.@If the database is an MDE, you will need to rebuild the
MDE from the source MDB. If you don't have the source MDB, you will need to
obtain a new version of the MDE that is compatible with the current version of Visual
Basic.@@1@@1

29053

2007

Microsoft Office Access can't create any more controls on this form or report.@If
you have deleted controls from this form or report in the past, you may be able to
rename the form or report and then add more controls to it.@@1@@@1
Microsoft Office Access can't create any more controls on this form or report.@If
you have deleted controls from this form or report in the past, you may be able to
rename the form or report and then add more controls to it.@@1@@1
Microsoft Access can't create any more controls on this form or report.@If you have
deleted controls from this form or report in the past, you may be able to rename
the form or report and then add more controls to it.@@1@@1

2003

2002

29054

2007

2003
2002
29055

2007
2003
2002

29056

2007

2003

29057

2007

2003

29058

2007
2003

Error Description

Microsoft Office Access can't add, rename, or delete the control(s) you
requested.@@@1@@@1
Microsoft Office Access can't add, rename, or delete the control(s) you
requested.@@@1@@1
Microsoft Access can't add, rename, or delete the control(s) you
requested.@@@1@@1

The form or report '|'
form or report before
The form or report '|'
form or report before
The form or report '|'
form or report before

has too
using it
has too
using it
has too
using it

many controls.@Reduce the number of controls on the
in this version of Microsoft Office Access.@@1@@@1
many controls.@Reduce the number of controls on the
in this version of Microsoft Office Access.@@1@@1
many controls.@Reduce the number of controls on the
in this version of Microsoft Access.@@1@@1

Someone else is using '|' and the Visual Basic for Applications project does not
match your version of Visual Basic.@You need to open the database exclusively in
order to upgrade the Visual Basic for Applications project in this
database.@@1@@@1
Someone else is using '|' and the Visual Basic for Applications project does not
match your version of Visual Basic.@You need to open the database exclusively in
order to upgrade the Visual Basic for Applications project in this database.@@1@@1
The database '|' is read-only and the Visual Basic for Applications project does not
match your version of Visual Basic.@You need to open the database read-write in
order to upgrade the Visual Basic for Applications project in this
database.@@1@@@1
The database '|' is read-only and the Visual Basic for Applications project does not
match your version of Visual Basic.@You need to open the database read-write in
order to upgrade the Visual Basic for Applications project in this database.@@1@@1
You can't create a module for a form or report while an instance of the form or
report is in browse mode.@@@1@@@1
You can't create a module for a form or report while an instance of the form or
report is in browse mode.@@@1@@1

29059

2007
2003
2002

Microsoft Office Access was unable do display the module.@@@1@@@1
Microsoft Office Access was unable do display the module.@@@1@@1
Microsoft Access was unable do display the module.@@@1@@1

29060

2007
2003

File not found.@@@1@@@1
File not found.@@@1@@1

29061

2007

There were compilation errors during the conversion or enabling of this
database.@This might be due to old DAO syntax that is no longer supported.For
an example on how to fixup the code, click Help. @@2@1@11705@1
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29061

2003

There were compilation errors during the conversion or enabling of this
database.@This might be due to old DAO syntax that is no longer supported.For
an example on how to fixup the code, click Help. @@2@611705@1

29062

2007

The module name '|' is misspelled or refers to a module that doesn't exist.@If the
invalid module name is in a macro, an Action Failed dialog box will display the
macro name and the macro's arguments after you click OK. Open the Macro
window, and enter the correct module name.@@1@@@1
The module name '|' is misspelled or refers to a module that doesn't exist.@If the
invalid module name is in a macro, an Action Failed dialog box will display the
macro name and the macro's arguments after you click OK. Open the Macro
window, and enter the correct module name.@@1@@1

2003

Error Description

29063

2007

The Visual Basic for Applications project in the database is corrupt.

29064

2007

You do not have exclusive access to the database at this time. If you proceed to
make changes, you may not be able to save them later.

29065

2007

Microsoft Office Access can't save design changes or save to a new database object
because another user has the file open. To save your design changes or to save to a
new object, you must have exclusive access to the file.
Microsoft Access can't save design changes or save to a new database object
because another user has the file open. To save your design changes or to save to a
new object, you must have exclusive access to the file.
You do not have exclusive access to the database at this time. Your design changes
will not be saved.

2002

2000
29066

2007

You do not have exclusive access to the database. Your design changes cannot be
saved at this time. Do you want to close without saving your changes?

29067

2007

You do not have exclusive access to the database. You cannot convert this
database at this time.

29068

2007

Microsoft Office Access cannot complete this operation. You must stop the code and
try again.
Microsoft Access cannot complete this operation. You must stop the code and try
again.

2002

29069

2007

2003

2002

29070

2007

2003

2002

29071

2007

Microsoft Office Access cannot save the digital signature at this time.@* You may
be in a database under Source Code Control.* You may be in a database which is
read only.* The database uses either the *.accdb or *.accde file name extension.
To sign such a database, click the Microsoft Office Button, point to the Publish
menu, and then click Package and Sign.@@1@@@1
Microsoft Office Access cannot save the digital signature at this time.@* You may
be in a database under Source Code Control.* You may be in a database which is
read only.@@1@@1
Microsoft Access cannot save the digital signature at this time.@* You may be in a
database under Source Code Control.* You may be in a database which is read
only.@@1@@1
Your Microsoft Office Access database or project contains a missing or broken
reference to the file '|1'|2@* To ensure that your database or project works
properly, you must fix this reference. @@1@2@5043@1
Your Microsoft Office Access database or project contains a missing or broken
reference to the file '|1'|2@* To ensure that your database or project works
properly, you must fix this reference. @@1@5043@1
Your Microsoft Access database or project contains a missing or broken reference to
the file '|1'|2@* To ensure that your database or project works properly, you must
fix this reference.* To learn how to fix this reference, click Help.@@2@5043@1

Missing or broken VBE reference to the file '|1'.
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29072

2007

2003

2002

Error Description
Microsoft Office Access has detected corruption in this file. To try to repair the
corruption, first make a backup copy of the file. Click the Microsoft Office Button,
point to Manage and then click Compact and Repair Database. If you are currently
trying to repair this corruption, you need to recreate this file or restore it from a
previous backup.@@@2@1@553714192@1
Microsoft Office Access has detected corruption in this file. To try to repair the
corruption, first make a backup copy of the file. Then, on the Tools menu, point to
Database Utilities and click Compact and Repair Database. If you are currently
trying to repair this corruption then you will need to recreate this file or restore it
from a previous backup.@@@2@553714192@1
Microsoft Access has detected corruption in this file. To try to repair the corruption,
first make a backup copy of the file. Then, on the Tools menu, point to Database
Utilities and click Compact and Repair Database. If you are currently trying to repair
this corruption then you will need to recreate this file or restore it from a previous
backup.@@@2@5117@1

29073

2007

You do not have exclusive access to the database. You cannot continue with the
Source Code Control command.

29074

2007

Microsoft Office Access failed to create the Visual Basic module.@If your database is
on a network drive, check your network connection, and then try again.@@1@@@1
Microsoft Office Access failed to create the Visual Basic module.@If your database is
on a network drive, check your network connection, and then try again.@@1@@1
Microsoft Access failed to create the Visual Basic module.@If your database is on a
network drive, check your network connection, and then try again.@@1@@1

2003
2002
29075

2007

2003

29076

2007
2003

29077

29078

2007
2003

2007
2003

Access cannot add a digital signature to a file created in Access 97 or
earlier.@Convert the file to Access 2000 or later file format, and then add a digital
signature.@@1@@@1
Access cannot add a digital signature to a file created in Access 97 or
earlier.@Convert the file to Access 2000 or later file format, and then add a digital
signature.@@1@@1
There was a problem with the digital certificate. The VBA project could not be
signed. The signature will be discarded.@@@1@@@1
There was a problem with the digital certificate. The VBA project could not be
signed. The signature will be discarded.@@@1@@1
Modifications to the database or project have invalidated the associated digital
signature.@This may require you to make a trust decision the next time you open
the database or project. @@2@393347091@1
Modifications to the database or project have invalidated the associated digital
signature.@This may require you to make a trust decision the next time you open
the database or project. To re-sign the database or project now, click Resign. &Re-sign &Close@@36@393347091@1

29079

2007

Microsoft Office Access is unable to read the VBA modules in this database and
cannot recover the modules because the file is read-only. To recover the VBA
modules, close the database and make a backup copy of the database. Then open
the database with read/write permission.@@@2@2@553713744@1

29080

2007

The VBA modules in this database appear to have been saved with errors. Access
can recover the modules, but you should backup the database first. To cancel so
you can make a backup copy of the database, click Cancel. Then make a backup
copy of the database. @If you have a backup copy of the database, click OK. When
the database opens, examine the modules to see that they are correct. If they are
not, you should revert to a recent backup.@@6@2@553713744@1
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29081

2007

The database cannot be opened because the VBA project contained in it cannot be
read. The database can be opened only if the VBA project is first deleted. Deleting
the VBA project removes all code from modules, forms and reports. You should
back up your database before attempting to open the database and delete the VBA
project.@To create a backup copy, click Cancel and then make a backup copy of
your database. To open the database and delete the VBA project without creating a
backup copy, click OK.@@6@2@553713744@1

29082

2007

The version of Access used to save this database cannot be detected. This problem
cannot be corrected because the database is read-only. Click OK, and after the
database closes, make a backup copy of the database. Then open the database
with read/write permission.@@@2@2@553713744@1

30000

2007

Microsoft Office Access could not find the SQL Server specified. Verify that the
server name is correct.
Microsoft Access could not find the SQL Server specified. Verify that the server
name is correct.

2002
30001

2007
2002

30002

2007
2002

Error Description

Microsoft Office Access could not find the database on the server. Verify that the
database name is correct.
Microsoft Access could not find the database on the server. Verify that the
database name is correct.
Microsoft Office Access could not log on to the server. Verify that the log on
information is correct.
Microsoft Access could not log on to the server. Verify that the log on information is
correct.

30004

2007

The Default Max Records setting must be between 0 and 2147483647.

30005

2007

Missing SQL command

30006

2007

Access was not able to perform this operation because the project is not connected
to a SQL Server database.

30007

2007

Can't sort on one or more fields specified in 'Order By' property or sorting/grouping
dialog.
Cannot Sort on one or more fields specified in the OrderBy property or the
Sorting/Grouping dialog.

2000
30008

2007

The server you are trying to access is case sensitive. Objects of the same name but
of different case are not supported. Using these objects may result in a loss of data.

30009

2007

Another user or application has deleted this record or changed the value of its
primary key.

30010

2007

Cannot apply Filter on one or more fields specified in the Filter property.

30011

2007

Cannot get column information for the database object being browsed.

30012

2007

A Server Filter cannot be applied to a stored procedure Record Source. Filter not
applied.

30013

2007

You can't update the record because another user or application deleted it or
changed the value of its primary key.

30014

2007

The data was added to the database but the data won't be displayed in the form
because it doesn't satisfy the criteria in the underlying record source.

30015

2007

The specified record source contains duplicate names for some output fields. Use
aliases in your SELECT statement to give each field a unique name.

30016

2007

The field '|' is read only.

30017

2007

This database is not enabled for publication.

30018

2007

Cannot create objects of type '|' against current SQL backend.
permissions and server setup.
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30019

2007

Error Description

2002

Microsoft Office Access cannot copy a table with a name that is longer than 64
characters.
Microsoft Access cannot copy a table with a name that is longer than 64 characters.

30020

2007

Cannot find column '|'.

30021

2007

Cannot use domain functions on stored procedures.

30022

2007

The Access project could not be opened. You may not have adequate permissions,
or the project may be read-only.

30023

2007

Cannot use domain functions on scalar functions.

30024

2007

Your password will not be encrypted before it is saved to the file.@Users who view
the source contents of the file will be able to see the account user name and
password. &Save Password Cancel@@36@1@553714179@
Your password will not be encrypted before it is saved to the file.@Users who view
the source contents of the file will be able to see the account user name and
password. &Save Password Cancel@@36@553714179@
Your password will not be encrypted before it is saved to the file.@Users who view
the source contents of the file will be able to see the account user name and
password. &Save Password Cancel@@36@5127@

2003

2002

30025

2007

Invalid SQL Statement. Check the server filter on the form record source

30026

2007

Access is unable to connect to '|1' database on the '|2' server. Make sure that the
database still exists and that the server is running.

30027

2007

The value you entered is not consistent with the data type or length of the column.

30028

2007

The database name for the attached database file is blank. Enter a name for your
database.

30029

2007

This version of Microsoft Office Access does not support design changes with the
version of Microsoft SQL Server to which your Access project is connected. See the
Microsoft Office Update Web site for the latest information and downloads. Your
design changes will not be saved.
This version of Microsoft Office Access doesn't support design changes with the
version of Microsoft SQL Server your Access project is connected to. See the
Microsoft Office Update Web site for the latest information and downloads (on the
Help menu, click Office on the Web). Your design changes will not be saved.
This version of Microsoft Access doesn't support design changes with the version of
Microsoft SQL Server your Access project is connected to. See the Microsoft Office
Update Web site for the latest information and downloads (on the Help menu, click
Office on the Web). Your design changes will not be saved.

2003

2002

31000

2007
2003

You must specify criteria for all conditional formats.@@@1@@@1
You must specify criteria for all conditional formats.@@@1@@1

31001

2007
2003

A conditional format expression can't be longer than 946 characters.@@@1@@@1
A conditional format expression can't be longer than 946 characters.@@@1@@1

31002

2007

Microsoft Office Access can't modify the control's conditional formats right
now.@Your program tried to modify the conditional format of a control while the
conditional format was being evaluated.@@1@@@1
Microsoft Office Access can't modify the control's conditional formats right
now.@Your program tried to modify the conditional format of a control while the
conditional format was being evaluated.@@1@@1
Microsoft Access can't modify the control's conditional formats right now.@Your
program tried to modify the conditional format of a control while the conditional
format was being evaluated.@@1@@1
Microsoft Access can't modify the control's conditional formats right now.@Your
program tried to modify the conditional format of a control while the conditional
format was being evaulated.@@1@@1

2003

2002

2000
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31003

2007
2003

31004

2007

2003

31005

2007

2003

Error Description
The setting for this property
characters for this property,
The setting for this property
characters for this property,

is too long.@You can enter up to either 255 or 2,048
depending on the data type.@@1@@@1
is too long.@You can enter up to either 255 or 2,048
depending on the data type.@@1@@1

The value of an (AutoNumber) field cannot be retrived prior to being
saved.Please save the record that contains the (AutoNumber) field prior to
performing this action.@@@1@@@1
The value of an (AutoNumber) field cannot be retrived prior to being
saved.Please save the record that contains the (AutoNumber) field prior to
performing this action.@@@1@@1

Access failed to evaluate one or more expressions because '|' was referenced in an
expression. Only functions and properties that are considered to be safe are allowed
in expressions when Access runs in sandbox mode.@For more information on
sandbox mode, search for "Sandbox mode" in Access Help.@@1@@@1
Access failed to evaluate one or more expressions because '|' was referenced in an
expression. Only functions and properties that are considered to be safe are allowed
in expressions when Access runs in sandbox mode.@For more information on
sandbox mode, search for "Sandbox mode" in Access Help.@@1@@1

31006

2007

This method is not supported for Attachment controls in the current database file
format.@@@1@@@1

31500

2007

Microsoft Office Access can't send this format in a mail message.@To send this
format in a mail message, click Export on the File menu, or use the OutputTo
method to create the files and attach them to a mail message.@@1@@@1
Microsoft Office Access can't send this format in a mail message.@To send this
format in a mail message, click Export on the File menu, or use the OutputTo
method to create the files and attach them to a mail message.@@1@@1
Microsoft Access can't send this format in a mail message.@To send this format in a
mail message, click Export on the File menu, or use the OutputTo method to create
the files and attach them to a mail message.@@1@@1
Microsoft Access can't send this format in a mail message.@To send this format in a
mail message, click Save As/Export on the File menu, or use the OutputTo method
to create the files and attach them to a mail message.@@1@@1

2003

2002

2000

31501

2007
2000

The selected transform file '|' cannot be found. Please select a different transform.
Microsoft Access can't find the dynamic-link library (DLL) Mso97rt.@You can't use
the /runtime command-line switch unless you have installed Microsoft Office 97
Developer Edition Tools.@@1@@3

31502

2007

Microsoft Office Access can't find the Microsoft Office international dynamic-link
library (DLL).@Reinstall Microsoft Office.@@1@@@3
Microsoft Office Access can't find the Microsoft Office international dynamic-link
library (DLL).@Reinstall Microsoft Office.@@1@@3
Microsoft Access can't find the Microsoft Office international dynamic-link library
(DLL).@Reinstall Microsoft Office.@@1@@3
Microsoft Access can't find the Microsoft Office international dynamic-link library
(DLL).@Reinstall Microsoft Office 97, Developer Edition.@@1@@3

2003
2002
2000

31503

2007

The specified transform did not successfully convert the data. Select a different
transform.

31504

2007

The data was transformed in a format that cannot be imported.

31505

2007

Are you sure you want to remove '|' from the list of available transforms?This
will not actually delete the transform file.

31506

2007

The selected transform file cannot be found. Select a different transform or remove
the transform. Then try to export again.

31507

2007

Invalid field data type.
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31508

2007

2003
31509

2007

2003

31510

2007
2003
2002

31511

2007

2003

31512

2007

2003

2002

31513

2007
2003
2002

31514

2007
2003
2002

Error Description
Cannot load the Office Web Components@Access had a problem loading the Office
Web Components Version 9.0. Try going through set-up to re-install
them@@1@@@3
Cannot load the Office Web Components@Access had a problem loading the Office
Web Components Version 9.0. Try going through set-up to re-install them@@1@@3

Cannot load the Office Web Components@Access had a problem loading the Office
Web Components Version 10.0. Try going through set-up to re-install
them@@1@@@3
Cannot load the Office Web Components@Access had a problem loading the Office
Web Components Version 10.0. Try going through set-up to re-install
them@@1@@3
Microsoft Office Access can't load the dynamic-link library |. @You need to resolve
the failure and start Access again.@@1@@@3
Microsoft Office Access can't load the dynamic-link library |. @You need to resolve
the failure and start Access again.@@1@@3
Microsoft Access can't load the dynamic-link library |. @You need to resolve the
failure and start Access again.@@1@@3
You have chosen to alter the mode in which SQL syntax will be interpreted in this
database. This will mean: @* Existing queries may return different results or not
run at all.* The range of data-types and reserved words will change.* Different
wildcards will be used. @It is recommended that you make a backup copy of this
database before continuing. If you agree to continue, Access will close this
database, compact it, and re-open in the new mode. Select OK to
continue.@5@1@24324@1
You have chosen to alter the mode in which SQL syntax will be interpreted in this
database. This will mean: @* Existing queries may return different results or not
run at all.* The range of data-types and reserved words will change.* Different
wildcards will be used. @It is recommended that you make a backup copy of this
database before continuing. If you agree to continue, Access will close this
database, compact it, and re-open in the new mode. Select OK to
continue.@5@324324@1
Microsoft Office Access can't open the mail session.@You may not have configured
an e-mail client on this computer. Ensure that your e-mail software has been
installed and configured properly.@@1@@@1
Microsoft Office Access can't open the mail session.@You may not have configured
an e-mail client on this computer. Ensure that your e-mail software has been
installed and configured properly.@@1@@1
Microsoft Access can't open the mail session.@You may not have configured an email client on this computer. Ensure that your e-mail software has been installed
and configured properly.@@1@@1

All open objects must be closed prior to converting to a different version.@Do you
want Microsoft Office Access to close the objects?@@19@@@2
All open objects must be closed prior to converting to a different version.@Do you
want Microsoft Office Access to close the objects?@@19@@2
All open objects must be closed prior to converting to a different version.@Do you
want Microsoft Access to close the objects?@@19@@2
Microsoft Office Access can't convert this database to a different version because
one or more objects are open.@Close all objects and try again.@@1@@@3
Microsoft Office Access can't convert this database to a different version because
one or more objects are open.@Close all objects and try again.@@1@@3
Microsoft Access can't convert this database to a different version because one or
more objects are open.@Close all objects and try again.@@1@@3
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Access

31515

2007

2003

31516

2007

2003

2002

31517

2007

2003

2002

31518

2007

2003

2002

31519

2007
2003

31520

2007

Error Description
Your database is using SQL Server Compatible Syntax (ANSI 92) for which Access
2000 has limited support. This will mean:@* Access 2000 users may not be able to
see some queries.* Existing queries may return different results or not run at
all.* The range of data-types and reserved words will change.* Different
wildcards will be used. @It is recommended that you change the SQL Server
Compatible Syntax (ANSI 92) setting before converting this database to the Access
2000 file format. Select Cancel to abort the conversion process and change the SQL
Server Compatible Syntax (ANSI 92) setting.@5@1@24324@1
Your database is using SQL Server Compatible Syntax (ANSI 92) for which Access
2000 has limited support. This will mean:@* Access 2000 users may not be able to
see some queries.* Existing queries may return different results or not run at
all.* The range of data-types and reserved words will change.* Different
wildcards will be used. @It is recommended that you change the SQL Server
Compatible Syntax (ANSI 92) setting before converting this database to the Access
2000 file format. Select Cancel to abort the conversion process and change the SQL
Server Compatible Syntax (ANSI 92) setting.@5@324324@1
Microsoft Office Access can't convert this database to the requested version because
it has been 'enabled' to work with newer versions of Microsoft Office Access than it
was originally created with.@You can convert this database to a newer format, and
then retry this operation with the newly converted database.@@1@@@1
Microsoft Office Access can't convert this database to the requested version because
it has been 'enabled' to work with newer versions of Microsoft Office Access than it
was originally created with.@You can convert this database to a newer format, and
then retry this operation with the newly converted database.@@1@@1
Microsoft Access can't convert this database to the requested version because it has
been 'enabled' to work with newer versions of Microsoft Access than it was originally
created with.@You can convert this database to a newer format, and then retry this
operation with the newly converted database.@@1@@1
Microsoft Office Access can't convert this database to the requested version because
it is from an older version of Microsoft Office Access.@You can convert this database
to a newer format, and then retry this operation with the newly converted
database.@@1@@@1
Microsoft Office Access can't convert this database to the requested version because
it is from an older version of Microsoft Office Access.@You can convert this database
to a newer format, and then retry this operation with the newly converted
database.@@1@@1
Microsoft Access can't convert this database to the requested version because it is
from an older version of Microsoft Access.@You can convert this database to a
newer format, and then retry this operation with the newly converted
database.@@1@@1
The following controls contain expressions that can't be represented in a Microsoft
Office Access project PivotTable or PivotChart view: |.@Do you still want to switch
to PivotTable or PivotChart view?@@19@@@2
The following controls contain expressions that can't be represented in a Microsoft
Office Access project PivotTable or PivotChart view: |.@Do you still want to switch
to PivotTable or PivotChart view?@@19@@2
The following controls contain expressions that can't be represented in a Microsoft
Access project PivotTable or PivotChart view: |.@Do you still want to switch to
PivotTable or PivotChart view?@@19@@2
You cannot import this file.@You cannot import a text file unless it has one of these
extensions: |.@@1@@@1
You cannot import this file.@You cannot import a text file unless it has one of these
extensions: |.@@1@@1
You cannot import this file.@You cannot import a text file that has one of these
extensions: |.@@1@@@1
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Access

31520

2003

You cannot import this file.@You cannot import a text file that has one of these
extensions: |.@@1@@1

31521

2007
2003

Cannot establish connection to the server.@|@@1@@@1
Cannot establish connection to the server.@|@@1@@1

31522

2007

Microsoft SQL Server Desktop Engine must be on the machine running Microsoft
Office Access.@@@1@@@1
Microsoft SQL Server Desktop Engine must be on the machine running Microsoft
Office Access.@@@1@@1
Microsoft SQL Server Desktop Engine must be on the machine running Microsoft
Access.@@@1@@1

2003
2002
31523

2007

2003

2002

31524

2007

2003

2002

31525

2007
2003

2002

31526

2007

2003

2002

Error Description

Microsoft Office Access was unable to open the file '|'. The file may not be an Access
file, the path or filename specified may be incorrect, or the file can not be opened
exclusively. To repair the file manually, on the File menu, point to Manage
Database, and then click Compact and Repair Database.@@@1@@@1
Microsoft Office Access was unable to open the file '|'. The file may not be an Access
file, the path or filename specified may be incorrect, or the file can not be opened
exclusively. To repair the file manually, on the Tools menu, point to Database
Utilities, and then click Compact and Repair Database.@@@1@@1
Microsoft Access was unable to open the file '|'. The file may not be an Access file,
the path or filename specified may be incorrect, or the file can not be opened
exclusively. To repair the file manually, on the Tools menu, point to Database
Utilities, and then click Compact and Repair Database.@@@1@@1
Microsoft Office Access can't transfer the user-defined function '|'. User-defined
functions can only be transferred between Microsoft SQL Servers that are version
8.0 or higher.@@@1@@@1
Microsoft Office Access can't transfer the user-defined function '|'. User-defined
functions can only be transferred between Microsoft SQL Servers that are version
8.0 or higher.@@@1@@1
Microsoft Access can't transfer the user-defined function '|'. User-defined functions
can only be transferred between Microsoft SQL Servers that are version 8.0 or
higher.@@@1@@1
You can copy and paste this object only if at least Microsoft SQL Server 2000 is
installed on both the source and destination servers.@@@1@@@1
The selected object can't be pasted because the version of either the source or the
destination server is less than 7.0.@Microsoft Office Access can only copy and paste
this object if both Microsoft SQL Servers are version 7.0 or higher.@@1@@1
The selected object can't be pasted because the version of either the source or the
destination server is less than 7.0.@Microsoft Access can only copy and paste this
object if both Microsoft SQL Servers are version 7.0 or higher.@@1@@1
You cannot create a Microsoft Office Access ADE or MDE file from a database saved
in Microsoft Office Access 2000 format.@Convert the database to the current
version of Microsoft Office Access. Then create the ADE or MDE file.@@1@@@1
You cannot create a Microsoft Office Access ADE or MDE file from a database saved
in Microsoft Office Access 2000 format.@Convert the database to the current
version of Microsoft Office Access. Then create the ADE or MDE file.@@1@@1
You can't create a Microsoft Access MDE database from a database in Microsoft
Access 2000 file format.@Close the database and convert it to the current version
of Microsoft Access. Then create the MDE database.@@1@@1

31527

2007
2003

Path not found: |.@@@1@@@1
Path not found: |.@@@1@@1

31528

2007
2003

Table '|' is in use. Please close the table and retry import.@@@1@@@1
Table '|' is in use. Please close the table and retry import.@@@1@@1

31529

2007

View '|' is in use. Please close the view and retry import.@@@1@@@1
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Access

31529

2003

View '|' is in use. Please close the view and retry import.@@@1@@1

31530

2007
2003

Procedure '|' is in use. Please close the procedure and retry import.@@@1@@@1
Procedure '|' is in use. Please close the procedure and retry import.@@@1@@1

31531

2007

Microsoft Office Access cannot create table(s) using the information contained in the
document(s) you are trying to import.@@@1@@@1
Microsoft Office Access cannot create table(s) using the information contained in the
document(s) you are trying to import.@@@1@@1
Microsoft Access cannot create table(s) using the information contained in the
document(s) you are trying to import.@@@1@@1

2003
2002

Error Description

31532

2007
2003
2002

Microsoft Office Access was unable to export the data.@@@1@@@1
Microsoft Office Access was unable to export the data.@@@1@@1
Microsoft Access was unable to export the data.@@@1@@1

31533

2007
2003

Invalid filename.@@@1@@@1
Invalid filename.@@@1@@1

31534

2007

Your database is using SQL Server Compatible Syntax (ANSI 92) for which Access
97 has limited support. This will mean:@* Existing queries may return different
results or not run at all.* The range of data-types and reserved words will
change.* Different wildcards will be used. @It is recommended that you change
the SQL Server Compatible Syntax (ANSI 92) setting before converting this
database to the Access 97 file format. Select Cancel to abort the conversion
process and change the SQL Server Compatible Syntax (ANSI 92)
setting.@5@1@24324@1
Your database is using SQL Server Compatible Syntax (ANSI 92) for which Access
97 has limited support. This will mean:@* Existing queries may return different
results or not run at all.* The range of data-types and reserved words will
change.* Different wildcards will be used. @It is recommended that you change
the SQL Server Compatible Syntax (ANSI 92) setting before converting this
database to the Access 97 file format. Select Cancel to abort the conversion
process and change the SQL Server Compatible Syntax (ANSI 92)
setting.@5@324324@1

2003

31535

2007
2003

31536

2007
2003

Invalid parameters for ExportXML.@Press Help for more
information.@@2@2@5170@1
Invalid parameters for ExportXML.@Press Help for more information.@@2@5170@1
The XML schema properties do not match the existing table structures.@Overwrite
existing structures?@@19@@@1
The XML schema properties do not match the existing table structures.@Overwrite
existing structures?@@19@@1

31537

2007
2003

There is already an object named '|' in the database.@@@1@@@1
There is already an object named '|' in the database.@@@1@@1

31538

2007

Microsoft Office Access cannot create this file. To create the file, you must give the
file a unique name, provide a valid connection string and user ID, and you must
have the necessary connection and file creation permissions.@@@1@@@1
Microsoft Office Access cannot create this file. To create the file, you must give the
file a unique name, provide a valid connection string and user ID, and you must
have the necessary connection and file creation permissions.@@@1@@1
Microsoft Access cannot create this file. To create the file, you must give the file a
unique name, provide a valid connection string and user ID, and you must have the
necessary connection and file creation permissions.@@@1@@1

2003

2002

31539

2007

There was an error loading the XSL transformation file '|1'. Please make sure that
the file is a properly formatted XSL file and is the correct file to use for the data
supplied. |2
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Access

31539

2002

There was an error loading the XSL transformation file. Please make sure that the
file is a properly formatted XSL file and is the correct file to use for the data
supplied.

31540

2007

There was an error loading the XML data file '|1'. Please make sure that the file is a
properly formatted XML file. |2
There was an error loading the XML data file. Please make sure that the file is a
properly formatted XML file.

2002
31541

2007

2003

2002

31542

2007
2003

31543

2007

2003

2002

31544

2007

2003

2002

31545

2007

2003

Error Description

Microsoft Office Access cannot open this file.@This file is located outside your
intranet or on an untrusted site. Microsoft Office Access will not open the file due to
potential security problems. @To open the file, copy it to your machine or an
accessible network location.@2@@@1
Microsoft Office Access cannot open this file.@This file is located outside your
intranet or on an untrusted site. Microsoft Office Access will not open the file due to
potential security problems. @To open the file, copy it to your machine or an
accessible network location.@2@@1
Microsoft Access cannot open this file.@This file is located outside your intranet or
on an untrusted site. Microsoft Access will not open the file due to potential security
problems. @To open the file, copy it to your machine or an accessible network
location.@2@@1
The startup action associated with this file may not be safe. Do you want to
execute the startup action as you open the file?@@@22@@@1
The startup action associated with this file may not be safe. Do you want to
execute the startup action as you open the file?@@@22@@1
The startup action associated with this file may not be safe. If you choose not to
execute the startup action, Microsoft Office Access will not open the file. Do you
want to execute the startup action and open the file?@@@22@@@1
The startup action associated with this file may not be safe. If you choose not to
execute the startup action, Microsoft Office Access will not open the file. Do you
want to execute the startup action and open the file?@@@22@@1
The startup action associated with this file may not be safe. If you choose not to
execute the startup action, Microsoft Access will not open the file. Do you want to
execute the startup action and open the file?@@@22@@1
Microsoft Office Access cannot open this file.@The author of this file has set it to
open only when a startup action is executed, and Microsoft Office Access is currently
set to disable startup actions.@To address this problem, contact the author of the
file or your system administrator.@2@@@1
Microsoft Office Access cannot open this file.@The author of this file has set it to
open only when a startup action is executed, and Microsoft Office Access is currently
set to disable startup actions.@To address this problem, contact the author of the
file or your system administrator.@2@@1
Microsoft Access cannot open this file.@The author of this file has set it to open only
when a startup action is executed, and Microsoft Access is currently set to disable
startup actions.@To address this problem, contact the author of the file or your
system administrator.@2@@1
Microsoft Office Access cannot open this file.@The Internet Security Zone Manager
is missing or not correctly installed and therefore the safety of this file cannot be
verified.@To address this problem, reinstall Windows Internet Explorer or the
appropriate Office System Pack.@2@@@1
Microsoft Office Access cannot open this file.@The Internet Security Zone Manager
is missing or not correctly installed and therefore the safety of this file cannot be
verified.@To address this problem, reinstall Microsoft Internet Explorer or the
appropriate Office System Pack.@2@@1
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Access

31545

2002

Microsoft Access cannot open this file.@The Internet Security Zone Manager is
missing or not correctly installed and therefore the safety of this file cannot be
verified.@To address this problem, reinstall Microsoft Internet Explorer or the
appropriate Office System Pack.@2@@1

31546

2007

This database is a Microsoft Office Access 7.0/8.0/9.0 Design Master.@If you click
OK, the database you selected will be renamed to |1 and then converted to |2.
Everyone using a replica of this database will have to upgrade to Microsoft Office
Access 2002 after the next synchronization.@@4@@@2
This database is a Microsoft Office Access 7.0/8.0/9.0 Design Master.@If you click
OK, the database you selected will be renamed to |1 and then converted to |2.
Everyone using a replica of this database will have to upgrade to Microsoft Office
Access 2002 after the next synchronization.@@4@@2
This database is a Microsoft Access 7.0/8.0/9.0 Design Master.@If you click OK, the
database you selected will be renamed to |1 and then converted to |2. Everyone
using a replica of this database will have to upgrade to Microsoft Access 2002 after
the next synchronization.@@4@@2

2003

2002

31547

2007
2003

2002
31548

2007
2003
2002

Error Description

Microsoft Office Access cannot export this object to XML when it is open in Print
Preview. Close the object and try again.@@@1@@@1
Microsoft Office Access cannot export this object to XML when it is open in Print
Preview. Close the object and try again.@@@1@@1
Microsoft Access cannot export this object to XML when it is open in Print Preview.
Close the object and try again.@@@1@@1

Microsoft Office Access cannot export a table to XML when it is open in Design.
Close the object and try again.@@@1@@@1
Microsoft Office Access cannot export a table to XML when it is open in Design.
Close the object and try again.@@@1@@1
Microsoft Access cannot export a table to XML when it is open in Design. Close the
object and try again.@@@1@@1

31549

2007

Finished importing document '|'.

31550

2007

Not all of your data was successfully imported. Error descriptions with associated
row numbers of bad records can be found in the Microsoft Office Access table '|'.
Not all of your data was successfully imported. Error descriptions with associated
row numbers of bad records can be found in the Microsoft Access table '|'.

2002
31551

2007
2003

31552

2007

2003

2002

31553

2007
2003

Only XML files can be exported to an Internet address (http://, ftp://). Enter a path
that points to a location on your computer or on the network.@@@1@@@1
Only XML files can be exported to an Internet address (http://, ftp://). Enter a path
that points to a location on your computer or on the network.@@@1@@1
The document(s) you are importing contain XML Schema (XSD) information created
outside Microsoft Office Access. XML Schema information created outside Microsoft
Office Access is not supported. If you continue, Microsoft Office Access will only
import the data, and ignore the XML Schema.@Would you like to
continue?@@19@@@1
The document(s) you are importing contain XML Schema (XSD) information created
outside Microsoft Office Access. XML Schema information created outside Microsoft
Office Access is not supported. If you continue, Microsoft Office Access will only
import the data, and ignore the XML Schema.@Would you like to
continue?@@19@@1
The document(s) you are importing contain XML Schema (XSD) information created
outside Microsoft Access. XML Schema information created outside Microsoft Access
is not supported. If you continue, Microsoft Access will only import the data, and
ignore the XML Schema.@Would you like to continue?@@19@@1
The Smart Tag property value cannot exceed 1024 characters.@@@1@@@1
The Smart Tag property value cannot exceed 1024 characters.@@@1@@1
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Access

31554

2007
2003

Error Description
You are attempting to apply more smart tags then the system can handle.@Please
uncheck some of the selected tags.@@1@@@1
You are attempting to apply more smart tags then the system can handle.@Please
uncheck some of the selected tags.@@1@@1

31555

2007

The specified transform did not successfully convert the data.Would you like to
save a copy of the Data to Export at '|' for troubleshooting?

31556

2007

To view object dependencies or change the Track name AutoCorrect info option,
Microsoft Office Access must close all objects and update dependency
information.@This could take several minutes. Do you want to
continue?@@21@1@553713744@1
To view object dependencies or change the Track name AutoCorrect info option,
Microsoft Office Access must close all objects and update dependency
information.@This could take several minutes. Do you want to
continue?@@21@553713744@1

2003

31557

2007
2003

31558

2007

2003

Microsoft Office Access cannot update dependency information because one or more
objects are open.@Close all objects and try again.@@1@@@3
Microsoft Office Access cannot update dependency information because one or more
objects are open.@Close all objects and try again.@@1@@3
The Track name AutoCorrect info option generates name maps for the objects in the
database. This may take several minutes.@Do you want to leave this option turned
on?@@3@@@1
The Track name AutoCorrect info option generates name maps for the objects in the
database. This may take several minutes.@Do you want to leave this option turned
on?@@3@@1

31559

2007

Microsoft Office Access could not connect to the site you specified. Verify the
address of the site or contact your site administrator.

31560

2007

The site you specified does not support linking to a Microsoft Office Access
database. The site must be running Windows SharePoint Services from Microsoft.
The site you specified does not support linking to a Microsoft Office Access
database. The site must be running Windows SharePoint Services from Microsoft

2003
31561

2007

2003

The site you specified does not support importing data to a Microsoft Office Access
database. The site must be running Microsoft Windows SharePoint Services.
The site you specified does not support importing data to a Microsoft Office Access
database. The site must be running Windows SharePoint Services from Microsoft.

31562

2007

The site you specified does not contain any lists. Verify the address of the site, or
contact your site administrator.

31563

2007

Microsoft Office Access could not enable name AutoCorrect for one or more objects
because Access could not open and save the objects. An open or save operation
could have failed due to one or more of the following reasons - the object is already
open, you don't have permissions to open the object in Design view, the database is
read-only, or the source of a linked table could not be
found.@@@2@1@553713743@1
Microsoft Office Access could not enable name AutoCorrect for one or more objects
because Access could not open and save the objects. An open or save operation
could have failed due to one or more of the following reasons - the object is already
open, you don't have permissions to open the object in Design view, the database is
read-only, or the source of a linked table could not be found.@@@2@553713743@1

2003

31564

2007
2003

To generate object dependencies, the Track name AutoCorrect info option must be
turned on.@Enable name AutoCorrect and continue?@@5@1@553713744@1
To generate object dependencies, the Track name AutoCorrect info option must be
turned on.@Enable name AutoCorrect and continue?@@5@553713744@1
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Access

31565

2007

2003

31566

2007
2003

31567

2007
2003

31568

2007
2003

31569

2007
2003

31570

2007

2003

31571

2007
2003

31572

2007

2003

31573

2007
2003

Error Description
Dependency information needs to be updated before
dependencies. This could take several minutes.@Do
continue?@@5@1@553713744@1
Dependency information needs to be updated before
dependencies. This could take several minutes.@Do
continue?@@5@553713744@1

you can view object
you want to

you can view object
you want to

The object dependencies feature is not enabled for this database because
dependency info needs to be updated.@@@5@1@553713744@1
The object dependencies feature is not enabled for this database because
dependency info needs to be updated.@@@5@553713744@1

The object that you have selected in the Object Dependencies pane no longer exists
in the database.@@@1@@@1
The object that you have selected in the Object Dependencies pane no longer exists
in the database.@@@1@@1
You do not have the necessary permissions to generate dependency information for
the selected object.@@@2@1@553713744@1
You do not have the necessary permissions to generate dependency information for
the selected object.@@@2@553713744@1
To view dependency information, you must select a table, query, form, or
report.@@@1@1@553713742@1
To view dependency information, you must select a table, query, form, or
report.@@@1@553713742@1
Dependency information cannot be generated because name maps are either
missing or outdated. Turn on the Track name AutoCorrect info option, make sure
you have sufficient permissions to open an object in Design view, and make sure
the database is not read-only.@@@2@1@553713744@1
Dependency information cannot be generated because name maps are either
missing or outdated. Turn on the Track name AutoCorrect info option, make sure
you have sufficient permissions to open an object in Design view, and make sure
the database is not read-only.@@@2@553713744@1
Dependency information cannot be generated because name maps are outdated,
and the database is read-only.@@@2@1@553713744@1
Dependency information cannot be generated because name maps are outdated,
and the database is read-only.@@@2@553713744@1

Microsoft Office Access cannot generate dependency information for a new unsaved
object. Save the new object and then check for object
dependencies.@@@2@1@553713744@1
Microsoft Office Access cannot generate dependency information for a new unsaved
object. Save the new object and then check for object
dependencies.@@@2@553713744@1
Microsoft Office Access cannot generate dependency information for objects in a
project.@@@1@@@1
Microsoft Office Access cannot generate dependency information for objects in a
project.@@@1@@1

31574

2007

Microsoft Office Access cannot export unbound forms or reports as XML documents.

31575

2007

All open objects must be closed prior to backing up your database or project.@Do
you want Microsoft Office Access to close the objects?@@19@@@2
All open objects must be closed prior to backing up your database or project.@Do
you want Microsoft Office Access to close the objects?@@19@@2

2003
31576

2007
2003

Microsoft Office Access cannot backup this database or project because one or more
objects are open.@Close all objects and try again.@@1@@@3
Microsoft Office Access cannot backup this database or project because one or more
objects are open.@Close all objects and try again.@@1@@3
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Access

31577

2007

Microsoft Office Access could not connect to the site you specified. Verify the
address of the site or contact your site administrator.

31578

2007

Microsoft Office Access was unable to transfer data to the Microsoft Windows
SharePoint Services site. The '|1' step failed.
|2
The table could not be exported because you do not have sufficient permissions.
Please contact your site administrator.

2003
31579

2007
2003

Error Description

The table could not be exported because you do not have sufficient permissions.
Please contact your site administrator.
A list with the specified name already exists. Type a different name and try again.

31580

2007
2003

A list with the specified name already exists. Type a different name and try again.
The list name cannot contain any of the following characters: \/:*?"<>|. Type a
different name and try again.

31581

2007

The list name cannot contain any of the following characters: \/:*?"<>|. Type a
different name and try again.
Microsoft Office Access cannot generate dependency information for objects in a
replica database.@@@1@@1

2003
31582

2007
2003

Microsoft Office Access cannot generate dependency information for objects in a
replica database.@@@1@@@1
Finished importing from '|'.

31583

2007
2003

Finished importing from '|'.
Finished linking to '|'.

31584

2007
2003

Finished linking to '|'.
Finished exporting table '|1' to '|2'.

31585

2007
2003

Finished exporting '|1' to '|2'.
The site you specified does not support importing data from a Microsoft Office
Access database. The site must be running Windows SharePoint Services from
Microsoft.

31586

2007

The site you specified does not support importing data from a Microsoft Office
Access database. The site must be running Windows SharePoint Services from
Microsoft.
Microsoft Office Access cannot generate dependency information because the Track
name AutoCorrect info option is turned off. This option cannot be turned on because
the database is either read-only or you do not have sufficient
permissions.@@@1@@1

2003

31587

2003

Microsoft Office Access cannot generate dependency information because the Track
Name AutoCorrect Info option is turned off. This option cannot be turned on
because the database is either read-only or you do not have sufficient
permissions.@@@1@@@1
Error exporting picture file '|1' to specified path '|2'.

2007
2003

Error exporting picture file '|1' to specified path '|2'.
Specified transform failed to successfully transform your data.

31589

2007
2003

Specified transform failed to successfully transform your data. |
A list named '|' already exists. You must either use a different name or go to the
site and delete the list.

31590

2007

A list named '|' already exists. You must either use a different name or go to the
site and delete the list.
Microsoft Office Access is unable to export '|' to Windows SharePoint Services due
to limitations on the number of times each data type can appear in a Windows
SharePoint Services list.@See help to find out exactly what the restrictions are and
for details on how to create a query that will define the Windows SharePoint
Services list that you would like to create.@@2@553714173@1

31588

2007

2003
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31591

2007

2003
31592

2007
2003

31593

2007
2003

Error Description
Microsoft Office Access is unable to export '|' to Windows SharePoint Services due
to limitations on the number of times each data type can appear in a Windows
SharePoint Services list.@See help to find out exactly what the restrictions are and
for details on how to create a query that will define the Windows SharePoint
Services list that you would like to create.@@2@1@553714173@1
Cannot find the specified schema file '|'. Remove or update the file reference and
try to import again.

Cannot find the specified schema file '|'. Remove or update the file reference, and
try again to import.@@@1@@@1
Microsoft Office Access has encountered an error processing the XML schema in file
'|1'. |2
Microsoft Office Access has encountered an error processing the XML schema in file
'|1'. |2@@@1@@@1
Microsoft Office Access was unable to export XML data to '|'.

31594

2007
2003

Microsoft Office Access was unable to export XML data to '|'.@@@1@@@1
You must install the Microsoft Access 2.0 Converter in order to convert this file.@To
get the Access 2.0 Converter from the Microsoft Office Web site, click "Microsoft
Office Online" on the Help menu.@@1@@1

31595

2007

This database was saved in the Microsoft Access | file format.@For information on
how to import data from this database into a new file, click Microsoft Office Online
on the Getting Started with Microsoft Office Access page.@@1@@@1

31596

2007

Cannot load the specification '|'. Try re-creating the specification.@@@1@@@1

31597

2007

The specification XML failed to validate against the schema. There is an error in the
following line of the XML document: |.@@@1@@@1

31598

2007

The specification XML failed to validate against the schema. There is an error in the
following specification XML string: |1 Possible value could be one of following
'|2'.@@@1@@@1

31599

2007

The specified name '|' cannot be set due to one of the following reasons:
• The specified name is not unique.
• The specified name is blank.
• The specified name does not follow Microsoft Office Access object-naming
rules.@@@1@@@1

31600

2007

The specified description '|' is too long. The description cannot exceed 255
characters.@@@1@@@1

31601

2007

The specification does not contain a description. '|'.@@@1@@@1

31602

2007

The specification with the specified index does not exist. Specify a different index.
'|'.@@@1@@@1

31603

2007

The name '|' is already in use. Enter a different name or click on the Manage Data
Tasks button to rename the existing specification. @@@1@@@1

31604

2007

The required element <Columns> is missing under <ImportText> and
<ExportText> for a fixed width format.@@@1@@@1

31605

2007

The Width attribute is required for all <column> elements under <ImportText> or
<ExportText> for a fixed width format.@@@1@@@1

31606

2007

Cannot open the destination database. If the database is open, close it, and then
try again.@@@1@@@1

31607

2007

The Path attribute is required for all formats except ImportWSS, ImportOutlook and
ExportXML.

31608

2007

Specify a name for the import specification in the Save As box.

31609

2007

Specify a name for the export specification in the Save As box.

31610

2007

Do you want to delete '|'?
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31611

2007

Specify the name of the source or destination file in the File name box.

31612

2007

The specification failed to execute. Try re-creating the specification.

31613

2007

You have selected "Tables and Related Views" as the way to group objects in the
database. Access needs to update information on object dependencies to create
the groups. This will take some time for large databases.@Do you want to
continue?@@3@@@1

31614

2007

Are you sure you want to delete the item '|' from the Categories list?@Note that the
individual groups and the shortcuts to the objects in the database will be deleted,
but the objects themselves will not be deleted.@@3@@@1

31615

2007

Are you sure you want to delete the group?@Note that only the shortcuts, and not
the actual objects will be deleted.@@3@@@1

31616

2007

Duplicate Item Name@An item with the name | already exists in the Categories list.
Specify a different name for the item.@@1@@@1

31617

2007

Duplicate Group Name@A group named | already exists. Specify a different name
for the group.@@1@@@1

31618

2007

Blank Item Name@You have not specified a name for the item that you added to
the Categories list.@@1@@@1

31619

2007

Blank Group Name@You have not specified a name for the group.@@1@@@1

31620

2007

This will clear all the contents in your MSysNavPaneXXX system tables.@Do you
want to continue?@@3@@@1

31621

2007

There is already a shortcut named '|1' to the '|2' object in this group.@@@1@@@1

31622

2007

The table description cannot be changed for a linked table

31623

2007

Microsoft Office Access has imported 'Favorites' and other groups into the converted
database. If you change the imported groups in Access 2007, you will not see those
changes if you open the database in an older version of Access. Also, if you change
the imported groups by using an older version of Access, you will not see those
changes if you open the database in Access 2007. @@@1@@@1

31624

2007

Enter a valid date.@@@1@@@1

31625

2007

Enter a valid value.@@@1@@@1

31626

2007

| issues were found that could result in unwanted behavior or missing data.@Do you
want to cancel the wizard and review the issues?@Click No to ignore the issues and
continue with the migration.

31627

2007

A copy of the database has moved to |. Continue opening current file?

31628

2007

Moving to SharePoint is not supported for databases that have the AllowBypassKey
property disabled.

31629

2007

Template '|1' could not be instantiated.@|2@@@@@3

31630

2007

Failed to set the database property '|'.

31631

2007

The object name '|' could not be used because it doesn't follow object-naming rules.

31632

2007

Failed to load '|1' into '|2'.

31633

2007

'|' is not a supported AccessObject type.

31634

2007

Failed to create relationship '|'.

31635

2007

Manifest.xml does not match the defined schema. |

31636

2007

Tables.xml does not exist.

31637

2007

This template cannot be used because it requires a later version of Microsoft Office
Access. See Microsoft Office Online for the latest templates you can use with
your current version of Microsoft Office Access.

31638

2007

Errors were encountered while loading Tables.xml.
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31639

2007

Manifest.xml does not exist.

31640

2007

Relationships.xml does not match the required schema.

31641

2007

An unexpected error occurred when opening the template.

31642

2007

NavPane.xml does not match the required schema.

31643

2007

'|' is not a valid template.

31644

2007

Failed to create a database with the specified CollatingOrder.

31645

2007

Failed to set |1 on |2 '|3'.

31646

2007

Failed to load NavPane.xml.

31647

2007

An error occurred while flipping |1 '|2' right-to-left.

31648

2007

An error occurred while performing Name AutoCorrect.

31649

2007

An error occurred while fixing up the labels on |1 '|2'.

31650

2007

The source file '|1' for |2 '|3' does not exist.

31651

2007

The object name '|' could not be used because another object with the same name
already exists.

31652

2007

You do not have exclusive access to the database. Your SharePoint Lists can not be
taken offline or cached at this time. Try again later.

31653

2007

Microsoft Office Access is unable to take your lists offline. A circular relationship was
detected.

31654

2007

Access denied. You do not have permissions to SharePoint server. Verify
permissions, and retry this operation.

31655

2007

Microsoft Office Outlook could not be started. Make sure Outlook is installed and
properly set up on your computer.

31656

2007

You must have Microsoft Office Outlook 2007 on this computer to enable this
feature.

31657

2007

You cannot set up a collecting data using e-mail task, because your database has
reached its maximum size limit. Free some disk space and try again.

31658

2007

The selected table or query does not have any fields that support collecting data
using e-mail.

31659

2007

| is read-only. You cannot use e-mail messages to collect or update data on this
object.

31660

2007

You cannot collect data for action queries, SQL-specific queries, and parameter
queries by using e-mail messages.

31661

2007

The e-mail address field you have specified does not contain any valid addresses.
Specify another field.

31662

2007

The value you have entered is not valid for the maximum number of replies.

31663

2007

The value you have entered is not valid for the date and time to stop.

31664

2007

The date and time to stop processing replies has to be greater than the current date
and time.

31665

2007

|

31666

2007

The UpdateDependencyInfo method could not update one or more objects.
Microsoft Office Access has created a Name AutoCorrect Save Failures table in the
current database with more information about the failing
objects.@@@2@1@553713744@1

31667

2007

Do you want to delete all of the selected objects? Deleting these objects will
remove them from all groups.@You cannot undelete forms, reports, and
modules.@@20@@@1
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31668

2007

Microsoft Office Access does not support opening HTML pages. @To open a Data
Access Page, use Windows Internet Explorer or Microsoft Office Access 2003 or
earlier.@@2@@4294967294@1

31669

2007

Design changes are not supported for Data Access Pages. @To change the design of
a Data Access Page, use Microsoft Office Access 2003 or
earlier.@@2@@4294967294@1

31670

2007

Microsoft Office Access does not support this operation for Data Access Pages. To
perform this operation, use Microsoft Office Access 2003 or earlier.@@@1@@@1

31671

2007

|

31672

2007

This operation is not supported for SharePoint linked tables. To manage SharePoint
linked tables, point to Get External Data on the Data menu, and then click
SharePoint List.

31673

2007

Changes have been made to this database by an older version of Access or by an
external source. In order to use the Tables and Related Views group in the
Navigation Pane the dependency tree must be rebuilt. This may take a few
moments.@Do you want to continue?@@3@@@1

31674

2007

Do you want to delete all of the selected objects? Deleting these objects will
remove them from all groups.@@@20@@@1

31675

2007

You cannot create an .accde or .mde file from a disabled (non-trusted) database. If
you trust the source of this database, you can enable it by using the Message
bar.@@@1@@@1

32000

2007

The '|1' macro action cannot run with the specified '|2' argument either when in
disabled mode or when called from an embedded macro.@@@1@@@1

32001

2007

The '|' RunCommand cannot be run in disabled mode.@@@1@@@1

32002

2007

Cannot open or run macro '|', because it is not valid.@@@1@@@1

32003

2007

The ApplyFilter action requires a valid control name that corresponds to a subform
or subreport.@@@1@@@1

32004

2007

The control name '|' is misspelled or refers to a control that doesn't exist.@If the
invalid control name is in a macro, an Action Failed dialog box will display the macro
name and the macro's arguments after you click OK. Open the Macro window, and
enter the correct control name.@@1@@@1

32005

2007

One or more actions are unknown and cannot be pasted.@@@1@@@1

32500

2007

The group '|' you entered is invalid.@@@1@@@1

32501

2007

The category '|' you entered is invalid.@@@1@@@1

32502

2007

The value you entered isn't valid for the field '|'.@For example, you may have
entered text in a numeric field or a number that is greater than the FieldSize setting
permits.@@1@@@1

32503

2007

Support for export to .PDF or .XPS is not installed on this computer.@@@1@@@1

32504

2007

The text you entered isn't an item in the list.@Do you want to edit the items in the
list?@@20@@@4

32505

2007

Microsoft Office Access has recovered this database. Examine the database to verify
that there are no missing database objects.@@@1@@@1

32506

2007

Microsoft Office Access has recovered this database, but one or more tables were
found to contain data corruption and were deleted. Deleted tables were logged in
the MSysRecoveryErrors table. This table is currently displayed in the
datasheet.@@@1@@@1

32507

2007

Microsoft Office Access has recovered this database, but one or more tables were
found to contain data corruption and were deleted. Deleted tables were logged in
the MSysRecoveryErrors table. @@@1@@@1

32508

2007

The 'Save as Outlook Contact' command failed.@@@1@@@1
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32509

2007

The 'Add from Outlook' command failed.@@@1@@@1

32510

2007

Microsoft Office Access could not find any fields that match the fields in a Microsoft
Office Outlook Contact.@@@1@@@1

32511

2007

Successfully added | contact(s).@@@1@@@1

32512

2007

You cannot save this database in an earlier version format, because it uses features
that require the current file format.@Features that require the current file format
include attachments, multivalued fields, offline data, or links to external files that
are not supported by earlier versions of Access.@@1@@@1

32513

2007

All open objects must be closed before you save the database.@Do you want
Microsoft Office Access to close all open objects?@@19@@@2

32514

2007

Microsoft Office Access can't save this database to a different version, because one
or more objects are open.@Close all objects, and then try again.@@1@@@3

32515

2007

You are about to delete the list and all its data from the SharePoint site. Do you
want to continue?

32516

2007

The filter string you entered is not valid or you cannot apply a filter at this time.

32517

2007

This SharePoint list or one of related lists doesn't exist on the SharePoint site.

32518

2007

The following errors have occurred:

32519

2007

The value specified for the Type parameter is invalid. Specify one of the following:
Report, Form, Query, or Table.

32520

2007

The repair operation was cancelled. To repair the file manually, on the File menu,
point to Manage Database, and then click Compact and Repair Database.

32521

2007

You can't change the value of this property in the OnPaint event.@@@1@@@1

32522

2007

No contacts were imported. None of the fields have the necessary '|' property
specified.@@@1@@@1

32523

2007

A custom macro in this report has failed to run, and is preventing the report from
rendering.@@@1@@@1

32524

2007

Access could not create '|1'.@|2@Make sure that the file name (and location, if
provided) are in the correct format, such as c:\location\file name.@1@@@1

32525

2007

Access could not download the template from Microsoft Office Online.

32526

2007

You attempted to create an .mdb file on a SharePoint site. You can create only
Access 2007 database (.accdb) files on SharePoint sites. Either change the file type
or select a different location.

32527

2007

You attempted to create an .adp file on a SharePoint site. You can create only
Access 2007 database (.accdb) files on SharePoint sites. Either change the file type
or select a different location.

32528

2007

The application is disabled, and databases may not be created.

32529

2007

This operation is not supported for parameterized queries or objects based on
parameterized queries.@@@1@@@1

32530

2007

Sharing to Windows SharePoint Services requires the database to be in an Access
2007 or greater format.

32531

2007

Microsoft Office Access failed to create the SharePoint list. This could be because
you don't have the necessary permissions.

32532

2007

The project cannot be converted to this format. The project can only be converted
to Access 2000 or newer format.

32533

2007

Failed to create field '|1' on table '|2'

32534

2007

Failed to delete predefined field '|1' on table '|2'

32535

2007

Failed to rename the the field '|1' on the SharePoint list '|2'
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32536

2007

The specified command (OutputTo) is not available now. Close objects open in
Design View or Layout View and try again.@@@1@@@1

32537

2007

Only 256 TempVars can be created. Be sure to remove any TempVars that are not
needed.

32538

2007

TempVars can only store data. They cannot store objects.

32539

2007

TempVars can only store strings with up to 65,356 characters.

32540

2007

The name of this TempVar is too long. TempVar names must be 256 characters or
less. Use a shorter name.

32541

2007

You must specify a name to set or remove a temporary variable.

32542

2007

You must specify a value to set the temporary variable to.

32543

2007

Do you want to connect to an existing SQL Server database?@Select No to create a
new SQL Server database.@@16@@@4

32544

2007

You are trying to convert an encoded database. Decode the database, and then try
again.To protect the converted database, use the Encrypt with Password
command.

32545

2007

You are trying to convert a password protected database. Remove the password,
and then try again.To protect the converted database, use the Encrypt with
Password command.

32546

2007

You are trying to convert an encoded database that uses a password. Decode the
database, remove the password, and then try again.To protect the converted
database, use the Encrypt with Password command.

32547

2007

You are trying to convert a database that is encrypted with a password. Remove the
password, and then try again.To protect the converted database, use the Set
Database Password command.

32548

2007

There was an error displaying the mail message. Make sure that there are no open
dialogs in Outlook and try again.

32549

2007

'|' contains over 10,000 rows. Processing may take several moments. Would you
like to continue?

32550

2007

'|' is an empty lookup field. You will not be able to collect data for this field. To
continue, remove the empty lookup field from the list of fields to be included in this
e-mail message.

32551

2007

There was an error displaying the task. Make sure that there are no open dialogs in
Outlook and try again.

32552

2007

This command is not available when the database is opened from the Web server.
Would you like to save a local copy of the database?

32553

2007

To sign and deploy a database, you must use a database created with Microsoft
Office Access 2007 or later. Convert the database to the Access 2007 format and
start the signing process again.

32554

2007

Microsoft Office Access could not create a deployment package with the current
database. Check the path to the file.@@@1@@@1

32555

2007

Microsoft Office Access could not sign the current database. Ensure that the digital
certificate used to sign the database is valid.@@@1@@@1

32556

2007

Microsoft Office Access could not extract the database. Check the file name and the
path to the file.@@@1@@@1

32557

2007

Microsoft Office Access could not download the packaged database. Network issues
or issues with the Web site may have prevented the download. Start the download
again or browse to the site and ensure that it is operating.@@@1@@@1

32558

2007

You requested an invalid file. The file may be corrupt. Contact the person who
created the file and request a new copy.@@@1@@@1

32559

2007

The template is in an unknown format and cannot be opened.
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32560

2007

The specified template does not exist.

32561

2007

The specified template contains errors or is not a valid template.

32562

2007

The specified template cannot be created in the specified file format. Specify a
different file format for the new database.

32563

2007

You cannot use a template file to create a database directly on a SharePoint site.

32564

2007

This does not appear to be a template file. The file may have become corrupt, or
the package format may contain an error.

32565

2007

The |0 '|1' could not be read from the template file. The object may be in an
unrecognized format or contain invalid data.

32566

2007

The table '|0' in the template could not be associated with a SharePoint list with ID
|1.

32567

2007

The |0 '|1' in the template could not be loaded from text because of a parsing error.
|2

32568

2007

The table |0 or one of its fields could not be successfully renamed.

32569

2007

Failed to add the VBA reference |0

32570

2007

A Design Master or Replica cannot be converted to the Access 2007 file
format.@@@1@@@1

32571

2007

The contents of the Navigation Pane may not be changed while it is locked.

32572

2007

Access Projects do not support custom groups in the Navigation Pane. You may not
import or export custom groups from an Access Project.

32573

2007

Microsoft Office Access cannot perform the export operation.

32574

2007

This template requires a SharePoint site with a newer version of Windows
SharePoint services. Specify a different site.

32575

2007

The acCmdExport command for RunCommand has been deprecated. Use the
OutputTo action or one of the more specific RunCommands, such as
acCmdExportExcel, acCmdExportRTF, and acCmdExportText.

32576

2007

The acCmdImport command for RunCommand has been deprecated. Use one of
the more specific RunCommands, such as acCmdImportAttachAccess,
acCmdImportAttachExcel, and acCmdImportAttachText.

32577

2007

The acCmdLinkTables command for RunCommand has been deprecated. Use one
of the more specific RunCommands, such as acCmdImportAttachAccess,
acCmdImportAttachExcel, and acCmdImportAttachText.

32578

2007

Microsoft Office Access could not load the Access database engine. Run setup again
and restart the application.@@@1@@@1

32579

2007

You do not have permissions to write to this SharePoint site. Contact your site
administrator for assistance.

32580

2007

Cannot publish the file | as the file is either checked out or locked for editing by
another user.

32581

2007

SQL Distributed Management Objects (SQL-DMO) must be on the machine running
Microsoft Office Access.

32582

2007

The specified file name could not be used to create a database. Specify a different
database name.

32583

2007

An error occurred while trying to create the database.

32584

2007

No object with the given name and type exists in the current database.

32585

2007

This feature is only available in an ADP.@@@1@@@1

32586

2007

This database object cannot be saved as a report.@@@1@@@1

32587

2007

The Source value you have specified is not valid.@@@1@@@1
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32588

2007

The table which you are trying to append to is currently open and must be closed
before proceeding. Do you want to save the changes and close the
table?@@@20@@@2

32589

2007

Microsoft Office Access encountered an error trying to close the table.@@@1@@@1

32590

2007

You cannot link to a database that is stored on an Internet location. You should first
save the database to a location that uses a Universal Naming Convention (UNC),
such as a server share, and then link to it.@@@1@@@1

32591

2007

The file path you specified is not valid. Please specify a full file path.@@@1@@@1

32592

2007

The file name extension of '|' is not valid for the format to which you are trying to
export. This action is potentially unsafe. Do you want to continue? @@@20@@@2

32593

2007

Overwite existing table or query '|'?@@@20@@@2

32594

2007

The Show Column History command is not available while you are working with a
SharePoint list offline. Reconnect to the list and try again.@@@1@@@1

32595

2007

Microsoft Office Access cannot delete the SharePoint list, because you don't have
the necessary permissions to delete the list or the list has been renamed or no
longer exists.

32596

2007

The Microsoft Office Access Outlook Add-in is disabled in Microsoft Office Outlook
2007. To collect data by using e-mail messages in Microsoft Office Access 2007,
verify that this add-in is installed and enabled from within Office Outlook 2007.

32597

2007

This database contains links to lists on the selected SharePoint site.Do you want
to be able to add shortcuts to each list's View menu? This will enable other people
to open forms and reports from the SharePoint Web page.

32598

2007

The name '|' is already in use. Enter a different name. @@@1@@@1

32599

2007

Only XML files can be imported from an Internet address (http://, ftp://). Enter a
path that points to a location on your computer or on the network.@@@1@@@1

32600

2007

The list |1 is already used by the |2 link table. Select a different list.

32601

2007

You are about to change sites. Any changes you have made to link tables will be
discarded. Do you want to continue without saving these changes?

32602

2007

The SetProperty action or method failed because there was no form or report
context.@To establish the correct context for SetProperty, call OpenForm or
OpenReport before calling SetProperty, or call SetProperty from an event on a form
or report.@@1@@@1

32603

2007

SharePoint List data will be cached in this database. If this database is shared,
users who do not have permissions to view this data will be able to see it.

32604

2007

There was an error publishing your database. Verify your publish URL and
permissions, and then try again.

32605

2007

Your data source contains more than 255 fields (columns). Access will import only
the first 255 fields.

32606

2007

Attachment fields are not supported in the MDB or ADP database formats.
Attachment fields are included in the source database table and those fields will not
be exported. Do you want to continue?

32607

2007

Attachment fields are not supported in the MDB or ADP database formats. If
attachment fields are included in the source database tables, those fields will not be
imported. Do you want to continue?

32608

2007

This database file cannot be converted because it contains linked tables that refer to
one or more files that cannot be found. To continue, delete these linked tables or
repair the links.@@@1@@@1

32609

2007

|1 cannot load customization '|2'. This customization name was already loaded.
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32610

2007

Automatic configuration of the current version of Microsoft Office Access has failed.
Your database might not function correctly. This can occur if you do not have the
necessary permissions to install Microsoft Office Access on this
computer.@@@1@@@1

32611

2007

The file '|' already exists.@Do you want to update the existing file?@@20@@@2

32612

2007

Microsoft Office Access cannot open this file.
This file was converted to runtime mode by changing its file name extension to
.accdr. This file will open only when Access is in runtime mode.
To open the file, either double-click it in Windows Explorer, open it by using a
shortcut, or use the /runtime command-line switch.
To modify the design of this database, rename it with an .accdb file name
extension, and then open it in Access.

32613

2007

This feature requires the Microsoft Office Access 2007 program to be installed on
your computer.
The application you are running is powered by the Microsoft Office Access 2007
Runtime. For information about the differences between the Microsoft Office Access
program and the Microsoft Office Access Runtime, in the status bar, click Powered
by Microsoft Office Access.
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